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[ Important
Avant d’utiliser le présent document et le produit associé, prenez connaissance des informations générales figurant dans la
section [«<Remarques» & la page 345}

 Remarque
Certaines captures d’écrans de ce manuel ne sont pas disponibles en francais a la date d’impression.

Octobre 2004
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LES GARANTIES DE QUALITE MARCHANDE OU D’ADAPTATION A VOS BESOINS. Certaines juridictions
n’autorisent pas 1'exclusion des garanties implicites, auquel cas I'exclusion ci-dessus ne vous sera pas applicable.

Ce document est mis a jour périodiquement. Chaque nouvelle édition inclut les mises a jour. Les informations qui y
sont fournies sont susceptibles d’étre modifiées avant que les produits décrits ne deviennent eux-mémes
disponibles. En outre, il peut contenir des informations ou des références concernant certains produits, logiciels ou
services non annoncés dans ce pays. Cela ne signifie cependant pas qu’ils y seront annoncés.

Pour plus de détails, pour toute demande d’ordre technique, ou pour obtenir des exemplaires de documents IBM,
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commercial.
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A propos de ce document

IBM® WebSphere® InterChange Server et sa boite a outils sont utilisés avec les
adaptateurs IBM WebSphere Business Integration pour fournir une intégration de
processus métier et une connectivité parmi les technologies e-business de pointe et
les applications d’entreprise.

Le présent document fournit une présentation des taches d’implémentation d'un
systéeme d’intégration métier avec WebSphere InterChange Server.

Public visé

Ce document s’adresse aux consultants et développeurs en charge de la conception
des systemes et des composants d’intégration de WebSphere InterChange Server.

Conditions préalables a I'utilisation de ce document

Avant d’utiliser ce document, il est conseillé de lire le document Technical
Introduction to IBM WebSphere InterChange Server.

Documents connexes

La documentation compléte qui accompagne ce produit présente les
caractéristiques et les fonctions communes a toutes les installations de WebSphere
InterChange Server et inclut des supports de référence sur des composants
spécifiques.

Vous pouvez télécharger la documentation sur les sites suivants :

* Pour obtenir une documentation sur InterChange Server :

[http:/ /www.ibm.com /websphere/integration /wicserver /infocenter]

e Pour obtenir une documentation sur la collaboration :

[http:/ /www.ibm.com /websphere/integration /wbicollaborations /infocenter|

* Pour obtenir une documentation sur les composants WebSphere Business
Integration Adapter :

[http:/ /www.ibm.com/websphere/integration/ wbiadapters /infocenter|

Ces sites contiennent des explications simples pour télécharger, installer et afficher
la documentation.

Remarque : Des informations importantes relatives a ce produit peuvent étre
disponibles dans les flashes de support technique (Technical Support
Flashes), apres la publication de ce document. Pour les consulter,
accédez au site Web de support technique de WebSphere Business
Integration a I’adresse
http:/ /www.ibm.com/software/integration/websphere/support/.
Sélectionnez les domaines d’intérét du composant et accédez aux
sections Technotes et Flashes.
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Conventions typographiques

Ce document utilise les conventions suivantes :

police courier

gras
italique, italique
texte en bleu

]

UNIX:/Windows:

%texte% et $texte

Indique une valeur littérale, comme le nom d’une
commande, le nom d’un fichier, des informations que vous
tapez ou que le systéme affiche a 1’écran.

Indique un nouveau terme a sa premiere occurrence.
Indique un nom de variable ou une référence croisée.

Le soulignement en bleu, visible uniquement lorsque vous
consultez le document en ligne, indique un hyperlien de
référence croisée. Si vous cliquez sur le terme souligné, vous
étes renvoyé a l'objet de la référence.

Dans une ligne de syntaxe, les accolades entourent un
ensemble d’options parmi lesquelles vous ne devez
sélectionner qu'une seule.

Dans une ligne de syntaxe, les crochets entourent un
parametre facultatif.

Dans une ligne de syntaxe, les points de suspension
indiquent une répétition du parametre précédent. Par
exemple, option[,...] signifie que vous pouvez entrer
plusieurs options séparées par des virgules.

Dans une convention d’appellation, les signes inférieur a et
supérieur a entourent les différents éléments d'un nom afin
de pouvoir les différencier les uns des autres, par exemple,
<nom_serveur><nom_connecteur>tmp.1og.

Dans ce document, les barres obliques inverses (\) sont
utilisées comme convention pour les chemins d’acces aux
répertoires. Pour les installations UNIX, remplacez les barres
obliques inverses par des barres obliques (/). Tous les noms
de chemin des produits IBM WebSphere InterChange Server
sont associés au répertoire dans lequel le produit WebSphere
InterChange Server est installé sur votre systeme.

Les paragraphes qui commencent par 1'un de ces éléments
indiquent des remarques sur les différences qui existent
entre les systéemes d’exploitation.

Du texte placé entre des signes pourcentage (%) indique la
valeur de la variable systéme texte Windows ou de la
variable utilisateur. Le symbole équivalent dans un
environnement UNIX est $texte, indiquant la valeur de la
variable d’environnement UNIX texte.

Utilisation de ce guide

viii

Ce guide est concu pour :

* présenter les étapes supérieures de I'implémentation de WebSphere InterChange
Server, depuis 1'évaluation des spécifications du client jusqu’au déploiement

d’un systéme actif ;

* fournir aux développeurs des instructions séquentielles sur les taches a réaliser
lors du développement et de la configuration des composants et des interfaces
d’une solution WebSphere InterChange Server ;

* fournir le document du concentrateur permettant d’accéder aux documents
systéme ou de développement appropriés pour des taches de développement

spécifiques.
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Ce guide contient des informations récentes et quelques informations de
configuration qui se trouvaient a l'origine dans le document Systern Administration
Guide. Pour les taches pouvant étre réalisées par les développeurs de composants
WebSphere InterChange Server et par les administrateurs d’un systeme actif
déployé, ce guide renvoie au document System Administration Guide.

A propos de ce document  iX
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Nouveautés de la présente édition

Nouveautés de I’édition 4.3

Cette édition comporte les modifications de produit suivantes :

e Des services Web sont a présent disponibles. Pour plus d’informations, voir

«Désignation de services Web en tant que composants d’intégration» a la page]

19

* Des propriétés de déploiement peuvent a présent étre configurées pendant la
phase de déploiement. Pour plus d’informations, voir |<<Conﬁguration des|
[propriétés de la phase de déploiement» a la page 65|

e Un contréle d’acces basé sur les roles est fourni en matiere de sécurité. Pour
plus d’informations, voir [«Configuration de la sécurité a 1'aide de System|
[Manager» a la page 126,

* Vous pouvez a présent configurer le systeme a 1'aide de la confidentialité de
bout-en-bout. Pour plus d’informations, voir [«Configuration de la confidentialité|
[a 'aide de System Manager» a la page 128}

* Il existe trois nouvelles options associées a la commande repos_copy. Pour plus
d’informations sur ces options, voir [Chapitre 6, «Utilisation de repos_copy», a la|

* Des modifications ont été apportées a Integrated Test Environment. Pour plus
d’informations, voir [(Modes d’InterChange Server» a la page 34|et|Chapitre 12|
[«Utilisation d'Integrated Test Environment», a la page 255}

Nouveautés de I’édition 4.2.2

Cette édition comporte les modifications de produit suivantes :

¢ Le flux de travail relatif au déploiement des composants a été modifié. Pour plus
d’informations, voir [<Déploiement de composants a ’aide de 1’assistant de]
[déploiement» a la page 70|

* Vous pouvez a présent déployer des composants a 1’aide de la fonction
glisser-déplacer dans System Manager. Pour plus d’informations, voir
«Déploiement de composants a I'aide de la fonction glisser-déplacer» a la page
75

¢ Une nouvelle perspective appelée Collaboration Debugger permet d’interrompre
I'exécution d’un objet de collaboration et d’afficher les données d’un flux en
cours de traitement. Pour plus d’informations, voir [Chapitre 13, «Utilisation de]
[Collaboration Debugger», a la page 313

¢ Des modifications importantes ont été apportées a la perspective Integrated Test
Environment. Pour plus d’informations, voir |Chapitre 12, «Utilisationl
[d'Integrated Test Environment», a la page 255

* Des modifications peu importantes ont été apportées a plusieurs interfaces de
System Manager. Pour plus d’informations sur System Manag
«Environnement et outils IBM WebSphere InterChange Server», a la page 23

* L’outil désigné sous le nom de System Monitor basé sur le Web dans les éditions
précédentes est désormais appelé System Monitor. La fonctionnalité de 1'outil
appelé System Monitor basé sur Windows dans les éditions précédentes a été
intégrée a une vue contenue dans System Manager et nommée InterChange
Server Component Management.
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Nouveautés de I’édition 4.2.1

Cette édition comporte les modifications de produit suivantes :

System Manager comporte a présent une interface permettant de configurer
I'unité d’exécution de vérificateur de mémoire. Pour plus d’informations, voir
[«Utilisation de 1'unité d’exécution du vérificateur de mémoire» a la page 341|

Vous pouvez a présent valider des packages dans System Manager avant de les
déployer. Pour plus d’informations, voir [«Validation d’un package a 'aide dd
[System Manager» a la page 68|

En cas de blocage de la base de données, InterChange Server tente désormais de
relancer les transactions bloquées au lieu d’échouer. Vous pouvez configurer le
nombre de tentatives et 'intervalle a respecter entre chacune d’elles. Pour plus
d’informations, voir [«Configuration des propriétés de la base de données a l'aide]
[de System Manager» a la page 117

Une nouvelle option appelée -nc a été ajoutée a repos_copy pour indiquer le
codage d'un fichier texte en cours d’importation provenant d’une version
antérieure a la version 4.2.0. Pour plus d’informations, Voir
[«Utilisation de repos_copy», a la page 131}

Nouveautés de I’édition 4.2.0

Cette édition comporte les modifications de produit suivantes :

CrossWorlds System Manager a été remplacé par l'infrastructure d’outils Eclipse
et sa fonctionnalité est fournie par un plug-in nommé System Manager dans
l'infrastructure. Pour plus d’informations, voir |Chapitre 3, «Environnement et]
[outils IBM WebSphere InterChange Server», a la page 23

Un nouveau plug-in d’outil appelé Integrated Test Environment permet de tester
I'ensemble d'une interface d’intégration.

Le modele de développement d'InterChange Server a été sensiblement modifié
par rapport a I’édition précédente. Pour une présentation du nouveau modele de
développement, voir [Chapitre 1, «Processus et modele de développement d’IBM|
[WebSphere InterChange Server», a la page 1}

Cette édition comporte les modifications du document Guide d'implémentation de
WebSphere InterChange Server suivantes :

Le [Chapitre 2, «Préparation des environnements», a la page 13|a été ajouté pour
fournir des recommandations sur la maniére de configurer les environnements.

Le [Chapitre 3, «Environnement et outils IBM WebSphere InterChange Server», a|
[la page 23 a été ajouté pour présenter System Manager et la procédure de
déploiement.

Le [Chapitre 5, «Configuration de WebSphere InterChange Server», a la page 109
a été ajouté pour présenter les deux pools disponibles pour configurer
InterChange Server.

Le [Chapitre 6, «Utilisation de repos_copy», a la page 131]a été ajouté pour
présenter repos_copy et quelques scénarios d’utilisation courants.

Le [Chapitre 11, «Utilisation de Test Connector», a la page 243 a été ajouté pour
présenter l'utilisation de Visual Test Connector.

Le [Chapitre 14, «Optimisation des performances», a la page 335|a été ajouté pour
centraliser la documentation relative a certaines fonctions et propriétés
configurables dans le systeme WebSphere InterChange Server qui peuvent
affecter les performances. Il ne s’agit pas d’une référence complete mais il
constitue la base des informations a venir.
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Nouveautés de I’édition 4.1.1

Dans I'édition 4.1.1 d’IBM CrossWorlds, InterChange Server, ses outils et les API
qui lui sont associées ont été internationalisés. L’internationalisation (I18N) permet
au systeme IBM CrossWorlds de prendre en charge les environnements locaux qui
rassemblent les informations relatives aux conventions culturelles spécifiques a un
pays, un territoire, une langue mais aussi un codage de caracteres. Les composants
d’IBM CrossWorlds peuvent ensuite étre localisés pour prendre en charge un
environnement local spécifique et son codage natif.

Ce document présente les composants internationalisés suivants :
* InterChange Server (ICS)

Le fichier de configuration systéme fournit un nouveau parametre, appelé
LOCALE, qui permet de spécifier I'environnement local utilisé par InterChange
Server. Si le parametre LOCALE n’est pas défini, InterChange Server utilise
I'environnement local du systeme d’exploitation.

Pour les version non anglaises du fichier de configuration systéme, le fichier de
configuration systéme traduit est appelé : InterchangeSystem <locale_name>.cfg
(o1 locale_name désigne le nom de 1’environnement local approprié).

InterChange Server génere ses propres messages d’erreur, de trace et d’état dans
le codage de caractéres de 1’environnement local. Pour les version non anglaises
du fichier de messages systéme, le fichier de messages systéme traduit est
appelé : InterchangeSystem_<locale_name>.txt (ou locale_name désigne le nom
de I’environnement local approprié).

* Connector Designer

Une nouvelle propriété de configuration des connecteurs, appelée Locale,
indique I’environnement local utilisé par l'infrastructure du connecteur. Si la
propriété Locale n’est pas définie, l'infrastructure du connecteur utilise
I'environnement local du systéme d’exploitation.

La propriété de configuration des connecteurs appelée CharacterEncoding
indique le codage de caracteres utilisé par l'infrastructure du connecteur.

La plupart des propriétés de configuration des connecteurs peuvent a présent
prendre en charge le codage natif des valeurs des propriétés. Toutefois, les noms
des propriétés de configuration des connecteurs utilisent uniquement des
caracteres anglais (ASCII).

Nouveautés de I’édition 4.1.0

Seules des modifications rédactionnelles ont été apportées au document Guide
d’implémentation de WebSphere InterChange Server depuis 1'édition 4.0.0.

Nouveautés de I’édition 4.0.0

La version du document Guide d'implémentation de WebSphere InterChange Server
pour CrossWorlds 4.0.0 est la premiere édition.

Nouveautés de la présente édition xiii
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Chapitre 1. Processus et modéle de développement d’IBM
WebSphere InterChange Server

Le systeme WebSphere InterChange Server se compose d’une infrastructure
principale (InterChange Server et la boite a outils d’intégration métier) et
d’éléments modulaires configurables qui s’associent pour intégrer des applications
et automatiser les processus métier. Ces éléments modulaires (appelés composants
d’intégration dans ce guide) incluent des connecteurs, des modeles de
collaboration, des objets de collaboration, des objets métier, des pools de connexion
de base de données, des mappes et des relations.

Remarque : InterChange Server et WebSphere Integration Toolset sont compatibles
avec IBM Tivoli License Manager (ITLM), ce qui signifie que les
logiciels exécutés sur des noeuds controlés peuvent étre détectés. Pour
plus d’informations sur ITLM, voir le document Technical Introduction.

Ce chapitre présente I'implémentation du systeme WebSphere InterChange Server
et contient les sections suivantes :

* |«Systeme d’intégration métier WebSphere InterChange Server»)|

* [«Modele de développement de WebSphere InterChange Server» a la page 3|

* |«Etapes d’une implémentation» 2 la page §|

Systeme d’intégration métier WebSphere InterChange Server

Cette section définit une partie des concepts d’intégration évoqués dans les
sections suivantes.

Composants d’intégration

Le systeme d’intégration métier IBM WebSphere InterChange Server comprend une
infrastructure principale (InterChange Server et la boite a outils), qui prend en
charge le développement et I’exécution de composants d’intégration modulaires
configurables. Les composants d’intégration remplissent différents roles et sont
développés pour s’exécuter ensemble. Par exemple, les connecteurs communiquent
avec les applications, les objets métier contiennent des données et les modeles de
collaboration définissent la logique du processus métier.

Interfaces

En général, vous développez les composants d’intégration dans le contexte d'une
interface. Une interface est un regroupement de composants d’intégration qui
travaillent conjointement pour automatiser un processus métier. Par exemple, une
interface peut synchroniser les enregistrements d'un employé entre PeopleSoft et
SAP. Une autre interface peut automatiser le traitement des commandes entre
Siebel et Oracle. Ou encore, elle peut synchroniser les enregistrements des clients
entre Siebel et SAP. Une interface est généralement le coeur d'un objet de
collaboration, lequel est 1'instance d’un modele de collaboration dont les ports sont
liés aux composants de l'interface.

Solutions

Vous pouvez également développer des composants d’intégration dans le contexte
d’une solution. Les solutions sont des regroupements de composants et parfois
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d’interfaces destinées a répondre aux besoins des processus métier, généralement
au sein d’'un secteur d’activité (comme le commerce ou l'industrie automobile).

Bibliotheques de composants d’intégration

Les interfaces et les solutions sont des regroupements conceptuels de composants
d’intégration. C’est-a-dire que les composants sont groupés en fonction du role
qu’ils remplissent dans le contexte de l'interface ou de la solution.

Les bibliotheques de composants d’intégration, quant a elles, sont des
regroupements des composants présents dans votre environnement de
développement. Vous définissez une bibliotheque dans System Manager et System
Manager crée un répertoire dans le systeme de fichiers qui représente la
bibliotheque. Le répertoire de la bibliotheque contient plusieurs sous-répertoires
pour chaque type de composant d’intégration. Lorsque vous créez un composant
d’intégration, il est créé en tant que fichier ou groupe de fichiers et stocké dans le
sous-répertoire correspondant dans le répertoire de la bibliotheque.

Les bibliotheques peuvent contenir des composants qui n’appartiennent pas a
I'interface que vous utilisez, mais a l'interface d’un autre développeur dans le
systeme d’intégration métier. Les bibliotheques vous permettent de stocker toutes
les définitions des composants présents dans toutes les interfaces développées chez
le client dans le systeme d’intégration métier. Vous pouvez méme avoir des
bibliotheques qui correspondent a des systemes dans des sites sur lesquels vous ne
travaillez plus. Bien qu’il n’existe pas de restrictions quant a la maniére de créer et
d’utiliser les bibliotheques, il est conseillé d’entretenir une corrélation un-a-un
entre les bibliotheques de composants d’intégration et les instances d’InterChange
Server.

Projets utilisateur

Les projets utilisateur sont des implémentations logicielles qui prennent en charge
les interfaces et les solutions dans WebSphere InterChange Server Toolset. Une
interface est une structure conceptuelle ; les composants sont regroupés dans une
interface car d’apres votre conception, les composants en question sont requis pour
automatiser ce processus métier. En revanche, une bibliothéeque de composants
d’intégration n’est pas une structure conceptuelle, elle est créée et utilisée dans la
boite a outils. Cependant elle n’a pas besoin d’étre organisée : comme 'explique la
section [«Bibliothéques de composants d’intégration»} une bibliotheque peut
contenir des définitions de composants qui n’appartiennent pas a l'interface que
vous utilisez.

Les projets utilisateur sont destinés a assurer 1’organisation des composants
d’intégration de sorte que leur appartenance a une interface soit visible. Les projets
utilisateur sont des regroupements de raccourcis vers les composants d’intégration
dans une ou plusieurs bibliotheques. Ainsi, vous pouvez créer un projet utilisateur
pour chaque interface. Les projets utilisateur peuvent avoir des raccourcis vers les
mémes composants dune bibliotheque dans la mesure ot les interfaces partagent
souvent les composants. Une interface de synchronisation des données client et
une interface de traitement des commandes qui nécessitaient toutes deux
I'application SAP, par exemple, requierent le composant Adapter for SAP. Par
conséquent, les projets utilisateur qui correspondent a ces interfaces disposent de
raccourcis vers la définition du connecteur SAP.
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Systemes d’intégration métier
Bien que les interfaces et les solutions puissent elles-mémes répondre aux besoins
des entreprises, elles sont généralement développées dans le contexte d’un systeme
d’intégration métier. Un systéme d’intégration métier est un regroupement des
interfaces et des solutions requises pour répondre aux besoins d'un client en
matiére d'intégration métier et d’automatisation. Le développement d’un systeme
d’intégration métier peut se dérouler en plusieurs phases, dans lesquelles les
interfaces sont regroupées, puis développées et mises en oeuvre en priorité afin de
répondre aux besoins les plus urgents tout en conservant des objectifs et des
calendriers réalistes.

Instances d’InterChange Server

WebSphere InterChange Server est 1'infrastructure logicielle qui assure l'intégration
et 'automatisation du processus métier. Lorsque vous installez InterChange Server
sur un ordinateur et que vous démarrez le serveur, vous démarrez une instance de
serveur. Une instance de serveur héberge le systéme d’intégration métier qui
comprend toutes les interfaces qui répondent aux besoins du client. Comme
'explique la section [<(Modeéle de développement de WebSphere InterChange]
chaque développeur dans le projet doit gérer sa propre instance
d’InterChange Server. Par ailleurs, des instances d'InterChange Server doivent étre
réservées pour tester le systéme d’intégration métier dans son ensemble et pour
héberger la version de production du systéme.

Modele de développement de WebSphere InterChange Server

Cette section présente le modéle de développement que vous devez suivre pour
développer un systéme d’intégration métier.

Cycle de vie d’une interface

Dans la majorité des cas, une personne peut développer entierement une interface.
Vous allez suivre les étapes d’implémentation décrites a la page@ pour développer
les composants d’intégration qui s’exécutent conjointement pour répondre aux
besoins de votre interface.

Développement de I'interface au niveau local
Pour développer des composants d’intégration, utilisez WebSphere InterChange
Server Toolset.

Vous devez au préalable préparer votre environnement de développement. Cela
nécessite d’installer WebSphere InterChange Server sur le systeme local. Pour plus
d’informations, voir [Chapitre 2, «Préparation des environnements», a la page 13|

Vous devez définir une bibliothéeque de composants d’intégration afin de stocker
les définitions des composants et créer un projet utilisateur destiné a représenter
I'interface. Ensuite, créez et stockez les composants d’intégration de l'interface dans
la bibliotheque et ajoutez des raccourcis vers le projet utilisateur. Pour plus
d’informations, voir [«Utilisation des bibliotheques de composants d’intégration» 3|
lla page 3§ et|«Utilisation des projets utilisateur» a la page 41}

Déploiement de I'interface au niveau local

Lorsque vous développez les composants d’intégration, ceux-ci n’existent que dans
le systeme de fichiers local. Lorsque l'interface est compléte, vous déployez le
projet utilisateur sur l'instance locale d’InterChange Server, ou les définitions de
composants sont stockées dans le référentiel. Contrairement a InterChange Server
version 4.2.0 ot vous utilisiez les définitions des composants directement dans le
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référentiel, vous utilisez maintenant les définitions des composants exclusivement
dans le systeme de fichiers local et vous les déployez ensuite sur le serveur. Ce
modele de développement est appelé “gestion statique des métadonnées”. 1l
consiste a séparer les activités de développement des activités d’exécution et
repose sur le modele de développement J2EE. Pour plus d’informations sur le
déploiement des projets utilisateur, voir kExportation de composants vers unl
lpackage a l'aide de System Manager» a la page 61}

Test de l'interface au niveau local

Une fois que vous avez déployé une interface sur l'instance locale d’InterChange
Server, vous devez la tester afin de vérifier qu’elle répond aux exigences du client.
Pour plus d’informations sur le test, voir [Chapitre 11, «Utilisation de Test|
Connector», a la page 243|et |Chapitre 12, «Utilisation d’Integrated Tesf
Environment», a la page 255

Une fois que vous avez vérifié 'intégrité de 'interface dans l'instance locale
d’InterChange Server, vous devez vous associer aux autres développeurs du projet
afin de la fusionner avec les autres interfaces dans un systéeme d’intéeration métier.
Pour plus d’informations, voir [Cycle de vie d’un systeme d’intégration métier»}

Cycle de vie d’'un systeme d’intégration métier

La [«Cycle de vie d’une interface» a la page 3 explique comment développer une
interface sur le systeme local. Cette section explique comment travailler en
association avec les autres développeurs pour proposer un systeme d’intégration
métier.

Déploiement sur un environnement d’intégration de
développement

Lorsque vous avez terminé de développer et de tester I'interface sur votre systeme
local, vous devez vous associer aux autres développeurs qui utilisent également les
interfaces du projet en vue de créer un systeme d’intégration métier. Chaque
développeur doit déployer son interface sur un environnement commun, souvent
appelé environnement d’intégration de développement.

Pour ce faire, créez une bibliotheque de composants d’intégration dans
I'environnement d’intégration de développement, puis chaque développeur exporte
un package contenant les composants de son interface et importe le package dans
la nouvelle bibliotheque.

Une fois que toutes les redondances ont été résolues et que les modifications ont
été apportées, déployez les composants qui représentent le regroupement
d’interfaces sur l'instance du serveur local dans l'environnement d’intégration de
développement.

Exécution de tests d’intégration

Lorsque les interfaces d'un systeme d’intégration métier (ou d’une phase
particuliere de I'implémentation du systéme) sont combinées, elles doivent étre a
nouveau testées. Cela permet de s’assurer que chaque interface continue de
répondre aux exigences métier définies par le client lorsqu’elle est exécutée avec
les autres interfaces. Si un incident se produisait dans la migration depuis les
environnements de développement locaux vers I’environnement de développement
intégré (par exemple, une mise a jour incorrecte d'un composant partagé), il serait
identifié grace a des tests rigoureux réalisés a ce stade.
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En fonction du site, le test d’intégration peut étre réalisé dans le serveur
d’intégration de développement ou dans un environnement de test dédié. Si vous
gérez un environnement de test séparé, vous pouvez combiner toutes les interfaces
dans l'environnement d’intégration de développement et vérifier son intégrité
avant de modifier 1’environnement de test. De cette maniere, des tests peuvent étre
réalisés dans I'environnement de test pour toutes les interfaces pendant que de
nouvelles interfaces sont préparées dans I'environnement d’intégration de
développement. Toutefois, cette méthode exige que le client acquiert le matériel
nécessaire pour prendre en charge un autre environnement et que ce dernier soit
configuré.

Exécution de tests de performances

Une fois que vous avez réalisé des tests d’intégration afin de vérifier que le
regroupement d’interfaces répond toujours aux exigences fonctionnelles, vous
pouvez réaliser des tests de marges pour vous assurer que le systéme d’intégration
métier est conforme aux exigences du client en matiére de performances.

Si vous configurez 1’environnement de test des performances pour étre identique a
I'environnement de production, la capacité de traitement simulée constituera une
estimation plus précise de ce que seront les performances de production. Toutefois,
les environnements de production peuvent étre cotiteux, et le client peut ne pas
réaliser 1'investissement nécessaire pour créer un environnement de test des
performances qui reproduise fideélement 1’environnement de production.

Pour migrer le systeme d’intégration métier dans I'environnement de test des
performances, vous devez suivre la méme procédure que celle utilisée pour
effectuer la migration dans un environnement d’intégration de développement :

* Exportez un package contenant les composants dans le systeme d’intégration
métier.

* Créez une bibliotheque de composants d’intégration dans 1’environnement de
test des marges.

* Importez le package dans la nouvelle bibliotheque.

* Mettez a jour les définitions de composants pour les propriétés spécifiques a
I'environnement.

* Déployez le package des composants modifiés dans le référentiel du serveur de
test des marges.

Si vous constatez que les performances ne sont pas satisfaisantes, vous devrez
peut-étre modifier ou reconfigurer certains composants. Pour plus d’informations
sur les configurations ou les méthodes qui modifient les performances, voir
(Chapitre 14, «Optimisation des performances», a la page 335}

Mise en production

Une fois que vous avez vérifié que le systeme d’intégration métier répond aux
exigences de fonctionnement et de performances, vous devez migrer le
regroupement d’interfaces dans un environnement de production.

Pour migrer le systeme d’intégration métier dans 'environnement de production,

vous devez suivre la méme procédure que celle que vous avez utilisée pour

effectuer une migration depuis les environnements précédents :

* Exportez un package contenant les composants dans le systeme d’intégration
métier.

* Créez une bibliotheque de composants d’intégration dans I’environnement de
production.
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* Importez le package dans la nouvelle bibliotheque.

* Mettez a jour les définitions de composants pour les propriétés spécifiques a
I'environnement.

* Déployez le package des composants modifiés dans le référentiel du serveur de
production.

Lalfigure 1 a la page 7] représente le flux des composants d’intégration depuis la
bibliotheque des composants d’intégration vers le projet utilisateur, puis vers le
référentiel du serveur et enfin vers le package exporté dans les différents
environnements.

L’équipe de développement doit effectuer un transfert des connaissances afin de
doter 'administrateur du site des compétences et des informations nécessaires
pour gérer le regroupement d’interfaces. L'implémentation de 'intégration est
terminée. Vous pouvez entreprendre le développement d’une nouvelle interface
dans la prochaine étape.
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Figure 1. Modeéle de développement de WebSphere InterChange Server
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Etapes d’une implémentation

Pour développer un systeme d’intégration métier, il est conseillé de procéder par
étapes. Les détails exacts, la nature et I'ordre des documents marketing créés a
chaque étape peuvent varier en fonction de l'entreprise qui réalise
I'implémentation. Toutefois, le développement d’un systeme d’intégration métier
comprend généralement les étapes suivantes :

+ [«Recherche et évaluation des besoins»|

» |«Préparation des environnements» a la page 9

* [«Conception» a la page 10

+ [«Développement et configuration» a la page 10|

* |«Validation» a la page 11

+ [«Déploiement» a la page 12|

Recherche et évaluation des besoins
Cette étape commence le processus d'implémentation en identifiant les objectifs
métier concernant le projet, la configuration systeme et la portée générale de
'objectif de développement.

La recherche commence a un niveau de détail élevé et se poursuit a des niveaux
de détail inférieurs. Elle doit commencer par les questions de niveau de détail
élevé suivantes :

* Quels sont les problemes inhérents a I'entreprise qui doivent étre résolus pour le
client ?

La réponse a cette question est importante, car elle définit les besoins
fonctionnels des interfaces au cours des étapes de test. Si le test révele que le
probleme de l’entreprise n’a pas été résolu, cela signifie que les interfaces n’ont
pas été correctement congues ou développées.

* Quels processus métier au niveau de l'entreprise doivent étre intégrés ou
automatisés afin de répondre au probleme de I'entreprise ?

Posez-vous les questions suivantes et toutes celles qui peuvent étre pertinentes :

— Quels sont les noms et les versions spécifiques des applications qui
nécessitent d’étre intégrées ?

— Quelles sont les applications source ?

— Quelles sont les applications cible ?

— Quelle application constitue le systéme d’enregistrement ?

— Les applications sont-elles mises en oeuvre ou sont-elles encore au stade
d’implémentation ?

— Les applications ont-elles été développées par un fournisseur de logiciels ou
par des développeurs employés par le client ? Si les applications sont des
produits congus par des développeurs sur le site du client, ces développeurs
sont-ils disponibles ?

* Dans quel environnement de la technologie (notamment les applications, les
bases de données et les API) les processus métier doivent-ils étre intégrés ?

Déterminez les caractéristiques de 1’environnement de la technologie. Examinez
chacun des éléments suivants :

version et fournisseur de base de données ;

plate-forme, systéme d’exploitation et version ;

API existantes pour les applications ;

emplacement de toutes les plates-formes des serveurs et clients d’application ;
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environnement réseau ;

volume de transaction prévu.

Pour identifier les interfaces requises pour l'implémentation et les composants qui
seront utilisés, vous devez rechercher les informations dans les niveaux inférieurs
de détail : identification et description des processus métier spécifiques que vous
envisagez d’implémenter, la logique métier et les transformations de données
nécessaires, les détails des applications et des bases de données impliquées. Votre
recherche peut inclure les taches de collecte d’informations suivantes :

* Identifiez et décrivez les processus métier qui doivent étre intégrés ou
automatisés pour résoudre le probleme de l’entreprise. Posez-vous les questions
suivantes :

Quelle est la série de taches automatiques et manuelles impliquées dans le
processus métier ?

Quel événement initialise le processus ?

Quelles sont les personnes impliquées dans le processus métier ?

Quelles sont les personnes affectées par le processus métier (les utilisateurs
finaux) ?

Quelles sont les entrées et les sorties ?

Existe-t-il des conditions préalables ou des dépendances pour les données ?
Existe-t-il des exigences de filtrage ?

S’il existe plusieurs applications cible, qu’est-ce qui détermine comment
I'entité a traiter doit étre acheminée ?

L’interface est-elle bidirectionnelle ?
Quel est la fréquence d’exécution du processus ?

Existe-t-il un délai d’achevement du processus ? Les autres processus
dépendent-ils des entités qu'il traite et de son exécution ?

Quel est le volume de données ?
Le processus métier doit-il avoir lieu en temps réel ou en lot ?

L’interface est-elle synchrone (le programme d’initialisation requiert une
réponse) ou asynchrone ?

Quelle est la procédure souhaitée pour répondre aux erreurs ?

* Décrivez la structure des entités traitées par l'interface.

e Identifiez les transformations de données nécessaires entre les structures d’entité
d’application source et cible.

* Illustrez le flux du processus métier par un organigramme (a I'aide d’"Holosofx,
par exemple). L’organigramme vous aidera a analyser les opérations a réaliser, et
permettra par la suite d’effectuer des comparaisons avec les modeles de
collaboration existants. Vous serez en mesure de déterminer quelle collaboration
utiliser et le niveau de modification nécessaire.

Cette étape n’est pas expliquée en détail dans la documentation d’IBM WebSphere

InterChange Server. Bien que certaines questions aient été abordées dans cette
section, le processus d’analyse des besoins est tres spécifique aux différentes
sociétés de conseil. Vous devez suivre la méthode appropriée. D’autres étapes

reposent moins sur des méthodes de conseil spécifiques mais plus sur des logiciels.

Préparation des environnements

Dans cette étape, vous préparez les environnements nécessaires pour offrir au
client une solution d’intégration de processus métier.
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En général, chaque développeur prépare son propre environnement de
développement pour développer son interface.

Il est préférable qu'un architecte systéme prépare et gere les environnements
d’intégration de développement, de test des marges et de production.

Pour plus d’informations sur la préparation des environnements, voir |Chapitre 2,
|«Préparation des environnements», a la page 1Bl

Conception

Les processus d’évaluation et de conception utilisent les informations collectées au
cours de la recherche.

Une fois que vous avez défini les exigences particulieres d'une interface et les
composants d’'intégration qu’elle comprend, vous pouvez analyser les composants
existants afin de déterminer s’ils peuvent répondre a ces exigences. Il arrive que
pour certaines exigences, des composants soient déja disponibles et que vous les
utilisiez en 'état. En revanche, pour d’autres exigences, vous pouvez avoir a
développer les composants existants (revisés selon vos besoins) ou créer d’autres
composants d’intégration (personnalisés).

Analysez comment chaque composant se comporte séparément et comment ils se
comportent les uns par rapport aux autres dans l'interface. En effet, vous ne
pouvez pas terminer la conception d’un composant tant que vous n’avez pas
également commencé a concevoir les composants avec lesquels il interagit dans
l'interface.

Pour plus d’informations sur la conception des composants, voir les documents
suivants :

 Connector Development Guide for C++

* Connector Development Guide for Java Server
* Business Object Development Guide

* Map Development Guide

e Collaboration Development Guide

Développement et configuration
Dans cette étape, vous développez des composants d’intégration selon les
spécifications indiquées a I'étape

Pour développer l'interface, vous devez modifier les composants existants
disponibles, comme les modéles de collaboration et les objets métier et créer des
composants spécifiques a 1’environnement (comme des mappes).

L’étape de développement et de configuration est itérative et vous pouvez avoir a
redévelopper les composants et modifier leur configuration a mesure que vous
progressez.

I est recommandé d’effectuer un test d’unité des composants a mesure que vous
les développez pour vous assurer qu’ils remplissent les roles qui leur ont été
affectés dans l'interface. Une fois que vous avez développé tous les composants et
effectué un test d’unité, vous devez procéder a des tests de chaine afin de vérifier
que l'interface s’exécute correctement (au moins dans votre environnement de
développement local).
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Le développement et la configuration s’effectuent généralement en une série
d’étapes, comme décrit dans |[Chapitre 4, «Développement d’interfaces de processus
métier», a la page 99|

Pour plus d’informations sur le développement des composants, voir les
documents suivants :

Chapitre 4, «Développement d’interfaces de processus métier», a la page 99|

* Guides relatifs aux adaptateurs dans la version logicielle WebSphere Business
Integration Adapters

* Connector Development Guide for C++

* Connector Development Guide for Java Server
* Business Object Development Guide

* Map Development Guide

¢ Collaboration Development Guide

[Chapitre 7, «Configuration des connecteurs», a la page 145

[Chapitre 9, «Configuration des objets de collaboration», a la page 203

Validation

Au cours de I'étape de validation, vous effectuez des tests systeme dans un
environnement de test contrdlé afin de s’assurer que toutes les interfaces répondent
aux besoins identifiés a 1'étape [Recherche et évaluation des besoins| lorsqu’elles ont
été développées. Les tests effectués sont généralement des tests fonctionnels, des
tests de performances et de régression :

* Test fonctionnel
Les tests fonctionnels permettent de vérifier que les interfaces du systéeme
d’intégration métier répondent aux objectifs d'intégration et d’automatisation du
processus métier.

* Test de performances

Les tests de performances permettent de vérifier que la capacité de traitement, le
temps de réponse et le temps d’attente sont conformes aux attentes du client.

* Test de régression

Si vous modifiez un composant a l'issue d'un test fonctionnel ou d’un test de
performances (par exemple, vous modifiez un modéle de collaboration qui ne
répondait pas aux besoins de I'entreprise, ou vous modifiez un connecteur dont
les performances n’étaient pas satisfaisantes), vous devez effectuer un test de
régression afin de vérifier que les modifications apportées au composant sont
conformes aux exigences.

Au cours de I'étape de validation, vous allez effectuer les opérations suivantes :

* Créer une matrice des exigences qui décrit toutes les exigences de
fonctionnement et de performances

e Préparer un environnement de test systéme
Y

* Identifier et développer une série de cas d’essai qui répondront aux exigences de
fonctionnement et de performances

* Migrer le systeme d’intégration métier depuis l'environnement d’intégration de
développement vers I'environnement de test

* Développer, coordonner les procédures et les plans de test systéme et obtenir
I'accord du client a ce sujet. Affecter des tests spécifiques pour chaque élément
de la matrice de tests
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Exécuter les tests fonctionnels et de performances décrits dans les matrices de
tests

Identifier, expliquer et corriger les défauts révélés par les tests
Réaliser le test de régression comme indiqué

Créer et publier un rapport sur les tests et la configuration ou le
re-développement a suivre

Obtenir I'approbation du client a propos du systeme développé

Pour plus d’informations sur le test des composants et des interfaces, voir :

Chapitre 11, «Utilisation de Test Connector», & la page 243

Map Development Guide

Déploiement

L’objectif de I'étape de déploiement est de migrer le systeme d’intégration métier
dans l'environnement de production et de démarrer I'instance de production
d’InterChange Server.

Au cours de I'étape de déploiement, vous allez effectuer les opérations suivantes :

Développer un plan général de déploiement et obtenir 'accord du client, en
s’assurant de la continuité des opérations avec les processus et les systemes
existants

Migrer le systétme développé et testé depuis 1’environnement de test vers
I'environnement de production

Obtenir et documenter les besoins relatifs a la conversion des données et des
processus métier spécifiques au client pour l'intégration des systemes

Développer, implémenter et tester les modifications nécessaires pour répondre
aux besoins d'un environnement de production comme les adresses de courrier
électronique, les ressources de base de données d’application et les mots de
passe

Installer et tester le systeme d’intégration métier dans 1’environnement de
production

Modifier les composants et I'environnement de production afin d’optimiser les
performances de cet environnement

Obtenir l'approbation du client a propos du systeme de production déployé

Pour plus d’informations sur la migration sur un environnement de production,
VOIr :

Chapitre 3, «Environnement et outils IBM WebSphere InterChange Server», a lal

[page 23|

System Administration Guide
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Chapitre 2. Préparation des environnements

Le présent chapitre décrit comment préparer les divers environnements requis
pour qu'une interface puisse suivre les processus de développement, de test et de
production.

Ce chapitre est un chapitre préliminaire a d’autres chapitres de ce guide, et décrit
quelques-uns des outils que vous devrez utiliser pour préparer un environnement.
La logique veut qu'il apparaisse ici car vous préparez les environnements sur site
apres la conception initiale et avant tout développement. Ce guide est donc congu
dans le respect du cycle de vie d’'une implémentation. Il est recommandé de
parcourir intégralement ce guide pour mieux revenir a ce chapitre.

Ce chapitre contient les sections suivantes :

+ |«Préparation de votre environnement de développement individuel»|

* |«Préparation d’un environnement d’intégration du développement» & la page 19

Préparation de votre environnement de développement individuel

Comme décrit dans la section |«Cycle de vie d’une interface» a la page 3| vous
serez généralement chargé de développer une seule et unique interface de
processus métier et ce, dans un environnement de développement que vous aurez
préparé sur un ordinateur que vous seul utilisez, comme un ordinateur portatif.
Bien que le document System Installation Guide for Windows fournisse la plupart des
informations d’installation et de configuration du logiciel requis, cette section
propose des alternatives a votre environnement pour vous permettre un
développement plus efficace.

Installation des logiciels requis

Méme si IBM WebSphere InterChange Server nécessite un certain nombre de
logiciels professionnels fournissant l'infrastructure d’intégration, vous pouvez
tout-a-fait exécuter tous les logiciels requis sur une station de travail ou un sur
ordinateur portatif performant, a condition de ne pas traiter un gros volume de
transactions via le systéme. Un ordinateur de ce type convient pour prendre en
charge le développement et le test des composants de 1'unité ; il ne peut cependant
pas traiter des flux importants. Les logiciels requis sont répertoriés ci-apres :

» IBM WebSphere InterChange Server

InterChange Server doit étre installé sur votre systeme local afin que vous
puissiez développer votre interface.

* IBM WebSphere Business Integration Adapters

Il est recommandé d’installer les adaptateurs permettant de communiquer avec
les applications de votre interface afin de vérifier la configuration du connecteur
et de valider la connectivité a I’application. Certains adaptateurs nécessitent
également l'installation d'un client d’application. Pour plus d’informations sur
les configurations d’installation requises, reportez-vous aux guides détaillant les
adaptateurs propres a votre interface.

* IBM Java Object Request Broker (ORB)

Vous devez installer IBM ORB pour permettre a vos clients, tels que les outils et
connecteurs, de communiquer avec InterChange Server.
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* WebSphere Workbench (la structure d’Eclipse est livrée avec IBM WebSphere
InterChange Server et installée si vous choisissez d’installer la boite a outils lors
de l'installation d’InterChange Server)

Vous pouvez utiliser WSWB ou WSADIE pour prendre en charge System
Manager et les plug-ins d’'Integrated Test Environment. Il est recommandé
d’utiliser WSWB, car non seulement il fournit I'intégralité de la prise en charge
des plug-ins, mais il est plus économe en ressources que WSADIE.

¢ WebSphere Application Server ou Jakarta Tomcat

Bien que System Monitor soit congu a 1’origine pour les administrateurs d’un
systéme de production, il posséde nombre de fonctions permettant de gérer I'état
des composants. Ces fonctions sont utiles dans certains contextes de
développement. Tomcat vous paraitra certainement plus économe en ressources
systeme.

* Serveur de base de données

Chaque développeur d'un projet possede habituellement son propre
environnement et s’appuie sur sa propre base de données du référentiel. Bien
qu’'une base de données puisse étre créée pour chaque développeur sur un
serveur de base de données commun hébergé sur le site, il est recommandé
d’installer un serveur de base de données sur votre ordinateur et d'y héberger
votre référentiel. Vous pourrez ainsi poursuivre le développement sans avoir
acces au serveur de base de données sur le site.

Du fait que vous développez tous les composants du systéme de fichiers local,
vous pouvez toujours développer sans avoir acces a un référentiel de serveur.
Etant donné que vous ne pouvez pas tester les composants sans référentiel et
que ce test doit étre effectué fréquemment, il est préférable de disposer d'un
référentiel toujours accessible.

* WebSphere MQ

Bien que WebSphere MQ soit préconisé pour des environnement de production
du fait qu’il fournit une persistance des données efficace, il n’est pas nécessaire
dans un environnement de développement et peut solliciter beaucoup de
ressources systeme. Il est préconisé d’utiliser IIOP plutdt que WebSphere MQ
dans votre environnement de développement individuel. Pour ce faire,
définissez la propriété DeliveryTransport de vos connecteurs sur la valeur IDL
avec Connector Configurator. Pour plus d’informations sur Connector

Configurator et les propriétés standard de connecteur, voir [Chapitre 7,
[«Configuration des connecteurs», a la page 145,

Recommandations d’installation
Voici quelques suggestions concernant l'installation du logiciel requis :

* Lorsque vous installez IBM WebSphere InterChange Server, indiquez un nom
d’instance de serveur. Dans un réseau, l'instance de serveur doit étre unique car
le serveur est considéré comme un objet appelé CORBA, avec lequel les clients
(tels que des outils et des connecteurs) doivent communiquer. Si un réseau
comprend de multiples objets portant le méme nom, les clients ne pourront pas
localiser le serveur en question. Si tous les développeurs d'un site acceptaient le
nom de serveur par défaut lors de l'installation sur leur machine locale, cela
créerait beaucoup de doublons dans les noms de serveur.

Les ordinateurs devant également porter un nom unique en réseau, il est par
conséquent recommandé de leur donner le méme nom que celui de l'instance
InterChange Server.

En outre, il peut étre utile d'inclure d’autres informations dans le nom de
serveur. Par exemple, si vous travaillez régulierement avec des courtiers de type
InterChange Server et WebSphere MQ Integrator Broker, vous pourriez décider
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d’inclure WICS dans le nom de serveur pour distinguer le type de courtier. Vous
pouvez mentionner le nombre 420 pour indiquer la version si vous installez
plusieurs instances en différentes versions sur votre systeme. Vous pouvez
préciser DEV pour indiquer que le serveur est destiné au développement plutdt
qu’a des tests ou a un environnement de production.

* Il peut étre utile d’installer le produit dans un répertoire possédant le méme
nom que celui spécifié pour l'instance InterChange Server. Cela vous permettra
de différencier une installation d’une autre dans le cas ol vous installeriez
plusieurs fois le produit sur un méme systéme.

* Il peut également s’avérer utile d’inclure, a l'installation, le nom de votre
instance InterChange Server dans le nom du groupe de programmes créé dans le
menu Démarrer.

* Nombre de logiciels a installer ajoutent des entrées aux variables
d’environnement PATH et CLASSPATH. Sous Windows, ces variables sont
limitées a une chaine de 512 caracteres ; il se peut que l'espace soit insuffisant,
ce qui empécherait un ou plusieurs programmes de démarrer. Pour pallier a
cette limitation, vous pouvez toujours partager le dossier d’une application et y
mapper une unité réseau, puis remplacer les entrées PATH et CLASSPATH du
répertoire d’installation original avec 1'unité réseau mappée.

Par exemple, si vous installez InterChange Server sur le répertoire suivant :
D:\ProgramFiles\IBM\WICSInstallations\WebSphereICS420DEV

Vous pouvez partager le répertoire WICSInstallations , y mapper une unité
réseau telle que F: pour pouvoir ensuite utiliser F:\WebSphereICS420DEV dans
les entrées PATH et CLASSPATH.

Utilisation d’InterChange Server en mode conception

II est préconisé de démarrer votre serveur local InterChange Server en mode
conception afin de pouvoir assembler vos composants d’intégration au fur et a
mesure, ce qui est irréalisable en mode production. Pour plus d’informations, voir
la section [<Modes d’InterChange Server» a la page 34

Modification de fichiers de traitement par lots

II est recommandé d’appliquer au fichier de traitement par lots start_server.bat
les modifications suivantes dans votre environnement de développement local :

* Ajoutez la commande pause dans la ligne vide située au-dessus de la commande
endlocal, a la fin du fichier de traitement par lots.

Par défaut, le fichier start_server.bat est écrit de sorte qu’il quitte
immédiatement si une erreur survient lors du démarrage d’InterChange Server.
Régulierement, le serveur subit une erreur lorsque vous essayez pour la
premiere fois de le démarrer, et la fenétre de la console affichant un message
d’erreur identifiant le probleme quitte avant que vous n’ayez pu lire le message.
En incluant la commande pause au fichier de traitement par lots, la fenétre de la
console affichera en permanence le message concernant l'erreur liée au probleme
de démarrage du serveur. La fin du fichier ressemblera a 1'exemple ci-dessous
une fois les modifications effectuées :

%CWJAVA% -Djava.ext.dirs=%JRE_EXT_DIRS%;"%MQ_LIB%";"%DB2_LIB%"
-Duser.home="%CROSSWORLDS%" -mx%CW_MEM_HEAP%m -DTEAgent=1200

-DCW_MEMORY_MAX=%CW_MEM_HEAP% %ORB:PROPERTY% -classpath %JCLASSES%
ServerWrapper -s%SERVERNAME% %2 %3

pause

endlocal
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* Bien que les logiciels requis, tels que les serveurs de base de données WebSphere
MQ et IBM ORB, sont nécessaires aux clients pour communiquer avec le serveur,
vous n’avez en revanche pas toujours besoin que le serveur ni les applications
annexes fonctionnent inutilement. Il est recommandé de configurer les services
pour des applications tierces comme les services manuels, et d’ajouter les
commandes net start aux fichiers de traitement par lots de votre serveur. Par
exemple, aprés la premiére initiale setlocal dans le fichier de traitement par
lots start_server.bat , vous pouvez ajouter les commandes suivantes pour
démarrer les services de WebSphere MQ et DB2 avant que le reste du fichier de
traitement par lot ne s’exécute :
setlocal
net start "IBM MQSeries"
net start "DB2 - DB2-0"
net start "DB2 License Server"
net start "DB2 Remote Command Server"
net start "DB2 Security Server"
net start "DB2DAS - DB2DAS00"

Si vous utilisez WebSphere Application Server pour héberger System Monitor,
vous pouvez créer un fichier de traitement par lots pour démarrer ses services et
services requis, et lancer automatiquement le navigateur par URL pour le
contrdle de I'application, suivant ’exemple ci-dessous :

net start "DB2 - DB2-0"

net start "DB2 License Server"

net start "DB2 Remote Command Server"

net start "DB2 Security Server"

net start "DB2DAS - DB2DAS00"

net start "IBM HTTP Administration"

net start "IBM HTTP Server"

net start "IBM WS AdminServer 4.0"

start iexplore http://devserver/ICSMonitor

Remarque : Assurez-vous de remplacer chaque nom de service ou URL en
fonction de votre propre environnement.

Configuration de la connexion dans un environnement de
développement

I est recommandé de faire pointer la connexion du serveur en sortie a la fois vers
la console et vers un fichier de votre environnement de développement, pour les
raisons suivantes :

* Il est plus pratique d’avoir une connexion en sortie vers la console car vous
pouvez “marquer” la console d'un simple clic. Cela a pour effet d’interrompre
momentanément le systeme. Cela vous permet d’envoyer un flux a travers le
systéme et de surveiller la console pour vérifier la présence éventuelle d’erreurs,
puis de marquer celle-ci afin que le processus marque une pause pour que le
message d’erreur reste a ’écran sans que d’autres messages d’erreurs ne
viennent immédiatement le remplacer.

Remarque : Assurez-vous d’avoir “démarqué” la console apres avoir recherché
une erreur. Il n’est pas rare, en voulant déboguer une interface, de
marquer la console pour analyser une erreur et d’oublier de la
démarquer. Le processus d’InterChange Server reste en pause
jusqu’a ce que le marquage soit désactivé et vous ne pourrez alors
pas compiler les composants dans le référentiel, ni exécuter de
déploiements pendant ce laps de temps. Si vous trouvez que, sans
raison apparente, un processus est un peu long, vérifiez que la
console InterChange Server ne soit pas marquée.
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* Il est utile que la connexion en sortie pointe autant vers un fichier journal que
vers la console : en cas de contact avec 1’assistance technique, vous disposerez
ainsi des informations sur 1’origine de 'erreur. Si message d’erreur ne se trouve
que dans la console et que celle-ci quitte anormalement, vous n’aurez pas les
informations nécessaires au service d’assistance technique pour résoudre le
probleme.

Pour plus d’informations sur la maniere de configurer la consignation et le suivi
d’InterChange Server, voir la section [Chapitre 5, «Configuration de WebSpher|
[InterChange Server», a la page 109

personnalisation de votre environnement

La plupart des développeurs travaillent plus efficacement lorsqu’ils personnalisent
leur environnement, comme décrit dans le section ci-apres.

Organisation de vos raccourcis

La plupart des développeurs trouvent utile d’organiser les raccourcis qu’ils
utilisent fréquemment pour éviter de recourir systématiquement au menu
Programmes. Vous pouvez créer un dossier pour les raccourcis du bureau ou bien
créer une barre d’outils personnalisée dans la barre des taches Windows. Il est plus
pratique d’inclure des raccourcis vers InterChange Server, tout connecteur
indispensable, WSWB (System Manager), 1'outil d’administration du serveur de la
base de données, la console WebSphere MQ, System Monitor, un éditeur de texte,
etc.

Modification des propriétés des raccourcis

par défaut, InterChange Server et les connecteurs fonctionnent dans une fenétre de
console de petite taille, avec une faible mémoire tampon d’écran et un schéma de
couleurs qui n’incite pas a la lecture. Pour modifier leurs raccourcis, procédez
comme suit :

1. Cliquez a l'aide du bouton droit de la souris sur le raccourci d'InterChange
Server ou du connecteur et sélectionnez Properties a partir du menu
contextuel.

2. Cliquez sur l'onglet Layout et effectuez les modifications suivantes :
* Attribuez a la zone Height du panneau “Screen buffer size” la valeur 9999 .

Cela permettra a la console de conserver plus d’informations en cache afin
que les messages d’erreur ne disparaissent pas soudainement lorsque le
systéme traite les événements.

* Attribuez a la zone Width la valeur 120 et a la zone Height la valeur 25
dans le panneau “Window size”.

Cela permettra de redimensionner la console afin d’afficher plus
d’informations en largeur et de rétrécir la hauteur. Vous pouvez loger trois
consoles d'une hauteur de 25 sur un méme écran, ce qui facilite la
réorganisation des fenétres d'InterChange Server et des deux connecteurs que
vous serez amené a tester pour une interface.

3. Cliquez sur l'onglet Colors et effectuez les modifications suivantes:

* Sélectionnez le bouton radio Screen background, puis sélectionnez une
couleur.

* Sélectionnez le bouton radio Screen text, puis sélectionnez une couleur.
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Remarque : Il est recommandé d’utiliser des couleurs foncées pour le fond et
des couleurs claires pour le texte de I'écran. Utilisez différents
schémas de couleurs pour InterChange Server et les consoles des
connecteurs, afin de facilement les distinguer.

4. Cliquez sur OK.

Configuration des préférences d’outils
Configurez vos préférences d’outils comme décrit dans la section [«Utilisation des|
lateliers Eclipse» a la page 89|

Paramétrage de votre espace de travail

Il est recommandé de définir votre espace de travail —le répertoire ou les projets
créés dans l'atelier sont stockés par défaut—a 1’emplacement qui vous conviendra
le mieux. Pour définir le répertoire de votre espace de travail, procédez comme
suit :

1. Accédez au répertoire bin du répertoire produit.

2. Modifiez fichier portant le nom startcsm.bat.

3. Attribuez une valeur apres 'option -data au répertoire que vous voulez définir
comme espace de travail par défaut. Par exemple, si vous définissez votre
espace de travail vers un répertoire intitulé Projects dans le répertoire produit
de WebSphere InterChange Server, le fichier apparaitra comme suit :
setlocal
set WSWB_EXECUTABLE=%1
"%WSWB_EXECUTABLE%" -data "%CROSSWORLDS%"/Projects -vmargs
-Xbootclasspath/p:"%CROSSWORLDS%"\1ib\vbjorb.jar
-Dorg.omg.CORBA.ORBClass=com.inprise.vbroker.orb.ORB
-Dorg.omg.CORBA.ORBSingletonClass=com.inprise.vbroker.orb.0RBSingleton
-DCWTooTs.home="%CROSSWORLDS%" \bin

4. Enregistrez et fermez le fichier.

Création de vos bibliotheques de composants d’intégration

I est recommandé de créer les bibliotheques de composants d’intégration suivantes

* Une pour chaque instance d'InterChange Server avec laquelle vous devez
communiquer. Vous devez conserver une corrélation un a un entre les
bibliotheques et les instances de serveur afin que votre environnement local
reflete le référentiel en question.

II est recommandé d’attribuer a ce type de bibliotheque un nom permettant de
I'associer au serveur auquel il correspond. Par exemple, si le nom du serveur est
WICS420DEV , vous pouvez dénommer la bibliotheque WICS420DEVICL . Il est
recommandé d’adopter la méme convention concernant les projets utilisateur de
la section [«Création de vos projets utilisateur»]

* Une bibliotheque “de transfert”. Vous pouvez utiliser cette bibliotheque pour
stocker des composants n’appartenant pas spécifiquement a un environnement
de serveur. Le contenu peut inclure des échantillons, des éléments de
démonstration, des composants en cours de développement et des composants
que vous réutilisez avec de multiples bibliothéeques.

Création de vos projets utilisateur

II est recommandé de créer les bibliotheques de composants d’intégration suivantes

* Une pour chaque bibliotheque de composants d’intégration que vous avez créée.
Puisqu’il est recommandé de maintenir une corrélation un a un entre les
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bibliotheques et le serveur et que vous devez avoir un projet utilisateur pour
déployer des composants d’une bibliotheque d'un serveur, il parait normal de
dédier un projet utilisateur a chaque bibliotheque afin de déployer l'intégralité
de celle-ci sur le serveur, le cas échéant.

I est recommandé de dénommer ce type de projet utilisateur de maniere a
I'associer au serveur lui correspondant. Par exemple, si le nom du serveur est
WICS420DEV, vous pouvez dénommer le projet utilisateur WICS420DEVUP. 11 est
recommandé d’adopter la méme convention concernant les bibliotheques de
composants d’intégration de la section [«Création de vos bibliotheques de
[composants d’intégration» a la page 18

* Une bibliotheque pour chaque interface que vous développez. C’est le meilleur
moyen d’exploiter un projet utilisateur—en créant des raccourcis dans le projet
utilisateur qui ne pointent que vers des composants nécessaires a l'interface,
vous obtiendrez un affichage trés ergonomique du sous-ensemble de composants
d’une bibliotheque.

Configuration des connecteurs

Vous pouvez installer et exécuter des connecteurs dans votre environnement de
développement local afin de pratiquer des tests de base de votre interface. Pour
utiliser au mieux les connecteurs dans ce contexte, suivez les recommandations
fournies dans ces sections.

Utilisation du protocole de transfert IDL

Comme décrit dans la section [«Installation des logiciels requis» a la page 13|
I'exécution de WebSphere MQ dans votre environnement de développement local
n’est peut-étre pas nécessaire, d’autant qu’il peut diminuer les performances. A la
place, attribuez a la propriété de vos définitions de connecteur DeliveryTransport
la valeur IDL pour plutét utiliser IIOP.

Utilisation de I'interrogation de clé

Si un connecteur est responsable d’une notification des événements, il doit
interroger une table des événements pour en détecter de nouveaux. L'interrogation
est nécessaire mais les messages s’affichant dans la fenétre de la console du
connecteur peuvent décaler d’importantes informations de dépannage et les faire
sortir de I’écran. Vous pouvez utiliser 'interrogation de clé pour que le connecteur
émette un appel d’interrogation uniquement sur demande. Pour plus
d’informations sur les interrogations de clé et la configuration des connecteurs,
voir la section |[Chapitre 7, «Configuration des connecteurs», a la page 145

Préparation d’un environnement d’intégration du développement

Comme décrit dans la section [«<Déploiement sur un environnement d’intégration|
lde développement» a la page 4, vous déploierez les interfaces que vous
développez dans un environnement centralisé en méme temps que les autres
développeurs du projet. Cet environnement est en principe dédié a la coordination
des interfaces, pour s’assurer que les dépendances d’interfaces croisées ont été
résolues et pour modifier les composants partagés ; il peut également constituer un
environnement de test en fonction des ressources disponibles et de la complexité
du systeme.

Il est recommandé qu'un développeur soit désigné comme responsable technique
chargé du processus de combinaison de toutes les interfaces dans l’environnement
d’intégration du développement. Bien que les définitions de mappes et les objets
de collaboration sont spécifiques a une seule et méme interface, les objets métiers,
les connecteurs, les relations et les modeles de collaboration sont souvent partagés

Chapitre 2. Préparation des environnements 19



entre de multiples interfaces. Le responsable technique devra s’assurer qu’une fois
les interfaces combinées entre elles, tous les composants partagés fonctionneront
comme prévu pour toutes les interfaces. Pour les objets métier et les modeles de
collaboration, cela n’est pas difficile a mettre en oeuvre tant que les développeurs
du projet communiquent bien pendant la durée de celui-ci.

Si une interface nécessite d’apporter une modification sur un composant partagé,
celle-ci doit étre effectuée par le développeur de l'interface en question, et les
autres développeurs dont les interfaces partagent le composant doivent importer la
version modifiée dans leur bibliotheque avant que leurs interfaces ne soient
terminées. La documentation du projet du composant et les interfaces concernées
doivent étre mises a jour pour refléter les modifications.

Certains composants, comme des connecteurs et des relations, nécessitent
couramment des modifications lorsque les interfaces sont combinées dans un
environnement d’intégration du développement. Par exemple, un systéme
d’intégration pourra avoir une interface de synchronisation client et une interface
de traitement des commandes, chacune impliquant un point d’acces au service. Les
interfaces seront probablement prises en charge par différents développeurs dans
leur propre environnement. Dans chaque environnement des développeurs, la
définition du connecteur du point d’acces au service doit juste avoir la
configuration nécessaire pour prendre en charge ces interfaces de développeurs. Le
développeur de l'interface de synchronisation client ne devrait pas avoir besoin de
recourir a des objets métier ni a d’autres composants pour l'interface de traitement
des commandes car ceux-ci sont en cours de développement. Lorsque les
développeurs déploient leurs interfaces dans 1’environnement d’intégration du
développement, 'adaptateur du point d’acces au service doit étre modifié pour
prendre en charge les objets métier et les mappes de chacune des interfaces. Le
responsable technique s’assure, au besoin, que les composants partagés sont
correctement mis a jour.

Vous devez tenir a jour une documentation minutieuse et fouillée sur les projets
pour déterminer les composants a modifier, méme si une nouvelle interface est
déployée dans l'environnement.

Utilisation du controle du code source

20

Plusieurs plug-ins sont disponibles pour les outils de l'atelier et permettent de
travailler avec les composants d’intégration sous le contrdle du code source. En
implémentant le contréle du code source, tous les développeurs d'un projet
peuvent ajouter une bibliothéque de composants d’intégration (ou un projet
utilisateur) a leur espace de travail et travailler sur les composants de la
bibliotheque, sans risque que d’autres développeurs apportent des modifications
aux composants.

Remarque : Bien que le contrdle du code source permette d’éviter que les
développeurs n’apportent de modifications a la méme définition de
composant, il ne peut pas empécher ceux-ci puissent déployer des
composants dans le serveur. Pour éviter que de multiples
développeurs ne puisse réécrire sur des composants du serveur,
nommez une personne chargée du déploiement et modifiez le mot de
passe d'InterChange Server.

IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



Utilisation de Rational ClearCase

Cette section fournit des instructions sur la maniere d’activer les plug-ins de
ClearCase et d’activer System Manager pour la connectivité de ClearCase. Elle
renseigne également sur la maniére d’utiliser ClearCase ; il est cependant
recommandé de lire la documentation sur ClearCase et sur les plug-ins ClearCase
pour plus d’informations. En outre, cette section ne couvre pas les étapes
préliminaires, notamment l'installation du client ClearCase, la création d'une vue,
etc.

Confirmation de l'installation et de I'activation des plug-ins
Pour confirmer que les plug-ins requis sont installés et activés dans votre atelier,
procédez comme suit :

1. Accédez au répertoire \plugins de votre structure d’outils Eclipse (telle que
WSWB ou WSADIE).

2. recherchez un répertoire dénommé com.ibm.btools.csm.ui.cc et, s'il existe,
ouvrez-le.

3. Recherchez un fichier dénommé plugin.xml. S’il n’existe aucun fichier de ce
nom mais qu’il existe un fichier dénommé plugin.xml.off , renommez
plugin.xml.off en plugin.xml .

4. Reprenez les étapes IZl é@ pour les plug-ins suivants :
e com.rational.clearcase
* com.rational.clearcase.help

Si 'un de ces répertoires est manquant ou s’ils ne contiennent pas de fichier
dénommé plugin.xml , vous ne pourrez pas utiliser System Manager avec
ClearCase.

Configuration de System Manager pour la connectivité de
ClearCase

Lorsque vous étes certain que les plug-ins sont activés dans le fichier systéme,
configurez System Manager pour la connectivité de Clearcase de la maniere
suivante :

Démarrez votre atelier.

Sélectionnez Perspective > Close All a partir de la barre de menu.
Ouvrez la perspective de System Manager.

Sélectionnez Perspective > Customize a partir de la barre de menu.
Développez le noeud Other.

Cochez la case ClearCase.

N o oD~

Cliquez sur OK.
Le menu ClearCase est ajouté a la barre de menu.

8. Cliquez sur la fleche noire courbée vers le bas dans la barre de titre de la vue
WebSphere Business Integration System Manager, puis sélectionnez Show
ClearCase decorations a partir du menu contextuel.

Les ressources de l’atelier comporteront désormais un menu contextuel
dénommé ClearCase qui vous permettra de controler le code source et
d’afficher des icones pour indiquer leur état (vérifié, etc.).

Connexion a ClearCase
Pour connecter System Manager a ClearCase, sélectionnez ClearCase > Connect to
Rational ClearCase a partir de la barre de menu.
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Déplacement d’un projet dans ClearCase

Pour que les développeurs puissent accéder aux mémes composants, une
bibliotheque de composants d’intégration doit initialement étre créée sur un
systeme, puis déplacée dans ClearCase. Pour déplacer une bibliotheque dans
ClearCase, procédez comme suit :

1. Cliquez a l'aide du bouton droit de la souris sur une bibliothéque de
composants d’intégration et sélectionnez ClearCase > Move Project Into
ClearCase a partir du menu contextuel.

2. Accédez au répertoire de votre vue ol1 vous voulez déplacer la bibliotheque de
composants d’intégration, puis cliquez sur OK.

La boite de dialogue “Progress Information” s’affiche aprés que le projet ait été
déplacé dans le contrdle du code source.

3. Dans la fenétre “Add Element(s) to Source Control” , sélectionnez les
composants d’intégration a ajouter a la bibliotheque, puis cliquez sur OK.

Ajout d’un projet a I’espace de travail

Une fois que la bibliothéque de composants d’intégration qui sera partagée par les
développeurs a été déplacée dans ClearCase par un développeur, les autres
développeurs peuvent exécuter la procédure suivante pour ajouter le projet a leur
propre espace de travail :

1. Sélectionnez ClearCase > Connect to Rational ClearCase a partir de la barre de
menu pour vous connecter a ClearCase.

2. Sélectionnez ClearCase > Add Project to Workspace a partir de la barre de
menu.

3. Dans la boite de dialogue “ClearCase Project Location”, accédez et sélectionnez
le répertoire de la bibliotheque de composants d’intégration qui a été déplacée
sous le controle du code source.

4. Cliquez sur OK.

5. Dans la boite de dialogue “Add Elements(s) to Source Control”, cliquez sur
OK.

Le dossier des projets est ajouté a votre espace de travail et vous pouvez
sélectionner et désélectionner les composants en cliquant dessus a 1'aide du
bouton droit de la souris et en utilisant le menu contextuel ClearCase.

Remarque : Vous devrez probablement redémarrer 'atelier pour faire
apparaitre le dossier du projet.

Utilisation de VCM

System Manager peut également s’utiliser avec VCM. Pour plus d’informations sur
la procédure correspondante, voir la documentation sur VCM en lui-méme et sur
les plug-ins VCM. Pour activer la connectivité de VCM, suivez les étapes décrites
dans la section [«Confirmation de I'installation et de l'activation des plug-ins» a la|
mais a partir des répertoires de plug-ins suivants :

e com.ibm.btools.csm.ui.vcm
* org.eclipse.vcm.core
* org.eclipse.vcm.ui
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Chapitre 3. Environnement et outils IBM WebSphere
InterChange Server

Ce chapitre présente le composant WebSphere InterChange Server Toolset que vous
utiliserez pour développer les interfaces d’intégration du processus métier. Il
contient les sections suivantes :

» |«A propos de System Manager, Integrated Test Environment et Collaboration)

Debugger»|
» |«Utilisation de System Manager» a la page 26

» |«Utilisation d’instances d’'InterChange Server» a la page 30|

» |«Utilisation des bibliotheques de composants d’intégration» a la page 38|

« |«Utilisation des projets utilisateur» a la page 41]

« |«Utilisation des composants dans les bibliotheques de composants d’intégration»|

a la page 46|

« |«Utilisation des solutions» a la page 59|

+ |«Exportation de composants vers un package a l'aide de System Manager» a la|

page 6]

+ |«Déploiement de composants sur un serveur» a la page 63

+ |«Utilisation des composants dans un référentiel d’InterChange Server» a la page]
7

+ |«Dépendances et références» a la page 86|

+ |«Opérations standard disponibles pour plusieurs ressources d’atelier» a la page]
8

+ |«Utilisation des ateliers Eclipse» a la page 89|

A propos de System Manager, Integrated Test Environment et
Collaboration Debugger

System Manager, Integrated Test Environment et Collaboration Debugger sont des
plug-ins s’exécutant dans les infrastructures d’outils Eclipse nommées WebSphere
Studio Workbench et WebSphere Studio Application Developer Integration Edition.
Cette section présente l'infrastructure Eclipse, les outils WSWB et WSADIE, ainsi
que les plug-ins des outils d’'IBM WebSphere InterChange Server.

A propos de la plate-forme Eclipse

La plate-forme Eclipse est un environnement de développement intégré (IDE) open
source permettant de créer des outils. Elle fournit aux développeurs d’outils un kit
de développement et un environnement d’exécution pour créer des plug-ins
permettant a l'utilisateur de tirer parti d'un type de ressource spécifique.

IBM possede deux versions personnalisées de la plate-forme Eclipse : WebSphere
Studio WorkBench (WSWB) et WebSphere Studio Application Developer
Integration Edition (WSADIE).

Plug-ins

Les plug-ins sont des extensions modulaires développées par les fournisseurs de
logiciels dans le but d’ajouter des fonctionnalités a un atelier Eclipse. Les plug-ins
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contiennent les perspectives, les éditeurs et les vues permettant aux utilisateurs de
l'atelier de tirer parti de types de ressource spécifiques.

Par exemple, un plug-in peut fournir les fonctions d’un éditeur de texte. Un autre
plug-in peut fournir les fonctions d’un éditeur HTML. Les plug-ins WebSphere
InterChange Server fournissent les fonctions permettant d’utiliser des composants
d’intégration. Ce modele de plug-in a pour avantage de fournir a l'utilisateur un
seul outil lui permettant d'utiliser plusieurs types de ressource, au lieu d’utiliser
des outils dédiés pour chaque type de ressource.

Pour installer un plug-in, vous devez extraire une ou plusieurs archives
compressées qui représentent le plug-in dans le répertoire plugins du répertoire de
produit de votre atelier. Les plug-ins WICS sont extraits dans le répertoire plugins
par le responsable de 'installation.

IBM fournit les plug-ins System Manager, Integrated Test Environment et
Collaboration Debugger avec WebSphere InterChange Server pour 'utilisation des
ressources d’intégration métier. Ces plug-ins sont intégrés dans un certain nombre
de répertoires non compressés dans le répertoire plugins de votre atelier sous
I'espace nom com.ibm.btools. Par exemple, une grande partie de l'interface
principale que vous utiliserez lors de la création de composants d’intégration
—System Manager— est intégrée au contenu du répertoire com.ibm.btools.csm du
plug-in.

Atelier

L’atelier est ’ensemble des perspectives, des éditeurs et des vues actifs dans votre
infrastructure d’outils Eclipse qui sont affectés par I'ensemble des plug-ins installés
et activés. Il s’agit d’un terme général utilisé pour faire référence a l'interface
Eclipse dans laquelle vous travaillez et qui ne tient pas compte du fait que
l'interface change en fonction de la maniére dont vous l'utilisez.

Espace de travail

Un espace de travail est un conteneur de projets. L’espace de travail est un
répertoire dans le systeme de fichiers dans lequel vous étes invité par défaut a
stocker vos projets.

Projets
Les projets sont des groupes de ressources définis par 1'utilisateur et représentent
en définitive les répertoires contenus dans le systeme de fichiers.

L’une des premieres taches a accomplir lors du développement d’une interface de
processus métier consiste a définir une bibliotheque de composants d’intégration,
c’est-a-dire un projet contenant les composants développés. Lors de la création de
la bibliotheque de composants d’intégration, vous devez indiquer un emplacement
de stockage dans le systeme de fichiers (par défaut, il s’agit du répertoire de
I'espace de travail). Un dossier est créé a cet emplacement avec le nom indiqué
pour la bibliothéque de composants d’intégration et un certain nombre de dossiers
sont créés dans le dossier de la bibliothéque pour chaque type de composant
d’intégration (par exemple, il existe des dossiers nommés Maps, BusinessObjects et
Connectors).

Vous pouvez également créer des projets nommés projets utilisateur. Les projets
utilisateur constituent un ensemble de raccourcis faisant référence aux composants
d’intégration. Vous devez ajouter des composants d’intégration a un projet
utilisateur a partir des bibliotheques de composants d’intégration afin de déployer
des composants dans une instance d’InterChange Server. Hormis le fait qu’ils
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soient nécessaires pour déployer des composants sur un serveur, les projets
utilisateur sont congus pour vous permettre de regrouper des composants d'un
point de vue fonctionnel. Une bibliotheque de composants d’intégration regroupe
tous les composants pouvant vous étre utiles alors qu'un projet utilisateur est
congu pour vous permettre de regrouper les composants que vous utilisez avec
une interface spécifique.

Ressources
Les ressources représentent les projets, fichiers et dossiers que vous utilisez dans
l'atelier.

Lors de la création d'un composant d’intégration, celui-ci est stocké en tant que
fichier dans le dossier approprié du projet ICL (Integration Component Library).
Les différents types de composant d'intégration sont stockés avec différentes
extensions (par exemple, les mappes sont stockées avec I'extension .cwm tandis que
les modeles de collaboration sont stockés avec 1’extension .cwt). Ils sont toutefois
tous stockés au format XML.

Certains composants, tels que les mappes et les modeles de collaboration,
disposent également de fichiers source Java en plus de leurs fichiers de définitions.

Perspectives
Une perspective est un groupe d’éditeurs et de vues congu pour fournir a un role
utilisateur spécifique ce dont il a besoin.

Par exemple, la perspective System Manager fournit des vues pour l'utilisation des
instances et des bibliotheques de composants d’intégration d’InterChange Server et
des éditeurs pour les définitions d’objets de collaboration et les pools de connexion
a une base de données. La perspective Integrated Test Environment comporte des
vues pour les interfaces d’émulation client et les données de test des objets métier
et des éditeurs pour les unités de test.

Editeurs
Les éditeurs permettent d’ouvrir, d’enregistrer et de fermer les ressources dans
l'atelier.

Par exemple, System Manager dispose d'un éditeur dans lequel vous pouvez
modifier les objets de collaboration et un autre dans lequel vous pouvez configurer
InterChange Server.

Vues
Les vues fournissent des informations sur les ressources que vous utilisez dans
l'atelier.

Par exemple, System Manager posséde la vue WebSphere Business Integration
System Manager qui indique les bibliothéques de composants d’intégration, les
projets utilisateur et la vue InterChange Server dans laquelle vous utilisez les
instances d'InterChange Server que vous avez enregistrées.

A propos des outils WSWB et WSADIE

WebSphere Studio Workbench (WSWB) est une version personnalisée de la
plate-forme Eclipse par IBM. IBM fournit WSWB avec WebSphere InterChange et
vous permet de l'installer en complément de l'infrastructure principale. WSWB est
en mesure d’exécuter tous les plug-ins nécessaires au développement des
composants d’intégration de WebSphere InterChange Server.
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WebSphere Studio Application Developer Integration Edition (WSADIE) est une
version personnalisée de la plate-forme Eclipse par IBM, tout comme WSWB, mais
cet outil peut également étre utilisé pour développer de nouveaux plug-ins.
WSADIE n’est pas fourni avec WebSphere InterChange Server car la capacité de
création de plug-ins n’est pas requise pour développer des composants
d’intégration. Toutefois, si cet outil est installé, vous pouvez l'utiliser pour exécuter
les plug-ins System Manager et Integrated Test Environment requis. Lors de
I'installation de WebSphere InterChange Server, vous avez la possibilité de mettre a
jour une installation de WSADIE pour installer les plug-ins nécessaires.

A propos de System Manager
System Manager désigne la perspective dans laquelle vous utilisez les composants
d’intégration et les instances du serveur dans un systéme d’intégration métier
WebSphere InterChange Server. Vous pouvez utiliser System Manager
principalement pour les taches suivantes :
* Lancement d’autres outils dans la boite a outils d’intégration métier de
WebSphere InterChange Server

* Développement et configuration de certains composants d’intégration
* Utilisation d’instances d'InterChange Server
* Déploiement de composants d’intégration dans un référentiel

A propos d’Integrated Test Environment

Integrated Test Environment désigne la perspective dans laquelle vous pouvez
tester les interfaces d’intégration métier que vous avez développées. Il fournit des
interfaces graphiques afin d’émuler les connecteurs, lancer les composants requis et
examiner les données des objets métier. Pour plus d’informations sur cette
perspective, voir |Chapitre 12, «Utilisation d'Integrated Test Environment», a la|
I’ 2

A propos de Collaboration Debugger

Collaboration Debugger désigne la perspective dans laquelle vous pouvez aisément
résoudre la logique de collaboration. Pour plus d’informations, voir
lUtilisation de Collaboration Debugger», a la page 313

Utilisation de System Manager

Cette section explique comment démarrer et utiliser la perspective System
Manager.

Démarrage de System Manager

Lorsque vous installez IBM WebSphere InterChange Server, vous pouvez soit
installer WebSphere Studio Workbench avec la fonction de prise en charge des
plug-ins requis pour communiquer avec InterChange Server, soit installer les
plug-ins dans une installation existante de WebSphere Studio Application
Developer Integration Edition.

Vous devez lancer l'atelier avec plusieurs arguments Java Virtual Machine qui
permettent a I’architecture de communiquer avec InterChange Server sur CORBA.
Pour y parvenir, un fichier de traitement par lots nommé startcsm.bat est créé
dans le répertoire bin du répertoire produit de WebSphere InterChange Server et
un raccourci vers ce fichier de traitement par lots est créé dans le groupe de
programmes. Pour que l'atelier s’exécute dans un environnement WebSphere
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InterChange Server, vous devez lancer le raccourci personnalisé au lieu de lancer
un raccourci quelconque dans le groupe de programmes de l'atelier ou de lancer
directement son fichier exécutable.

Pour démarrer System Manager, procédez comme suit :

1. Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server
> IBM WebSphere Business Integration Toolset > Administrative > System
Manager.

2. Sélectionnez Windows > Open Perspective > Other dans la barre de menus.
3. Sélectionnez System Manager dans la liste des perspectives, puis cliquez sur OK.

WebSphere Studio Workbench démarre et s’affiche. La figure 2]illustre la
perspective System Manager et l{«Interface de System Manager»| représente
I'interface et ses éléments.

Interface de System Manager

La perspective System Manager contient plusieurs vues et éditeurs dans la
configuration par défaut avec laquelle elle s’ouvre. La illustre la
perspective System Manager :

<

& System Manager - WebSphere Stu > Workbench SDK IS
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2 Benchmark
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Figure 2. Perspective System Manager

Le tableau 1 a la page 28| contient les éléments de l'interface de la perspective
System Manager, représentés par des numéros dans la fficure 2 a la page 27]:
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Tableau 1. Eléments d’interface de la perspective System Manager

Numéro de 1’élément
d’interface Nom de 1’élément d’interface
1 [<Barre de menus et barre d’outils»|
2 [<Barre de raccourcis Perspective» a la page 29
3 «Fenétre WebSphere Business Integration System Manager» 2|
la page 29
4 «Fenétre InterChange Server Component Management» a la|
page 22|
5 [<Fenétre Editor» a la page 30
6 |<Fenétre Console» a la page 30|

Les sections suivantes présentent plus en détail les éléments de l'interface de
System Manager.

Barre de menus et barre d’outils

La barre de menus et la barre d’outils s’utilisent avec I'architecture d’outils Eclipse
et les composants de WebSphere InterChange Server. La plupart des options de la
barre de menus ont des équivalents sur la barre d’outils, par conséquent, les
sections suivantes ne présentent que la barre de menus et les options associées.

Menu File : II s’agit d'un menu standard Eclipse utilisé pour gérer les ressources.
Vous l'utiliserez principalement pour créer de nouvelles bibliotheques de
composants d’intégration et des projets utilisateur.

Pour plus d’informations sur la création des bibliotheques de composants
d’intégration et des projets utilisateur, voir [«Utilisation des bibliothéques de]
composants d’intégration» a la page 38|et|«Utilisation des projets utilisateur» a la|

page 41l

Menu Edit: Il s’agit d’'un menu standard Eclipse qui contient de nombreuses
options telles que Cut, Copy et Paste.

Pour plus d’informations sur les fonctions couper, copier, coller et supprimer, voir
«Utilisation des composants dans les bibliotheques de composants d’intégration» 3

la page 4§|.

Menu Navigate : Ce menu standard Eclipse permet de naviguer parmi les
ressources présentes dans l’atelier. Pour plus d’informations sur ce menu, voir la
documentation relative a l’atelier.

Menu Search: Ce menu standard Eclipse permet de rechercher des ressources.
Pour plus d’informations sur ce menu, voir la documentation relative a 'atelier.

Menu Project: Ce menu standard Eclipse contient plusieurs options de menu
permettant de gérer les ressources de projet dans 'atelier. Ce menu ne s’utilise pas
avec la perspective System Manager. Pour plus d’informations sur ce menu, voir la
documentation relative a l'atelier.

Menu Component: Ce menu est fourni avec la perspective System Manager et
permet de travailler avec les composants d’intégration que vous créez. Les options
de ce menu sont décrites tout au long de ce document et dans d’autres sections
relatives a des taches plus spécifiques.
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Menu Tools: Ce menu est fourni avec la perspective System Manager et permet
de lancer des outils permettant de créer des composants d’intégration.

Pour plus d’informations, voir [«Utilisation des composants dans les bibliotheques|
[de composants d’intégration» a la page 46|

Menu Server: Ce menu contient I'option Register Servers qui permet
d’enregistrer une instance d’InterChange Server.

Pour plus d’informations, voir [«Enregistrement d’une instance d’InterChange]
Server» a la page 30|

Menu Run: Ce menu contient une option permettant de configurer des outils
externes afin d’exécuter des programmes, des fichiers de traitement par lots et de
créer des scripts. Pour plus d’informations, voir la documentation relative a
l'atelier.

Menu Window : Ce menu contient des options qui permettent de travailler avec
des perspectives, des affichages, des éditeurs et des préférences.

Ces options sont présentées dans la documentation relative a 'atelier et dans
différentes sections de ce document.

Menu Help: Les options de ce menu permettent de lancer la documentation de
l'atelier et contiennent des informations de version sur l'atelier et les perspectives.

Barre de raccourcis Perspective

Utilisez la barre de raccourcis Perspective pour naviguer entre les différentes
perspectives. Pour cela, vous devrez peut-étre ouvrir les perspectives System
Manager, Integrated Test Environment et Java. Vous pouvez cliquer sur leurs
icones d’espace de travail dans la barre de raccourcis Perspective pour passer de
l'une a l'autre.

Vous pouvez également accéder aux autres perspectives grace au menu Window :

* Pour accéder a une perspective représentée par une icone située plus haut dans
la barre de raccourcis Perspective que 1'icone de la perspective affichée, utilisez
le raccourci clavier Alt+Fleche haut.

* Pour accéder a une perspective représentée par une icone située plus bas dans la
barre de raccourcis Perspective que 1'icone de la perspective affichée,
sélectionnez la commande Perspective > Next dans la barre de menus, ou
utilisez le raccourci clavier Alt+Fleche bas.

Fenétre WebSphere Business Integration System Manager
Cette fenétre contient les noeuds User Projects et Integration Component
Libraries, qui sont des types de projet de WebSphere InterChange Server.

Pour plus d’informations sur l'utilisation de ces types de projet, voir |«Utilisati0;|
des bibliotheques de composants d’intégration» a la page 38 et [«Utilisation des|
rojets utilisateur» a la page 41}

Fenétre InterChange Server Component Management

Cette fenétre permet d’utiliser les instances d’InterChange Server et les composants
intégrés. Lorsque vous enregistrez des instances d’InterChange Server, une ligne et
une entrée sont créées sous le noeud Server Instances pour chaque serveur. Vous
pouvez développer le noeud pour afficher les composants présents dans le
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référentiel de cette instance et utiliser les options du menu contextuel (bouton droit
de la souris) pour manipuler ces composants.

Pour plus d’informations sur I'enregistrement et 'utilisation des instances
d’InterChange Server, voir [«Utilisation d’instances d’InterChange Server»|

Fenétre Editor

Cette fenétre contient les différentes ressources présentes dans 'architecture,
comme les fichiers et les définitions des composants d’intégration. Différents
éditeurs s’ouvrent pour utiliser les divers types de ressource. Par exemple, les
fichiers texte s’ouvrent dans un éditeur de texte tandis que les définitions des
objets de collaboration s’ouvrent dans un éditeur propre a WebSphere InterChange
Server.

Fenétre Console

Cette fenétre comporte deux onglets : Console et Log Output. Lorsque vous
compilez des mappes ou des modeles de collaboration dans System Manager,
l'onglet Console affiche des messages qui indiquent pour chaque composant si la
compilation a abouti, et I'onglet Log Output affiche les messages d’erreurs ou
d’avertissements éventuels.

Utilisation d’instances d’InterChange Server

Cette section décrit les taches a entreprendre dans System Manager pour utiliser
InterChange Server.

Enregistrement d’une instance d’InterChange Server

Pour utiliser une instance d’InterChange Server, vous devez l’enregistrer dans
System Manager. Procédez comme suit :

Important : Pour ouvrir une session sur une instance d’InterChange Server, ce
dernier doit étre en cours d’exécution. Pour plus d’informations sur le
lancement d'InterChange Server, voir System Administration Guide.
Vous pouvez toujours enregistrer un serveur qui n’est pas en cours
d’exécution mais System Manager n'y sera pas connecté par la suite.

1. Effectuez I'une des opérations suivantes pour afficher la boite de dialogue
“Register Server” :
* Sélectionnez Server > Register Servers dans la barre de menus.

* Cliquez avec le bouton droit de la souris sur le noeud InterChange Server
Instances dans la vue InterChange Server Component Management, puis
sélectionnez Register Server dans le menu contextuel.

Remarque : Si vous ne voyez pas la vue InterChange Server, activez-la en
suivant les instructions contenues dans la section [«Affichage e
|fermeture des vues» a la page 91I

2. Effectuez 'une des opérations suivantes pour entrer le nom du serveur dans la
zone Server name :

¢ Entrez le nom de l'instance d’InterChange Server dans la zone Server name.
Important: Le nom d’une instance d'InterChange Server respecte les

majuscules et les minuscules : vous devez par conséquent étre
précis lors de la spécification du nom.
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* Procédez comme suit pour rechercher l'instance d’InterChange Server sur le
réseau :

a. Cliquez sur Browse.

System Manager recherche les serveurs actifs sur le réseau et les
répertorie dans la boite de dialogue “Find Server”. Selon la taille, la
vitesse et la configuration du réseau, cette opération peut prendre
quelques minutes.

Remarque : Bien que vous puissiez enregistrer un serveur qui n’est pas
en cours d’exécution en tapant son nom, vous ne pourrez le
rechercher sur le réseau s’il ne fonctionne pas.

b. Sélectionnez l'instance du serveur que vous souhaitez enregistrer, puis
cliquez sur OK.

Entrez le nom d’utilisateur qui doit interagir avec l'instance d’InterChange
Server dans la zone User name.

Le nom d’utilisateur par défaut est admin.

Entrez le mot de passe du nom d’utilisateur spécifié a 1'étape El dans la zone
Password.

Le mot de passe par défaut du nom d’utilisateur admin par défaut est null.

Si vous ne souhaitez pas devoir indiquer le nom d’utilisateur et le mot de passe
chaque fois que vous vous connectez a l'instance d’InterChange Server dans
System Manager, activez la case a cocher Save User ID and Password.

Important : Tenez compte des implications d"une mise en cache du nom
d’utilisateur et du mot de passe par ce moyen sur la sécurité.
Certaines définitions de composant requiérent des informations
sensibles telles que des noms d’utilisateur et des mots de passe
valides pour I'ouverture d'une session sur des applications en
cours d’intégration. En possession de ces informations, n’importe
qui peut accéder aux enregistrements stockés dans ces applications
et aux informations critiques stockées dans ces enregistrements,
telles que des informations relatives a I’actif ou a la paye. Il est par
conséquent recommandé de mettre en cache le nom d’utilisateur et
le mot de passe par ce moyen uniquement lorsque les informations
accessibles via System Manager ne concernent pas la production.

Pour enregistrer I'instance d’InterChange Server en tant que serveur de test
local, activez la case a cocher Local Test Server, puis entrez le chemin d’acces
complet au répertoire du produit WebSphere InterChange Server dans la zone
Test Server Installation Path ou bien utilisez le bouton Browse pour accéder
au répertoire du produit.

II est conseillé d’activer cette case a cocher uniquement lorsque vous devez
tester une interface et de la désactiver lors du développement de composants
ou de l'utilisation d'un serveur de production.

Pour plus d’informations sur la vérification des interfaces, voir |Chapitre 12
«Utilisation d’Integrated Test Environment», a la page 255 et [Chapitre 13
«Utilisation de Collaboration Debugger», a la page 313

Cliquez sur OK.

System Manager enregistre 'instance d’InterChange Server, s’y connecte (si le
nom de l'instance d’InterChange Server, le nom d’utilisateur et le mot de passe
fournis sont exacts et que le serveur et le courtier ORB (Object Request Broker)
d’IBM Java fonctionnent) et affiche une entrée s’y rapportant dans la vue
InterChange Server Component Management.
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Vous pouvez par la suite utiliser I'instance d'InterChange Server en cliquant
avec le bouton droit de la souris dans la vue InterChange Server Component
Management.

La présente la boite de dialogue “Register new server” dans laquelle le
nom d’utilisateur et le mot de passe ont été entrés et mis en cache.

# x|

Server name;

| pTzIDncs Browse, ..

User namea:
| admin
Paaiyeand:

| Ty

[T Sawe user ID and password

I+ Local server
Local server irstallation pathi

| C:\EMyWabSpheralCSibinieny_usa Browsa, . |
| O I Cancel

Figure 3. Enregistrement d’une instance d’InterChange Server

Connexion a InterChange Server

Lorsque vous enregistrez une instance d’'InterChange Server dans System Manager,
System Manager se connecte automatiquement a l'instance si le nom de cette
instance, le nom d’utilisateur et le mot de passe sont exacts et que le serveur et le
courtier ORB d’IBM fonctionnent.

Si vous devez arréter 1'instance ou quitter System Manager, vous devez alors
reconnecter System Manager a l'instance. Cette tache différe quelque peu selon que
vous choisissez ou non de mettre en cache le nom d’utilisateur et le mot de passe.
Par conséquent, suivez les étapes indiquées dans la section appropriée suivante.

Connexion avec mise en cache du nom d’utilisateur et du mot de
passe

Procédez comme suit si vous choisissez de mettre en cache le nom d’utilisateur et
le mot de passe lors de I'enregistrement initial du serveur :

1. Cliquez avec le bouton droit de la souris sur 'entrée associée a I'instance
d’InterChange Server dans la vue InterChange Server Component Management,
puis sélectionnez Connect dans le menu contextuel.

La boite de dialogue “Login” s’affiche avec les informations de connexion mises
en cache. Lalfigure 4 a la page 33| présente cette boite de dialogue.
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SErvEr Name

| wics42zDEy

User name

1 admin

Password

] dkisk

V' Save User ID and Password

| Ok I Canicel

Figure 4. Boite de dialogue de I'ID utilisateur et du mot de passe du serveur avec les
informations mises en cache

2. Cliquez sur OK.

Remarque : Si System Manager ne parvient pas a se connecter au serveur, voir le

document Problem Determination Guide.

Connexion sans mise en cache du nom d’utilisateur et du mot de
passe

Si vous n’avez choisi de mettre en cache le nom d’utilisateur et le mot de passe
lors de 'enregistrement initial d’une instance d’InterChange Server, procédez
comme suit :

1.

Cliquez avec le bouton droit de la souris sur I'entrée associée a l'instance
d’InterChange Server dans la vue InterChange Server Component Management,
puis sélectionnez Connect dans le menu contextuel.

Entrez le nom d’utilisateur qui doit interagir avec l'instance d’InterChange
Server dans la zone User name.

Le nom d’utilisateur par défaut est admin.

Entrez le mot de passe du nom d’utilisateur spécifié a 1'étape El dans la zone
Password.

Le mot de passe par défaut du nom d’utilisateur admin par défaut est null.

Si vous ne souhaitez pas devoir indiquer le nom d’utilisateur et le mot de passe
chaque fois que vous vous connectez a l'instance d’InterChange Server dans
System Manager, activez la case a cocher Save userid/password.

Important : Tenez compte des implications d'une mise en cache du nom
d’utilisateur et du mot de passe par ce moyen sur la sécurité.
Certaines définitions de composant requierent des informations
sensibles telles que des noms d’utilisateur et des mots de passe
valides pour 'ouverture d"une session sur des applications en
cours d’intégration. En possession de ces informations, n'importe
qui peut accéder aux enregistrements stockés dans ces applications
et aux informations critiques stockées dans ces enregistrements,
telles que des informations relatives a 1’actif ou a la paye. Il est par
conséquent recommandé de mettre en cache le nom d’utilisateur et
le mot de passe par ce moyen uniquement lorsque les informations
accessibles via System Manager ne concernent pas la production.

5. Cliquez sur OK.

Chapitre 3. Environnement et outils IBM WebSphere InterChange Server 33



34

Modes d’InterChange Server

InterChange Server peut s’exécuter dans différents modes qui s’adaptent aux
différentes étapes du cycle d’implémentation.

Mode conception

En mode conception, InterChange Server admet un référentiel incohérent : vous
pouvez ajouter des composants au référentiel méme si les composants dont ils
dépendent n’existent pas encore. Par exemple, si vous essayez d’importer une
définition d’objet métier associée a un objet enfant dans le référentiel, mais que cet
objet enfant n’existe pas encore, I'utilisation d'InterChange Server en mode
production entraine I'échec de I'importation afin de protéger l'intégrité du
référentiel. Par contre, I'utilisation d’InterChange Server en mode conception vous
permet de poursuivre afin de pouvoir assembler vos composants d’'intégration en
accord avec votre approche en matiére de développement.

En outre, la compilation des mappes et des modeles de collaboration lors du
déploiement d'un package sur un serveur en mode conception est facultative. En
mode production, le serveur compile automatiquement 1’ensemble des mappes et
des modeles de collaboration.

Le mode conception est particulierement utile lorsque vous importez des
composants depuis un autre environnement. Vous pouvez ne pas connaitre toutes
les dépendances : il est par conséquent tres utile de pouvoir importer de maniere
incrémentielle des composants sans que les opérations d’importation échouent en
raison de dépendances non résolues.

Pour démarrer InterChange Server en mode conception, utilisez le parametre
-design lors du lancement du serveur. Lalfigure 5 & la page 35|indique le raccourci
vers InterChange Server sur un systéme Windows. La zone Target contient le
parametre -design. Sur un systeme Unix, vous devez utiliser le parametre -design
lors de I'exécution du script ics_manager.
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@enersl Shortout | optians | Fort | Layeut | Colors | securty |

|BM WekSphere InterChande Server

Targettype:  MS-DOS Batch File

Target location:  bin
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Figure 5. Raccourci vers InterChange Server en mode conception

Mode test

Apres avoir enregistré InterChange Server, vous pouvez le démarrer en mode test.
Pour démarrer InterChange Server en mode test, utilisez le parameétre -test lors
du lancement du serveur.

Remarque : Pour permettre au serveur de fonctionner en mode test, vous devez
vous assurer que la fonction test a les autorisations nécessaires pour
réaliser certaines taches telles que le démarrage, 1'arrét, le
déploiement, etc.

Les serveurs locaux et distants sont pris en charge dans ITE (Integrated Test
Environment). Un serveur local est un serveur InterChange lancé depuis le
gestionnaire de taches d’'Integrated Test Environment. Pour lancer un serveur
depuis le gestionnaire de taches, InterChange Server doit étre enregistré comme un
serveur local dans le panneau d’enregistrement. Un serveur distant est un serveur
InterChange démarré en dehors d'ITE. Ainsi, méme si un serveur a été démarré
sur la méme machine qu’ITE, il sera distant s’il a été lancé en dehors d’ITE.

Le script du serveur local peut étre modifié automatiquement afin de veiller a ce
que le serveur soit lancé en tant que serveur test. Un serveur distant ne peut pas
étre démarré de cette facon. Par conséquent, 1'option de lancement du serveur sera
désactivée si le serveur enregistré est un serveur distant.

Mode production

En mode production, InterChange Server est concu pour garantir l'intégrité du
référentiel. Il ne vous permettra pas de déployer un package contenant des
dépendances non résolues dans le référentiel et compilera automatiquement toutes
les mappes et les modeles de collaboration dans le package de déploiement. Ces
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restrictions assurent a ’environnement du serveur un état dans lequel ses
composants peuvent s’exécuter correctement. S'il existait des composants avec des
dépendances non résolues ou des composants non compilés dans 1’environnement
du serveur au moment de I'exécution, toute transaction impliquant ces composants
échouerait. Bien que cette situation soit acceptable dans un environnement de
développement dans lequel vous étes supposé créer les composants requis, elle ne
I'est pas dans un environnement de production : ces restrictions font donc valoir
les procédures de déploiement sécurisé.

Le mode production est le mode par défaut pour InterChange Server : aucune
tache de configuration n’est par conséquent nécessaire pour un démarrage dans ce
mode. Toutefois, si vous souhaitez démarrer InterChange Server en mode
production, veillez & ne pas effectuer les étapes de démarrage en mode conception
et confirmez le mode dans la vue InterChange Server Component Management de
System Manager.

Modification du mot de passe d’InterChange Server

Vous pouvez utiliser le mot de passe du compte d’utilisateur utilisé pour la
connexion a InterChange Server. Procédez comme suit pour modifier le mot de
passe :

1. Cliquez avec le bouton droit de la souris sur I'entrée associée a l'instance
d’InterChange Server dans la vue InterChange Server, puis sélectionnez Change
Password dans le menu contextuel.

La boite de dialogue “Change InterChange Server Password” s’affiche, comme
indiqué dans la

2. Entrez le mot de passe actuel dans la zone Old Password.
3. Entrez le nouveau mot de passe dans la zone New Password.

4. Entrez une nouvelle fois le nouveau mot de passe dans la zone Confirm
Password.

5. Cliquez sur OK.

4P Change InterChange Server Pa rd x|

Old Password

I sk

Mew Password

| seskdolok ok

Confirm Password

| Aok o

Cancel

Figure 6. Modification du mot de passe d’InterChange Server

Actualisation d’InterChange Server

Apres avoir déployé des composants dans une instance d’InterChange Server, vous
devez actualiser I'instance dans System Manager pour qu’elle affiche avec précision
les composants du serveur. Par exemple, si vous déployez des composants dans un
serveur, puis que vous essayez de créer une nouvelle bibliotheque d’intégration et
d’ajouter des composants a cette bibliotheque a partir du serveur, System Manager
ne répertorie pas les composants récemment déployés a moins que vous
n’actualisiez le serveur.
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Pour actualiser une instance du serveur, cliquez avec le bouton droit de la souris
dans la vue InterChange Server Component Management, puis sélectionnez
Refresh dans le menu contextuel.

Déconnexion d’InterChange Server

Pour déconnecter System Manager d'une instance d'InterChange Server, cliquez
avec le bouton droit de la souris sur l'instance d’InterChange Server dont vous

souhaitez effectuer la déconnexion dans la vue InterChange Server Component

Management, puis sélectionnez Disconnect dans le menu contextuel.

Arrét d’InterChange Server

Pour arréter une instance d’'InterChange Server, cliquez avec le bouton droit de la
souris sur l'instance d’InterChange Server que vous souhaitez arréter dans la vue
InterChange Server Component Management, sélectionnez Disconnect dans le
menu contextuel, puis sélectionnez Gracefully ou Immediately dans le sous-menu
en fonction de la maniere dont vous souhaitez arréter 1'instance.

Si vous sélectionnez Immediately comme procédure d’arrét, InterChange Server
s’arréte immédiatement et tout flux en cours de traitement a cet instant échoue.
Vous pouvez par la suite résoudre les flux ayant échoués a 1’aide de Flow
Manager. Utilisez cette procédure d’arrét dans les environnements de
développement et de test dans lesquels vous ne vous préoccupez pas des flux
contenus dans le systéme ou dans les environnements de production dans lesquels
la soumission de flux ayant échoué n’entraine aucune complication.

Si vous sélectionnez Gracefully comme procédure d’arrét, les composants
d’intégration d’InterChange Server terminent le traitement des flux en cours avant
I'arrét du serveur. Utilisez cette procédure d’arrét dans les environnements de
production dans lesquels des complications peuvent intervenir suite a I'échec des
flux.

Remarque : Vous pouvez également arréter InterChange Server en fermant la
fenétre de la console dans laquelle il s’exécute. Cela provoque l'arrét
immeédiat et I'échec des flux en cours de traitement. Cette opération
est possible dans un environnement de développement dans lequel
l'intégrité des données importe peu mais elle ne doit pas étre utilisée
dans un environnement de production. L’utilisation de System
Manager pour arréter InterChange Server, méme dans un
environnement de développement, permet un affichage de I'état du
serveur dans la vue InterChange Server Component Management.
Cette vue ne peut toutefois pas détecter ni signaler les modifications
apportées a 1’état du serveur si celui-ci est arrété par un moyen autre
que System Manager.

Suppression d’une instance d’InterChange Server de la vue

Vous pouvez souhaiter supprimer une instance d’InterChange Server de la vue
InterChange Server Component Management dans System Manager. Par exemple,
si plusieurs serveurs sont enregistrés, il peut étre incommode que ceux que vous
n’utilisez plus soient encore répertoriés. Procédez comme suit pour supprimer une
instance d'InterChange Server :

1. Veillez a ce que System Manager ne soit pas connecté a l'instance
d’InterChange Server que vous souhaitez supprimer. Pour ce faire, déconnectez
System Manager de l'instance d’InterChange Server ou arrétez l'instance
d’InterChange Server.
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Pour plus d’informations sur la déconnexion de System Manager d'une
instance d’InterChange Server, voir [<Déconnexion d’InterChange Server» a la|

Pour plus d’informations sur l'arrét d’une instance d’InterChange Server, voir

[«Arrét d’InterChange Server» a la page 37|

2. Dans la vue InterChange Server Component Management, cliquez avec le
bouton droit de la souris sur l'instance d’InterChange Server que vous
souhaitez supprimer, puis sélectionnez Delete dans le menu contextuel.

3. AlVlinvite “Delete server confirmation”, cliquez sur OK.

L’instance du serveur est supprimée de la vue.

Autres commandes de System Manager pour InterChange

Le menu contextuel affiché lorsque vous cliquez avec le bouton droit de la souris
sur une instance d’InterChange Server comprend plusieurs autres éléments de

menu décrits dans d’autres manuels.

Tableau 2. Autres commandes de System Manager pour InterChange Server

Elément de menu d’InterChange Server

Edit Configuration

Pour plus d’informations sur cet élément
de menu, voir|Chapitre 5, «Configuration|

de WebSphere InterChange Server», a la|

page 109

Statistics

Pour plus d’informations sur cet élément
de menu, voir le document System
Administration Guide.

System View

Pour plus d’informations sur cet élément
de menu, voir le document System
Administration Guide.

Server object delete

Pour plus d’informations sur cet élément

de menu, Voirl«Suppression del

composants a 1’aide de 'assistant Server|

Object Delete» a la page 84

Delete Repository

«Suppression de 'intégralité dul

référentiel» a la page 83|

Monitor definition wizard

Pour plus d’informations sur cet élément
de menu, voir le document System
Administration Guide.

Utilisation des bibliothéeques de composants d’intégration

38

Vous pouvez utiliser les bibliotheques de composants d’intégration pour stocker les
composants que vous développez. Cette section décrit comment créer une

bibliotheque de composants d’intégration.

Apres avoir créé une bibliotheque de composants d’intégration, vous souhaiterez
probablement procéder aux taches suivantes :

* Vous souhaiterez importer des composants dans la bibliotheque. Pour plus
d’informations sur les différentes maniéres de procéder, voir kUtilisation ded

[composants dans les bibliotheques de composants d’intégration» a la page 46|
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* Vous souhaiterez créer des raccourcis vers les composants dans les projets
utilisateurs. Pour plus d’informations a ce sujet, voir |«Utilisation des projetd
[utilisateur» a la page 41}

* Vous souhaiterez déployer les composants dans une instance d’InterChange
Server. Pour plus d’informations, voir [<Déploiement de composants sur un|
[serveur» a la page 63

* Vous souhaiterez exporter les composants vers un package pour les importer par
la suite dans des serveurs ou dans d’autres bibliotheques ou pour sauvegarder
votre développement. Pour plus d’informations, voir [«Exportation del
[composants vers un package a 'aide de System Manager» a la page 61

Pour plus d’informations conceptuelles sur les bibliotheques de composants
d’intégration, voir |«Bibliothéques de composants d’intégration» a la page 2}

Création de bibliotheques de composants d’intégration

Procédez comme suit pour créer une bibliotheque de composants d’intégration
dans System Manager a 1’aide d’un assistant :

1. Effectuez I'une des opérations suivantes pour démarrer l'assistant “New
Integration Component Library” :

* Sélectionnez File > New > Integration Component Library dans la barre de
menus.

¢ Dans la vue WebSphere Business Integration System Manager, cliquez avec le
bouton droit de la souris sur le dossier Integration Component Libraries,
puis sélectionnez New Integration Component Library dans le menu
contextuel.

* Cliquez sur le bouton Open The New Wizard dans la barre d’outils, puis
sélectionnez New Integration Component Library dans le menu.

La présente l'assistant “New Integration Component Library”.

New Integration Component Library

Mew Integration Component Library P
()
Create a new ICL project ﬁ

Project name: ICustnmerSyn[

Project contents:
¥ Use default

Directary: | C:IBMiWebSpherelCS) Toals| WSWB203 \Workspace \CustomerSync

Import components from server
|wics42zDEy ~|

Register new server...

< Back Mext > | Cancel

Figure 7. Création d’'une bibliothéque de composants d’intégration
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2. Entrez un nom pour la bibliotheque de composants d’intégration dans la zone

Project name.

Les noms de projet peuvent contenir uniquement des caractéres
alphanumériques et des traits de soulignement et doivent étre spécifiés en
anglais.

Pour obtenir des recommandations concernant la désignation d’une
bibliotheque de composants d’intégration, voir |<<Création de vos bibliothéques|

[de composants d’intégration» a la page 18|

Pour créer le dossier de la bibliotheque a I’emplacement par défaut (votre
espace de travail) et lui affecter un nom identique au nom indiqué pour la
bibliotheque, activez la case a cocher Use default location.

Si vous souhaitez indiquer un nom et un emplacement pour le dossier de la
bibliotheque, procédez comme suit :

a. Désactivez la case a cocher Use default location.

b. Entrez le chemin d’acces complet et le nom du répertoire que vous
souhaitez utiliser pour la bibliotheque dans la zone Location ou cliquez sur
Browse pour sélectionner un répertoire existant.

Remarque : Il n’existe pas d’autre méthode pour créer le dossier d'une
bibliotheque dans le chemin de 1’espace de travail que de laisser
System Manager le faire au moyen de la case a cocher Use default
location.

Si vous ne souhaitez pas importer de composants dans la bibliotheque a partir
du référentiel d'un serveur a ce moment, passez a 1’étape 5 2 la page 41|
Si vous souhaitez importer des composants dans la bibliotheque a partir du

référentiel d'un serveur en cours d’exécution, procédez comme suit :

a. Effectuez 'une des opérations suivantes pour indiquer le serveur a partir
duquel vous souhaitez importer les composants :

* Sélectionnez le serveur dans le menu déroulant Import components from
server.

Le serveur doit étre en cours d’exécution et System Manager doit y étre
connecté pour que le serveur soit affiché dans le menu déroulant.

* Cliquez sur Register new server, puis ajoutez le serveur a la liste via
l’assistant. Pour plus d’informations, voir [«Enregistrement d’une instance
[d'InterChange Server» a la page 30

b. Cliquez sur Next.

La [figure 8 a la page 41| présente 'écran dans lequel vous devez importer
des composants depuis le serveur :
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Figure 8. Importation de composants dans une bibliotheque a partir d’'un serveur

c. Dans I'écran suivant de 1’assistant, activez la case a cocher en regard de
I'instance du serveur pour ajouter tous les composants contenus dans son
référentiel ou développez le dossier du serveur et activez les cases a cocher
en regard des groupes de composants ou bien développez les dossiers des
groupes et activez les cases a cocher en regard de chaque composant
individuel.

d. Activez la case a cocher Deep pour ajouter toutes les dépendances du
composant sélectionné. Pour plus d’informations sur les dépendances, voir
[<Dépendances et références» a la page 86

5. Cliquez sur Finish pour mettre fin a 1’assistant.

System Manager crée un dossier avec le nom indiqué sous le dossier
Integration Component Libraries.

Utilisation des projets utilisateur

Vous pouvez créer des raccourcis dans les projets utilisateur vers les composants
d’intégration que vous souhaitez utiliser dans une ou plusieurs bibliotheques. Les
projets utilisateur vous permettent d’organiser l'affichage des composants sous
forme d’interface. Vous devez ajouter a un projet utilisateur des raccourcis vers les
composants pour déployer ces composants sur un serveur depuis System Manager.

La présente section contient les sections suivantes :

» |«Création de projets utilisateur» a la page 42|

+ [«Ajout de raccourcis & un projet utilisateur» a la page 44|

«Exportation d’une solution» a la page 59|

Pour plus d’informations conceptuelles sur les projets utilisateur, Voir
utilisateur» a la page 2|
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Configuration des préférences du courtier d’intégration pour
les projets utilisateur

Vous pouvez utiliser System Manager pour créer des projets utilisateur pour
plusieurs courtiers d’intégration. Procédez comme suit pour activer System
Manager pour différents courtiers d’intégration :

1. Ouvrez le fichier nommé cwtools.cfg dans ProductDir\bin dans un éditeur de
texte.

2. Pour activer System Manager pour les projets WebSphere InterChange Server,
affectez a la propriété Installed de la section ICS_PROJECT la valeur true.

Pour activer System Manager pour les projets WebSphere Application Server,
affectez a la propriété Installed de la section WAS_PROJECT la valeur true. Pour
plus d’informations sur l'utilisation des projets WebSphere Application Server,
voir Implementing Adapters with WebSphere Application Server.

Pour activer System Manager pour les projets WebSphere MQ Integrator
Broker, affectez a la propriété Installed de la section WMQI_PROJECT la valeur
true. Pour plus d’informations sur 'utilisation des projets WebSphere MQ
Integrator Broker, voir Implementing Adapters with WebSphere Message Brokers.

3. Enregistrez et fermez le fichier.

Création de projets utilisateur

Procédez comme suit pour créer un projet utilisateur dans System Manager a l'aide
d’un assistant :

1. Effectuez l'une des opérations suivantes pour démarrer 1’assistant “New User
Project” :
* Sélectionnez File > New > User Project dans la barre de menus.

* Dans la vue WebSphere Business Integration System Manager, cliquez avec le
bouton droit de la souris sur le dossier User Projects, sélectionnez New User
Project, puis sélectionnez New ICS project dans le menu contextuel.

* Dans la vue WebSphere Business Integration System Manager, développez le
dossier User Projects, cliquez avec le bouton droit de la souris sur le dossier
InterChange Server Projects, puis sélectionnez New ICS project dans le
menu contextuel.

* Cliquez sur le bouton Open The New Wizard dans la barre d’outils puis
sélectionnez New User Project dans le menu.

2. Entrez un nom pour le projet utilisateur dans la zone Project name.

Les noms de projet peuvent contenir uniquement des caracteres
alphanumériques et des traits de soulignement et doivent étre spécifiés en
anglais.

Pour obtenir des recommandations concernant la désignation des projets
utilisateur, voir [«Création de vos projets utilisateur» a la page 18|

3. Pour créer le dossier du projet utilisateur a I'emplacement par défaut (votre
espace de travail) et lui affecter un nom identique au nom indiqué pour le
projet utilisateur, activez la case a cocher Use default dans le panneau “Project
contents”.

Si vous souhaitez indiquer un nom et un emplacement pour le dossier du
projet utilisateur, procédez comme suit :

a. Désactivez la case a cocher Use default dans le panneau “Project contents”.

b. Entrez le chemin d’accés complet et le nom du répertoire que vous
souhaitez utiliser pour le projet utilisateur dans la zone Directory ou
cliquez sur Browse pour sélectionner un répertoire existant.
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Remarque : Il n’existe pas d’autre méthode pour créer le dossier d'un projet
utilisateur dans le chemin de 'espace de travail que de laisser

System Manager le faire au moyen de la case a cocher Use default
location.

4. Si vous ne souhaitez pas créer de raccourcis vers des composants d’intégration
existants a ce moment, passez a l'étape El

Si vous souhaitez créer des raccourcis vers des composants d’intégration
existants, activez la case a cocher en regard de la bibliotheque de composants
d’intégration pour créer des raccourcis vers tous les composants contenus dans
cette bibliotheque ou développez un dossier de bibliotheque de composants
d’intégration et désactivez les cases a cocher en regard des groupes de
composants ou bien développez les dossiers des groupes et désactivez les cases
a cocher en regard de chaque composant individuel.

Remarque : Si vous sélectionnez des composants du méme nom dans plusieurs
bibliotheques de composants d’intégration, aucune invite ne vous
informe que vous avez sélectionné des références en double. Dans
le cas ol vous sélectionneriez des composants en double, des
raccourcis seront créés pour le composant de la bibliotheque de
composants d’'intégration positionnée en dernier dans la liste des
bibliotheques lors de votre sélection dans l’assistant.

La présente l'assistant “New User Project”.

New User Project i
Mewy User Project creation a

Project name: | WiehSpherelC3420DEVUP

¥ Use default location

Locafion ICt»"-febﬁghere[CEAEDDE\f'-F'rn]E-?i.;'rlfv‘ehSpnerei[s&r]DE\-’LlP Browse I

- [[Ji=$ DOCUMENTATIOND1 DEV420ICL
0@ DOCUMENTATICNOZDEY4201CL
=[]z WebSpherelCS420DEVICL
on B@ Benchmark
®-[¥]Z= Business Objects
#-[#]= Collaboration Objects
¥z Collaboration Templates
#-[#]= Connectars
[¥]=> Database Connection Pools
=- [ maps
M= Relationships
[ schedules

Cancel |

Figure 9. Création d’un projet utilisateur

5. Cliquez sur Finish pour mettre fin a 1’assistant.

System Manager crée un dossier avec le nom indiqué dans le sous-dossier
InterChange Server Projects du dossier User Projects.
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Ajout de raccourcis a un projet utilisateur

Vous pouvez ajouter des raccourcis a un projet utilisateur pour obtenir une vue de
l'interface que vous utilisez. Il existe différentes manieres d’ajouter des raccourcis a
un projet utilisateur, comme le montrent les sections suivantes :

« |«Utilisation de I'assistant Dependency Tree»|

* |«Utilisation de l'assistant Update Project» a la page 45|

« |«Glisser-déplacer de composants» a la page 46|

+ [dmportation d’une solution» a la page 61]

+ |<dmportation d’une solution» a la page 61]

Utilisation de I’assistant Dependency Tree

L’assistant “Dependency Tree” est l'interface la plus adaptée pour ajouter des
raccourcis vers des composants a un projet utilisateur. Les projets utilisateur sont
principalement concus pour représenter les interfaces et les interfaces sont
généralement au coeur d'un objet de collaboration. De plus, les projets utilisateur
sont aussi au coeur d'un objet de collaboration d'une maniére générale et vous
pouvez d’ordinaire créer les raccourcis que vous souhaitez pour un projet
utilisateur en recherchant les dépendances d"un objet de collaboration.

Pour plus d’informations conceptuelles sur les dépendances, voir lDépendances ef]
iréférences» a la page 86|

Procédez comme suit pour ajouter des raccourcis a un projet utilisateur en utilisant
l'assistant “Dependency Tree” :

1. Cliquez avec le bouton droit de la souris sur un composant d’intégration, tel
qu’'un objet de collaboration, dans une bibliotheque, puis sélectionnez Show
Dependencies dans le menu contextuel.

2. Sélectionnez le projet utilisateur auquel vous souhaitez ajouter des raccourcis
dans le menu déroulant Add to the project.

3. Sélectionnez les composants pour lesquels vous souhaitez créer des raccourcis
dans le panneau de gauche de lassistant.

Vous pouvez utiliser les raccourcis clavier pour simplifier le processus, par
exemple en appuyant sur Maj pour sélectionner plusieurs objets a la suite ou
en maintenant la touche Ctrl enfoncée pour sélectionner un a un des objets non
contigus.

4. Cliquez sur la fleche vers la droite pour ajouter les composants dans le
panneau de droite de 1'assistant.

La [figure 10 a la page 45| présente 1'assistant “Dependency Tree” :
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Figure 10. Ajout de raccourcis a un projet utilisateur a l'aide de I'assistant Dependency Tree

5. Cliquez sur OK.

System Manager crée les raccourcis vers les composants sélectionnés dans le
projet utilisateur spécifié.

Utilisation de I'assistant Update Project

L’assistant “Update Project” fournit une interface permettant d’ajouter des
raccourcis a un projet utilisateur identique a l'interface affichée lors de la création
initiale d’un projet utilisateur. Procédez comme suit pour utiliser 1’assistant
“Update Project” :

1.

Cliquez avec le bouton droit de la souris sur n'importe quel objet utilisateur
dans la vue WebSphere Business Integration System Manager, puis sélectionnez
Update project dans le menu contextuel.

Activez la case a cocher en regard de la bibliotheque de composants
d’intégration pour créer des raccourcis vers tous les composants contenus dans
cette bibliothéque ou développez un dossier de bibliotheque de composants
d’intégration et désactivez les cases a cocher en regard des groupes de
composants ou bien développez les dossiers des groupes et désactivez les cases
a cocher en regard de chaque composant individuel.

Cliquez sur Finish.

Si le projet utilisateur contient des raccourcis vers des composants du méme
nom que ceux sélectionnés dans l'assistant, une invite s’affiche pour vous
permettre d’effectuer les opérations suivantes :

* remplacer le composant affiché ;
 remplacer tous les composants en double ;
* ne pas remplacer le composant ;
 annuler I'opération de mise a jour.

Si vous n’avez sélectionné aucun composant du méme nom que les composants
pour lesquels des raccourcis existent déja dans le projet utilisateur, les
raccourcis sont alors ajoutés au projet et 1’assistant se ferme.
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Glisser-déplacer de composants

Vous pouvez sélectionner des composants dans la bibliotheque de composants
d’intégration et utiliser la fonction glisser-déplacer dans un projet utilisateur pour
ajouter des raccourcis vers ces composants au projet utilisateur.

5’il n’existe actuellement aucun raccourci dans le dossier du projet utilisateur, vous
devez alors faire glisser les composants et les déplacer sur le dossier lui-méme.
Effectuez un glisser-déplacer des composants sur le dossier et relachez le bouton
de la souris lorsqu'un carré apparait sous le pointeur de la souris.

S’il existe déja des raccourcis dans le dossier du projet utilisateur, vous ne pouvez
alors pas faire glisser les composants et les déplacer sur le dossier. Effectuez un
glisser-déplacer des composants entre les raccourcis existants du dossier jusqu’a ce
qu’une ligne s’affiche, puis relachez le bouton de la souris.

Utilisation des composants dans les bibliotheques de composants
d’intégration
Lors de I'implémentation d’un systéme d’intégration WebSphere InterChange
Server, vous passez la majeure partie de votre temps a utiliser des composants
d’intégration. Bien que ce document ne détaille pas la méthode permettant de
développer des composants individuels, la présente section indique comment
lancer les outils de conception, comment débuter la création de composants,

comment débuter la modification de composants existants et comment utiliser les
quelques composants développés dans System Manager.

Pour plus d’informations sur la maniere de développer des composants
d’intégration, voir les documents suivants :

* Collaboration Development Guide

* Map Development Guide

* Business Object Development Guide

* Connector Development Guide for C++

* Connector Development Guide for Java Server
* Access Development Guide

Pour plus d’informations sur l'utilisation des composants développés et déployés
dans une instance d’InterChange Server, voir |[«Utilisation des composants dans un|
fréférentiel d’InterChange Server» a la page 76|

Lancement des outils de conception

Cette section décrit les différentes manieres de lancer chacun des outils de
conception. Vous pouvez utiliser les outils de conception pour créer des
composants ou pour ouvrir et modifier des composants existants.

Remarque : Si vous tentez de lancer 1'un des outils de conception et que vous
rencontrez une erreur concernant une classe introuvable, vous devez
lancer System Manager puis tenter de lancer de nouveau l'outil de
conception. Il n’est toutefois pas nécessaire que System Manager
fonctionne apres le lancement initial de 1’outil.

Business Object Designer
Pour lancer Business Object Designer, effectuez 1'une des opérations suivantes :
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* Cliquez avec le bouton droit de la souris sur le dossier Business Objects dans la
vue WebSphere Business Integration System, puis sélectionnez Create New
Business Object dans le menu contextuel.

* Sélectionnez n'importe quel dossier dans la vue WebSphere Business Integration
System, puis effectuez I'une des opérations suivantes :

— Sélectionnez Tools > Business Object Designer dans la barre de menus.
— Cliquez sur le bouton Business Object Designer de la barre de menus.
— Utilisez le raccourci clavier Ctrl+4.

* Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Development > Business
Object Designer.

Pour plus d’informations sur Business Object Designer, voir le document Business
Object Development Guide.

Connector Configurator
Pour lancer Connector Configurator, effectuez 1'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur le dossier Connectors dans la vue
WebSphere Business Integration System, puis sélectionnez Create New
Connector dans le menu contextuel.

* Sélectionnez n'importe quel dossier dans la vue WebSphere Business Integration
System, puis effectuez 1'une des opérations suivantes :

— Sélectionnez Tools > Connector Configurator dans la barre de menus.
— Cliquez sur le bouton Connector Configurator de la barre d’outils.
— Utilisez le raccourci clavier Ctrl+1.

* Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Development > Connector
Configurator.

Pour plus d’informations sur Connector Configurator, voir
l«Configuration des connecteurs», a la page 145|et le document Connector
Development Guide for C++ ou Connector Development Guide for Java Server.

Map Designer

Pour lancer Map Designer, effectuez 1'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur le dossier Maps dans la vue
WebSphere Business Integration System, puis sélectionnez Create New Map
dans le menu contextuel.

* Sélectionnez le dossier de n'importe quel type de composant d’intégration dans
la vue WebSphere Business Integration System Manager, puis effectuez I'une des
opérations suivantes :

— Sélectionnez Tools > Map Designer dans la barre de menus.
— Cliquez sur le bouton Map Designer de la barre d’outils.
— Utilisez le raccourci clavier Ctrl+3.

¢ Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Development > Map Designer.

Map Designer propose une fonction appelée Automatic Mapping dans le menu
Tools. Cette fonction permet de créer des mappes automatiquement entre plusieurs
objets métier avec des attributs identiques. Pour plus d’informations sur Map
Designer et sur la fonction Automatic Mapping, voir le document Map Development
Guide.
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Relationship Designer
Pour lancer Relationship Designer, effectuez 1'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur le dossier Relationships dans la
vue WebSphere Business Integration System Manager, puis sélectionnez
Relationship Designer dans le menu contextuel.

* Sélectionnez le dossier de n'importe quel type de composant d’intégration dans
la vue WebSphere Business Integration System, puis effectuez 1'une des
opérations suivantes :

— Sélectionnez Tools > Relationship Designer dans la barre de menus.
— Cliquez sur le bouton Relationship Designer de la barre d’outils.
— Utilisez le raccourci clavier Ctrl+5.

* Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Development > Relationship
Designer.

Pour plus d’informations sur Relationship Designer, voir le document Map
Development Guide.

Process Designer
Pour lancer Process Designer, effectuez 1'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur le dossier Collaboration Templates
dans la vue WebSphere Business Integration System, puis sélectionnez Create
New Collaboration Template dans le menu contextuel.

* Sélectionnez le dossier de n'importe quel type de composant d’intégration dans
la vue WebSphere Business Integration System, puis effectuez 1'une des
opérations suivantes :

— Sélectionnez Tools > Process Designer dans la barre de menus.
— Cliquez sur le bouton Process Designer de la barre d’outils.
— Utilisez le raccourci clavier Ctrl+2.

e Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Development > Tools >
Process Designer.

Pour plus d’informations sur Process Designer, voir le document Collaboration
Development Guide.

Création de composants
Le lancement des outils de conception respectifs de chacun des composants
suivants, comme indiqué a la section [«Lancement des outils de conception» a la]
permet de créer un composant de ce type :

* Objets métier

* Connecteurs

* Mappes

* Relations

* Modeles de collaboration

Certains composants ne disposent d’aucun outil de conception dédié : vous devez
par conséquent les créer dans des interfaces affichées par System Manager. Pour
créer des bancs d’essai, des objets de collaboration, des pools de connexion a une
base de données et des plannings, voir [tableau 3 a la page 49| :
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Tableau 3. Techniques de création de composants d’intégration sans outil de conception

Composant

Technique

Pour plus
d’informations,
Voir...

Banc d’essai

Cliquez avec le bouton droit de la souris sur
le dossier Benchmark dans la vue
WebSphere Business Integration System, puis
sélectionnez 1'une des options suivantes
dans le menu contextuel Benchmark Setup :

* Configure new Benchmark
 Edit existing Benchmark

* Generate work load to a file

Benchmarking Guide

Objet de collaboration

Cliquez avec le bouton droit de la souris sur
le dossier Collaboration Objects dans la vue
WebSphere Business Integration System, puis
sélectionnez Create New Collaboration
Object dans le menu contextuel.

Chapitre 9)

«Configuration des|

objets de|

collaboration», a lal

[page 203|

Pool de connexion a

une base de données

Cliquez avec le bouton droit de la souris sur
le dossier Database Connection Pools dans
la vue WebSphere Business Integration
System, puis sélectionnez Create New
Database Connection dans le menu
contextuel.

Chapitre 8,|

«Configuration des|

pools de connexion|

A une base de|

données», a la page

191

Planning

* Cliquez avec le bouton droit de la souris
sur le dossier Schedules dans la vue
WebSphere Business Integration System,
puis sélectionnez Edit Components’
schedule dans le menu contextuel.

* Cliquez avec le bouton droit de la souris
sur n’importe quel composant pouvant
étre planifié dans une bibliotheque ou sur
le raccourci vers n‘importe quel
composant pouvant étre planifié dans un
projet utilisateur, puis sélectionnez Edit
Components’ schedule dans le menu
contextuel.

System
Administration Guide

Désignation de services Web en tant que composants
d’intégration

La présente section décrit comment enregistrer et appeler un service Web comme
composant d’intégration dans System Manager et contient les sections suivantes :

e |«Présentation»

* |«Enregistrement d’un service Web» a la page 50|

+ |«Affichage d’un service Web enregistré» a la page 51|

+ |«Test d’un service Web enregistré» a la page 51|

Présentation

Les services Web sont des applications distribuées via un réseau et intégrées a un
processus métier. Ces services ne font pas partie d'InterChange Server ou d'une
collaboration. IIs communiquent cependant avec InterChanger Server en utilisant la
structure d’acces. Ils mettent a jour les bases de données sous le controle
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d’InterChange Server. Ceci implique qu’Interchange Server doive contacter les
services Web pour donner des informations afin de pouvoir synchroniser les
données dans le processus métier.

Les services Web peuvent étre locaux, distribués ou basés sur le Web. Ils sont
constitués a partir de normes ouvertes telles que TCP/IP, HTTP, Java, HTML et
XML. IIs utilisent les nouvelles technologies standard telles que SOAP (Simple
Object Access Protocol) pour la messagerie, UDDI (Universal Description,
Discovery and Integration) et WSDL (Web Services Description Language) pour la
publication et l’exploration.

Grace a System Manager, vous pouvez enregistrer un service Web comme
composant d"une bibliotheque de composants d’intégration. Le processus
d’enregistrement répertorie le service Web comme un composant sous le noeud
Integration Component Libraries et génere automatiquement les objets métier
qu’InterChange Server utilisera pour communiquer avec le service Web. Vous
pouvez également utiliser System Manager pour tester le service Web enregistré
avant de le déployer sur le serveur.

Enregistrement d’un service Web
Dans System Manager, utilisez 'assistant Register a new Web service pour
enregistrer un service Web.

1. Pour lancer l'assistant, développez Integration Component Libraries dans la
vue WebSphere Business Integration System, cliquez avec le bouton droit de la
souris sur le dossier Web Services, puis sélectionnez Register New Web
Service. La fenétre Choose a method to register Web services s’affiche.

2. Cliquez sur 'une des options suivantes :

Option Description

Enter a URL for WSDL file Permet d’indiquer exactement le service Web
que vous souhaitez enregistrer.

Search UDDI registry for a Web service | Permet d’indiquer un registre UDDI dans
lequel effectuer une recherche pour localiser le
service Web par la suite.

3. Cliquez sur Next.

4. Sivous avez cliqué sur Enter a URL for WSDL file a I'étape 2, la fenétre
Please enter WSDL URL s’affiche. Dans la zone WSDL URL, indiquez 1’'URL
du service a enregistrer, cliquez sur Next, puis passez a l’étape

5. Si vous avez cliqué sur Search UDDI registry for a Web service a 1’étape 2, la
fenétre Searching for Web services s’affiche. Procédez comme suit :

a. Dans la zone Search terms, entrez le critere de recherche du service Web.

b. Sélectionnez un ou plusieurs registres UDDI parmi les registres pris en
charge suivants :

¢ Registre UDDI d'IBM
* Registre UDDI de Microsoft
* Registre UDDI de XMethods

c. Cliquez sur Search. L’onglet Search Results affiche les noms des registres
dans lesquels des résultats ont été trouvés. Si le registre sélectionné n’est
pas disponible, un message d’erreur s’affiche.

6. Pour chaque nom de registre dans la liste, procédez comme suit :

* Sélectionnez le nom de registre pour afficher le nombre de résultats de la
recherche pour ce registre.
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* Développez la liste des registres pour afficher les noms des services trouvés
dans ce registre.

* Sélectionnez le nom d’un service pour afficher les détails du service Web.

7. Sélectionnez le nom du service Web que vous souhaitez enregistrer, puis

cliquez sur Next pour accéder a la page suivante de l’assistant. La fenétre
New Web service is found s’affiche.

Dans la page New Web service is found, vous pouvez procéder aux
opérations suivantes :

¢ Cliquez sur l'onglet Available Methods pour afficher la liste des services
pouvant étre appelés pour le service Web. Les services représentent
essentiellement des méthodes pouvant étre appelées par un client.

* Cliquez sur l'onglet WSDL pour afficher le code XML qui décrit le service
Web.

Lorsque vous cliquez sur une méthode disponible, des informations
supplémentaires s’affichent (si disponibles) dans le panneau de droite. Notez
que le parametre Fault(s) est utilisé pour stocker les erreurs ou les exceptions
pouvant intervenir lorsqu'un service est appelé.

10. Cliquez sur Finish pour enregistrer le service Web.

Affichage d’un service Web enregistré
Apres avoir enregistré un service Web, vous pouvez 'afficher dans System
Manager.

1.

Sous Integration Component Libraries > Web Services, cliquez deux fois sur le
nom du service Web : I'onglet Overview s’affiche.

Cliquez sur 'onglet Overview pour afficher la fenétre Available Operations.
Cette fenétre fournit la liste des services ou méthodes, associés a ce service
Web. Le panneau Web Service Methods, qui s’affiche a droite de la page
Available Operations, affiche également la liste des méthodes.

Toutes les méthodes du service Web, que vous envisagiez de les utiliser ou non,
sont enregistrées et s’affichent dans la colonne Operation de la page Available
Operations.

Les objets métier créés pour chaque méthode lors de l’enregistrement du
service Web (voir [Enregistrement d’un service Web» a la page 50) sont
répertoriés sous les colonnes Input BO et Output BO.

Pour recréer les objets métier, cliquez sur Create Business Objects Definitions.

Dans le panneau Web Service Methods, sélectionnez une méthode pour afficher
ses parametres dans le panneau Method Parameters. Les parametres sont
répertoriés sous les catégories Input, Output et Fault.

Test d’un service Web enregistré
Vous pouvez tester un service Web enregistré avant de le déployer sur le serveur
d’intégration.

1.

Sous Integration Component Libraries > Web Services, cliquez deux fois sur le
nom du service Web. L’onglet Overview, ainsi que les panneaux Web Service
Methods et Method Parameters, s’affichent.

Dans le panneau Web Service Methods, sélectionnez une méthode.

Dans la page Overview, cliquez deux fois sur le nom de la méthode ou cliquez
dessus avec le bouton droit de la souris, puis sélectionnez Test pour tester la
méthode. Une page de test pour la méthode sélectionnée s’affiche avec le nom
des objets métier d’entrée et de sortie de la méthode. Cette page est utilisée
pour tester la méthode sélectionnée.

4. Pour tester I'objet métier, procédez comme suit :
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¢ Cliquez sur Create New Request. L’objet métier de requéte sera créé dans le
panneau de gauche. Indiquez les parametres d’entrée. Vous pouvez ignorer
les attributs suivants : SOAPConfigMO, ProtocolConfigMO et OBjectEventID.

* Cliquez sur Invoke Web Services pour appeler le service Web. La réponse
du service Web s’affiche dans le panneau Response business object.

5. Cliquez deux fois sur chacune des méthodes dans la page Overview pour les
tester dans la page de test.

Modification des composants existants

Pour modifier des objets métier, des connecteurs, des mappes, des relations et des
modeles de collaboration, vous pouvez procéder comme suit :

* Cliquez deux fois sur le composant dans une bibliotheque ou sur le raccourci
vers un composant dans un projet utilisateur.

* Sélectionnez le composant dans une bibliotheque ou le raccourci vers un
composant dans un projet utilisateur puis procédez comme suit :

— Lancez son outil de conception comme indiqué a la section |[«Lancement des|

[outils de conception» a la page 46|

— Appuyez sur Entrée.

— Appuyez sur Ctrl+E.

— Sélectionnez Component > Edit Definitions dans la barre de menus.

* Cliquez avec le bouton droit de la souris sur le composant dans une
bibliotheque ou sur le raccourci vers un composant dans un projet utilisateur,
puis sélectionnez Edit definition dans le menu contextuel.

* Lancez 'outil de conception du composant comme indiqué a la section

[<Lancement des outils de conception» a la page 46} puis ouvrez le composant

une fois 'outil démarré.

Pour plus d’informations sur la maniére de modifier les bancs d’essai des
composants, les objets de collaboration, les pools de connexion a une base de
données et les plannings, voir :

Tableau 4. Techniques de modification des composants d’intégration sans outil de

conception
Pour plus
d’informations,
Composant Technique Voir...

Banc d’essai

Cliquez avec le bouton droit de la souris sur
le dossier Benchmark dans la vue
WebSphere Business Integration System, puis
sélectionnez I'une des options suivantes
dans le menu contextuel Benchmark Setup :

* Configure new Benchmark
» Edit existing Benchmark

¢ Generate work load to a file

Benchmarking Guide

Objet de collaboration

Cliquez deux fois sur 1'objet de collaboration
dans le dossier Collaboration Objects dans
la vue WebSphere Business Integration
System.

Chapitre 9]

«Configuration des|

objets de|

collaboration», a la|

[page 203|
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Tableau 4. Techniques de modification des composants d’intégration sans outil de
conception (suite)

Pour plus
d’informations,
Composant Technique Voir...
Pool de connexion a Il est impossible de modifier un pool de Chapitre 8,|
une base de données |connexion a une base de données. Vous «Configuration des|
pouvez modifier certaines propriétés du pools de connexion|
composant du pool mais vous ne pouvez a une base de|
pas modifier les éléments de définition tels |[données», a la page|
que la base de données a laquelle le pool est ||191

connecté.

Planning . System

Cliquez avec le bouton droit de la souris n ) ]
Administration Guide

sur le dossier Schedules dans la vue
WebSphere Business Integration System,
puis sélectionnez Edit Components’
schedule dans le menu contextuel.

* Cliquez avec le bouton droit de la souris
sur n’importe quel composant pouvant
étre planifié dans une bibliotheque ou sur
le raccourci vers n’importe quel
composant pouvant étre planifié dans un
projet utilisateur, puis sélectionnez Edit
Components’ schedule dans le menu
contextuel.

L’interface “Schedule” s’affiche et vous
permet de modifier les plannings définis.

Importation de composants dans une bibliotheque a partir
d’un serveur a I'aide de I’assistant d’importation

Vous pouvez importer des composants d’intégration dans une bibliotheque a partir
d’un référentiel d’InterChange Server. Cette opération est particuliéerement utile
lorsque vous intégrez une équipe de développement et que vous devez mettre a
jour votre environnement de développement personnel avec des composants
existants.

Vous pouvez importer des composants a partir des bibliotheques des autres
développeurs. Toutefois, s’ils ne gerent pas leurs composants correctement, vous
pouvez souhaiter utiliser uniquement des composants dont vous étes siir de la
qualité. Les environnement de test et de production sont la plupart du temps gérés
correctement et sont généralement plus fiables que les environnements de
développement personnels.

Procédez comme suit pour importer des composants dans une bibliotheque de
composants d'intégration a partir d’un référentiel d'InterChange Server :

Remarque : Pour importer des composants dans une bibliothéque a partir d"une
instance d’'InterChange Server, le serveur doit étre en cours
d’exécution. Si System Manager n’est pas connecté au serveur lorsque
vous lancez l'assistant “Import components”, aucun composant ne
sera affiché pour I'importation.

1. Connectez System Manager a InterChange Server comme indiqué dans la
section [<Connexion a InterChange Server» a la page 32|
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2. Dans la vue WebSphere Business Integration System Manager, cliquez avec le
bouton droit de la souris sur la bibliotheque dans laquelle vous souhaitez
importer des composants, sélectionnez Import components from server dans le
menu contextuel, puis effectuez 1'une des opérations suivantes pour lancer
l'assistant “Import components” :

* Sélectionnez Components dans le sous-menu pour afficher tous les types de
composant contenus sur le serveur.

¢ Sélectionnez un type de composant dans le sous-menu pour afficher
uniquement ce type de composant.

System Manager affiche 1’assistant “Import the additional components from the
server”, comme indiqué dans la

Import the additional components from the server

Import the additional components from the server e

@
Make sure you have not chosen the same object from two different servers @

=Bl WICS422DEY
O Benchmark
#-[](& Business Obijects
- [z Collaboration Objects
+-[#(= Collaboration Templates
EIDE— Connectors
#-[Jiz Database Connection Pools
-] Maps
#-[Jiz Relationships
[ schedules

¥ Deep
V¥ Overwrite the existing components without warning

Finish Cancel

Figure 11. Importation de composants a partir du serveur

3. Activez les cases a cocher en regard des serveurs, des groupes de composants
ou des composants individuels que vous souhaitez importer a partir du
serveur.

4. Activez la case a cocher Deep si vous souhaitez également importer les
dépendances du composant. Pour plus d’informations sur les dépendances, voir
[<Dépendances et références» a la page 86|

5. Activez la case a cocher Overwrite the existing components without warning
si vous souhaitez remplacer tous les composants contenus actuellement dans la
bibliotheque et portant un nom identique a ceux sélectionnés pour
I'importation depuis le serveur.

Si vous n’avez sélectionné aucune mappe ni aucun modele de collaboration,
passez a 'étape|7 a la page 55

Si vous avez sélectionné des mappes ou des modeles de collaboration a
importer, effectuez l'une des opérations suivantes :

* Si vous importez a partir d’une instance du serveur des mappes et des
modeles de collaboration antérieurs a la version 4.2.2 et que vous souhaitez a
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I'instant les mettre a niveau avec la version 4.2.2, passez a 'étape E pour
accéder a I"écran suivant de l'assistant.

* Si les mappes et les modeles de collaboration importés sont déja au format

4.2.2 ou ﬁe vous ne souhaitez pas les mettre a niveau pour l'instant, passez

a I'étape|7| pour mettre fin a l’assistant.

6. Dans le second écran de l'assistant “Import components”, activez les cases a

cocher Maps et Collaboration Templates pour permettre a System Manager de

convertir au format 4.2.2 les mappes et modeles de collaboration contenus
parmi les composants sélectionnés.

Si vous avez utilisé repos_copy pour déployer les composants depuis une
version antérieure a 4.2.2 vers un référentiel de serveur version 4.2.2, les

mappes et les modeles de collaboration stockés ne sont alors pas mis a niveau.
Vous pouvez uniquement mettre a niveau ces composants avec le format 4.2.2 a

l'aide de System Manager ou des outils Map Designer et Process Designer.

Dans le second écran de l'assistant “Import components”, vous pouvez laisser

les cases a cocher Maps et Collaboration Templates activées pour que les
mappes et les modeles de collaboration soient convertis a l'instant méme ou
bien les désactiver pour remettre la conversion a plus tard, lorsque vous
pourrez le faire a I'aide des outils de conception. Vous pouvez souhaiter
reporter la conversion car le processus peut étre long, notamment lorsque le
nombre de ces types de composant est important.

La [figure 12| présente le second écran de l'assistant “Import components” :

Import the additional components from the server E

Import the additional components from the server P

&
These are the old Maps and Templates, They need to be converted, this action may take a long @
time.

< Back Next > | Einish I Cancel

Figure 12. Conversion de mappes et de modéles de collaboration lors d’une importation a
partir du serveur

7. Cliquez sur Finish.
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Importation de composants dans une bibliothéque a partir du
serveur a l’aide de la fonction glisser-déplacer

Procédez comme suit pour importer des composants dans une bibliothéque de
composants d’intégration a 'aide des techniques de glisser-déplacer parmi les vues
de System Manager :

1. Procédez comme suit dans la vue InterChange Server Component Management
pour sélectionner les composants que vous souhaitez déployer :

* Choisissez tous les composants d’un méme type en sélectionnant le dossier
concerné dans un projet utilisateur ou dans une bibliotheque de composants
d’intégration.

* Développez les dossiers de composants et sélectionnez des composants
individuels. Vous pouvez utiliser les techniques de sélection standard de
Windows pour sélectionner plusieurs projets utilisateur en méme temps pour
le déploiement, comme suit :

— Maintenez la touche Maj enfoncée pour sélectionner des éléments
contigus.

— Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

2. Effectuez un glisser-déplacer des ressources sélectionnées sur la bibliotheque de
composants d’intégration dans laquelle vous souhaitez importer les composants
de la vue WebSphere Business Integration System Manager.

System Manager tente d’importer les composants dans la bibliotheque de
composants d’intégration. Les messages et les erreurs s’affichent dans la vue
Console.

Importation de composants dans une bibliotheque a partir
d’un package
Vous pouvez exporter des composants d’intégration vers un package de fichiers
.jar, comme indiqué a la section |[«Exportation de composants vers un package 2|
['aide de System Manager» a la page 61| Cette opération facilite la migration des
composants entre les environnements, leur partage avec d’autres développeurs et
leur soumission au support technique.

Procédez comme suit pour importer des composants dans une bibliotheque de
composants d’intégration a partir d’'un package :

Important : S’il existe des composants du méme nom que ceux contenus dans le
package que vous importez, System Manager remplace les composants
existants sans vous en avertir.

1. Cliquez avec le bouton droit de la souris sur une bibliotheque de composants
d’intégration, puis sélectionnez Import from Repository File dans le menu
contextuel.

System Manager affiche 1’assistant “Import Repository File”, comme indiqué
dans lafigure 13 a la page 57
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Import from Repository File
Components will be imported into the ICL project from repository file. D
A
Integration component library name: I WICS422DEVICL ;l
% InterChange server reposiory file: | C:AIBMyWebSpherelCSibackups| 10282 |5
" Import from a Repositary Files directary I Browse, ., |
Einish Cancel

Figure 13. Importation d’un package

2. Dans l'écran “Import Repository File”, veillez a ce que le menu déroulant
Integration Component Library Name contienne le nom de la bibliotheque dans
laquelle vous souhaitez importer les composants.

Si vous avez lancé l'assistant “Import from Repository File” depuis une
bibliotheque autre que celle dans laquelle vous souhaitez importer les
composants, vous pouvez modifier la cible de cette maniere au lieu de fermer
l'assistant et de le lancer de nouveau.

3. Effectuez I'une des opérations suivantes pour indiquer les composants que
vous souhaitez importer :

* Pour importer un seul fichier du package, entrez le chemin d’accés complet
et le nom du fichier .jar que vous souhaitez importer dans la zone
InterChange server repository file ou cliquez sur Browse pour sélectionner
le fichier.

* Pour importer l'intégralité du répertoire des fichiers du package, entrez le
chemin d’acces complet au répertoire dans la zone Import from a Repository
Files directory ou cliquez sur Browse pour sélectionner le fichier.

4. Cliquez sur Finish.
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Remarque : N'utilisez pas 1’élément de menu File > Import de l'atelier pour
importer un fichier du package. Bien que 'assistant “Zip file” utilise
des archives dont 'extension est .jar et que 'extension des fichiers
du package InterChange Server est .jar, l'assistant “Zip file” ne
fonctionne pas correctement avec des fichiers du package.

Modification des propriétés d’'une mappe et d’un objet de
collaboration dans les bibliotheques de composants
d’intégration
Les mappes et les objets de collaboration ont des propriétés que vous pouvez
modifier pour changer le comportement de ces composants. Pour modifier les
propriétés d’'un composant, cliquez avec le bouton droit de la souris sur le
composant dans une bibliotheque de composants d’intégration ou sur un raccourci
vers ce composant dans un projet utilisateur, puis sélectionnez Properties dans le

menu contextuel. System Manager affiche une boite de dialogue pour configurer
les propriétés du composant.

Pour plus d’informations sur les propriétés d’un objet de collaboration, voir
(Chapitre 9, «Configuration des obijets de collaboration», a la page 203|

Map Designer propose une fonction importante qui permet de générer
automatiquement des mappes entre les objets métier possédant des attributs source
et cible de méme nom. Pour plus d’informations sur les propriétés d’une mappe,
voir le document Map Development Guide.

Validation des pools de connexion a une base de données

I existe un élément de menu contextuel appelé Validate Connection pour les
composants des pools de connexion a une base de données. Pour plus
d’informations sur cet élément de menu, voir [«Validation des pools de connexion 3|
fune base de données» a la page 198

Compilation de mappes et de modeéles de collaboration

La fonction de compilation des mappes et des modeles de collaboration dans
System Manager est treés pratique car les composants doivent étre compilés pour
étre déployés ou exportés vers un package. System Manager utilise la compilation
asynchrone, ce qui signifie que, pendant que vous compilez un composant, System
Manager est capable de réaliser une autre tache.

La compilation des composants fait appel au rapport d’avancement des éléments et
a la barre de progression. Ces informations sont conservées dans une table du
cache sur le serveur. L’état d’avancement est mis a jour a la fin de chaque
opération sur chaque artefact.

Remarque : Lorsque System Manager utilise la compilation asynchrone, une seule
compilation peut étre réalisée a la fois.

Si le composant en cours de compilation utilise des bibliotheque qui ne sont pas
fournies par IBM, par exemple les bibliotheques que vous avez créé vous—méme
ou qui sont fournies par un autre fournisseur, vous devez configurer System

Manager de sorte qu’il référence ces bibliotheques. Pour plus d’informations sur
I'interface de préférences “Compiler”, voir 4 a la page 9

Effectuez 1'une des opérations suivantes pour compiler une mappe ou un modele
de collaboration :
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* Sélectionnez la mappe ou le modele de collaboration dans une bibliotheque de
composants d’intégration ou le raccourci associé dans un projet utilisateur, puis
effectuez I'une des opérations suivantes :

— Appuyez sur Ctrl+F7.
— Sélectionnez Component > Compile dans la barre de menus.

* Cliquez avec le bouton droit de la souris sur la mappe ou le modele de
collaboration dans une bibliothéque de composants d’intégration ou sur le
raccourci associé dans un projet utilisateur, puis sélectionnez Compile dans le
menu contextuel.

Effectuez l'une des opérations suivantes pour compiler ’ensemble des mappes ou
des modeles de collaboration dans une bibliotheque de composants d’intégration :

* Sélectionnez le dossier Maps ou Collaboration Templates dans une bibliotheque
de composants d’intégration, puis effectuez 1'une des opérations suivantes :

- Appuyez sur F7.
— Sélectionnez Component > Compile all dans la barre de menus.
* Cliquez avec le bouton droit de la souris sur le dossier Maps ou Collaboration

Templates dans une bibliotheque de composants d’intégration, puis sélectionnez
Compile all dans le menu contextuel.

Pour compiler une mappe avec ses sous-mappes, cliquez avec le bouton droit de la
souris sur la mappe dans une bibliotheque de composants d’intégration ou sur le
raccourci associé dans un projet utilisateur, puis sélectionnez Compile with
submap(s) dans le menu contextuel.

Utilisation des solutions

Vous pouvez exporter un projet utilisateur en tant que solution. Cette opération
copie les raccourcis depuis le projet utilisateur ainsi que les définitions de
composant auxquelles les raccourcis font référence dans la bibliotheque de
composants d’intégration. Cela facilite la migration de l'intégralité d’une interface
ou d'un systéeme d’intégration métier d'un environnement a un autre.

Exportation d’une solution

Procédez comme suit pour exporter un projet utilisateur ainsi que les composants
d’intégration auxquels il fait référence en tant que solution :

1. Dans la vue WebSphere Business Integration System Manager, développez le
dossier User Projects, cliquez avec le bouton droit de la souris sur le dossier
InterChange Server Projects, puis sélectionnez Export Solution dans le menu
contextuel.

System Manager affiche 1’assistant “Export Solution”, comme indiqué dans la
[figure 14 2 1a page 60
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Export Solution

Export Solution Page 1 &

@
Select components ko export ﬁ

Dﬁ CustomerSync_Clanfy ToCassar
O CustomerSync_Clarify TaSap
[ = WICS42ZDEVLP

[+
#
®

| CHIBMIWebSpherelCSibackups|11.03.2003

Browse... I

I Qvervrite existing file without warning

Cancel

Figure 14. Exportation d’une solution

2. Utilisez les techniques suivantes pour sélectionner les composants que vous
souhaitez exporter :

* Activez la case a cocher en regard des projets utilisateur afin de sélectionner
tous les composants contenus dans les projets.

* Activez la case a cocher en regard d'un groupe de composants afin de
sélectionner tous les composants contenus dans ce dernier.

* Mettez en surbrillance un groupe de composants puis cochez les cases en
regard des composants individuels dans le panneau de droite afin de
sélectionner ces derniers.

3. Entrez le chemin d’acces complet et le nom du répertoire dans lequel la
solution doit étre exportée dans la zone de texte au bas de 'écran de l'assistant
ou cliquez sur Browse pour accéder au répertoire souhaité.

4. Cliquez sur Finish.
System Manager procede comme suit pour exporter la solution dans le
répertoire spécifié a I'étape [3]:
* Il crée un répertoire User contenant les raccourcis dans les projets utilisateur
sélectionnés au cours de I'exportation de la solution.

¢ Il crée un répertoire System contenant les répertoires de la bibliotheque de
composants d’intégration référencée par les raccourcis dans les projets
utilisateur sélectionnés au cours de 'exportation de la solution.

5. Lorsque le message indiquant la fin de l'opération d’exportation s’affiche,
cliquez sur OK.
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Importation d’une solution
Procédez comme suit pour importer une solution :

1. Dans la vue WebSphere Business Integration System Manager, développez le
dossier User Projects, cliquez avec le bouton droit de la souris sur le dossier
InterChange Server Projects, puis sélectionnez Import Solution dans le menu
contextuel.

System Manager affiche 1’assistant “Import Solution”, comme indiqué dans la
_fiure 15

Import Solution

Import Solution

[,

Solution directory name:
I CHIEMwebspherelCS\backups|11.03.2003 Browse. .. !

Warning: Importing this will overwrite any
existing projects with the same name.

Cancel I

Figure 15. Importation d’une solution

2. Entrez le chemin d’acces complet et le nom du répertoire dans lequel se trouve
la solution exportée dans la zone Solution directory name ou cliquez sur
Browse pour accéder au répertoire souhaité.

3. Cliquez sur Finish.

System Manager crée les bibliotheques de composants d’intégration et les
projets utilisateur définis dans la solution exportée dans votre environnement.

Exportation de composants vers un package a I'aide de System
Manager

Vous pouvez exporter des composants d’intégration vers un fichier du package.
Les composants d’intégration sont des ressources qui, en fin de compte,
correspondent a des fichiers stockés dans le systeme de fichiers, comme indiqué
dans la section |«Ressources» a la page 25 Lorsque System Manager exporte des
composants dans un package, il compresse les ressources suivantes en fichier .jar
(fichier d’archive Java) :

* les fichiers de définitions (stockés au format XML avec différentes extensions
selon le type de composant) ;

* les fichiers source Java pour les mappes et les modeles de collaboration ;
* les fichier de messages.

Procédez comme suit pour exporter des composants dans un package :
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Important : Pour pouvoir exporter des mappes ou des modeéles de collaboration,
ces derniers doivent étre compilés. Si vous tentez d’exporter des
mappes ou des modéles de collaboration non compilés, System
Manager vous invite d’abord a le faire.

1. Cliquez avec le bouton droit de la souris sur une bibliotheque de composants
d’intégration ou un projet utilisateur qui contient les composants que vous
souhaitez exporter, puis sélectionnez Export as Repository File dans le menu
contextuel.

dans la

System Manaier affiche 1’assistant “Export Repository File”, comme indiqué

Export Repository File iR

InteiChange System Components Export Wizard l
Select distinct component(s) from the follwing @

= [Vl WehSpherelCS4200EVICL
- M= Benchmark
[¥]= Business Objects
- [AIE collaboration Objects
[ collaboration Templates
[ connectors
E@ Database Connection Pools
M= IntzorationComponentLisraties
& Maps
E& Relationships

IrterChange server repository jar file path:

I CriNvehSpherelCS420DEY backupsiNehSpherelCS420DEVICLO3 12003 jar

Browse...

v Qverwrite existing file without warning

Finish | Cancel

Figure 16. Exportation d’un package

2. Utilisez les techniques suivantes pour sélectionner les composants que vous
souhaitez exporter :

* Activez la case a cocher en regard de la bibliothéque de composants
d’intégration ou du projet utilisateur afin de sélectionner tous les composants
contenus dans cette bibliotheque ou ce projet.

* Activez la case a cocher en regard d'un groupe de composants afin de
sélectionner tous les composants contenus dans ce dernier.

* Mettez en surbrillance un groupe de composants puis cochez les cases en
regard des composants individuels dans le panneau de droite afin de
sélectionner ces derniers.
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3. Si vous envisagez de spécifier un fichier .jar existant dans lequel exporter les
composants et que vous souhaitez le remplacer sans recevoir d’invite, activez la
case a cocher Overwrite existing file without warning.

Remarque : Pour tirer profit de la case a cocher Overwrite existing file
without warning, vous devez l'activer avant de spécifier le fichier
a utiliser, comme indiqué a l'étape El System Manager vous invite
a remplacer un fichier des qu’il s’apercoit qu’un fichier existant a
été spécifié et n’attend pas que vous ayez terminé avec l’assistant.
Vous devez par conséquent activer cette option en premier lieu
pour pouvoir en tirer profit.

4. Entrez le nom et le chemin du fichier .jar dans lequel les composants doivent
étre exportés dans la zone InterChange server repository jar file path, cliquez
sur Browse pour sélectionner un fichier a remplacer ou bien accédez a un
répertoire et indiquez un nom de fichier.

i vous avez indiqué le nom et le chemin d’un fichier existant, que vous n’avez
S diqué 1 t le ch d’un fich tant, q ’

pas activé la case a cocher Overwrite existing file without warning et que
vous souhaitez remplacer le fichier existant, cliquez sur Yes a l'invite.

Remarque : Si vous entrez le nom et le chemin du fichier dans la zone, vous
devez inclure I'extension .jar afin d’activer le bouton Finish.

5. Cliquez sur Finish pour mettre fin a I'assistant.

Déploiement de composants sur un serveur

Comme indiqué a la section [«Cycle de vie d’une interface» a la page 3 vous
pouvez créer des composants d’intégration dans une bibliotheque de votre systeme
de fichiers local et les déployer dans une instance d’InterChange Server pour les
rendre exécutables. Lorsque les composants sont déployés sur le serveur, le module
Server Runtime est mis a jour de sorte qu'ils puissent étre utilisés immédiatement.

Vous pouvez utiliser l'interface graphique de System Manager ou l'interface de
ligne de commande repos_copy pour déployer un module de composants
d’intégration. Pour plus d’informations sur 'utilisation de System Manager, voir
[<Déploiement de composants a l'aide de l’assistant de déploiement» a la page 70}
Pour utiliser 'interface de ligne de commande repos_copy pour cette tache, vous
devez d’abord créer un fichier de module. Pour plus d’informations sur la création
d’un fichier de module, voir [«Exportation de composants vers un package a I'aidq
[de System Manager» a la page 61] Pour plus d’informations sur les avantages et les
inconvénients de chaque interface, voir [«Utilisation de System Manager ou d¢
frepos_copy pour le déploiement»|

Utilisation de System Manager ou de repos_copy pour le
déploiement

Le |tableau 5 a la page 64{ décrit les avantages et les inconvénients de 1'utilisation de
System Manager ou de repos_copy pour le déploiement. Comparez les deux
interfaces et utilisez celle qui correspond le mieux a vos besoins.
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Tableau 5. Avantages et inconvénients de System Manager et de repos_copy dans le

déploiement

Interface

Avantages

Inconvénients

System
Manager

* System Manager utilise une
interface graphique.

* Vous pouvez choisir les
composants du projet
utilisateur que vous souhaitez
déployer.

* Vous pouvez choisir de créer ou
non des schémas de relation
dans le référentiel du serveur
au cours du déploiement.

* Vous pouvez déployer plusieurs
projets utilisateur en méme
temps.

* Grace au déploiement utilisant
la fonction glisser-déplacer,
vous pouvez facilement
déployer des projets utilisateur,
des bibliotheques de
composants d’intégration, voire
méme des composants
individuels.

System Manager fonctionne
uniquement sous Windows.

repos_copy

* Il n’est pas obligatoire que les
composants soient regroupés
ensemble comme c’est le cas
dans un projet utilisateur lors
du déploiement via System
Manager.

* Repos_copy est indépendant de
la plate-forme.

Repos_copy utilise une interface de
ligne de commande.

Vous devez commencer par exporter
les composants que vous souhaitez
déployer dans un fichier du
package, a l'aide de System
Manager ou de repos_copy.

Vous ne pouvez pas déployer de
maniére sélective les composants
dans le fichier du package.

Vous pouvez uniquement déployer
un seul fichier du package a la fois.

Configuration de I’état initial des composants pour le

déploiement

Pour les composants associés a un état (tels que les connecteurs, les objets de
collaboration, les mappes, les relations et les pools de connexion a une base de
données), vous pouvez définir 1’état affecté au composant lors du redémarrage du
serveur apres le déploiement. Procédez comme suit pour définir 1’état de
post-déploiement initial des composants :

1. Sélectionnez les raccourcis vers les composants dont vous souhaitez définir
I'état initial dans un projet utilisateur.

Vous pouvez utiliser les techniques de sélection standard de Windows pour
sélectionner plusieurs composants, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.

* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non

contigus.
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2. Cliquez avec le bouton droit de la souris sur la sélection effectuée au cours de
I'étape précédente, puis effectuez 1'une des opérations suivantes :

* Sélectionnez Start ou Start All pour initialiser les composants sélectionnés a
I'état “Running”.

* Sélectionnez Stop ou Stop All pour initialiser les composants sélectionnés a
I'état “Stopped”.

Configuration des propriétés de la phase de déploiement

Les propriétés de la phase de déploiement sont les propriétés d'un artefact
configurées pendant la phase de déploiement plutét que pendant la phase de
conception. System Manager vous permet de spécifier les propriétés de la phase de
déploiement spécifiques a un serveur.

Lorsqu’un artefact est déployé sur un serveur, System Manager applique les
propriétés de la phase de déploiement qui lui sont associées avant le déploiement.
Vous pouvez également copier les propriétés d'un artefact sur plusieurs serveurs.
Cela vous évite ainsi de devoir effectuer le suivi de toutes les propriétés des
différents composants pour chaque serveur. Vous pouvez identifier les propriétés
qui auront des valeurs différentes pour les différents serveurs et ajouter ces
propriétés dans le cadre de la configuration du déploiement. Vous pouvez ensuite
configurer les valeurs de ces propriétés en fonction du serveur.

Lors du déploiement de 1’objet sur le serveur, System Manager applique
automatiquement les valeurs configurées pour chaque serveur concerné avant le
déploiement. Pour configurer les propriétés de la phase de déploiement, cliquez
avec le bouton droit de la souris sur le projet ICL, puis sélectionnez Edit
deployment descriptor. La [figure 17 a la page 66 s’affiche.
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Figure 17. Fenétre Deployment Configuration

La fenétre Deployment Configuration vous permet de procéder aux opérations
suivantes :

1. Ajout d’un serveur : pour ajouter un serveur, cliquez sur Add server. Une boite
de dialogue dans laquelle vous devez indiquer le nom du serveur cible
s’affiche. Cliquez sur OK.

Remarque : Si un composant et une propriété ont déja été configurés dans la
boite de dialogue de configuration, ces valeurs seront applicables a
tous les serveurs ajoutés a la configuration.

2. Suppression d'un serveur : pour supprimer un serveur, sélectionnez-le dans le
menu déroulant et cliquez sur Delete server.
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3. Configuration des propriétés : La liste de sélection des propriétés vous permet
de procéder aux opérations suivantes :

* Ajout de composants : pour ajouter des composants a la liste Deployment
Configuration, cliquez avec le bouton droit de la souris sur une cellule vide,
puis sélectionnez les composants a ajouter dans la boite de dialogue
Components Selection.

* Modification des propriétés : pour modifier les propriétés, cliquez deux fois
sur la cellule de la propriété a modifier, puis entrez le parametre approprié
dans la colonne Value.

* Ajout de propriétés : pour ajouter une propriété, cliquez avec le bouton droit
de la souris sur le composant auquel vous souhaitez ajouter une propriété
puis sélectionnez Add property dans le menu contextuel qui s’affiche.
Sélectionnez les propriétés a ajouter dans la liste affichée dans la boite de
dialogue Properties selection, puis cliquez sur OK.

* Suppression de propriétés : pour supprimer une propriété de déploiement
individuelle sur un serveur spécifique, sélectionnez le serveur, cliquez avec le
bouton droit de la souris sur la propriété a supprimer, puis sélectionnez
Delete dans le menu contextuel.

Remarque : La suppression d’une propriété d’une configuration de serveur
n’entraine pas sa suppression des autres configurations de
serveur.

Copie de propriétés entre serveurs

La gestion de la configuration présente 1’avantage de pouvoir copier les propriétés
entre les serveurs. Pour copier les propriétés, cliquez avec le bouton droit de la
souris sur la propriété, puis sélectionnez Copy dans le menu contextuel. Pour
coller les propriétés, cliquez avec le bouton droit de la souris sur un composant,
puis sélectionnez Paste. Plusieurs propriétés peuvent étre copiées depuis un
serveur et collées sur un autre. Une fois les propriétés copiées, les valeurs qui leurs
sont associées sont également copiées.

Remarque : Si les propriétés en cours de collage sont déja présentes dans la
configuration du serveur, cette opération entrainera le remplacement
des valeurs existantes.

Importation et exportation des propriétés de la phase de
déploiement

La configuration du déploiement peut étre importée ou exportée depuis et vers un
fichier a partir de la boite de dialogue Deployment Configuration. Pour exporter
des propriétés, il suffit de cliquer avec le bouton droit de la souris sur la propriété
concernée et de sélectionner Export dans le menu. La boite de dialogue Export
Property Descriptor dans laquelle vous devez choisir entre 1'option Selected
properties ou All properties s’affiche. Entrez le nom du fichier dans lequel vous
souhaitez exporter les propriétés ou sélectionnez Browse pour rechercher le fichier.
Cliquez sur OK.

Pour importer des propriétés, cliquez avec le bouton droit de la souris sur la
propriété concernée, puis sélectionnez Import dans le menu contextuel. La boite de
dialogue Import Properties s’affiche. Vous pouvez choisir d’écraser les propriétés
existantes ou de les fusionner. Dans la zone Please select Property Descriptor file,
entrez le nom du fichier ou sélectionnez Browse. Cliquez sur OK.
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Configuration des propriétés de déploiement a I'aide de

repos_copy

Lorsque vous créez un fichier repos_copy en dehors de System Manager, les
propriétés de la phase de déploiement lui sont automatiquement affectées. Ces
propriétés sont appliquées aux artefacts avant d’étre envoyées au serveur. Pour
plus d’informations sur l'utilisation de repos_copy et sur les options de ligne de

commande, voir [Chapitre 6, «Utilisation de repos_copy», a la page 131]

Validation d’un package a I'aide de System Manager

Pour vous assurer de la réussite du déploiement, vous pouvez au préalable valider
un package contenant les composants que vous souhaitez déployer. Procédez
comme suit pour valider un package de composants :

1. Ajoutez des raccourcis vers les composants que vous souhaitez valider aux

projets utilisateur.

Pour plus d’informations sur la création d’un projet utilisateur, voir [«Création|

[de projets utilisateur» a la page 42| et

pour plus d’informations sur 1’ajout de

raccourcis a un projet utilisateur, voir
[utilisateur» a la page 44|

«Ajout de raccourcis & un projet|

Remarque : Dans la mesure o1 vous pouvez valider plusieurs projets
utilisateur en méme temps, ajoutez des raccourcis pour tous les
composants souhaités dans les projets utilisateur appropriés.

2. Dans la vue WebSphere Business Integration System Manager, sélectionnez les

projets utilisateur que vous souhaitez

valider, cliquez avec le bouton droit de la

souris sur 1'un des projets sélectionnés, puis choisissez Validate user project

dans le menu contextuel.

System Manager affiche 1’assistant “Validate Project(s)”, comme indiqué dans la

[figure 18 a la page 69)
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< Back Mext > H Einish I Cancel

Figure 18. Sélection de composants pour validation

3. Sélectionnez le serveur a partir duquel vous souhaitez valider les composants
dans le menu déroulant Please select the server to validate with.

4. Utilisez les techniques suivantes pour sélectionner les composants que vous
souhaitez valider :

* Activez la case a cocher en regard de la bibliothéque de composants
d’intégration ou du projet utilisateur afin de sélectionner tous les composants
contenus dans cette bibliothéque ou ce projet.

* Activez la case a cocher en regard d’un groupe de composants afin de
sélectionner tous les composants contenus dans ce dernier.

* Développez un groupe de composants, puis cochez les cases en regard des
composants individuels afin de sélectionner ces derniers.

Remarque : Si vous sélectionnez des composants du méme nom dans plusieurs
projets utilisateur, vous devez en sélectionner un seul parmi les
composants en double dans I’écran suivant de 1’assistant.

Si vous n’avez sélectionné aucun composant en double, passez a 1'étape
page 70
Si vous avez sélectionné des composants en double, passez a 'étape

5. Cliquez sur Next.

System Manager affiche 1’écran “Local Duplicates”, comme indiqué dans la
[figure 19 a la page 70|
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Figure 19. Sélection de composants distincts dans des projets utilisateur pour validation

Sélectionnez des composants distincts parmi les composants en double.
6. Cliquez sur Finish.

System Manager crée un package contenant les composants sélectionnés et le
valide en fonction du référentiel du serveur. Un message indique alors si la
validation a échoué ou abouti.

Déploiement de composants a I'aide de System Manager

Vous pouvez déployer des composants dans une instance d’InterChange Server de
deux manieres présentées dans les sections suivantes :

* [«<Déploiement de composants a 'aide de l’assistant de déploiement»]

+ |[«Déploiement de composants a I'aide de la fonction glisser-déplacer» a la pagel
73

Déploiement de composants a I'aide de I'assistant de
déploiement

Procédez comme suit pour utiliser 'assistant de déploiement afin de déployer un
package de composants dans une instance d’InterChange Server :

1. Sil'un des composants a déployer existe déja dans le référentiel du serveur,
vous devez d’abord (sauf s’il s’agit d’'une mappe) l'arréter avant de le
déployer.

Utilisez la vue InterChange Server Component Management ou System
Monitor pour arréter les composants en double dans le serveur avant le
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déploiement d’un package. Pour plus d’informations, voir [«Gestion de 1’étaf
[des composants dans le référentiel» a la page 78

Il est recommandé de définir I'état initial des composants que vous déployez.
Pour plus d’informations, voir [«Configuration de I’état initial des composantg
[pour le déploiement» a la page 64|

Ajoutez des raccourcis vers les composants que vous souhaitez déployer a un
projet utilisateur.

Pour plus d’informations sur la création d’un projet utilisateur, Voir
[de projets utilisateur» a la page 42| et pour plus d’informations sur I'ajout de
raccourcis a un projet utilisateur, voir [<Ajout de raccourcis a un projetl
[utilisateur» a la page 44|

Remarque : Dans la mesure ou vous pouvez déployer plusieurs projets
utilisateur en méme temps, ajoutez des raccourcis pour tous les
composants souhaités aux projets utilisateur appropriés.

Dans la vue “WebSphere Business Integration System Manager”, sélectionnez
chaque projet utilisateur que vous souhaitez déployer dans une instance du
serveur. Vous pouvez utiliser les techniques de sélection standard de Windows
pour sélectionner plusieurs projets utilisateur en méme temps pour le
déploiement, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.

* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

Cliquez avec le bouton droit de la souris sur un projet utilisateur sélectionné,
puis sélectionnez Deploy user project dans le menu contextuel.

System Manager affiche 1’écran “Deploy wizard page 17, comme indiqué dans
la [figure 20 a la page 72
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Figure 20. Sélection de composants pouvant étre déployés et d’options de déploiement

6. Dans I’écran “Deployable Components”, procédez comme suit :

a. Sélectionnez l'instance du serveur dans laquelle vous souhaitez déployer
les composants dans le menu déroulant Please select the destination
server.

b. Utilisez les techniques suivantes pour sélectionner les composants a
déployer :
* Activez la case a cocher en regard d’un projet utilisateur afin de
déployer tous les composants contenus dans ce dernier.

* Développez le noeud du projet utilisateur et activez la case a cocher en
regard de 1’ensemble des groupes de composants pour déployer tous les
composants de ce type.

* Développez le noeud du projet utilisateur et celui d’un groupe de
composants, puis activez la case a cocher en regard de chaque
composant pour déployer uniquement les composants concernés.

Remarque : Si vous sélectionnez des composants du méme nom dans
différents projets utilisateur, vous devrez choisir dans I'écran
suivant de l'assistant le composant a déployer parmi les
composants en double.
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C. Activez la case a cocher Create schema si vous souhaitez créer les schémas
des pools de connexion a une base de données et des relations au cours du
processus de déploiement.

Les schémas des relations et des pools de connexion a une base de
données doivent étre créés pour les interfaces qui y font référence pour
fonctionner. Si vous déployez une interface dans le but de I'exécuter, vous
devez alors activer cette option pour tous les composants utilisés par cette
interface.

Remarque : Vous devez uniquement activer cette option si les parametres
des pools de connexion a une base de données et des relations
font référence aux informations de connexion appropriées du
serveur sur lequel vous déployez les composants. Si vous
migrez des composants depuis un environnement dans lequel
les parametres de base de données sont corrects vers un autre
environnement dans lequel ces mémes parametres ne seront
plus valides, vous pouvez ne pas souhaiter créer les schémas
associés a ces composants au cours du déploiement.

d. Activez la case a cocher Perform compilation on InterChange Server
machine si vous souhaitez compiler le composant dans InterChange
Server.

e. Activez la case a cocher Ignore compile warnings si vous ne souhaitez pas
recevoir les avertissements générés au cours de la compilation, concernant
par exemple une méthodologie déconseillée.

f. Activez la case a cocher Skip validation during deployment si 1'objet que
vous déployez a déja été validé. En regle générale, vous ne devez pas
cocher cette case : vous valideriez des objets que vous étes en train de
déployer.

g. Effectuez 1'une des opérations suivantes en fonction des choix effectués :

* Si vous avez sélectionné des composants en double dans les différents
projets utilisateur sélectionnés mais que vous n’avez pas sélectionné de
composant existant déja dans le référentiel du serveur, vous pouvez
commencer le déploiement des a présent. Pour ce faire, passez a 1'étape
9 a la page 75

* Si vous avez sélectionné des composants en double dans les différents
projets utilisateur sélectionnés mais que vous avez sélectionné des
composants existant déja dans le référentiel du serveur, I'écran “Server
Duplicate Objects” s’affiche. Pour poursuivre, passez a I'étape
pag 4

* Si vous avez sélectionné des composants en double dans les projets
utilisateur, passez a 1'étape Iz

7. Cliquez sur Next.

Si vous avez sélectionné des composants en double dans les projets utilisateur,
I"écran “Deploy wizard page 2” s’affiche, comme indiqué dans la

page 71
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Figure 21. Sélection parmi les composants locaux en double lors du déploiement

Développez les dossiers des projets utilisateur affichés et activez les cases a
cocher des composants spécifiques que vous souhaitez déployer entre les
composants locaux en double.

Effectuez I'une des opérations suivantes en fonction des choix effectués :

* Si vous avez choisi de ne déployer aucun des composants qui existent déja
sur le serveur, vous pouvez démarrer le déploiement deés a présent. Pour ce
faire, passez a l’étape |9 a la page 75

* Si vous avez choisi de déployer les composants qui existent déja sur le
serveur, passez a 1'étape 8

8. Cliquez sur Next.

Si vous avez choisi de déployer les composants qui existent déja sur le
serveur, I'écran “Server Duplicate Objects” s’affiche comme indiqué dans la
figure 22 a la page 75
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Figure 22. Sélection des objets en double a remplacer sur le serveur

Développez les dossiers des projets utilisateur affichés et activez les cases a
cocher des composants en double a écraser dans le référentiel du serveur.

9. Cliquez sur Finish.

System Manager tente de déployer les composants sélectionnés dans le
référentiel du serveur. Si vous affichez le résultat de la connexion du serveur,
vous trouverez des messages consignés indiquant le démarrage de la session
de déploiement et I'ajout des composants dans le référentiel.

Une fois la session de déploiement terminée, System Manager affiche un
message d’information indiquant la fin du déploiement ou un message
d’erreur indiquant son échec.

10. Tenez compte de toute information significative spécifiée dans le message. Ce
dernier peut par exemple vous inviter a relancer le serveur pour activer
certains composants déployés ou vous indiquer que 1’échec du déploiement
est dli a une impossibilité de remplacer les composants actifs. Cliquez sur OK
et procédez aux opérations nécessaires indiquées dans le message.

Déploiement de composants a I'aide de la fonction
glisser-déplacer

Procédez comme suit pour déployer des composants a l'aide des techniques de
glisser-déplacer contenues dans les vues de System Manager :

1. Sil'un des composants que vous souhaitez déployer existe déja dans le
référentiel du serveur, vous devez d’abord l'arréter avant de le déployer.
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Utilisez la vue InterChange Server Component Management ou System
Monitor pour arréter les composants en double dans le serveur avant le
déploiement d’un package. Pour plus d’informations, voir [«Gestion de 1’état|
[des composants dans le référentiel» a la page 78|

2. Procédez comme suit dans la vue WebSphere Business Integration System
Manager pour sélectionner les composants a déployer :

* Sélectionnez les projets utilisateur ou les bibliothéques de composants
d’intégration pour choisir tous les composants qu’ils contiennent.

* Choisissez tous les composants d’un méme type en sélectionnant le dossier
concerné dans un projet utilisateur ou dans une bibliotheque de composants
d’intégration.

* Développez les dossiers de composants et sélectionnez des composants
individuels. Vous pouvez utiliser les techniques de sélection standard de
Windows pour sélectionner plusieurs projets utilisateur en méme temps pour
le déploiement, comme suit :

— Maintenez la touche Maj enfoncée pour sélectionner des éléments
contigus.

— Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

3. Effectuez un glisser-déplacer des ressources sélectionnées vers 1'instance
d’InterChange Server dans laquelle vous souhaitez déployer les composants de
la vue InterChange Server Component Management.

System Manager tente de déployer les composants dans 1'instance
d’InterChange Server spécifiée. Les messages et les erreurs s’affichent dans la
vue Console.

Remarque : Si vous avez sélectionné des composants en double dans la vue
WebSphere Business Integration System Manager, System Manager
génere une erreur lorsque vous tentez de les déployer. Affinez
votre sélection pour inclure uniquement des composants uniques
puis tentez a nouveau de les déployer.

Utilisation des composants dans un référentiel d’InterChange Server

La vue InterChange Server Component Management vous permet de gérer les
référentiels des instances d’InterChange Server enregistrées ainsi que les
composants contenus dans ces référentiels.

Validation des composants dans le référentiel

Comme indiqué dans la section [<Modes d’InterChange Server» a la page 34}
InterChange Server posséde différentes restrictions concernant l'intégrité du
référentiel en fonction du mode utilisé pour le démarrer. Bien qu'un serveur
s’exécutant en mode conception admette un référentiel incohérent pour que vous
puissiez ajouter des composants dés qu’ils sont disponibles, un serveur s’exécutant
en mode production requiert que toutes les références et les dépendances des
composants soient résolues. Lorsque vous effectuez une migration depuis un
serveur en mode conception vers un serveur en mode production, vous devez
valider le référentiel au préalable afin de vous assurer de la cohérence de son état.

Procédez comme suit pour valider un référentiel a 1'aide de System Manager :

1. Dans la vue InterChange Server Component Management, cliquez avec le
bouton droit de la souris sur l'instance du serveur dont vous souhaitez valider
le référentiel, puis sélectionnez Validate Repository dans le menu contextuel.
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2. Sil'état du référentiel est cohérent, un message d’information s’affiche.
Cliquez sur OK pour fermer le message “Validate Repository”.

S’il existe des dépendances non résolues dans le référentiel, la boite de dialogue
“Missing Dependencies” s’affiche, comme indiqué dans la Cliquez sur
Finish pour fermer la boite de dialogue “Missing Dependencies”.

Remarque : Vous devez résoudre les dépendances manquantes avant de
pouvoir démarrer le serveur en mode production. Pour plus
d’informations sur le mode production, voir [Mode production» 3|

Missing Dependencies . H

Validation Completed - Missing Dependencies #
Mizsing and Unresolved Ohjects B

~{z% BusinessObject Address<--This is the missing dependeny.
E 1w BusinessObject BuyerAttributes=---This component has missing dependencies
| -13% BusinessObjectAddress=—-This is the mizsing dependeny.
E =¥ BusinessObject Contact=—— This component has missing dependencies.
1@ BusinessObject Address=---Thig is the missing dependeny.
=15 BusinessObject: CustomerRole=—This componert has missing dependencies.
-1{=% BusinessObject Address=—Thig iz the missing dependeny.
== BusinessObjectinstalledProduct=—-This component has missing dependencies,
e BusinessObject Address=---This is the missing dependeny.
21 BusinessObjectinvaice=—--This component has missing dependencies.
~1a BusinessOhiect: Address=---Thig is the missing dependeny,
e BusinezsObject CustomerRole=---Thiz component has missing dependencies.
£ 1= BusinezsObject nvoiceLinetem=---This componert has missing dependencies.
E =% BusinessObjectinvoicelinetem=---Thiz compaonent has missing dependencies.
: & BusinessOhject: CustomerRale=---This component has missing dependencies.
E =% BusinessObjectLinebem=--_This component has mizsing dependencies .
o ﬁ Business0bject: CustomerRole=---Thiz component has missing dependencies.
E ﬁ BusinessObject: Order<---This component has missing dependencies.
! ﬁ BusinessOhject OrcerLineftems---This component has missing dependencies,

| »

o ﬁ BusinessObject Address<---Thiz iz the mizsing dependeny.
£ I; BuzinezzOhject: CustomerRole=---This companent has missing dependencies.
E @ BusinessObject: CrderLinefem=---This component has missing dependencies.
ﬁ BusinessObject CustomerRole=---This component has mizsing dependencies

E JaF BusinessObject: Supplier Attributes=---Thiz component has missing dependencies.
. -T2 BusinessObiect Address=---This is the missing denendeny. ﬂ

Cancel

Figure 23. Dépendances non résolues dans le référentiel

Validation des pools de connexion a une base de données

Pour valider un pool de connexion a une base de données, cliquez avec le bouton
droit de la souris dans la vue InterChange Server Component Management, puis
sélectionnez Validate database connection dans le menu contextuel.

Pour plus d’informations sur les pools de connexion a une base de données, voir
Chapitre 8, «Configuration des pools de connexion a une base de données», a la|

page 191l
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Gestion de I’état des composants dans le référentiel

Vous pouvez utiliser la vue InterChange Server Component Management pour
gérer 'état des composants dans le référentiel d’une instance d’InterChange Server.

Cela peut étre particulierement utile lorsque vous développez une interface dans la
mesure ol vous devez tester les composants que vous développez. Il est assez
fréquent que les composants testés doivent étre modifiés. Une fois modifiés, vous
devrez déployer les composants sur le serveur et les tester a nouveau. Toutefois,
pour déployer des composants sur le serveur, ils doivent étre inactifs : vous devez
par conséquent arréter les composants avant leur déploiement. Dans la mesure ol
vous pouvez développer, déployer et tester une interface dans l'atelier, il est tres
utile de pouvoir également gérer I'état des composants a partir de ce méme
emplacement.

Pour modifier I’état d'un composant dans la vue InterChange Server Component
Management, cliquez avec le bouton droit de la souris sur le composant dans
I'arborescence de navigation, puis sélectionnez 1'état souhaité dans le menu
contextuel. Le [tableau 6 a la page 79|indique les états pouvant étre appliqués a
chaque type de composant doté de plusieurs états d’exécution. Pour plus
d’informations sur le comportement du systéeme lorsque les composants ont un état
différent, voir le document System Administration Guide.
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Tableau 6. Etats disponibles pour les composants dans System Manager

Type de composant Etat

Objet de collaboration o Start

* Stop
e Pause
¢ Shut Down

Connecteur e Start

* Stop

* Pause

e Shut Down
* Boot

Mappe e Start
* Stop

Relation e Start

* Stop

Vous pouvez également sélectionner plusieurs composants, cliquer avec le bouton
droit de la souris sur 1'un des composants et appliquer des modifications d’état a
tous les composants a la fois. Cette opération peut étre particulierement utile
lorsque vous devez déployer un certain nombre de composants a la fois car cela
vous évite de devoir réaliser une opération de gestion des états distincte pour
chaque composant. Vous pouvez utiliser les techniques de sélection standard de
Windows pour sélectionner plusieurs projets utilisateur en méme temps pour le
déploiement, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.
* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non contigus.

Remarque : Si aucun état n’a été sélectionné pour certains composants lorsque
vous tentez de réaliser une opération de gestion des états sur un
groupe de composants sélectionnés, les options de gestion des états ne
sont pas affichées dans le menu contextuel. Par exemple, si vous
souhaitez arréter plusieurs connecteurs mais que vous avez par
mégarde sélectionné également une définition d’objet métier, les
opérations de gestion des états ne sont alors pas affichées dans le
menu contextuel.

Pour modifier I'état de tous les composants d'un type spécifique, cliquez avec le
bouton droit de la souris sur le dossier associé au type de composant concerné
dans la vue InterChange Server Component Management, puis sélectionnez Start
All ou Stop All dans le menu contextuel.

Il est recommandé d’utiliser System Monitor pour gérer les composants contenus
dans une installation de production. System Monitor offre une souplesse

importante et constitue un outil d’administration dédié. Pour plus d’informations
sur l'utilisation de System Monitor, voir le document System Administration Guide.
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Modification des propriétés d’'un composant dans le
référentiel

Les mappes, connecteurs et objets de collaboration ont des propriétés d’exécution
que vous pouvez modifier pour changer le comportement de ces composants.
Suivez les instructions des sections suivantes pour modifier les propriétés de
composants spécifiques :

+ |«Modification des propriétés d’un objet de collaboration»|

* |«Modification des propriétés d'une mappe» a la page 81

+ [«Modification des propriétés d'un connecteur» a la page 81|

Modification des propriétés d’un objet de collaboration

Procédez comme suit pour modifier les propriétés d'un objet de collaboration :

1. Cliquez avec le bouton droit de la souris sur l'objet de collaboration dont vous
souhaitez modifier les propriétés dans la vue InterChange Server Component
Management, puis sélectionnez Properties dans le menu contextuel.

2. Affectez aux propriétés contenues dans les onglets “Collaboration General
Properties” et “Properties” les valeurs souhaitées.

Pour plus d’informations sur les propriétés d’un objet de collaboration, voir
[Chapitre 9, «Configuration des objets de collaboration», & la page 203

La présente la boite de dialogue “Properties” des objets de
collaboration :

cﬁ: Properties . k ,EI

i Collaboration General Properties | Properties |

Create from template; |'Il.':'-tomer Sync

Effective transaction level |Mune ll Minimum transaction level Haone
System Trace Level IE - And detailed message n:olj Collaboration trace level IO vI

Email notification address

™ Pause when critical error occur Maximum number of concurrent events |1 "'I

™ Persist Service Call in Transit State Recovery Mode I.C\Iways 'I
[V Implcic Database Transaction Max Event Capacity | 2147483647

Iv Blocking Type

OK I Cancel

Figure 24. Modification des propriétés d’un objet de collaboration

3. Cliquez sur OK.
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Modification des propriétés d’'une mappe
Procédez comme suit pour modifier les propriétés d'une mappe :

1.

o ops Propery age x

Cliquez avec le bouton droit de la souris sur la mappe dont vous souhaitez
modifier les propriétés dans la vue InterChange Server Component
Management, puis sélectionnez Properties dans le menu contextuel.

Affectez aux propriétés contenues dans la boite de dialogue “Maps Property
Page” les valeurs souhaitées.

Pour plus d’informations sur les propriétés d’une mappe, voir le document
Map Development Guide.

La présente la boite de dialogue “Maps Property Page” :

Trace Level

Data Validation level ID "I [V Implicit Database Transaction
Map instance pool size | 100 ~| I Map instance reuse

Source Destination

I\faesar;u::h::"uer II:u;:trJn'\Er

| OK I Cancel

Figure 25. Modification des propriétés d’'une mappe

3. Cliquez sur OK.

Modification des propriétés d’un connecteur
Procédez comme suit pour modifier les propriétés d’un connecteur :

1.

Cliquez avec le bouton droit de la souris sur le connecteur dont vous souhaitez
modifier les propriétés dans la vue InterChange Server Component
Management, puis sélectionnez Properties dans le menu contextuel.

Affectez aux propriétés contenues dans les onglets “Connector Standard
Properties”, “Associated Maps” et “Resources” les valeurs souhaitées. Pour
plus d’informations sur les propriétés d’un connecteur, Voir
[«Configuration des connecteurs», a la page 145,

La [figure 26 a la page 82| présente la boite de dialogue “Properties” des
connecteurs :
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# Properties . - g ,EI

{ Connector Standard Froperties | Associated Maps | Resources ]

| Property name | value
0 AgentTracelevel 5
1 ControllerTraceLevel 5
2 PollFrequency 10001
3 ControllerStoreAndForwardMode true
4 RestartRetryCount 3
S RestartRetryInterval 1
6 OADAutoRestartAgent False
Fi OADMaxMurmRetry 1000
3 OADRetryTimeInterval 10
9 MaxEventCapacity 2147453647

OK I Cancel

Figure 26. Modification des propriétés d’un connecteur

3. Cliquez sur OK.

Compilation de composants dans le référentiel

Les modeéles de collaboration doivent étre compilés pour permettre aux objets de
collaboration qui en dépendent de fonctionner et les mappes doivent également
étre compilées pour s’exécuter. Vous pouvez déployer des modeles de collaboration
et des mappes dans une instance d’InterChange Server fonctionnant en mode
conception sans qu'il soit nécessaire de les compiler mais vous devez veiller a ce
qu’ils le soient pour les tester.

Pour compiler un modeéle de collaboration sur le serveur, cliquez avec le bouton
droit de la souris sur le modele concerné dans la vue InterChange Server
Component Management, puis sélectionnez Compile dans le menu contextuel.

Pour compiler tous les modeles de collaboration sur le serveur, cliquez avec le
bouton droit de la souris sur le dossier Collaboration Templates dans la vue
InterChange Server Component Management, puis sélectionnez Compile All dans
le menu contextuel.

Pour compiler une mappe sur le serveur, cliquez avec le bouton droit de la souris
sur la mappe concernée dans la vue InterChange Server Component Management,
puis sélectionnez Compile dans le menu contextuel.

Pour compiler toutes les mappes sur le serveur, cliquez avec le bouton droit de la

souris sur le dossier Maps dans la vue InterChange Server Component
Management, puis sélectionnez Compile All dans le menu contextuel.
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Pour compiler une mappe ainsi que ses sous-mappes, cliquez avec le bouton droit
de la souris sur la mappe concernée dans la vue InterChange Server Component
Management, puis sélectionnez Compile with submaps dans le menu contextuel.

La vue “Console” affiche les messages concernant 1’échec ou l'aboutissement des
tentatives de compilation.

Suppression de composants dans le référentiel

Lorsque vous développez un systeme d’intégration métier, la conception du
systéme change régulierement. De nouvelles spécifications et différences
environnementales impliquent généralement la reconception d’une interface. Vous
souhaiterez vous assurer que le référentiel contient uniquement les composants
dont il a besoin pour résoudre les incidents en fonction de la conception courante,
ce qui signifie que vous devrez parfois supprimer des composants appartenant a
des conceptions antérieures.

Suppression de I'intégralité du référentiel
Pour supprimer tous les composants contenus dans un référentiel du serveur a
l'aide de System Manager, procédez comme suit :

1. Dans la vue InterChange Server Component Management, cliquez avec le
bouton droit de la souris sur l'instance du serveur dont vous souhaitez
supprimer le référentiel, puis sélectionnez Delete Repository dans le menu
contextuel.

2. AVYinvite “Delete repository confirmation”, cliquez sur OK.

3. AVlinvite “Delete repository confirmation” suivante, cliquez sur OK.

Suppression de composants a I’aide du navigateur de
composants

Procédez comme suit pour supprimer des composants dans un référentiel
d’InterChange Server a 'aide du navigateur de composants :

1. Dans la vue InterChange Server Component Management, sélectionnez les
composants a supprimer dans le navigateur.

Vous pouvez utiliser les techniques standard de Windows pour sélectionner
plusieurs éléments en méme temps, par exemple en maintenant la touche Maj
enfoncée pour sélectionner plusieurs éléments contigus ou en maintenant la
touche Ctrl enfoncée pour sélectionner plusieurs éléments non contigus.

2. Pour supprimer un composant, vous devez tout d’abord vérifier qu’il est
inactif. Avant d’essayer de supprimer des composants, vous devez étre siir
qu’ils sont inactifs avant de les arréter.

Pour arréter un composant a 'aide de la vue InterChange Server Component
Management dans System Manager, voir [«Gestion de 1’état des composants|
[dans le référentiel» a la page 78

Pour arréter un composant a 'aide de System Monitor, voir le document Systermn
Administration Guide.

3. Effectuez I'une des opérations suivantes pour supprimer les composants
sélectionnés :

* Appuyez sur Delete.

* Cliquez avec le bouton droit de la souris sur 1'un des composants
sélectionnés, puis sélectionnez Delete dans le menu contextuel.

e Sélectionnez Edit > Delete dans la barre de menus.
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La présente System Manager lorsque le navigateur de composants est
utilisé pour supprimer des composants.

dp InterChange v x ] Conscle

= L@ InterChange Server Instances T TARGTraT i on Tammiale (ST omerParinararantar 19

(-1 WebSpherelC5421DEVServer @ warning! B
:f: :Z E‘;”:E::m ;irj“fc'::“ Are you sure you wark to delete the selected object(s) with the following options?
@y CustomerSync_ClarfyToCassar::CustomarSync [v Delete selected components even if other components are dependent on them.
(i CustomerSync_Clarify ToSAP: :CustomerSync [¥ Delete components that depend on the selected components also.i
{y OrderStatusQuery_webToCassar::OrderStatusQuery
% ;::m:;%mﬁzhﬂm#n;it “Pure E Cancel |

I“ RequisitionSplitter_PortToCaesar: :RequisitionSplitter
B} [ Connectors
Bl (= Business Objects
#- (= Maps

1 (= Relationshios =
4| | »

InterChange Servers | InterChange Server Component Management | [ Console ELou Qutput

B |

ollaberation Template ContactWrapper is compiled
larify_PartRequest_to_CwOrder compiled successfu
larify_PartRequest_to_CwoOrder compiled successtu

Figure 27. Suppression de composants a l'aide du navigateur de composants

4. Procédez comme suit lorsque la boite de dialogue s’affiche :

* Activez la case a cocher Delete selected components even if other
components are dependent on them pour supprimer le composant méme si
d’autres composants l'utilisent comme référence.

Par exemple, un objet métier ne peut pas étre supprimé s’il contient d’autres
objets métier car ils en dépendent, méme si ces composants dépendants sont
également sélectionnés pour étre supprimés, a moins que cette option ne soit
activée.

* Activez la case a cocher Delete components that depend on the selected
components also pour supprimer également les dépendances des
composants sélectionnés. Pour plus d’informations sur les dépendances, voir
[<Dépendances et références» a la page 86,

Cliquez sur Finish.
Si I'opération de suppression aboutit, I’assistant se ferme.

Si l'opération de suppression échoue, cliquez sur OK pour fermer le message
d’erreur, résolvez l'incident et renouvelez 1'opération. Les informations
contenues dans le message d’erreur peuvent étre tres difficiles a interpréter
pour l'identification et la résolution des incidents. Il est par conséquent
recommandé d’utiliser le résultat de la connexion du serveur pour déterminer
la cause de l'incident.

Suppression de composants a I'aide de I'assistant Server Object
Delete
Procédez comme suit pour utiliser System Manager afin de supprimer des

composants dans un référentiel d’InterChange Server a 'aide de l'assistant Server
Object Delete :

1.

Dans la vue InterChange Server Component Management, cliquez avec le
bouton droit de la souris sur l'instance du serveur dont vous souhaitez
supprimer les composants du référentiel, puis sélectionnez Server object delete
dans le menu contextuel.

Pour supprimer un composant, vous devez tout d’abord vérifier qu’il est
inactif. Avant d’essayer de supprimer des composants, vous devez étre siir
qu’ils sont inactifs avant de les arréter.

Pour arréter un composant a 'aide de la vue InterChange Server Component
Management dans System Manager, voir [«Gestion de I'état des composants]
[dans le référentiel» a la page 78
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Pour arréter un composant a ’aide de System Monitor, voir le document System
Administration Guide.

3. Procédez comme suit pour sélectionner les composants a supprimer :

* Activez la case a cocher de l'instance du serveur pour supprimer tous les
composants dans le référentiel.

* Développez le dossier de 'instance du serveur et activez la case a cocher
associée a un type de composant pour supprimer tous les objets de ce type.

* Sélectionnez le dossier d'un type de composant pour compléter le panneau
de droite par une liste de composants de ce type contenus dans le référentiel,
puis activez la case a cocher des composants individuels.

4. Activez la case a cocher Force remove even if other objects depend on this
object pour supprimer le composant méme si d’autres composants 'utilisent
comme référence.

Par exemple, un objet métier ne peut pas étre supprimé s’il contient d’autres
objets métier car ils en dépendent, méme si ces composants dépendants sont
également sélectionnés pour étre supprimés, a moins que cette option ne soit
activée.

5. Activez la case a cocher Delete dependent objects also pour supprimer
également les dépendances des composants sélectionnés. Pour plus
d’informations sur les dépendances, voir [«<Dépendances et références» a la page]

=
La présente la fenétre “Server Objects Delete Wizard”.

Server Objects Delete Wizard |

Server Objects Delete Wizard s &
)
Selected objects will be deleted from the server, ﬁ
=-[E11a# WebSpherelC5420DEVServer ] & contractiine ;!
~[& Benchmark. O & controller
-[E] = Business Chjects [0 & controllerchild |
O Collaboration Ghiects O& cost
Eg Ecllabo:;tlon Templates O & CreditareaCreditData
cnnsckors ) [0 & creditCardpata
G Database Connection Paols
16 Maps & Customer
- Relationships 0 & customert
Dl:f_\:} Schedules D é CustomerAccount
[0 & customeraccountingData 5
1] | =

¥ Force remaove even if other objecks depends on this abject.
¥ Delete dependent objects also

Cancel

Figure 28. Suppression d’objets du serveur

6. Cliquez sur Finish.
Si I'opération de suppression aboutit, I’assistant se ferme.

Si I'opération de suppression échoue, cliquez sur OK pour fermer le message
d’erreur, résolvez l'incident et renouvelez 1'opération. Les informations
contenues dans le message d’erreur peuvent étre tres difficiles a interpréter
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pour l'identification et la résolution des incidents. Il est par conséquent
recommandé d’utiliser le résultat de la connexion du serveur pour déterminer
la cause de l'incident.

Dépendances et références

Les composants d’intégration dépendent les uns des autres pour accomplir leurs
taches dans le systétme d’intégration métier. Par exemple, les définitions d’objets
métier peuvent contenir d’autres définitions d’objets métier en tant qu’enfant, les
modeles de collaboration ont des définitions d’objets métier associées a leurs ports
et les connecteurs ont des mappes associées a leurs objets métier pris en charge.
Ces dépendances doivent étre satisfaites pour que le systeme puisse fonctionner
correctement et lorsqu’InterChange Server est lancé en mode production, il vérifie
que toutes les dépendances et références sont résolues. S’il détecte des
dépendances ou des références non résolues, le démarrage d’InterChange Server en
mode production échoue.

Les termes dépendances et références sont utilisés pour décrire la relation entre les
composants, selon le contexte. Par exemple, la définition d"un connecteur nécessite
la présence de définitions d’objets métier prises en charge et de mappes associées a
ces définitions d’objets métier de sorte qu'il puisse échanger des données avec
InterChange Server. Dans ce contexte, les définitions d’objets métier et les mappes
constituent les dépendances de la définition du connecteur. Si vous affichez la
méme relation entre la définition de 1'objet métier et la définition du connecteur,
mais dans le contexte de I'objet métier, le connecteur constitue 1'une des références
de la définition de 1'objet métier, comme c’est le cas également des autres objets
métier qui le contiennent en tant qu’enfant, des mappes qui le transforment, des
modeéles de collaboration qui le prennent en charge pour leurs définitions de port
et ainsi de suite.

Le indique les composants pouvant constituer une dépendance et une
référence pour chaque type de composant.

Tableau 7. Dépendances et références des composants d’intégration

Composant Dépendances Références
Objets métier * Objets métier * Objets métier
* Mappes

* Connecteurs
* Modeles de collaboration

* Objets de collaboration

Relations * Objets métier Aucun
Connecteurs + Objets métier + Objets de collaboration
* Mappes
Mappes * Objets métier * Connecteurs
* Mappes * Objets de collaboration
Modeles de collaboration |, Objets métier Aucun

86  IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



Tableau 7. Dépendances et références des composants d’intégration (suite)

Composant Dépendances Références
Objets de collaboration * Objets métier *+ Objets de collaboration
* Mappes

e Connecteurs

* Modeles de collaboration

* Objets de collaboration

Affichage des dépendances et des références

Vous pouvez utiliser System Manager pour afficher les dépendances et les
références d’un composant d’intégration.

Pour afficher les dépendances d"un composant, cliquez dessus avec le bouton droit
de la souris dans System Manager, puis sélectionnez Show Dependencies dans le
menu contextuel. L’assistant “Dependency Tree” s’affiche. Pour plus
d’informations, voir [«Utilisation de 'assistant Dependency Tree» a la page 44

Pour afficher les références d’un composant, cliquez dessus avec le bouton droit de
la souris dans System Manager, puis sélectionnez Show References dans le menu
contextuel. La fenétre “Object References” s’affiche.

Dépendances ne pouvant pas étre détectées par le systeme

Certaines relations de dépendance et de référence ne peuvent pas étre
automatiquement détectées et imposées par le systeme. Le décrit les
composants pour lesquels le systeme n’est pas en mesure de déterminer les
dépendances et les références.

Bien que le systeme soit incapable de détecter ces dépendances et références, elles
doivent tout de méme étre satisfaites pour permettre au systeme de fonctionner
correctement. Vous devez conserver une documentation de projet précise afin de
vous assurer que, lorsque vous déployez une interface d’un environnement a un
autre, vous incluez ces dépendances supplémentaires.

Tableau 8. Composants pour lesquels le systéme ne peut pas déterminer les dépendances
et les références

Composant Explication

Relations Les mappes et les modéles de collaboration peuvent utiliser des
relations, mais pour ce faire, ils utilisent des API en code Java.
Le systeme n’est pas en mesure d’analyser 1'ensemble du code
dans toutes les mappes et tous les modeles de collaboration
pour détecter "utilisation de relations.

Pools de connexion a Les mappes et les modeles de collaboration peuvent utiliser des
une base de données pools de connexion a une base de données, mais pour ce faire,
ils utilisent des API en code Java. Le systeme n’est pas en
mesure d’analyser 1’'ensemble du code dans toutes les mappes et
tous les modeles de collaboration pour détecter l'utilisation de
pools de connexion a une base de données.

Gestionnaires de Les connecteurs, ainsi que d’autres composants, peuvent utiliser
données des gestionnaires de données pour formater des données. Les
gestionnaires de données n’étant pas du tout gérés par le
systeme, ce dernier ne peut pas les détecter.
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Tableau 8. Composants pour lesquels le systeme ne peut pas déterminer les dépendances
et les références (suite)

Composant Explication

Tout composant utilisé | Bien que le systéme puisse déterminer qu’'une mappe dépend
exclusivement dans du | d’un objet métier apres que vous ayez effectué un

code glisser-déplacer de la définition de 'objet métier dans la mappe
en tant que source ou cible, il ne peut pas détecter 1'utilisation
de composants intervenant exclusivement par l'intermédiaire de
code Java personnalisé. Si vous instanciez un nouvel objet
métier ou que vous appelez manuellement une mappe dans une
autre mappe ou une collaboration, le systeme est incapable de
détecter cette dépendance.

Bancs d’essai Le systeme ne prend généralement pas en charge la détection
des dépendances et des références associées aux bancs d’essai.

Plannings Le systeme ne prend généralement pas en charge la détection
des dépendances et des références associées aux plannings.

Opérations standard disponibles pour plusieurs ressources d’atelier

Bien que nombre des taches réalisées dans 1’atelier soient spécifiques a la ressource
que vous utilisez, de nombreuses opérations affectent toutes les ressources de la
méme maniére. Cette section décrit les tiches que vous pouvez réaliser dans
l'atelier et qui fonctionnent de maniere identique pour toutes les ressources.

Ajout de projets a I’espace de travail a partir du contréle de
code source

Vous pouvez ajouter des bibliotheques de composants d’intégration et des projets
utilisateur a votre espace de travail a partir d’un systéme de contrdle de code
source tel que Rational ClearCase.

Pour plus d’informations sur la maniere de procéder, consultez la documentation
relative au plug-in du systeme de controle de code source.

Pour obtenir un exemple d’utilisation de ClearCase, voir |[«Ajout d’un projet 3|
[espace de travail» a la page 22|

Coupage, copie et collage de ressources

Vous pouvez couper, copier et coller des ressources dans System Manager et dans
le systeme de fichiers.

Pour couper, copier ou coller un projet utilisateur, une bibliotheque de composants
d’intégration, un composant d’intégration, un raccourci ou un dossier dans System
Manager, cliquez avec le bouton droit de la souris sur la ressource, puis
sélectionnez I'élément de menu souhaité. Si vous copiez des composants
d’intégration, vous ne pouvez pas les coller dans la méme bibliotheque (par
exemple, copier une définition d’objet métier et la coller dans la méme
bibliotheque afin d’indiquer un nom différent et 1'utiliser en tant que modele).
Vous pouvez par contre ouvrir la définition du composant dans son outil de
conception et effectuer une opération “Save as” pour l'enregistrer avec un nouveau
nom dans la méme bibliotheque.

Pour couper, copier et coller des composants d’intégration ou des raccourcis dans
le systeme de fichiers, lancez Windows Explorer et accédez au sous-répertoire
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approprié dans le répertoire de projets, copiez le fichier qui partage le nom du

composant et collez-le dans le sous-répertoire approprié du répertoire de projets
cible.

Si vous utilisez les opérations de coupage, copie et collage dans le systeme de
fichiers, vous devez actualiser la bibliothéque de composants d’intégration ou le
projet utilisateur dans System Manager afin d’afficher les ressources ajoutées. Pour
plus d’informations, voir [<Actualisation des ressources»}

Vous ne pouvez pas uniquement couper, copier ou coller I'ensemble des projets
utilisateurs ou bibliotheques de composants d’intégration car 'atelier comporte des
références aux métadonnées qui indiquent les projets utilisateur et les bibliotheques
existantes. La copie d'un dossier dans le répertoire de 'espace de travail
n‘implique pas la mise a jour de ces références aux métadonnées. Vous pouvez par
contre créer un projet utilisateur ou une bibliotheque dans System Manager pour
satisfaire les entrées de métadonnées, puis coller les dossiers de définitions de
composants dans le répertoire de la nouvelle bibliotheque ou du nouveau projet
utilisateur.

Actualisation des ressources

Si vous ajoutez des définitions de composants a une bibliothéque ou des raccourcis
a un projet utilisateur en coupant, copiant et collant des fichiers dans le systeme de
fichiers (comme indiqué dans la section [<Modification des propriétés d’une mappel
et d’un objet de collaboration dans les bibliothéques de composants d’intégration»|
a la page 58), vous devez actualiser la bibliotheque dans System Manager afin
d’appliquer les modifications apportées.

Pour actualiser une bibliotheque de composants d’intégration ou un projet
utilisateur, cliquez dessus avec le bouton droit de la souris dans System Manager,
puis sélectionnez Refresh View dans le menu contextuel.

Suppression de ressources
Procédez comme suit pour supprimer une ressource d’atelier :

1. Cliquez avec le bouton droit de la souris sur la ressource dans System Manager,
puis sélectionnez Delete dans le menu contextuel ou sélectionnez la ressource
dans System Manager et appuyez sur la touche Suppr.

2. Lorsque la boite de dialogue “Delete Component” s’affiche, cliquez OK.

Remarque : Si un composant a des dépendances, vous ne serez pas autorisé a le
supprimer.

Utilisation des ateliers Eclipse
Cette section décrit certaines taches facultatives pouvant étre réalisées dans votre

infrastructure d’outils afin d’optimiser 1'utilisation des outils.

Ouverture et fermeture de perspectives

Cette section décrit comment ouvrir et fermer des perspectives.

Ouverture de perspectives
Procédez comme suit pour ouvrir une perspective dans I'atelier :

1. Sélectionnez Window > Open Perspective > Other dans la barre de menus de
l'atelier.
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2. Dans la boite de dialogue “Select Perspective”, sélectionnez la perspective que
vous souhaitez ouvrir, puis cliquez sur OK.

Outre les perspectives System Manager, Integrated Test Environment et
Collaboration Debugger que vous utilisez avec les composants d’intégration de
WebSphere InterChange Server, vous pouvez également souhaiter explorer les
perspectives décrites dans les sections suivantes :

Perspective Resource: Cette perspective vous permet d’utiliser directement les
fichiers de métadonnées qui représentent des outils de projet, tels que les
bibliotheques de composants d’intégration. La présente la perspective
Resource ouverte dans laquelle le fichier .cwt représentant le modéle de
collaboration ContactSync a été ouvert depuis la vue Navigator pour afficher son
contenu dans la vue Editor.
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Figure 29. Perspective Resource

Important : Les fichiers de métadonnées affichés via la perspective Resource
définissent les composants d’intégration de WebSphere InterChange
Server. La perspective System Manager permet d’utiliser ces
composants en toute sécurité via des interfaces. Si vous manipulez des
fichiers de métadonnées directement, vous risquez d’altérer la
définition du composant. Il est par conséquent recommandé d’utiliser
les fichiers de métadonnées des composants uniquement si vous
maitrisez parfaitement leurs structures ou dans le cadre d'une
interaction sollicitée par 1’assistance technique pour identifier et
résoudre un probléme de définition.

Perspective Java: Cette perspective fournit des éditeurs et des vues qui
permettent la création de fichiers Java. Bien que vous exécutiez la plupart des
opérations de programmation Java dans les outils de conception, vous devez de
temps a autre créer des composants externes, tels que les gestionnaires de données,
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ou des classes utilitaires. Dans ces cas, la perspective Java peut étre tres utile. La
figure 29 présente la perspective Java.
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Figure 30. Perspective Java

Fermeture de perspectives
Vous pouvez procédez comme suit pour fermer des perspectives :

* Sélectionnez Window > Close Perspective pour fermer la perspective active.

* Sélectionnez Window > Close All Perspectives pour fermer toutes les
perspectives ouvertes.

* Cliquez avec le bouton droit de la souris sur 1'icone d’une perspective dans la
barre de raccourcis vers les perspectives, puis sélectionnez Close dans le menu
contextuel pour fermer cette perspective.

* Cliquez avec le bouton droit de la souris sur 'icone d’une perspective dans la
barre de raccourcis vers les perspectives, puis sélectionnez Close All dans le
menu contextuel pour fermer toutes les perspectives ouvertes.

Affichage et fermeture des vues

Vous pouvez controler les panneaux affichés dans les perspectives WebSphere
WorkBench et WebSphere Studio Application Developer Integration Edition.

Affichage des vues
Procédez comme suit pour afficher une vue :

1. Sélectionnez Window > Show View > Other.
2. Développez le dossier d'un groupe de vues, tel que ICS Control View.

3. Sélectionnez la vue concernée, telle que InterChange Server Component
Management.

4. Cliquez sur OK.
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Fermeture des vues
Pour fermer une vue, effectuez 1'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur la barre de titre de la vue, puis
sélectionnez Close dans le menu contextuel.

* Cliquez sur le bouton de fermeture dans la barre de titre de la vue.

Personnalisation des perspectives

Vous pouvez personnaliser une perspective pour y inclure les perspectives, les
vues, les assistants et les interfaces de plug-in que vous souhaitez afin de réduire
la fréquence d’ouverture des éléments que vous utilisez souvent et de fermeture
des éléments dont vous n’avez plus besoin. Procédez comme suit pour
personnaliser la perspective active :

1. Sélectionnez Window > Customize Perspective dans la barre de menus.

2. Cliquez sur le noeud que vous souhaitez personnaliser pour le développer.

3. Cochez et décochez les cases des éléments du noeud. Le répertorie les
noeuds de perspectives personnalisables et les effets produits par leur
activation.

Tableau 9. Noeuds de perspectives personnalisables

Noeud de perspective

personnalisable Résultat

File > New Ajoute ou supprime des éléments dans le menu File > New.
Window > Open Ajoute ou supprime des perspectives dans le menu Window >
Perspective Open Perspective.

Window > Show View Ajoute ou supprime des vues dans le menu Perspective >
Show View.

Other Ajoute ou supprime des éléments dans la barre de menus et la
barre d’outils. Vous devez par exemple cocher la case
ClearCase pour afficher le menu ClearCase.

Enregistrement de perspectives

Vous pouvez enregistrer une configuration de perspective pour conserver les
parametres de personnalisation définis. Procédez comme suit pour enregistrer une
perspective :

1. Sélectionnez Window > Save Perspective As dans la barre de menus de
l'infrastructure d’outils.

2. Entrez un nom pour la perspective dans la zone Name.
3. Cliquez sur OK.

Configuration de la perspective par défaut

Par défaut, l'infrastructure d’outils ouvre la perspective Resource. Si vous utilisez
essentiellement 1'infrastructure d’outils avec les composants d’intégration, vous
pouvez souhaiter configurer 1'une des perspectives d'IBM WebSphere InterChange
Server en tant que perspective par défaut. Pour ce faire, procédez comme suit :

1. Sélectionnez Window > Preferences dans la barre de menus de l'infrastructure
d’outils.

2. Développez le noeud Workbench.

3. Sélectionnez le noeud Perspectives sous le noeud Workbench.

4. Sélectionnez la perspective souhaitée (telle que System Manager) dans la liste
Available Perspectives.
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5.
6.

Cliquez sur Make Default.
Cliquez sur OK.

Configuration des préférences de System Manager

Pour définir les préférences de System Manager, procédez comme suit :

1.
2.

Sélectionnez Window > Preferences dans la barre de menus de l'atelier.

Sélectionnez System Manager Preferences puis procédez comme suit pour
configurer les options de préférence disponibles :

* Si vous ne souhaitez pas recevoir d’invite lors de la suppression d'un
composant dans une bibliotheque de composants d’intégration, activez la
case a cocher du type de composant dans le panneau “Do not confirm object
deletion”.

Remarque : Le fait de cocher la case Unresolved Flows n’a aucun effet sur la
réception ou non d’une invite lors de la suppression d'un flux
dans Flow Manager. Pour plus d’informations sur Flow Manager
et sur la maniere de configurer les préférences de cet outil, voir
le document System Administration Guide.

* Activez la case a cocher Deep Copy si vous souhaitez copier les
dépendances d'un composant en méme temps que le composant lorsque
vous effectuez une copie.

Par exemple, si la case a cocher Deep Copy est activée et que vous copiez
une définition d’objet métier d'une bibliothéque a une autre, tous les objets
métier enfant qu’elle contient seront également copiés. Par contre, si la case a
cocher Deep Copy est désactivée et que vous copiez une définition d’objet
métier d’une bibliotheque a une autre, seul 1'objet métier est copié.

Pour plus d’informations sur les dépendances, voir [«<Dépendances et|
[références» a la page 86|

* Entrez le nom et le chemin d’un fichier dans la zone Log File ou cliquez sur
Browse pour sélectionner un fichier. Lorsque des erreurs se produisent dans
System Manager, le message d’erreur est écrit dans le fichier spécifié. Entrez
un numéro dans la zone Max Size pour indiquer, en mégaoctets, la taille
maximale du fichier journal.

* Cliquez sur Restore Defaults pour configurer les éléments des préférences en
fonction de leurs valeurs par défaut.

La [figure 31 a la page 94| présente l'interface des préférences de System
Manager.
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Figure 31. Préférences de System Manager

3. L’interface “Broker Preferences” vous permet de configurer System Manager de

sorte qu'il fonctionne avec les courtiers de messages WebSphere pris en charge.

Procédez comme suit pour définir les préférences du courtier :

a. Développez System Manager Preferences, puis sélectionnez Broker

Preferences.

b. Entrez le chemin d’acces complet a l'utilitaire d’importation WebSphere MQ
Integrator Broker dans la zone Specify the Integrator broker importer path
ou cliquez sur Browse pour sélectionner le répertoire.

c. Entrez le chemin d’acceés complet a 'utilitaire d’importation WebSphere BI
Message Broker dans la zone Specify the Message broker importer path ou

cliquez sur Browse pour sélectionner le répertoire.

d. Entrez le chemin d’acces complet au répertoire de 'espace de travail Eclipse
de WebSphere BI Message Broker dans la zone Specify the Message broker
workspace directory ou cliquez sur Browse pour sélectionner le répertoire.

La [figure 32 & la page 95| présente l'interface “Broker Preferences” :
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Figure 32. Préférences du courtier

4. L'interface des préférences “Compiler” vous permet de spécifier I'emplacement

des bibliotheques requises par les mappes ou les collaborations développées

afin de permettre au compilateur de les localiser.

Procédez comme suit pour définir les préférences du compilateur :

a. Développez System Manager Preferences, puis sélectionnez Compiler.
b. Cliquez sur New.
c. Dans la boite de dialogue “Add Classpath”, accédez a la bibliotheque que

vous souhaitez ajouter au chemin de classe du compilateur, sélectionnez-la,
puis cliquez sur Open.

La [figure 33 a la page 96| présente l'interface des préférences “Compiler” :

Chapitre 3. Environnement et outils IBM WebSphere InterChange Server

95



96

E

-7
=

fru
=

0n-E-F-F

v Workbench
- Build Order
-Collaboration Debugger
-Debug
External Tools
. HB||J
- InstallfUpdate
t- Integrated Test Environment
e Java
- Plug-In Development
- System Manager Preferences
i~ Broker Preferences
Compiler
. Deplayment Settings
o System Manitar Settings

=

H- Team

Compiler

Compiler classpaths:

C\IBMWebSphereICSibiCross\iarlds. jar

Do |

Restare Defaults | Apply

Impart... Eport... |

o | cancel

Figure 33. Préférences du compilateur

5.

L’interface “Deployment Settings” vous permet de définir des options utiles

lors du déploiement de composants sur un serveur a partir de System Manager.

Procédez comme suit pour définir les préférences de déploiement :

a. Développez System Manager Preferences, puis sélectionnez Deployment

Settings.

b. Activez la case a cocher Overwrite Components in Server during Drag and

Drop deployment.

La [figure 34 a la page 97| présente l'interface “Deployment Settings” :
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Figure 34. Interface Deployment Settings

6. L’interface “System Monitor Settings” permet de configurer le comportement
des fonctions de contrdle de la vue InterChange Server Component
Management.

Procédez comme suit pour définir les préférences de System Monitor :

a. Développez System Manager Preferences, puis sélectionnez System
Monitor Settings.

b. Entrez dans la zone Poll Interval le nombre de secondes pendant lesquelles
vous souhaitez que System Manager patiente avant de vérifier I'état du
systeme pour afficher les informations dans la vue System View.

La [figure 35 a la page 98| présente l'interface “System Monitor Settings” :
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Figure 35. Interface System Monitor Settings

Pour plus d’informations sur la vue System View, voir le document System
Administration Guide.

7. Cliquez sur Apply pour enregistrer vos préférences et continuer dans la boite
de dialogue “Preferences” ou cliquez sur OK pour enregistrer vos préférences
et quitter la boite de dialogue.
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Chapitre 4. Développement d’interfaces de processus métier

Ce chapitre décrit une méthode possible de développement des interfaces de
processus métier a utiliser dans un systéeme d’intégration métier WebSphere avec
InterChange Server. Selon les conditions spécifiques a votre site, vous pouvez
développer plusieurs interfaces en parallele et développer différentes interfaces a
différents stades du cycle de développement.

Vous devez suivre l'ordre des étapes décrit ici pour le développement de la plupart
des interfaces. Bien que des ajouts soient possibles a n’‘importe quel stade d'une
implémentation en cours, ces étapes fournissent une structure pour le processus de
développement.

Ce chapitre contient les sections suivantes :

+ |«Flux de développement général»|

+ [«Ordre des tiches de développement» a la page 101

Flux de développement général

I est recommandé de développer les composants d’intégration dans 1’ordre
suivant :

* Connecteurs et gestionnaires de données

Les connecteurs et les objets métier propres a I'application sont les composants
d’intégration qui communiquent directement avec les applications en cours
d’intégration.

— Si vous devez développer un connecteur personnalisé, ce développement peut
intervenir en parallele avec d’autres processus de développement. Les
compétences requises pour développer un connecteur different de celles
nécessaires au développement d’autres composants ; il est donc courant qu'un
développeur ne s’attache qu'au développement d’un connecteur si cela
s’avere nécessaire. Par cette approche, un développeur peut travailler sur le
connecteur en méme temps que le reste de I'équipe de développement
travaille sur d’autres composants.

— Les collaborations et les mappes dépendent des objets génériques, lesquels
dépendent des objets métier propres a I'application. Vous ne pouvez pas
développer d’objets métier propres a l'application tant que vous ne savez pas
comment les connecteurs qui les traitent utilisent leurs métadonnées. Vous
devez donc sélectionner préalablement le connecteur pour éviter d’avoir a
retravailler sur la conception et a développer des composants dépendants
dans l’étape finale de l'implémentation. En outre, nombre d’adaptateurs
contiennent des agents ODA (Object Discovery Agents) qui peuvent
grandement faciliter le développement d’objets métier propres a I'application.

* Objets métier propres a l’application

Vous devez développer des objets métier propres a 1’application apres les

connecteurs car il vous faut comprendre ceux-ci afin de pouvoir développer les

objets métier. Vous devez développer les objets métier propres a l'application
avant de développer les objets métier génériques car ceux-ci représentent
généralement un sur-ensemble des objets propres a l'application d’une interface.

I est recommandé de créer des objets métier propres a l'application dans
plusieurs itérations. Développez 'objet métier propre a l'application comme une
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structure relativement simple, puis testez-le pour vous assurer que le connecteur
peut utiliser la structure de 'objet métier pour échanger correctement des
données avec l'application. Intégrez des éléments plus complexes et testez a
nouveau l'objet métier pour vous assurer que l'interface fonctionne toujours
malgré les modifications. Répétez ce processus jusqu’a ce que l'importance et la
complexité de 1'objet métier réponde aux exigences de l'interface.

* Objets métier génériques
Apres avoir développé tous les objets métier propres a l'application pour une
interface, vous devez développer 'objet générique comme un sur-ensemble des
objets métier propres a l'application de l'interface.
Assurez-vous qu’il n’y a pas déja des objets métier génériques susceptibles d’étre
fournis avec le programme d’installation ou de faire partie d'une solution
sectorielle, afin d’éviter tout développement personnalisé superflu. Il est inutile
de perdre son temps a réaliser un travail qui a déja été fait. Lorsque vous
recherchez un contenu existant a utiliser, assurez-vous de comprendre les termes
de la licence correspondant au site et vérifiez si la licence couvre ou non
l"utilisation de 1’objet.
A la fin, développez I'objet métier générique pour qu’il contienne :
— tous les attributs nécessaires pour répondre aux exigences de l'interface dans

sa conception courante ;

— tous les attributs nécessaires pour répondre aux exigences de modification de
l'interface ou d’ajout dans un futur proche ;

— aucun attribut ne répondant pas aux exigences actuelles ou futures de
l'interface ;

* Mappes et relations

Une fois que vous avez identifié ou développé les objets métier d'une interface,
vous devez développer les mappes qui transforment les objets métier propres a
I'application en objets génériques, et vice versa. Utilisez 1’outil Map Designer
pour créer une mappe, définir les regles de transformation et tester la mappe a
l'aide d’un modele d’objet métier générique ou propre a l'application.

Apres avoir validé la transformation de la mappe via le test de l'unité, créez une
relation requise pour l'interface, puis implémentez les références croisées dans
les mappes appropriées. Effectuez un test d'unité des mappes dans 'ordre dans
lequel elles doivent intervenir pendant 1’exécution de l'interface a laquelle elles
appartiennent.

Pour plus d’informations, voir le document Map Development Guide.
* Modeles de collaboration

Les modeles de collaboration définissent la logique applicative de l'interface. Les
collaborations les plus simples ne font que router les objets métier entre les
connecteurs. D’autres collaborations peuvent avoir des interactions plus
complexes, faisant intervenir des transactions, des traitements métier a long
terme et une délégation de traitements vers d’autres objets de collaboration. Par
ailleurs, les collaborations sont axées autour des objets métier génériques qui
représentent un super-ensemble des objets métier propres a I'application dans
une interface.

Pendant le test du développement et de I'unité d’une collaboration, vous n’avez
pas besoin d’utiliser d’objets métier propres a 'application, ni de mappes, ni de
connecteurs. Si la collaboration n'implique pas de modifications particulieres aux
données d’un objet métier générique en cours d’exécution, ou bien qu’elle
exécute des opérations qui dépendent clairement de la structure de 1’objet métier
générique, vous n’avez pas besoin que 'objet métier générique soit développé
avant le modele de collaboration. Tant que le processus métier est clairement
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défini, vous pouvez développer le modele de collaboration et le tester avec la
version simplifiée de I'objet métier générique jusqu’a ce qu’il soit développé
dans son ensemble.

Au moment d’évaluer le besoin en modéles de collaboration, recherchez les
modeles déja disponibles et déterminez si les termes de la licence du site
autorisent l'utilisation de ceux-ci. Si aucun des modeéles de collaboration ne
correspond aux besoins, il faut alors développer un modele personnalisé.

Pour plus d’informations, voir le document Collaboration Development Guide et
consultez la documentation sur les collaborations que vous souhaitez
spécifiquement utiliser.

Objet de collaboration

Lorsque vous achevez le modele de collaboration et tous les composants
auxquels il se rattache, vous devez créer un objet de collaboration basé sur le
modele.

Vous devez effectuer un test d’unité de 1’objet de collaboration sans les agents de
connecteur en cours d’exécution en utilisant Integrated Test Environment ou Test
Connector. Cela vous permettra de tester 1'intégrité de l'interface sans introduire
de notion de connectivité et donc d’ignorer les erreurs liées a la mappe et a la
logique de collaboration. Il vous faut ensuite tester l'interface proprement dite
avec les agents du connecteur en cours d’exécution.

Ordre des taches de développement

La

plupart des composants d’intégration d’une interface s’appuient sur une autre

interface, de sorte que les taches de développement de chacun des composants
sont liées et itératives.

Il est recommandé de développer vos composants d’intégration dans 'ordre

suivant :
1. |[«Développement de connecteurs personnalisés»|
2. |«Développement ou modification d’objets métier propres a Iapplication» a la|
[page 102|
3. |«Configuration des connecteurs» a la page 102
4. [«Test de la connectivité et des objets métier propres a ’application» a la page|
102
5. |«<Développement ou modification d’objets métier génériques» a la page 104]
6. |[«Configuration de relations» a la page 104
7. |«Configuration des pools de connexion a une base de données» a la page 105
8. |«Développement et test des mappes» a la page 105
9. [«Développement et test des modeles de collaboration» a la page 105|
10. |«Configuration des connecteurs pour la prise en charge des objets métier et leg
mappes associées» a la page 106
11. [«Création et configuration d’objets de collaboration» a la page 106|
12. [«Déploiement de I'interface» a la page 106|

Développement de connecteurs personnalisés

Un développeur doté des compétences requises doit commencer le développement

de

tous les connecteurs personnalisés nécessaires des le lancement du projet.

Chapitre 4. Développement d’interfaces de processus métier 101



Pour plus d’informations sur le développement de connecteurs personnalisés, voir
les documents suivants : Connector Development Guide for C++ ou Connector
Development Guide for Java Server.

Développement ou modification d’objets métier propres a
I’application
Ce chapitre donne un bref apercu du développement d’objets métier propres a

l'application. Pour plus d’informations sur l'utilisation d’objets métier propres a
l'application, voir le document Business Object Development Guide.

Lorsque vous créez ou modifiez un objet métier propre a l’application, procédez
comme suit :

* Reportez-vous au guide de 1'adaptateur pour déterminer si celui-ci comprend un
agent ODA pouvant étre utilisé pour générer des objets métier propres a
l'application. Les agents ODA facilitent grandement cette phase de
développement.

 Si l'adaptateur ne comprend pas d’agent ODA, essayez d’obtenir un objet
échantillon pour l'application ou I'objet métier propre a 'application de 1’entité
d’un autre site client. Assurez-vous de ne violer aucune clause de propriété
intellectuelle concernant le contenu du client.

 Sil'adaptateur ne comprend pas d’agent ODA et qu’il n'y a aucun échantillon
ou d’objet métier existant a modifier, vous devez développer un objet métier
propre a I'application dans Business Object Designer.

Lorsque vous créez une définition d’objets métier, vous devez également créer au
besoin des déclencheurs d’application source ou d’autres mécanismes de détection
d’événements.

Pour plus d’informations sur la conception et le développement de définitions
d’objets métier propres a l'application, voir le document Business Object
Development Guide.

Configuration des connecteurs

Lorsque vous configurez un connecteur a des fins de test d'unité d'un objet métier
propre a l’application, il se peut que vous n’ayez pas encore développé toutes les
définitions d’objets et les mappes nécessaires au connecteur pour que celui-ci
puisse jouer son role dans l'implémentation. Vous pouvez cependant ajouter une
prise en charge de la définition d’objets métier a tester pour pouvoir le tester
correctement sans ces autres composants. Lorsque vous avez terminé le
développement des autres composants, vous devez ensuite reconfigurer la
définition du connecteur pour inclure la prise en charge des définitions d’objets
métier et associer les mappes nécessaires.

Pour plus d’informations sur les propriétés liées a I'application, voir le guide
concernant votre adaptateur. Pour plus d’informations sur les propriétés standard
du connecteur et sur 'emploi de Connector Configurator, voir le [Chapitre 7,

l«Configuration des connecteurs», a la page 145|

Test de la connectivité et des objets métier propres a
’application
Une fois que vous avez développé 1'objet métier propre a l'application et que vous

avez inclus sa prise en charge dans une définition de connecteur, vous pouvez
effectuer un test d'unité sur I'objet métier afin de vérifier que le connecteur peut
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l'utiliser pour échanger correctement des données avec l'application. Vous n’avez
pas besoin des objets génériques, des mappes, ni des modeles de collaboration que
I'interface utilisera éventuellement dans le cadre du test. Pour effectuer un test
d’unité sur un objet métier propre a I'application, procédez comme suit :

1. Créez un modele de collaboration pass-through selon la conception suivante :

Le modele de collaboration comporte deux ports : 'un dénommé From,
l'autre dénommé To.

Les ports From et To prennent tous deux en charge la définition d’objets
métier propres a l'application.
Le modele de collaboration n’a qu’'un seul scénario dénommé Main.

Le port From est configuré comme le port déclencheur du scénario Main pour

toutes les instructions appartenant a la définition de 1’objet métier.

Le scénario Main comprend les éléments suivants :

— Un noeud Start connecté a un noeud Action par un lien de transition.

— Un noeud Service Call connecté a un noeud Action, doté des
caractéristiques suivantes :

- Le menu déroulant Port dans le panneau “Regular service call” est
défini sur le port To.

- Le menu déroulant Verb dans le panneau “Regular service call” est
défini sur I'instruction Create (ou toute instruction principale liée a
I'objet métier en question).

- La zone BO Variable dans le panneau “Regular service call” est définie
sur la valeur triggeringBusObj, qui correspond a la variable servant a
référencer 1’objet métier qui déclenche la collaboration.

— Un noeud End Success connecté a un noeud Action par un lien de
transition.

Pour plus d’informations sur la création de modeles de collaboration, voir le
document Collaboration Development Guide.

2. Configurez les propriétés de la définition du connecteur, incluez la prise en
charge de la définition d’objet métier et cochez la case Agent Support de la
définition d’objet métier.

3. Incluez la prise en charge de I'objet métier propre a 'application dans une
autre définition de connecteur, “dummy”. Vous n’avez pas besoin de configurer
cette définition de connecteur puisque vous ne I'émulerez qu’avec des outils de
test. Assurez-vous que la case Agent Support est cochée pour la définition
d’objet métier.

4. Si le connecteur est responsable de la notification des événements, procédez
comme suit :

¢ Créez un objet de collaboration basé sur le modele pass-through avec le

connecteur a tester relié au port From et le connecteur “dummy” relié au port
To.

Déployez les connecteurs, le modele de collaboration, 1’objet de collaboration
et les définitions d’objet métier sur le serveur.

Pour plus d’informations sur le déploiement des composants, voir la section

«Exportation de composants vers un package a l'aide de System Manager» 3
la page 61

Lancez 1'agent du connecteur en cours de test.

Pour plus d’informations sur le démarrage d’un connecteur, voir le guide de
votre adaptateur et le document System Administration Guide.
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e Démarrez Test Connector, ouvrez la définition de ’autre connecteur ot vous
avez inclus la prise en charge de la définition d’objets métier et connectez
Test Connector a l’agent.

Pour plus d’informations sur Test Connector, voir [Chapitre 11, «Utilisation de|
|Test Connector», a la page 243l

* Déclenchez un événement dans l'application source.

* Si le test réussit, le connecteur enverra a la collaboration un objet métier
représentant I'événement et apparaitra comme une requéte dans Test
Connector.

5. Si le connecteur est responsable du traitement des requétes, procédez comme
suit :

* Créez un objet de collaboration basé sur le modele pass-through avec le
connecteur a tester relié au port To et le connecteur “dummy” relié au port
From.

Pour plus d’informations sur la création d’objets de collaboration, voir
[Chapitre 9, «Configuration des objets de collaboration», & la page 203}

* Déployez les connecteurs, le modele de collaboration, I'objet de collaboration
et les définitions d’objet métier sur le serveur.

Pour plus d’informations sur le déploiement des composants, voir la section
«Exportation de composants vers un package a 'aide de System Manager» |

la page 61[

e Lancez 'agent du connecteur en cours de test.

Pour plus d’informations sur le démarrage d'un connecteur, voir le guide de
votre adaptateur et le document System Administration Guide.

e Démarrez Test Connector, ouvrez la définition de ’autre connecteur ot vous
avez inclus la prise en charge de la définition d’objets métier et connectez
Test Connector a 'agent.

Pour plus d’informations sur Test Connector, voir [Chapitre 11, «Utilisation de|
[Test Connector», a la page 243

* Envoyez une requéte d’objet métier a partir de Test Connector.

* Si le test réussit, le connecteur recoit et traite la requéte d’objet métier,
générant un enregistrement de 'entité de 'application.

Développement ou modification d’objets métier génériques

Déterminez s’il existe un objet générique pouvant s’appliquer au processus métier.
Assurez-vous que les termes de la licence du site autorisent 'utilisation de 1’objet.

Si aucun objet métier générique existant ne peut étre utilisé, vous devrez soit
étendre un objet métier générique existant, soit en créer un nouveau. Pour plus
d’informations sur la création de nouveaux objets métier, voir le document Business
Object Development Guide.

Configuration de relations

Configurez des relations a ce stade afin de les utiliser ultérieurement lors du
développement de mappes.

Pour plus d’informations sur la configuration de relations, voir le document Map
Development Guide.
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Configuration des pools de connexion a une base de données

Apres avoir configuré les relations nécessaires aux mappes, vous devez faire de
méme pour les pools de connexion a une base de données. La configuration
préalable des pools de connexion a une base de données vous permet de coder
leur utilisation dans les mappes a mesure que vous les développez.

Pour plus d’informations sur la configuration des pools de connexion a une base
de données, voir |[Chapitre 8, «Configuration des pools de connexion a une base del
ldonnées», a la page 191

Développement et test des mappes

Des lors que tous les objets métier génériques requis, les objets métier propres a
l'application, les relations et les pools de connexion a une base de données sont
créés, vous pouvez développer les mappes qui transforment les objets dans
I'interface.

A mesure que vous développez les mappes, vous devez effectuer des tests d"unité
en utilisant les fonctions de débogage de Map Designer. Effectuez un test d’unité
de vos mappes aux stades suivants :

* aprés avoir défini toutes les regles de transformation simples, telles que des
déplacements, des séparations et des associations ;

* apres avoir développé les régles de transformation les plus complexes, devant
faire appel a un code Java personnalisé ;

* apres avoir inclus 1'utilisation de relations et de pools de connexion a une base
de données.

Lorsque vous testez une mappe utilisant des relations, assurez-vous de tester les
mappes en suivant l'ordre dans lequel elles devront s’exécuter dans l'interface.
Sinon, la logique des références croisées ne s’appliquera pas correctement.

Pour plus d’informations sur le développement et le test de mappes, voir le
document Map Development Guide.

Développement et test des modeéles de collaboration

Les modeles de collaboration définissent la logique du processus métier d'une
interface. Vous devez rechercher les modeéles de collaboration disponibles pour
déterminer si I'un de ces modeles est conforme a votre processus métier. S'il
n’existe aucun modeéle de collaboration correspondant exactement a votre
processus métier, vous devez déterminer s’il en existe un de similaire. Le cas
échéant, vous devrez le modifier si les dispositions de la licence du site
l'autorisent, ceci afin d’accélérer le processus de développement.

Si aucun des modeéles n’est similaire, vous devrez développer un nouveau modele
de collaboration. Pour plus d’informations sur la maniere de développer un
nouveau modele de collaboration ou de modifier un modele existant, voir le
document Collaboration Development Guide.

Vous pouvez effectuer un test d'unité sur le modéle de collaboration sans utiliser
les mappes, les objets métier propres a I'application ou les connecteurs que vous
développez pour l'interface. Pour effectuer un test d’unité sur un modele de
collaboration, procédez comme suit :

1. Incluez la prise en charge de 1’objet métier générique qui est traité par le
modele de collaboration dans la définition de PortConnector.
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2. Créez un objet de collaboration basé sur le modele de collaboration dont les
ports de la collaboration sont reliés au composant PortConnector.

Pour plus d’informations sur la création d’objets de collaboration, voir
[Chapitre 9, «Configuration des objets de collaboration», a la page 203.

3. Déployez le composant PortConnector, le modeéle de collaboration, 1’objet de
collaboration et les définitions d’objets métier sur le serveur.

Pour plus d’informations sur le déploiement des composants, voir la section
«Exportation de composants vers un package a I'aide de System Manager» a la|

[page 61}

4. Démarrez Test Connector, ouvrez la définition du composant PortConnector et
connectez Test Connector a 'agent.

Pour plus d’informations sur Test Connector, voir [Chapitre 11, «Utilisation de]
[Test Connector», a la page 243

5. Créez une instance de 1'objet métier générique contenant des données et
transmettez 1'événement comme une requéte de Test Connector.

La collaboration regoit et traite 'événement et chaque appel de service transmet
I'objet métier générique a Test Connector, d’ot1 vous pouvez examiner les
données en vue de les modifier.

6. Examinez la sortie journal d’InterChange Server pour vous assurer que la
logique de collaboration s’est déroulée comme prévue.

Configuration des connecteurs pour la prise en charge des
objets métier et les mappes associées

Pour pouvoir tester ensemble tous les composants développés, vous devez
reconfigurer les définitions de connecteurs pour intégrer la prise en charge des
objets métier génériques et propres a l'application nécessaire a leur participation
dans l'interface. Chaque fois qu’il le peut, le systeme associe chaque mappe
automatiquement ; dans certains cas cependant, lorsque plusieurs mappes peuvent
transformer les objets, vous devez les associer au cas-par-cas. Pour plus
d’informations, voir [Chapitre 7, «Configuration des connecteurs», a la page 145,

Création et configuration d’objets de collaboration

Une fois que vous avez inclus la prise en charge des définitions d’objets métier
requises dans les connecteurs, vous pouvez créer un objet de collaboration basé sur
le modele et relier ses ports aux composants appropriés.

Pour plus d’'informations sur 1'utilisation des objets de collaboration, voir
[Chapitre 9, «Configuration des objets de collaboration», a la page 203|

Déploiement de lI'interface

Apres avoir créé tous les composants nécessaires de l'interface, vous devez
déployer celle-ci dans votre instance InterChange Server locale pour la tester. Pour
plus d’informations sur le déploiement, voir la section [<Déploiement de]
komposants sur un serveur» a la page 63l

Test de l'interface

Apres avoir déployé 'interface dans votre instance InterChange Server locale, il
vous faut tester l'interface dans son ensemble pour vérifier que tous les
composants sont conformes aux besoins métier dans le cadre du travail en
collaboration. Pour tester l'interface, procédez comme suit :

1. Assurez-vous que tous les composants requis sont actifs.
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Déclenchez un événement dans le systeme source.

Examinez la sortie de journal d’'InterChange Server pour vérifier que tous les
composants de l'interface s’exécutent correctement.

Examinez le systeme cible pour vérifier que l’entité a été traitée correctement et
que les données apparaissent telles qu’elles devraient figurer.
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Chapitre 5. Configuration de WebSphere InterChange Server

Vous devez configurer InterChange Server en utilisant les informations spécifiques
a son environnement d’exécution. Les informations de configuration sont
enregistrées au format XML dans un fichier InterchangeSystem.cfg, stocké dans le
répertoire produit. Les deux outils que vous pouvez utiliser pour configurer
InterChange Server sont les suivants :

* InterChange Server Configuration Wizard

Cet outil n’affiche pas l'intégralité des options de configuration disponibles pour
InterChange Server, mais il peut étre utilisé lorsque le serveur n’est pas actif.

* System Manager
Cet outil permet de configurer davantage d’options qu’InterChange Server

Configuration Wizard. Cependant, le serveur doit étre exécuté et System
Manager doit s’y connecter.

Ce chapitre explique comment utiliser InterChange Server Configuration Wizard et
System Manager pour configurer une instance de serveur. Il comprend les sections
suivantes :

+ |«Utilisation d'InterChange Server Configuration Wizard»|

+ |«Utilisation de System Manager» a la page 115|

Utilisation d’InterChange Server Configuration Wizard

Procédez comme suit pour démarrer InterChange Server Configuration Wizard et
mettre a jour le fichier de configuration :

1. Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server
> IBM WebSphere InterChange Server >IBM WebSphere InterChange Server
Configuration Wizard.

2. Affectez les valeurs de votre choix a tous les champs des onglets de 'assistant,
comme décrit dans les sections suivantes :

+ |[«Configuration des propriétés du serveur a l'aide de l’assistant»|

« |«Configuration des propriétés de WebSphere MQ a l'aide de l’assistant» a la|

page 11{]

« |«Configuration des propriétés de la base de données a 1'aide de l’assistant» a
la page 111

+ |«Configuration des propriétés de sécurité a l'aide de l’assistant» a la page 114

3. Cliquez sur Apply.
4. Lorsque la boite de dialogue “Changes Complete” s’affiche, cliquez sur OK.
5. Cliquez sur Exit.

Configuration des propriétés du serveur a I'aide de I’assistant

L’onglet “InterChange Server” de 'assistant de configuration permet de modifier
certaines propriétés de base du serveur lui-méme. Pour configurer les propriétés
d’InterChange Server, procédez comme suit :

1. Cliquez sur 'onglet “InterChange Server”.

La [figure 36 a la page 110|représente ’onglet “InterChange Server” :
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InterChange Server Configuration - . x|

] WebSphere MQi Daiabase] Secur'rty;

Server Mame GTZICICE

Log File |C: IBM IS pherelCSinterchange sy stem Jog

Locale en_LUS x

Drefault Apply Exit

Figure 36. Onglet de configuration d’InterChange Server

2. Indiquez le nom de l'instance d’InterChange Server dans le champ Server
Name.

3. Procédez comme suit pour définir la valeur du champ Log File :

* Entrez la valeur STDOUT dans le champ pour indiquer a InterChange Server
de se connecter a la console.

¢ Entrez le nom et le chemin d’acceés d’un fichier dans le champ ou cliquez sur
Browse pour sélectionner un fichier auquel InterChange Server doit se
connecter.

Remarque : Tenez compte des informations contenues dans la section
«Configuration de la connexion dans un environnement de]
développement» a la page 16|lorsque vous définissez cette
propriété.

4. Sélectionnez 1'environnement local dans le menu déroulant Locale.

Configuration des propriétés de WebSphere MQ a I'aide de
I'assistant

L’onglet “WebSphere MQ” de 1’assistant de configuration vous permet de modifier
les propriétés qui spécifient comment InterChange Server communique avec le
serveur de messagerie permanente WebSphere MQ. Pour configurer les propriétés
de WebSphere MQ, procédez comme suit :

1. Cliquez sur l'onglet WebSphere MQ.
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La représente 1'onglet “WebSphere MQ” :

InterChange Server Configuration = x|

Host Mame JcARENLT

Port Number |1 414

Queue Manager Name  [WICS422DEV.queue.manager

Channel JCHANNELA

Defautt | Djeoerd | apay | Exit

Figure 37. Onglet de configuration de WebSphere MQ

2. Entrez le nom de l'ordinateur sur lequel le serveur WebSphere MQ est installé
dans le champ Host Name.

3. Entrez dans le champ Port Number le port sur lequel WebSphere MQ autorise
les clients a communiquer avec le serveur.

Le port par défaut est 1414.

4. Entrez dans le champ Queue Manager Name le nom du gestionnaire de files
d’attente qui a été créé pour contenir les files d’attente sur lesquelles
InterChange Server stockera de maniere permanente les messages des flux qu’il
traite.

5. Entrez dans le champ Channel le nom du canal sur lequel les clients de
WebSphere MQ communiquent avec le serveur WebSphere MQ. La valeur par
défaut est CHANNEL1. Consultez I'administrateur WebSphere MQ sur le site pour
déterminer si CHANNEL1 peut étre utilisé et dans le cas contraire, le canal a
utiliser.

Configuration des propriétés de la base de données a l'aide
de l'assistant

L’onglet “Database” de l'assistant de configuration vous permet de modifier les
propriétés qui spécifient les bases de données qu’utilise InterChange Server pour
stocker le référentiel, les données de gestion des événements et des transactions.
Pour configurer les propriétés de la base de données, procédez comme suit :

1. Cliquez sur l'onglet Database.
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La représente l'onglet de configuration “Database” :

InterChange Server Configuration it x|

InterChange Server ] WebSphere MG

rDatabaze Connectivity
Database Driver  |DBE2 | MaxConnections I Unlimited

Max Poals 10
Idle Tirmenout 2

rEvent Management
Host Mame | Login |wicsadmin

Database ficsrepos Password | Change

tax Connections W Unlimited Faort Mumber

rTransactions

Huost Mame | Lagin |wicaadmin
Database ficsrepos Password | Change
Max Connections [ [ Unlimited  PortNumber [
rRepositary
Host Marme | Lagin |wicaadmin
Database |icsrepu:us Fassword | Change

tax Connections [+ Unlirnited Faort Mumber

rFlosey bonitoring

HINIEN

Host Mame | Login |wiczacmin
Database ficsrepos Password | Change
Schema Mame | Port Mumber

tax Connections [+ Unlirnited

Detautt Apply Exit

Figure 38. Onglet de configuration de la connexion de la base de données

2.

Sélectionnez la valeur appropriée dans le menu déroulant Database Driver
(DB2, MQ SQL Server(Type 4) ou Oracle(Type 4)) selon le fournisseur de base
de données.

Entrez le nombre maximal de connexions que vous voulez qu’InterChange
Server établisse avec le serveur de la base de données dans le champ Max
Connections, ou cochez la case Unlimited pour autoriser un nombre illimité de
connexions.

Entrez le nombre maximal de pools qu'InterChange Server doit créer pour
contenir les connexions de la base de données mises en cache dans le champ
Max Pools.

Entrez le délai en minutes pendant lequel vous voulez qu'un objet de
connexion reste inactif avant d’étre renvoyé au pool de connexion de la base de
données pour étre réutilisé dans le champ Idle Timeout.

Pour configurer la connexion de la base de données pour utiliser le service de
gestion des événements, procédez comme suit dans le panneau “Event
Management” :

112  1BM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



a. Si vous avez choisi MQ SQL Server(Type 4) ou Oracle(Type 4) dans le
menu déroulant Database Driver, entrez le nom de 1'ordinateur sur lequel
réside le serveur de la base de données dans le champ Host Name.

Entrez le nom de la base de données dans le champ Database.

c. Entrez le nombre maximal de connexions que vous voulez qu'InterChange
Server établisse avec le serveur de la base de données spécifique dans le
champ Max Connections, ou cochez la case Unlimited pour autoriser un
nombre illimité de connexions.

d. Entrez le nom d’utilisateur qu’InterChange Server doit utiliser pour se
connecter a la base de données indiquée dans le champ Login.

e. Entrez le mot de passe associé au nom d’utilisateur indiqué a I'étape @
dans le champ Password.

f. Si vous avez choisi MQ SQL Server(Type 4) ou Oracle(Type 4) dans le menu
déroulant Database Driver, vous devez entrer le numéro de port sur lequel
les clients communiquent avec le serveur de la base de données dans le
champ Port Number.

Répétez 1'étape |6 a la page 112|dans le panneau “Transactions” pour configurer

la connexion de la base de données pour utiliser le service de gestion des
transactions.

Répétez I'étape 6 a la page 112|dans le panneau “Repository” pour configurer

la connexion de la base de données pour utiliser le service de référentiel.

Pour configurer la connexion de la base de données pour utiliser le service de
controle des flux, procédez comme suit dans le panneau “Flow Monitoring” :

a. Si vous avez choisi Oracle(Type 4) dans le menu déroulant Database
Driver, entrez le nom de 'ordinateur sur lequel réside le serveur de la base
de données dans le champ Host Name.

Remarque : La base de données Microsoft SQL Server n’est pas prise en
charge pour le service WebSphere Business Integration Monitor.
Si vous utilisez SQL Server pour les autres bases de données
utilisées par WebSphere InterChange Server, vous ne pouvez
pas utiliser le service Flow Monitoring.

b. Entrez le nom de la base de données dans le champ Database.

c. Entrez le nom du schéma utilisé par WebSphere Business Integration
Monitor dans le champ Schema.

Si vous utilisez Oracle comme base de données de contrdle des flux, le nom
du schéma correspond au nom du compte utilisateur. Si vous utilisez IBM
DB2 comme base de données de controle des flux, le nom du schéma peut
étre différent de celui du compte utilisateur. Par conséquent, vous devez
indiquer le nom du schéma.

d. Entrez le nombre maximal de connexions que vous voulez qu’InterChange
Server établisse avec le serveur de la base de données spécifique dans le
champ Max Connections, ou cochez la case Unlimited pour autoriser un
nombre illimité de connexions.

e. Entrez le nom d’utilisateur qu’InterChange Server doit utiliser pour se
connecter a la base de données indiquée dans le champ Login.

—

Entrez le mot de passe associé au nom d’utilisateur indiqué a l'étape |9¢| dans
le champ Password.

g. Si vous avez choisi Oracle(Type 4) dans le menu déroulant Database
Driver, vous devez entrer le numéro de port sur lequel les clients
communiquent avec le serveur de la base de données dans le champ Port
Number.
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Pour plus d’informations sur le service Flow Monitoring, voir le document
System Administration Guide.

Modification des mots de passe de la base de données
Pour changer le mot de passe associé au nom d’utilisateur qu’InterChange Server
utilise pour accéder a I'une des bases de données, procédez comme suit :

1. Cliquez sur le bouton Change situé en regard du champ Password dans les
panneaux “Event Management”, “Transactions”, “Repository” ou “Flow
Monitoring”.

2. Entrez le nouveau mot de passe dans le champ New Password.

3. Entrez a nouveau le mot de passe dans le champ Confirm Password.

4. Cliquez sur OK.

Configuration des propriétés de sécurité a I'aide de I'assistant

L’onglet Security de l'assistant de configuration permet de modifier les propriétés
qui spécifient les options de sécurité d’InterChange Server. Pour configurer les
propriétés de sécurité, procédez comme suit :

1. Cliquez sur 'onglet Security.
La présente I'onglet de configuration Security.

X

InterChange Server Configuration

InterChange Server] WehSphere MG‘!] Databaze

rUzer Regiztry Type

ser Registry |Repnsitor\; ﬂ

rRepositary
Host MName | Login |wicsadin

Datahase ficsrepos Password | Change
Max Connections ¥ Unlimited  Port Murmber

Default Apply Exit

Figure 39. Onglet Security de I'assistant
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Dans le menu déroulant User Registry, sélectionnez Repository ou LDAP. Si
vous avez choisi Repository, vous devez indiquer les informations suivantes
dans la zone Repository de 1'onglet Security :

* le nom d’hote ;

* la base de données ;

* le nombre maximal de connexions (ou sélectionner Unlimited) ;
* le nom de connexion ;

* le mot de passe ;

* le numéro de port.

Remarque : Pour plus d’informations sur la sécurité et la configuration, voir le
Guide d’administration.

Utilisation de System Manager

System Manager offre davantage de souplesse pour configurer InterChange Server.
Toutefois, le serveur doit étre exécuté et System Manager doit s’y connecter.

Pour ouvrir I'éditeur de configuration d’InterChange Server dans System Manager,
procédez comme suit :

1.

2.

Démarrez System Manager, comme décrit dans [<Démarrage de System|
[Manager» a la page 26,

Connectez System Manager a 'instance d’InterChange Server, comme décrit
dans [«Connexion a InterChange Server» a la page 32|

Cliquez avec le bouton droit de la souris sur I'instance d'InterChange Server,
puis sélectionnez Edit Configuration dans le menu contextuel.

Effectuez les changements nécessaires dans les onglets de configuration, comme
décrit dans les sections suivantes :

« |«Affichage des propriétés générales a I'aide de System Manager» a la page|
116

« |«Configuration des propriétés de la base de données a 1’aide de System|
Manager» a la page 117

* |«Configuration des niveaux de trace a I'aide de System Manager» a la page]
119

+ |«Configuration des propriétés de tracage et de journalisation a 'aide de]
System Manager» a la page 120|

+ |«Configuration des propriétés de notification par courrier électronique 3
I’aide de System Manager» a la page 122]

« [«Configuration des autres propriétés a 'aide de System Manager» a la pagel
[

« |«Configuration des variables d’environnement a l'aide de System Manager» 3
la page 125

+ [«Configuration des propriétés de WebSphere MQ a l'aide de System|
Manager» a la page 125

» |«Configuration de la sécurité a 'aide de System Manager» a la page 126

* [«Configuration de la confidentialité a I'aide de System Manager» a la page|

12

Lorsque vous avez terminé, utilisez le raccourci clavier Ctrl+S pour enregistrer
le fichier.
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Affichage des propriétés générales a I'aide de System
Manager

L’onglet “General” de I'éditeur du fichier de configuration de System Manager
contient les champs en lecture seule suivants :

* Le champ Server name, qui correspond au nom de l'instance d’InterChange
Server.

* Le champ Server version, qui correspond a la version du logiciel IBM
WebSphere InterChange Server exécutée par le serveur.

* Le champ Total memory, qui correspond a la mémoire vive totale disponible sur
l'ordinateur qui exécute InterChange Server.

* Le champ Free memory, qui indique la mémoire vive disponible sur 1’ordinateur
qui exécute InterChange Server.

* Le champ Startup time, qui indique 'heure a laquelle l'instance du serveur a
démarré.

e Le champ Local Time Zone, qui indique le fuseau horaire dans lequel réside
l'ordinateur qui exécute System Manager.

* Le champ Server Time Zone, qui indique le fuseau horaire dans lequel réside
l'ordinateur qui exécute InterChange Server.

* Le champ Server locale, qui correspond a I'environnement local de I'ordinateur
sur lequel est exécuté InterChange Server.

La représente 1'onglet “General” de 1’éditeur du fichier de configuration
de System Manager :

B X
SErver name: Startup time:

[wics4zzpew | Wed Now 05 11:18:19 PST 2003
SErver version: Local Time Zone:

[42.20 | Americajlos_Angeles

Total memory: Server Time Zone:

| 62650880 | AmericaiLos_Angeles

Free memory; Server locale:

| 2zzo1104 |en_Us

General |Databm | Tracing Levels | TracefLog Files | E-mail  Misc | Environment Properties | WebSphere MQ

Figure 40. Configuration des propriétés générales d’InterChange Server
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Configuration des propriétés de la base de données a l'aide
de System Manager

L’onglet “Database” de l'éditeur du fichier de configuration vous permet de
modifier les propriétés qui spécifient les bases de données qu’utilise InterChange
Server pour stocker le référentiel, les données de gestion des événements et des
transactions. Vous pouvez également configurer InterChange Server pour la
résilience de la base de données dans cet onglet. Pour configurer les propriétés de
la base de données, procédez comme suit :

1. Cliquez sur 1'onglet Database.

La présente l'onglet “Database” dans I'éditeur du fichier de
configuration de System Manager :

Database connectivity

Database driver |IEM DBZ Server ™ | Maximum number of connections | v Unlimited
IMazximum number of pools | 10
Idle timeout | 2 Mlinites
IMaximumn deadlock retry | 5
Deadlock retry inkerval | 20 Seconds
[Max conneck retries | 3
Connect rekry inkerval | &0 Secondis)

Event ranagernent

| Login | wicsadmin
Database | IEsrepos Password | Change
Maximum number of connections | [¥ Unlimited |
Max conneck rekries |3 Connect rekry interval |6U Second(s)
Transactions

| Login | whicsadmin

General Database | Tracing levels | Trace and log files | E-mail | COREA | Miscellaneous | Environment properties | WebSpheare MG | Security - REAC | Privacy

Figure 41. Onglet Database de System Manager

2. Sélectionnez la valeur appropriée dans le menu déroulant Database Driver
(IBM DB2 Server, MS SQL Server ou Oracle Server) selon le fournisseur de la
base de données.

3. Entrez le nombre maximal de connexions que vous voulez qu’InterChange
Server établisse avec le serveur de la base de données dans le champ
Maximum number of connections, ou cochez la case Unlimited pour
autoriser un nombre illimité de connexions.

4. Entrez le nombre maximal de pools qu’InterChange Server doit créer pour
contenir les connexions de la base de données mises en cache dans le champ
Maximum number of pools.

5. Entrez le délai en minutes pendant lequel vous voulez qu'un objet de
connexion reste inactif avant d’étre renvoyé au pool de connexion de la base
de données pour étre réutilisé dans le champ Idle Timeout.

6. Entrez le nombre de tentatives dont dispose le serveur pour exécuter une
transaction de base de données bloquée dans le champ Maximum deadlock

retry.
Ce Chamr est associé au champ Deadlock retry interval décrit a 1’étape
page 118

Pour plus d’informations sur le comportement du serveur en cas de blocage

de la base de données, voir le document System Administration Guide.
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7. Entrez le délai d’attente en secondes entre chaque tentative du serveur pour
exécuter une transaction de base de données bloquée dans le champ Deadlock
retry interval.

Ce champ est associé au champ Maximum deadlock retry décrit a 1’étape
Pour plus d’informations sur le comportement du serveur en cas de blocage
de la base de données, voir le document System Administration Guide.

8. Entrez le nombre de tentatives dont InterChange Server dispose pour rétablir
une connexion avec la base de données en cas d’interruption dans le champ
Max connect retries.

9. Entrez le délai d’attente (en secondes) d’InterChange Server pour se
reconnecter a la base de données dans le champ Connect retry interval.

10. Pour configurer la connexion de la base de données pour utiliser le service de
gestion des événements, procédez comme suit dans le panneau “Event
Management” :

a. Si vous avez choisi MQ SQL Server(Type 4) ou Oracle(Type 4) dans le
menu déroulant Database Driver, entrez le nom de l'ordinateur sur lequel
réside le serveur de la base de données dans le champ Host name.

b. Entrez le nom de la base de données dans le champ Database.

Entrez le nombre maximal de connexions que vous voulez qu’'InterChange
Server établisse avec le serveur de la base de données spécifique dans le
champ Maximum number of connections, ou cochez la case Unlimited
pour autoriser un nombre illimité de connexions.

d. Dans le champ Max connect retries, entrez le délai d’attente d'InterChange
Server avant de rétablir une connexion en cas d’interruption.

e. Entrez le nom d’utilisateur qu’InterChange Server doit utiliser pour se
connecter a la base de données indiquée dans le champ Login.

f. Entrez le mot de passe associé au nom d’utilisateur indiqué a 1'étape
dans le champ Password.

g. Si vous avez choisi MS SQL Server (Type 4) ou Oracle (Type 4) dans le
menu déroulant Database Driver, vous devez entrer le numéro de port sur
lequel les clients communiquent avec le serveur de la base de données
dans le champ Port Number.

h. Entrez le délai d’attente (en secondes) d'InterChange Server avant
d’essayer de se reconnecter apres une interruption dans le champ Connect
retry interval.

11. Répétez 1'étape dans le panneau “Transactions” pour

configurer la connexion de la base de données pour utiliser le service de
gestion des transactions.

12. Répétez 'étape |6 a la page 112| dans le panneau “Repository” pour configurer

la connexion de la base de données pour utiliser le service de référentiel.

13. Pour configurer la connexion de la base de données pour utiliser le service de
controle des flux, procédez comme suit dans le panneau “Flow Monitoring” :

a. Si vous avez choisi Oracle(Type 4) dans le menu déroulant Database
Driver, entrez le nom de I'ordinateur sur lequel réside le serveur de la
base de données dans le champ Host Name.

Remarque : La base de données Microsoft SQL Server n’est pas prise en
charge pour le service WebSphere Business Integration
Monitor. Si vous utilisez SQL Server pour les autres bases de
données utilisées par WebSphere InterChange Server, vous ne
pouvez pas utiliser le service Flow Monitoring.
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Entrez le nom de la base de données dans le champ Database.

Entrez le nom du schéma utilisé par WebSphere Business Integration
Monitor dans le champ Schema.

Si vous utilisez Oracle comme base de données de controle des flux, le
nom du schéma correspond au nom du compte utilisateur. Si vous utilisez
IBM DB2 comme base de données de controle des flux, le nom du schéma
peut étre différent de celui du compte utilisateur. Par conséquent, vous
devez indiquer le nom du schéma.

d. Entrez le nombre maximal de connexions que vous voulez qu’InterChange
Server établisse avec le serveur de la base de données spécifique dans le
champ Maximum number of connections, ou cochez la case Unlimited
pour autoriser un nombre illimité de connexions.

e. Dans le champ Max connect retries, entrez le délai d’attente d'InterChange
Server avant de rétablir une connexion en cas d’interruption.

f. Entrez le nom d’utilisateur qu’'InterChange Server doit utiliser pour se
connecter a la base de données indiquée dans le champ Login.

g. Entrez le mot de passe associé au nom d’utilisateur indiqué a I'étape
dans le champ Password.

h. Si vous avez choisi Oracle(Type 4) dans le menu déroulant Database
Driver, vous devez entrer le numéro de port sur lequel les clients
communiquent avec le serveur de la base de données dans le champ Port
Number.

i. Entrez le délai d’attente (en secondes) d’InterChange Server avant d’essayer
de se reconnecter apres une interruption dans le champ Connect retry
interval.

Pour plus d’informations sur le service Flow Monitoring, voir le document
System Administration Guide.

Modification des mots de passe de la base de données
Pour changer le mot de passe associé au nom d’utilisateur qu’InterChange Server
utilise pour accéder a I'une des bases de données, procédez comme suit :

1. Cliquez sur le bouton Change situé en regard du champ Password dans les
panneaux “Event Management”, “Transactions” ou “Repository”.

2. Entrez le nouveau mot de passe dans le champ New Password.
3. Entrez a nouveau le mot de passe dans le champ Confirm Password.
4. Cliquez sur OK.

Configuration des niveaux de trace a I’aide de System
Manager

Procédez comme suit pour configurer les propriétés relatives au tragage des flux et
au sous-systeme de tracage dans l'onglet Tracing Levels :

1. Cliquez sur l'onglet Tracing Levels.

La [figure 42 a la page 120| représente 1'onglet Tracing Levels de l’éditeur du
fichier de configuration de System Manager :
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Flows tracing levels
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Component

| Lewel
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aTP
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BOMHeader
BOMItern
Buyerattributes
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Contact
ContactCustarmer
ContactRef
ContactReferences
Contract
ContractConkackRef
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7

|

IEM WebSphere Business Integration system trace level:

Subsystem Trace level

4

Event management
Messaging

Repositary

=]

Database connectivity
Diomain state
Data handlers
User database connections |0

HTTPS authentication

=]

i i i i i

Transport layer security

‘WebSphere MO

Flows monitaring

General | Database | Tracing levels | Trace and log files | E-mail | COREA | Miscellaneous | Environment properties | WebSphere MG | Security - REAC | Privacy

Figure 42. Configuration des niveaux de trace d’InterChange Server

2. Pour configurer le niveau de trace des flux d'un objet métier, sélectionnez la
valeur souhaitée dans la colonne Level de I'objet métier en question dans le

panneau “Flow Tracing Levels”.

Pour plus d’informations sur le tragage des flux, voir le document System

Administration Guide.

3. Pour configurer le niveau de trace pour un sous-systeme InterChange Server,
sélectionnez le niveau de trace de votre choix dans le menu déroulant

correspondant au sous-systeme.

Pour connaitre les informations qu’indique chaque niveau de trace pour chaque
sous-systeme, voir I'annexe “Configuration Parameters” du document System
Installation Guide for Windows ou System Installation Guide for UNIX.

Configuration des propriétés de tracage et de journalisation a
'aide de System Manager

Procédez comme suit pour configurer les emplacements dans lesquels InterChange
Server enregistre et analyse les informations d’exécution :

1. Cliquez sur l'onglet Trace/Log Files.

La [figure 43 a la page 121| représente 1'onglet Trace/Log Files dans l’éditeur du

fichier de configuration de System Manager :
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Logging

Tracing

WebSphere M Tracing

™ To Conscle ™ To Console

¥ ToFie I ToFie
[sroour i [ .
Log file 1 jmrmﬂmw Trace file 1 jmp rdmied
Nuraber of archives 0 j Nureber of archives 0 j

Business Process Diagnostics

General Database | Tracing Levels | TracefLog Files |E-mai Misc Environment Properties WebSphere MQ

_oio|| | Eneble Stack Tracing ™
Tracing Severity Level

Figure 43. Configuration des propriétés de tracage et de journalisation d’InterChange Server

2. Procédez comme suit dans le panneau Logging pour configurer la maniére dont
InterChange Server journalise les informations d’exécution :

* Cochez la case To Console pour qu’'InterChange Server envoie les données
de journalisation a la console.

¢ Cochez la case To File pour qu'InterChange Server envoie les données de
journalisation dans un fichier. Si vous cochez cette case, procédez comme suit

a. Indiquez dans le champ sans titre le nom et le chemin d’acces du fichier
vers lequel le résultat doit étre consigné, ou cliquez sur le bouton de
navigation pour sélectionner un fichier.

b. Procédez comme suit pour indiquer le mode de stockage des fichiers
journaux :

Cochez la case Unlimited pour qu'InterChange Server enregistre les
informations dans le fichier indiqué a l’étape% sans limite de taille du
fichier.

Remarque : Veillez a stocker correctement le fichier si vous
sélectionnez cette option car InterChange Server pourrait
remplir le disque et provoquer une défaillance du
systeme.

Pour configurer une méthode d’archivage des fichiers journaux,

procédez comme suit :

1) Sélectionnez Byte, KB, MB, ou GB dans le menu déroulant sans
nom pour indiquer s’il faut stocker les fichiers d’archive et les
fichiers journaux par incréments d’octets, de kilooctets, de
mégaoctets ou de gigaoctets.

2) Sélectionnez un numéro dans le menu déroulant Log file pour
indiquer la taille en octets, kilooctets, mégaoctets ou gigaoctets que
vous voulez que le fichier journal atteigne avant de I'archiver.
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3) Sélectionnez dans le menu déroulant Number of archives le
nombre de fichiers journaux qui doivent étre conservés avant d’étre
supprimés.

3. Répétez I'étape 2 a la page 121f pour le panneau “Tracing”.

4. Pour activer le tracage pour WebSphere MQ, indiquez dans le champ sans titre
le nom et le chemin d’accés du fichier vers lequel le résultat doit étre consigné
dans le panneau “WebSphere MQ Tracing”, ou cliquez sur le bouton de
navigation pour sélectionner un fichier.

5. Pour utiliser la fonction de trace de pile, cochez la case Enable Stack Tracing et
sélectionnez le niveau de sévérité souhaité dans le menu déroulant Tracing
Severity Level.

Pour plus d’informations sur la fonction de trace de pile, voir le document
System Administration Guide.

Configuration des propriétés de notification par courrier
électronique a I'aide de System Manager

InterChange Server peut envoyer des notifications par courrier électronique lorsque
des erreurs surviennent dans 1’environnement systeme WebSphere Business
Integration. Par défaut, le serveur utilise les API Java de courrier électronique pour
envoyer des notifications par courrier électronique pour un certain nombre de
sous-systemes. Pour permettre au serveur d’envoyer des notifications par courrier
électronique afin de signaler des erreurs rencontrées par des collaborations, vous
devez configurer le systéme de sorte qu'il utilise WebSphere Business Integration
Adapter for e-Mail. Pour plus d’informations sur la configuration du systeme pour
utiliser la notification par courrier électronique, voir le document System
Administration Guide. Pour effectuer les modifications nécessaires dans le fichier de
configuration (qui ne représente qu'une étape parmi l'ensemble des taches
expliquées dans le document System Administration Guide), procédez comme suit :

1. Cliquez sur 'onglet E-mail.

La [figure 44 a la page 123| représente ’onglet “E-mail” dans I’éditeur du fichier
de configuration de System Manager :
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E-mail send type Connector mail vl
Default e-mail recipient | |

‘WebSphere MQ errors recipient |

Repository errors recipient |

Database persistence errors recipient |

Database access errors recipient |

Transactions errors recipisnt

Collaboration errors recipient

Map errors recipient

Security errors recipient

Connector controller errors recipient

DTP errors recipient

CORBA errors recipient

Activation errors recipient

Submission manager etrors recilent

|
|
|
I
[
|
Connector agent errors reciglent |
|
[
[
|

Deadlock srrors recipient

General Database | Tracing Levels | Trace/Log Files |E-rn=ll \Misc | Environment Properties | WebSphere MQ

Figure 44. Configuration des propriétés de notification par courrier électronique d’InterChange
Server

2. Sélectionnez le type de messagerie Java mail ou Connector mail dans le menu
déroulant E-mail send type selon la méthode de notification par courrier
électronique que vous voulez utiliser.

Remarque : Gardez a l'esprit que les collaborations ne pourront envoyer de
notifications par courrier électronique que si vous sélectionnez
Connector mail.

3. Sivous avez choisi Java mail a I'étape EI entrez le nom de l'ordinateur sur
lequel le serveur SMTP est installé dans le champ SMTP mail host.

4. Entrez une adresse e-mail ou une série d’adresses e-mail séparées par des
virgules dans les champs de texte pour chaque sous-systeme.

Configuration des autres propriétés a I’aide de System
Manager

L’onglet “Misc” dans 1’éditeur du fichier de configuration de System Manager
comporte des panneaux permettant de configurer des fonctions telles que le
contrdle permanent, le contrdle des flux et les processus métier de longue durée.
Pour configurer les parametres de ces fonctions, procédez comme suit :

1. Cliquez sur l'onglet Misc.

Chapitre 5. Configuration de WebSphere InterChange Server 123



124

La représente l'onglet “Misc” dans I’éditeur du fichier de

configuration de System Manager :

EE x|

Persistent Monitoring ‘WorkFlow Management
Action on error |Shutdnwn 'I Business object consumer processor | 1

Persistent monitoring service | 0

~Flow Control ~Server Memory

Cortroller wakeup thresheld 0.9 Memmory checker sleap time (minutes) lo
Collaboration wakeup threshald | 0.9 Memmory upper threshold percent I'BEI

Collaboration def ewent capadty | 2147483647 Mermory lowser threshold parcent ian

Conn def event capacity Im Connector pause time at threshold (minutes) 157
Saturated read size 100
Saturated min size [T
Saturated max size |3—
(- Flaw Monitoring
Max flow queve depth [500 T Maxvalue

General |Database  Tracing Levels | Trace(Log Fies |E-mail | Misc |Environmen: Properties | WebSphere MQ

Figure 45. Configuration des propriétés diverses d’InterChange Server

2.

Procédez comme suit dans le panneau “Persistent Monitoring” :

a. Sélectionnez Continue dans le menu déroulant Action on error pour
qu’InterChange Server continue de s’exécuter en cas d’erreurs rencontrées
par le sous-systeme de contrdle permanent.

Sélectionnez Shutdown dans le menu déroulant Action on error pour
qu’InterChange Server s’arréte en cas d’erreurs rencontrées par le
sous-systeme.

b. Sélectionnez le niveau de trace de votre choix dans le menu déroulant
Persistent monitoring service pour indiquer le niveau de trace appliqué au
sous-systeme.

Pour plus d’informations sur les éléments de l'interface dans le panneau “Flow
Control”, voir le document System Administration Guide.

Pour plus d’informations sur les éléments de l'interface dans le panneau “Flow
Monitoring”, voir le document System Administration Guide.

Dans le panneau “Workflow Management”, entrez un nombre dans le champ
Business object consumer processor pour indiquer combien d’unités
d’exécution vous voulez générer afin de traiter les objets métier impliqués dans
un processus métier de longue durée.

Ces unités d’exécution transférent les objets métier depuis 'exécution de la
collaboration vers les contréleurs de connecteur correspondants lorsque les
objets métier sont extraits de la mémoire persistante pour reprendre le
traitement dans un processus métier de longue durée. Pour plus d’informations
sur les processus métier de longue durée, voir le document Collaboration
Development Guide.

Pour plus d’informations sur le panneau “Server Memory”, voir |:<Utilisation da
["unité d’exécution du vérificateur de mémoire» a la page 341}
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Configuration des variables d’environnement a l'aide de
System Manager

Dans l'onglet “Environment Properties”, vous pouvez indiquer les propriétés de
I'environnement utilisateur qui peuvent étre requises dans WebSphere Business
Integration. En effet, certains environnements peuvent nécessiter des variables. Au
lieu de les ajouter au script qui démarre InterChange Server, vous pouvez les
ajouter au fichier de configuration a l'aide de I'onglet “Environment Properties”.
Pour ajouter une nouvelle propriété d’environnement, procédez comme suit :

1. Cliquez sur 'onglet Environment Properties.

La représente 'onglet “Environment Properties” dans 1'éditeur du
fichier de configuration de System Manager :

[ Property value

General | Database | Tracing Levels | Trace/Log Files |E-mail Misc Envircnment Properties | WebSphere MQ

Figure 46. Configuration des variables d’environnement d’InterChange Server

2. Indiquez le nom de la propriété dans le champ Property name.
3. Entrez la valeur de la propriété dans le champ Property value.

4. Cliquez sur Add Property.
Pour supprimer une propriété, sélectionnez-la, puis cliquez sur Delete Property.

Pour modifier la valeur d'une propriété, sélectionnez-la et modifiez-la dans la
colonne Property value de la propriété.

Configuration des propriétés de WebSphere MQ a 'aide de
System Manager

Procédez comme suit pour configurer la connexion entre InterChange Server et le
logiciel de messagerie permanente WebSphere MQ :
1. Cliquez sur l'onglet WebSphere MQ.
La [figure 47 a la page 126| représente 1’'onglet “WebSphere MQ” dans I'éditeur
du fichier de configuration de System Manager :
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Channel | cHamEL
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Figure 47. Configuration des propriétés d’InterChange Server WebSphere MQ

2. Entrez le nom de l'ordinateur sur lequel le serveur WebSphere MQ est installé
dans le champ Host name.

3. Entrez dans le champ Port number le port sur lequel WebSphere MQ autorise
les clients a communiquer avec le serveur.

Le port par défaut est 1414.

4. Entrez dans le champ Queue manager name le nom du gestionnaire de files
d’attente qui a été créé pour contenir les files d’attente sur lesquelles
InterChange Server stockera de maniere permanente les messages des flux qu'il
traite.

5. Entrez dans le champ Channel le nom du canal sur lequel les clients de
WebSphere MQ communiquent avec le serveur WebSphere MQ. La valeur par
défaut est CHANNEL1. Consultez I'administrateur WebSphere MQ sur le site pour
déterminer si CHANNEL1 peut étre utilisé et dans le cas contraire, quel canal
utiliser.

Configuration de la sécurité a I’'aide de System Manager

L’une des fonctions principales d’'InterChange Server est d’accorder des droits
d’acces aux utilisateurs qui acceédent au systeme a 1’aide de roles. Cette fonction est
mieux connue sous le nom de fonction RBAC (Role-Based Access Control).
L’administrateur peut définir des roles et les affecter a un groupe d’utilisateurs en
limitant I’acces aux composants clés aux seuls utilisateurs authentifiés.

L’utilisation de la fonction RBAC garantit que seul un administrateur ou des
utilisateurs bénéficiant de 1’autorisation d’administrer les roles sont autorisés a
créer des utilisateurs et a affecter des rdles. Si la fonction RBAC n’est pas activée
sur le serveur, nimporte quel utilisateur peut créer des utilisateurs et des roles
sans avoir a s’authentifier. Par conséquent, si vous souhaitez utiliser le serveur
avec la fonction RBAC activée, indiquez a I'administrateur d’activer la fonction
RBAC une fois le produit installé. Aucun utilisateur ne pourra ainsi activer la
fonction RBAC ou modifier d’autres champs.
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Pour plus d’informations sur la sécurité et le controle d’acces basé sur les roles,
voir le Guide d’administration.

Remarque : Vous pouvez également configurer la sécurité en utilisant le nouveau
parametre -xmsp avec la commande repos_copy. Pour plus
d’informations sur 'utilisation de la commande repos_copy, voir
[Chapitre 6, «Utilisation de repos_copy», a la page 131}

Pour configurer InterChange Server pour utiliser le controle d’acces basé sur les
roles, procédez comme suit :

1. Commencez par créer un utilisateur avec le réle d’administrateur. S’il n’existe
aucun utilisateur doté du role d’administrateur, le serveur se réamorcera avec
la fonction RBAC désactivée méme si cette derniére est activée dans la
configuration d’InterChange Server.

2. Cliquez sur l'onglet Security - RBAC.

La présente I'onglet Security - RBAC dans I'éditeur du fichier de
configuration de System Manager.

B x|

[¥ Enable audit Search criteria

REAC setting LDAP setking

[ Enable REAC LDAP LRL |

User registry |Reposit0ry ﬂ ser name DK |

Server stark user | Password |

Server start password | Userbase DN |

Audit setking User name atkribuke |
|
|

Audit log direckary | CIBMyWebSpherelZSogs) Audit s L e off SeeriEh el

Audit log Frequency |WEEKL\" ﬂ r

pud file size (MB) | 1

Repository details

| Login | wicsadmin
Database | icsrepos Passwiord | BRI Change
Mairnurn number of connections | W' Unlimited |
Mazx conneck retries | 3 Connect: rekry interval | 60 Second(s)

General |Database | Tracing levels | Trace and log files |E-mail | COREA | Miscellaneous | Environment properties | WWebSphere MO | Securiby - REAC | Privacy
Figure 48. Onglet Security dans System Manager

3. Cochez la case Enable RBAC.
4. Dans le menu déroulant User registry, sélectionnez Repository ou LDAP.

Si vous avez choisi Repository, vous devez indiquer les informations suivantes
dans la zone Repository details de I'onglet Security - RBAC :

¢ la base de données ;

* le nombre maximal de connexions, ou sélectionner la case a cocher
Unlimited ;

* le nombre maximal de tentatives de connexion ;

¢ le nom de connexion ;

* le mot de passe ;

* lintervalle entre les nouvelles tentatives de connexion.
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Si vous avez choisi LDAP, vous devez indiquer les informations suivantes dans
la zone LDAP setting de 1'onglet Security - RBAC :

* I'URL du protocole LDAP ;
* le nom distinctif de l'utilisateur ;
* le mot de passe ;

* le nom distinctif du parc utilisateur, qui correspond au nom spécifique de
base ;

* Jattribut du nom d’utilisateur, qui correspond a l'attribut dans le schéma
LDAP qu’InterChange Server utilise comme nom d’utilisateur ;

* les criteres de recherche a utiliser pour extraire les utilisateurs LDAP ;

* le nombre maximal de résultats de recherche, qui correspond au nombre
maximal d’entrées renvoyées a 'issue d'une recherche ;

* le protocole SSL, qui indique si vous voulez sécuriser une connexion entre
InterChange Server et LDAP.

5. Dans le champ Server start user, entrez le nom d’utilisateur qui permet de
démarrer le serveur.

6. Dans le champ Server start password, entrez le mot de passe associé au nom
d’utilisateur.

7. Pour activer les parametres d’audit, sélectionnez la case a cocher Enable audit
et renseignez les champs suivants :

* Audit log directory, qui correspond au chemin d’acces du journal d’audit ;
* Audit log frequency, par exemple, Daily, Weekly ou Monthly ;
* Audit file size (MB), qui correspond a la taille maximale du fichier d’audit.

Pour plus d’informations sur les options de configuration d’InterChange Server,
voir le Guide d’administration.

Configuration de la confidentialité a I’aide de System Manager

La confidentialité de bout-en-bout est une fonction fondamentale d’InterChange
Server. Elle vous permet d’envoyer des messages de maniére sécurisée depuis
I'adaptateur source jusqu’a l'adaptateur cible via InterChange Server.

La vérification d’extrémité est essentielle a tout systeme sécurisé. IBM WebSphere
InterChange Server garantit la sécurité a chaque extrémité du flux d’informations.

Lorsque des communications vers InterChange Server sont acheminées de maniere
asynchrone par transfert JMS, les messages sont stockés sur disque par
l'intermédiaire du gestionnaire de files d’attente en vue de leur traitement. La
confidentialité de bout-en-bout garantit la sécurité de ces messages a ce niveau.

Remarque : Pour plus d’informations sur la confidentialité de bout-en-bout, voir le
Guide d’administration.

Pour configurer InterChange Server de sorte qu’il utilise la confidentialité de
bout-en-bout, procédez comme suit :

1. Cliquez sur 'onglet Privacy.
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Message bype Security level

Destinakion

Mame Security level Destination

all Mone

General | Database | Tracing levels | Trace and log files | E-mail | CORBA | Miscellaneous | Environment properties | webSphere MO | Security - REAC | Privacy

Figure 49. Onglet Privacy dans System Manager

2. Indiquez le chemin d’acces au magasin de clés et le mot de passe associé. Pour
plus d’informations, voir le Guide d’administration.

3.

Cliquez sur Import privacy setting, puis sélectionnez I'un des connecteurs

disponibles. Cette opération a pour effet de charger la configuration de la
confidentialité pour ce connecteur.

Vous pouvez également définir un parametre de confidentialité générale en

procédant comme suit :

a. Dans la zone General privacy setting, cliquez sur All dans la colonne
Message type. Un menu déroulant s’affiche. Sélectionnez un type de
message.

Cliquez sur None dans la colonne Security level.
c. Sélectionnez une cible pour les messages en cliquant deux fois dans une

cellule dans la colonne Destination, par exemple, System Test Connector ou
Destination Connector.

Pour définir un parametre de confidentialité pour un objet métier, procédez
comme suit :

a.

Indiquez le nom de 1'objet métier ou sélectionnez un objet métier dans la
liste figurant dans la colonne Name sous le parametre Individual business
object.

Sélectionnez un niveau de sécurité en cliquant deux fois sur une cellule
dans la colonne Security level et en sélectionnant une option dans la liste
déroulante.

Sélectionnez une cible pour les messages en cliquant deux fois dans une
cellule dans la colonne Destination, par exemple, System Test Connector ou
Destination Connector.

Pour plus d’informations sur les options de configuration d’InterChange Server
concernant la confidentialité de bout-en-bout, voir le Guide d’administration.
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Chapitre 6. Utilisation de repos_copy

L’utilitaire repos_copy est une interface de ligne de commande qui permet de
travailler avec les composants d’intégration et les référentiels d'InterChange Server.
I1 permet de déployer un module (ensemble de composants d’intégration) dans un
référentiel de serveur ou d’exporter des composants depuis le référentiel vers un
module.

Pour exécuter repos_copy, entrez la commande dans une fenétre d’invite de shell
(UNIX) ou d’invite de commande MS-DOS (Windows). Le répertoire
ProductDir/bin dans lequel réside 1'utilitaire doit se trouver dans le chemin suite a
I'installation.

Remarque : Le fichier de sortie de repos_copy contient des mots de passe chiffrés
pour les relations et les applications de connecteur. Si vous tentez
d’ouvrir le fichier de sortie et de modifier ces mots de passe,
repos_copy ne fonctionnera pas.

Important: Lorsque repos_copy déploie les composants dans le référentiel, il les
déploie dans le référentiel uniquement. Il ne les déploie pas dans les
tables en mémoire des définitions d’objet métier. Lorsque la
commande repos_copy est utilisée pour déployer des composants, il
n’est pas nécessaire de redémarrer le serveur. Il doit toutefois étre
redémarré lors de 1'utilisation de la commande repos_copy -d. Dans le
cas contraire, la structure des données stockées en mémoire ne sera
pas mise a jour.

Ce chapitre contient les sections suivantes :

* |«Syntaxe de repos_copy» a la page 131|

+ |«<Exemples d’utilisation de repos_copy» a la page 137

+ |«Environnement local des fichiers de repos_copy» a la page 143|

Pour plus d’informations sur la sauvegarde du systeme, voir System Administration
Guide.

Syntaxe de repos_copy

Le [tableau 10 & la page 132| décrit les options et les arguments de la commande
repos_copy et explique les incidences de la casse et de 1’espacement entre 'option
et son argument. Les options entre accolades ({}) représentent une suite d’options
obligatoires. Si vous ne spécifiez pas les options -u , -p , -i , -0 ou -s sur la ligne
de commande, repos_copy vous les demande. Si vous ne les spécifiez pas a
I'invite, repos_copy ne fonctionne pas. Les options entre crochets ([]) sont
facultatives.

Remarque : De nouveaux arguments sont apparus dans la version 4.2 et certains
anciens arguments n’existent plus. Pour connaitre la liste de ces
arguments, voir [<Nouveaux arguments de la version 4.2» a la pagel
et|«Arguments supprimés de la version 4.2» a la page 137

repos_copy
[-snom_serveur] [-unom utilisateur] [-pmotdepasse]
{-i[nom_fichierl] [-rnom_relation[nom_relation2]][[-k][-ai|-ar|-arp]
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[-xcompilePackage] [-vp|-vr]}

{-o[nom_fichier sortie[[-ffichier_entité][-etype entité:entitél

[+type entité:entite2] [+...]]

[-deep] [-summary] }

{[-d]|[-dotype_entité:entité[+type entité:entité2] [+...]]
[-dfotype_entité:entité[+type_entité:entité2] [+...]}

{-v}
{-vr}
{

[-xCompileAl1]| [-xCompileAl1Col1abs] | [-xCompileAl1Maps] |

[-xCompileCollab:nom modéle collab[+nom modéle collab] [+...]]|
[-xCompileMap:nom_mappe native[+nom_mappe native][+...]]}

Tableau 10. Options de la commande repos_copy

Option

Description

-ai

Ignore et ne charge pas les objets en double
(objets métier, mappes, relations, modeles et objets
de collaboration, connecteurs) détectés lors du
déploiement d'un module.

-ar

Remplace les objets en double (objets métier,
mappes, relations, modeles et objets de
collaboration, connecteurs) détectés lors du
déploiement d’un module.

Remarque : L’option -ar ne fonctionne qu’avec la
version 4.2.0 et les versions ultérieures.

-arp

Version interactive de 1’option -ar. Si un
composant du module en cours de déploiement
existe déja dans le référentiel, repos_copy affiche
une invite qui vous demande si vous voulez
Iignorer ou le remplacer.

Remarque : L’option -arp ne fonctionne qu’avec
la version 4.2.0 et les versions ultérieures.

Supprime les composants dans le référentiel,
hormis les données d’état. Utilisez cette option
pour supprimer tous les composants contenus
dans le référentiel.

-deep

Option utilisée avec -e quand vous voulez inclure
tous les composants dépendants. Si vous omettez
I'option -deep, seul le composant spécifié avec
l'option -e sera inclus.

-dfotype_entité:entité[+type_entité:entité2]

Cette option est identique a I'option -do hormis
qu’elle supprime toujours le composant méme s'il
possede des référents qui en dépendent. Cette
option ne fonctionne qu’avec le référentiel d'un
serveur exécuté en mode conception. Un serveur
qui s’exécute en mode production n’autorise pas
les références et les dépendances non résolues.

-do type_entité:entité[+type entité:entité?]

Indique les entités a supprimer du référentiel. Voir
[tableau 11 & la page 136 pour obtenir la liste des
types d’entité et des mots clés. Si I'objet n’a pas
de référent (des composants qui en dépendent), la
suppression a lieu. Dans le cas contraire, la
suppression échoue et un message s’affiche. Le
comportement est le méme en mode conception et
en mode production. Pour plus d’informations sur
le démarrage du serveur en mode conception ou
production, voir System Implementation Guide.

132  IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server




Tableau 10. Options de la commande repos_copy (suite)

Option

Description

-etype_entité:entitél[+type entité:entité2...]

Exporte une ou plusieurs entités de premiere
classe référencées. Une entité de premiere classe
peut étre un objet métier, un objet de
collaboration, un modeéle de collaboration, un
connecteur, un pool de connexions a une base de
données, une mappe ou une relation. Vous
identifiez I'entité a charger ou a décharger en
spécifiant I'un des mots clés contenus dans le
[tableau 11 a la page 136

Apres le mot clé type_entité, ajoutez deux points
(:) puis le nom de I'entité. Utilisez le signe “+”
pour spécifier plusieurs entités. Quand elle est
combinée avec l'option -o, I'option -e décharge
les données dans un fichier de sortie.

-ffichier_entite

Cette option est identique a I'option -e hormis
que les noms des entités a importer sont stockés
dans un fichier. Le fichier doit contenir des
références aux entités. Les conditions suivantes
doivent étre respectées :

e Les noms des entités doivent suivre le mot clé
type_entité qui convient. Les types d’entité et
leurs mots clés sont répertoriés dans le
[tableau 11 & la page 136]

* Le type d’entité et le nom de l’entité sont
séparés par deux points (:).

* Chaque référence d’entité doit étre entrée sur
une ligne séparée.

Quand elle est combinée avec l'option -o, cette
option exporte les composants dans un module.

-inom_fichier

Déploie le fichier de module spécifié dans le
référentiel. Si vous omettez le nom du fichier
d’entrée, la commande vous demande de
I'indiquer. Ce fichier peut étre un fichier de type
.jar contenant des objets au format XML ou un
fichier texte issu d’une version antérieure a la
version 4.2.0.

Le fichier .jar créé par repos_copy ou System
Manager a une structure particuliere qui doit étre
conservée pour que les importations ultérieures de
ce type de fichier réussissent. Vous ne devez donc
jamais modifier manuellement un fichier d’entrée.

Modifie le comportement par défaut de la
commande repos_copy quand elle trouve une
mappe de Mercator dans le fichier de module
qu’elle charge. Par défaut, la commande
repos_copy s’arréte quand elle trouve une mappe
de Mercator. Si vous utilisez 1'option -k,
repos_copy ignore les mappes de Mercator dans le
fichier de module et continue le processus de
déploiement.

Chapitre 6. Utilisation de repos_copy 133



Tableau 10. Options de la commande repos_copy (suite)

Option Description

-mode Revient au mode du serveur. Pour plus
d’informations sur les modes d’'InterChange
Server, voir Guide d'implémentation de WebSphere
InterChange Server.

-nccodage Spécifie le codage de caracteres a utiliser pour

importer un fichier de référentiel au format texte
antérieur a la version 4.2.0.

Pour obtenir la liste des codages de caracteres
valides, voir la documentation Java sur la classe
String.

-onom_fichier de sortie

Exporte les composants contenus dans le
référentiel vers le fichier de module spécifié. Vous
devez indiquer le nom du fichier de module. Si ce
fichier existe déja, repos_copy vous demande s'il
faut le remplacer ou non. Le fichier de sortie est
au format .jar et contient les définitions de
composant au format XML ainsi que les fichiers
source .java pour les composants qui en
possedent. Cette option ne peut pas se combiner
avec les options -1 ou -d. Elle ne permet pas non
plus d’exporter des composants au format texte
comme dans les versions antérieures. La
commande repos_copy n’ajoute pas l’extension
.Jjar et vous devez donc I'indiquer quand vous
spécifiez le nom du fichier de sortie.

-pmot de passe

Spécifie le mot de passe associé au nom
d’utilisateur fourni avec 'option -u. Le mot de
passe distingue les majuscules et les minuscules.
Si vous ne spécifiez pas cette option, la
commande repos_copy vous demande d’entrer le
mot de passe.

-r*

Cette option est identique a I'option -r ; elle
permet d’importer les définitions des relations
sans créer les schémas d’exécution associés.

-rnom_relationl[:nom relation2]

Charge la ou les définitions de relation indiquées
dans le référentiel sans créer de schéma
d’exécution.

-snom_serveur

Spécifie le nom de l'instance d'InterChange Server
avec laquelle repos_copy doit s’interfacer. Ce nom
fait la différence entre les majuscules et les
minuscules. Si le nom du serveur n’est pas
indiqué, repos_copy vous demande de l’entrer.

-summary

Cette option affiche la liste des composants
contenus dans le référentiel du serveur (ils sont
identifiés comme “objets” au lieu de composants
dans la sortie). La sortie est au format XML. Vous
pouvez combiner cette option avec 1'option -0
pour enregistrer la sortie dans un fichier au lieu
de l'afficher sur la console.

-unom_utilisateur

Spécifie le nom de 1'utilisateur a connecter a
InterChange Server. Si aucun nom d’utilisateur
n’est spécifié, repos_copy vous demande de
I'indiquer.
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Tableau 10. Options de la commande repos_copy (suite)

Option

Description

=V

Affiche le numéro de version du programme que
l'utilitaire repos_copy exécute.

_Vp

Valide un fichier de module. Le serveur valide les
modules par rapport au référentiel et s’assure que
les dépendances présentes parmi les composants
du module sont résolues. Si la validation échoue,
repos_copy affiche la liste des dépendances
manquantes. Cette option n’apporte pas de
modifications au référentiel ; elle ne fait que
valider le fichier de module. Quand vous utilisez
I'option -vp, vous devez aussi utiliser I'option -i
pour indiquer le fichier de module a valider.

-vr

Valide le référentiel. Le message de sortie indique
si la validation a réussi ou non. Si la validation
échoue, repos_copy affiche la liste des
dépendances manquantes.

Quand cette option est spécifiée, repos_copy
n’affiche aucun des avertissements qui peuvent
étre émis au cours de la compilation des mappes
ou des modeles de collaboration. Seules les
erreurs qui surviennent au cours de la
compilation sont affichées. Ceci vous permet
d’ignorer les avertissements sur les méthodes
déconseillées par exemple.

-xCompileAll

Compile toutes les mappes et les modéles de
collaboration contenus dans le référentiel. Cette
option n’est valide que pour les mappes et les
modeles de collaboration créés avec la version 4.2
ou une version ultérieure.

-xCompileAl1Collabs

Compile tous les modeéles de collaboration
contenus dans le référentiel. Cette option n’est
valide que pour les modeles de collaboration créés
avec la version 4.2 ou une version ultérieure.

-xCompiTleAl1Maps

Compile toutes les mappes contenues dans le
référentiel. Cette option n’est valide que pour les
mappes créées avec la version 4.2 ou une version
ultérieure.

-xCompileCollab:nom_modéle de collaboration[+nom_modéle de
collaboration]

Compile le modeéle de collaboration spécifié dans
le référentiel. Cette option n’est valide que pour
les modeles de collaboration créés avec la version
4.2 ou une version ultérieure.

-xCompileMap:nom_mappe native[+nom_mappe native]

Compile les mappes spécifiées dans le référentiel.
Cette option n’est valide que pour les mappes
créées avec la version 4.2 ou une version
ultérieure.
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Tableau 10. Options de la commande repos_copy (suite)

Option

Description

-xCompilePackage

Compile automatiquement le module en cours de
déploiement sur le serveur. Dans la mesure ot le
serveur en mode production compile
automatiquement tous les modules, cette option
ne s’applique qu’aux serveurs en mode
conception. Pour obtenir une description complete
des modes d’InterChange Server, voir le
document System Implementation Guide.
Remarque: Cette option ne fonctionne que si
vous déployez des composants de la version 4.2.
Si les composants sont issus d"une version
antérieure, cette option sera ignorée.

-xdi Permet d’exporter les propriétés de temps du
déploiement dans System Manager.

-xdn Permet d’ignorer les propriétés de temps du
déploiement qui font partie du fichier repos_copy.

-Xmsp Importe et exporte les informations relatives a

l'appartenance et a la sécurité afin de procéder a
des mises a niveau sans recréer les roles et les
regles de sécurité.

Tableau 11. Mots clés des différents types d’entité

Type d’entité

Mot clé

objet métier

BusObj

objet de collaboration

Collaboration

modele de collaboration

CollabTemplate

pool de connexions a une base de données | ConnectionPool

connecteur Connector
mappe Map
relation Relationship

Nouveaux arguments de la version 4.3

La liste suivante contient toutes les nouvelles options de la commande repos_copy

pour la version 4.3 :

o -xdi
e -xdn
° -Xmsp

Nouveaux arguments de la version 4.2

La liste suivante contient toutes les nouvelles options de la commande repos_copy

pour la version 4.2 :

» -dfotype entité:entité[+type_entité:entitéz]

» -dotype_entité:entité[+type_entité:entité2]

* -mode
L] _Y‘*
* —summary
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* -wi
» -xCompilePackage

Arguments supprimés de la version 4.2

Le tableau suivant répertorie les arguments de la commande repos_copy qui ont

été supprimés dans

Tableau 12. Arguments supprimés pour repos_copy

Arguments supprimés

Motif de la suppression

[-xCompileUpdated]
xCompileUpdatedCollabs]

Toutes les options de compilation des mises a jour ont été
supprimées car le serveur ne prend pas en charge les
mappes ou les modeles antérieurs a la version 4.x.

[-
[-xCompileUpdatedMaps]
[-

xUncompress]

Dans le nouveau format de module, toutes les définitions
sont stockées dans le format d’archive Java (JAR) au lieu
d’utiliser un algorithme de compression propriétaire.
L’argument -xUncompress n’est donc plus nécessaire.

[-eProject][-w]

Le type de projet n’est plus pris en charge avec l'option -e.
Les projets sont a présent gérés dans le systeme de fichiers
local par System Manager au lieu de 1’étre par le serveur.

Exemples d’utilisation de repos_copy

Cette section décrit quelques situations courantes dans lesquelles vous pourrez
utiliser repos_copy. Elle contient les sous-sections suivantes :

+ |«Sortie de la commande repos_copy»|

+ [«Validation d’un module» a la page 138§|

» |«Validation d’'un module» a la page 138|

+ [«Déploiement d’un module dans le référentiel» a la page 138

» |<Importation et exportation des informations relatives a I’appartenance dans et

depuis le référentiel» a la page 140|

* |«Suppression de composants dans le référentiel» a la page 141|

[«Exportation de composants dans un module» a la page 142|

[«Edition de la liste des composants d’un référentiel» a la page 143|

Sortie de la commande repos_copy

Vous pouvez exécuter repos_copy sans arguments pour obtenir une sortie.
L’exemple suivant montre 1'utilisation de repos_copy sans argument et la sortie

correspondante :
C:\>repos_copy

Aucun argument de ligne de commande n'a été spécifié avec repos_copy.
Syntaxe : repos_copy {-o[fichier de sortie] | -i[fichier d'entrée]}
[-snom_serveur] [-unom utilisateur] [-pmotdepasse]
[-ai] [-ar] [-arp] [-d] [-k] [-v]

[-etype_entité:nom_entitél[+type_entité:nom_entité2] -deep]

[-ffichier_entité]

[-rnom_relationl[:nom_relation2] ]

[-xCompileAl1] [-xCompileAl1Collabs] [-xCompileAllMaps]
[-xCompileCollab:nom_modéle collab[+nom modéle collab]]
[-xCompileMap:nom_mappe native[+nom_mappe native]]

[-xcompilepackage]
[-mode]

[-dotype_entité:nom_entitél[+type entité:nom entité2] -deep]
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[-dfotype_entité:nom_entitél[+type_entité:nom_entité2] -deep]
[-summary]

[-vp]

[-vr]

Validation d’un module

Vous pouvez valider un module de composants avant de le déployer sur un
serveur. Cela est particulierement utile car lorsque vous déployez un module sur
un serveur en mode production, toutes les dépendances doivent étre résolues,
faute de quoi le déploiement échoue. Vous ne pouvez pas valider un projet
d’utilisateur ou une bibliotheque de composants d’intégration dans System
Manager pour vous assurer que les dépendances sont satisfaites. La seule maniere
de savoir si un module est valide quand vous le déployez avec System Manager
consiste a lancer le déploiement et a utiliser les données d’erreur pour résoudre les
dépendances en cas d’échec. Si le module contient beaucoup de composants, ce
processus peut demander du temps.

Vous ne pouvez pas valider une bibliotheque de composants d’intégration
directement mais vous pouvez 'exporter dans un fichier de module puis valider ce
dernier avec repos_copy.

Pour valider un module avec repos_copy, utilisez 'option -i pour spécifier le nom
du fichier de module a valider et 'argument -vp afin de le valider au lieu de le
déployer.

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iWebSphereICS420DEVServer. jar -vp

La commande repos_copy valide le contenu du module et affiche un message qui
indique si les dépendances ont été résolues ou non.

Déploiement d’un module dans le référentiel

L’option -1 vous permet de déployer un module de composants dans le référentiel.
Si vous ne spécifiez pas le nom du fichier de module, un message vous demande
de l'indiquer.

L’exemple qui suit illustre le déploiement d'un fichier nommé
WebSphereICS420DEVServer. jar dans un référentiel :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iWebSphereICS420DEVServer. jar

Si vous avez créé le fichier repos_copy depuis System Manager, les propriétés de la
phase de déploiement sont automatiquement incluses. Lorsque ce fichier est copié
sur le serveur, ces propriétés sont appliquées aux composants avant qu’ils ne soient
envoyés au serveur. Si le fichier repos_copy a été créé grace a une copie du
contenu en dehors du serveur, il ne contiendra pas les propriétés de la phase de
déploiement. Dans ce cas, vous pouvez exporter les propriétés de la phase de
déploiement depuis System Manager sous la forme d’un fichier du descripteur de
déploiement a 'aide de 'option -xdi. Si l'option -xdi est utilisée alors que les
propriétés de la phase de déploiement se trouvent déja dans le fichier repos_copy,
les propriétés spécifiées dans le fichier du descripteur de déploiement remplacent
alors celles indiquées dans le fichier repos_copy.

La syntaxe de la commande repos_copy est la suivante :

reposcopy -sservername -uusername -ppassword -ireposcopyfile
-xdideploymentdescriptorfile
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La configuration du déploiement du fichier repos_copy peut étre ignorée grace a
l'option -xdn, comme suit :

reposcopy -sservername -uusername -ppassword -ireposcopyfile -xdn

Remarque : Si l'option -xdn est utilisée avec l'option -xdi, l'option -xdi est alors
ignorée.

Traitement des composants en double au cours du déploiement
On trouvera souvent des composants portant le méme nom dans un fichier de
module comme dans le référentiel. Dans ce cas, vous devez décider si vous voulez
ou non remplacer les composants du référentiel par ceux du fichier de module.
L’option -ai spécifie que les composants en double ne doivent pas étre chargés
dans le référentiel :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iCustomer.jar -ai

Si vous voulez remplacer tous les composants en double dans le référentiel, utilisez
l'option -ar comme dans I'exemple suivant :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iCustomerSyncInterface.jar -ar

Vous pouvez aussi utiliser 1'option -arp pour remplacer en mode interactif les
composants en double dans le référentiel. Cela vous permet de décider pour
chaque composant en double si le remplacement doit avoir lieu ou non.

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iCustomerSyncInterface.jar -arp

Remarque : Les options -ar et -arp ne fonctionnent qu’avec la version 4.2.0 et les
versions ultérieures.

Compilation et création de schémas

Pour que les mappes et les modeles de collaboration s’exécutent au démarrage, ils
doivent étre compilés. Pour que les relations fonctionnent correctement au
démarrage, leurs schémas doivent avoir été créés.

Quand vous déployez des composants sur un serveur en mode production, tous
les modeles sont automatiquement compilés et tous les schémas de relation sont
créés. Pour que le déploiement aboutisse, le code de la mappe et les modeles de
collaboration doivent étre valides et InterChange Server doit pouvoir communiquer
avec la base de données spécifiée dans les parametres des définitions de relation.

Quand vous déployez des composants sur un serveur en mode conception, les
modeles ne sont pas automatiquement compilés mais les schémas de relation sont
créés. Il existe toutefois des options que vous pouvez utiliser pour compiler les
modeles et d’autres qui permettent de ne pas créer les schémas de relation.

La syntaxe suivante utilise 'option -xCompilePackage sans l'option -r . Quand le
module désigné par l'option -1 est déployé, les mappes et les modeles de
collaboration sont compilés et des schémas sont créés pour les relations :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iWebSphereICS420DEVServer.jar -xCompilePackage

I arrive qu’on ne souhaite pas créer de schéma de relation lors d'un déploiement.
Par exemple, quand vous déployez un module d’un environnement dans un autre
et que vous n’avez pas changé les propriétés des relations afin d’utiliser les

ressources de base de données dans le nouvel environnement, vous ne voulez pas
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créer les schémas avant d’avoir modifié les propriétés appropriées. La syntaxe
suivante utilise l'option -r#* pour ne pas créer les schémas des relations contenues
dans le module déployé.

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-iWebSphereICS420DEVServer.jar -xCompilePackage -r=*

Remarque : Vous pouvez utiliser 1’option -r sans astérisque pour indiquer
individuellement les noms des relations dont les schémas ne doivent
pas étre créés. Par exemple :

-rCustomer:Order ne crée pas de schéma pour les relations Customer et
Order mais en crée pour toutes les autres relations contenues dans le
module déployé.

Important : Bien qu’il existe des options pour compiler les mappes et les modéles
de collaboration apres le déploiement, ni la commande repos_copy ni
System Manager ne permettent de créer le schéma d’une relation
autrement que pendant le déploiement. Si vous choisissez de ne pas
créer le schéma d’une relation au cours du déploiement parce que
vous avez besoin de changer les parametres de la base de données,
vous devez redéployer la relation ensuite et permettre a repos_copy de
créer le schéma pour la relation.

Importation et exportation des informations relatives a
I’appartenance dans et depuis le référentiel

Les informations relatives a 'appartenance et a la sécurité peuvent étre importées
et exportées depuis la commande repos_copy a 'aide de I'option -xmsp, comme
indiqué dans 1’exemple suivant :

repos_copy -sServerName -uUserName -pPassword -oOutputfile -xmsp

Validation du référentiel

Le référentiel doit étre dans un état valide pour qu'une instance du serveur puisse
démarrer en mode production. La raison en est que le référentiel doit étre valide
pour que le serveur puisse traiter les flux de données. Utilisez 'option -vr pour
valider un référentiel de serveur, comme dans l'exemple ci-dessous :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull -vr

Si le serveur est valide, repos_copy affiche la sortie suivante sur la console :
Validation Succeeded.A11 Dependencies Resolved.

Si le référentiel n’est pas valide, repos_copy affiche la liste des dépendances qui
doivent étre résolues.

Compilation de composants dans le référentiel

Si vous avez déployé des mappes ou des modeles de collaboration dans le
référentiel et que vous ne les avez pas compilés au cours du déploiement, vous
pouvez utiliser repos_copy pour les compiler par la suite. Cela peut étre utile
quand les composants a déployer sont nombreux car le déploiement peut prendre
du temps et la compilation peut 1’étendre encore. Attendre que le déploiement soit
terminé pour faire la compilation peut réduire le temps de la migration si une
erreur se produit.

L’exemple suivant montre comment utiliser 1’option -xCompileAll pour compiler
toutes les mappes et les modeles de collaboration dans le référentiel :
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C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-xCompileAll

11 existe aussi des options pour compiler tous les composants d'un type donné.
Utilisez -xCompileAl1Col1abs pour compiler tous les modeles de collaboration et
-xCompileAlTMaps pour compiler toutes les mappes. L’exemple ci-dessous montre
comment utiliser

-xCompileAlTMaps:

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-xCompileAllMaps

De méme que vous pouvez compiler tous les composants d'un type donné, vous
pouvez aussi ne compiler qu’un seul composant. Utilisez 1’option -xCompileColTab
ou -xCompileMap suivie de deux points (:) puis du nom du modele de collaboration
ou de la mappe pour compiler ce composant. L’exemple suivant montre comment
compiler un modele de collaboration nommé CustomerSync :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-xCompileCollab:CustomerSync

Remarque : Les options de compilation ne fonctionnent qu’avec WebSphere
InterChange Server version 4.2.0 et ultérieure.

Suppression de composants dans le référentiel

La commande repos_copy a plusieurs options qui permettent de supprimer des
composants dans le référentiel. Vous pouvez supprimer tout le référentiel, des
composants individuels, ou des composants et les composants qui les référencent.

Remarque : Les composants doivent étre inactifs pour que vous puissiez les
supprimer. Si vous supprimez un unique composant, vous devez le
désactiver préalablement ou la suppression échouera. Si vous voulez
supprimer un composant et tous les composants qui le référencent,
vous devez désactiver 'ensemble de ces composants. Vous pouvez
supprimer 1’ensemble du référentiel quand les composants ont 1'état
actif. Utilisez System Monitor ou web-based System Monitor pour
gérer |'état des composants. System Monitor et web-based System
Monitor sont décrits dans le document System Administration Guide.

Suppression de l'intégralité du référentiel
Utilisez 'option -d pour supprimer tous les composants contenus dans le
référentiel. L’exemple qui suit montre la syntaxe a utiliser :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin
-pnull -d

La commande repos_copy vous demande si vous voulez supprimer tout le
référentiel ou non.

Suppression de composants sans référents

Si un composant n’a pas de référents (d’autres composants qui le référencent et
nécessitent qu’il existe pour pouvoir remplir leur fonction dans le systeme), vous
pouvez alors le supprimer.

Utilisez 'option -do suivie du type d’entité, de deux points (:) et du nom du
composant. Les types d’entité sont répertoriés dans le [tableau 11 a la page 136}
L’exemple suivant montre comment supprimer une relation nommée Customer :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin
-pnull -doRelationship:Customer
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Suppression de composants avec référents

Si un composant a des référents (d’autres composants qui le référencent et
nécessitent qu’il existe pour pouvoir remplir leur fonction dans le systéme), vous
ne pouvez alors le supprimer que si le serveur s’exécute en mode conception et
avec certaines options uniquement.

Suppression forcée en cas de références: Siun composant a des référents,
repos_copy ne vous permet pas de les supprimer avec I'option -do. Vous devez
utiliser 1'option -dfo pour forcer la suppression d'un composant doté de référents.
La suppression forcée d’un composant doté de référents laisse le référentiel dans
un état incohérent, ce qu'un serveur en mode production ne permet pas. Cette
option ne fonctionne donc qu’avec un serveur exécuté en mode conception.
L’exemple suivant montre comment utiliser 1’option -dfo pour supprimer 1'objet
métier Order qui est référencé par d’autres composants du systeme (par exemple
des mappes et des relations) :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-dfoBusObj:0rder

Suppression simultanée des référents: Une autre maniere de supprimer un
composant doté de référents consiste a utiliser 1’option -deep afin de supprimer
aussi ces référents. Seront supprimés le composant et tous les composants qui le
référencent. L’exemple suivant montre comment utiliser les options -deep et -do
pour supprimer 1’objet métier Customer :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-doBusObj:Customer -deep

A la différence de 'option -dfo, cette option est prise en charge par les serveurs
exécutés en mode production car supprimer les référents en méme temps que le
composant garantit que le référentiel reste valide. Gardez a l’esprit toutefois que de
nombreux composants peuvent étre supprimés dans ce cas ; ayez conscience des
implications de cette action avant de 'exécuter.

Exportation de composants dans un module

L’option -0 vous permet d’exporter des composants depuis le référentiel dans un
module. Vous devez indiquer le nom du fichier de module. Quand vous utilisez
l'option -0 seule, I'ensemble du référentiel est exporté dans un fichier, comme dans
I'exemple qui suit :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-oWebSphereICS420DEVServer. jar

Vous pouvez demander 'exportation de composants spécifiques avec 'option -e.
Vous devez utiliser I'option -e avec le mot clé type_entité approprié (voir la liste
dans le [tableau 11 a la page 136) suivi du nom du composant. Vous pouvez
spécifier plusieurs composants en les regroupant a l'aide du signe plus (+). Dans
I'exemple suivant, I’'objet métier Customer et le modele de collaboration
CustomerSync sont exportés dans un module nommé CustomerSyncInterface.jar.

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-eBusObj:Customer+CollabTemplate:CustomerSync -oCustomerSyncInterface.jar

Vous pouvez utiliser 1'option -deep pour exporter également les dépendances d'un
composant. Dans I'exemple précédent, I'objet métier Customer a été exporté mais
pas ses objets métier enfants. L’exemple qui suit montre comment utiliser 1’option
-deep pour exporter 'objet de collaboration CustomerSync_ClarifyToSAP et toutes
ses dépendances.
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C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-eCollaboration:CustomerSync_ClarifyToSAP -oCustomerSyncInterface.jar -deep

Si vous voulez exporter des composants spécifiques sans entrer le type et les noms
de composant, vous pouvez les enregistrer dans un fichier texte et utiliser I'option
-f. Cela est pratique quand vous voulez exporter souvent les mémes composants.
L’exemple qui suit montre comment utiliser I’option -f pour charger les
composants listés dans un fichier texte nommé Components.txt :

C:\WebSphereICS420DEV>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull
-fComponents.txt -oCustomerSyncInterface.jar -deep

Le contenu du fichier Components.txt apparait ci-dessous ; chaque couple
type_entité /nom_entité apparait sur une ligne distincte :
BusObj:Customer

Relationship:Customer
CollabTemplate:CustomerSync

Remarque : La commande repos_copy et System Manager n’identifient pas les
dépendances de la méme maniere. Si vous essayez de supprimer un
composant avec repos_copy et que d’autres composants en dépendent,
repos_copy considere ces composants référents comme des
dépendances. En revanche, si vous cliquez a l'aide du bouton droit de
la souris sur le composant dans System Manager et que vous
sélectionnez Show Dependencies dans le menu contextuel, System
Manager répertorie les composants dont le composant sélectionné
dépend.

Edition de la liste des composants d’un référentiel

Vous pouvez utiliser 'argument -summary avec la commande repos_copy pour
obtenir la liste des composants contenus dans le référentiel. La sortie est éditée au
format XML. Bien que ce ne soit pas nécessairement utile, vous pouvez combiner
les arguments -summary et -0 pour réacheminer la sortie dans un fichier puis
regarder ce dernier dans un navigateur ou un éditeur XML. La syntaxe de la
commande sera alors la suivante :

C:\>repos_copy -sWebSphereICS420DEVServer -uadmin -pnull -summary -oRepository.xml

Environnement local des fichiers de repos_copy

L’utilitaire repos_copy lit les métadonnées depuis le référentiel et écrit les données
dans des fichiers au format Unicode (UTEF-8). Il peut aussi lire ce type de fichier et
les charger dans le référentiel en Unicode (UTF-8 ou UCS-2, selon la base de
données du référentiel sous-jacent).

Les fichiers repos_copy créés avec IBM WebSphere ICS dans des versions
antérieures a la 4.1.1 ne peuvent étre chargés dans le référentiel que si les dates et
heures des plannings de composants sont au format US. (Cela ne pose
généralement pas de probleme car repos_copy enregistre toutes les dates de
planning au format US uniquement. L’incompatibilité se produit généralement

/////
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Chapitre 7. Configuration des connecteurs

Ce chapitre décrit les procédures de configuration de WebSphere Business
Integration Adapters et contient les sections suivantes :

» |«Utilisation de Connector Configurator»|

* |«Propriétés standard des connecteurs» a la page 164]

Pour plus d’informations sur le développement de WebSphere Business Integration
Adapters, voir le document Connector Development Guide.

Utilisation de Connector Configurator

Cette annexe décrit comment utiliser Connector Configurator pour définir les
valeurs des propriétés de configuration de votre adaptateur.

Connector Configurator permet de réaliser les opérations suivantes :

¢ Créer un modele de propriété spécifique a un connecteur afin de le configurer
* Créer un fichier de configuration

* Définir les propriétés dans un fichier de configuration

Cette annexe couvre les sujets suivants :

+ |«Présentation générale de Connector Configurator» a la page 145

+ |«Démarrage de Connector Configurator» a la page 146|

+ [«Création d’un modéle de propriété spécifique au connecteur» a la page 147

* [«Création d’un fichier de configuration» a la page 150)|

* |«Définition des propriétés d'un fichier de configuration» a la page 153|

« |«Utilisation de Connector Configurator dans un environnement globalisé» a la|

[page 163|
Présentation générale de Connector Configurator

Connector Configurator vous permet de configurer le connecteur de votre
adaptateur afin d’utiliser les courtiers d’intégration suivants :
* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker et WebSphere
Business Integration Message Broker, désignés collectivement sous 1’appellation
WebSphere Message Brokers (WMQI)

* WebSphere Application Server (WAS)

Si votre adaptateur prend en charge DB2 Information Integrator, utilisez les options
de WMOQI et les propriétés standard DB2 II (voir la colonne Remarques de 1’annexe
Propriétés standard).

Connector Configurator permet de réaliser les opérations suivantes :
* Créer un modele de propriété spécifique a un connecteur afin de le configurer

* Créer un fichier de configuration de connecteur (vous devez créer un fichier de
configuration par connecteur a installer)

* Définir les propriétés dans un fichier de configuration
Vous devrez peut-étre modifier les valeurs par défaut définies pour les
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propriétés dans les modeles de connecteur. Vous devez également déterminer les
définitions d’objet métier prises en charge, indiquer les mappes a utiliser avec
les collaborations a 1'aide d’ICS et spécifier les parameétres d’application de
messagerie, de journalisation, de trace ainsi que ceux du gestionnaire de
données, le cas échéant.

Le mode dans lequel vous exécutez Connector Configurator et le type de fichier de
configuration que vous utilisez peuvent différer en fonction du courtier
d’intégration que vous exécutez. Par exemple, si vous utilisez WMQI comme
courtier, vous exécutez Connector Configurator directement, et non a partir de

System Manager (voir [«Exécution de Connector Configurator en mode autonome»|
_-

Les propriétés de configuration du connecteur incluent des propriétés de
configuration standard (les propriétés communes a tous les connecteurs) et des
propriétés spécifiques au connecteur (propriétés requises par le connecteur pour
une technologie ou une application spécifique).

Dans la mesure ou les propriétés standard sont utilisées par tous les connecteurs,
vous n’avez pas besoin de définir ces propriétés de toute piece ; Connector
Configurator les incorpore a votre fichier de configuration des que vous créez ce
fichier. Cependant, vous devez définir la valeur de chaque propriété standard dans
Connector Configurator.

L’intervalle des propriétés standard peut étre différent pour tous les courtiers et
toutes les configurations. Certaines propriétés ne sont disponibles que si vous
attribuez une valeur spécifique a d’autres propriétés. La fenétre des propriétés
standard dans Connector Configurator affiche les propriétés disponibles pour votre
configuration spécifique.

Cependant, pour les propriétés spécifiques au connecteur, vous devez d’abord
définir les propriétés, puis leur attribuer une valeur. Pour ce faire, créez un modele
de propriétés spécifiques au connecteur pour votre adaptateur particulier. Il se peut
qu'un modele soit déja configuré dans votre systeme, auquel cas vous pouvez
l"utiliser. Dans le cas contraire, suivez les étapes décrites dans la section
[d’un nouveau modéle» a la page 148 pour configurer un nouveau modele .

Exécution de connecteurs sur UNIX

Connector Configurator s’exécute uniquement dans 1’environnement Windows. Si
vous exécutez le connecteur dans un environnement UNIX, utilisez Connector
Configurator dans Windows pour modifier le fichier de configuration, puis copiez
le fichier dans votre environnement UNIX.

Certaines propriétés contenues dans Connector Configurator ont recours a des
chemins de répertoire qui utilisent par défaut la convention Windows pour les
chemins de répertoire. Si vous utilisez le fichier de configuration dans un
environnement UNIX, revoyez les chemins de répertoire pour qu’ils correspondent
a la convention UNIX. Sélectionnez le systeme d’exploitation cible dans la liste
déroulante de la barre d’outils de sorte que les regles appropriées du systeme
d’exploitation soient utilisées pour la validation étendue.

Démarrage de Connector Configurator

Vous pouvez démarrer et exécuter Connector Configurator dans 1'un de ces deux
modes :

* de maniere indépendante, en mode autonome ;
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* depuis System Manager.

Exécution de Connector Configurator en mode autonome

Vous pouvez exécuter Connector Configurator sans exécuter System Manager et
utiliser les fichiers de configuration de connecteur indépendamment de votre
courtier.

Pour ce faire, procédez comme suit :

* Sélectionnez Démarrer>Programmes, puis cliquez sur IBM WebSphere Business
Integration Adapters>IBM WebSphere Business Integration Toolset>Connector
Configurator.

* Sélectionnez File>New>Connector Configuration.

* Lorsque vous cliquez sur le menu déroulant en regard de System Connectivity

Integration Broker, vous pouvez sélectionner ICS, WebSphere Message Brokers
ou WAS, en fonction de votre courtier.

Vous pouvez choisir d’exécuter Connector Configurator en mode autonome pour
créer le fichier, puis de vous connecter a System Manager afin de l’enregistrer dans

un projet System Manager (voir [«Remplissage d’un fichier de configuration» a la|

Exécution de Configurator depuis System Manager

Vous pouvez exécuter Connector Configurator a partir de System Manager.

Pour exécuter Connector Configurator, procédez comme suit :
1. Ouvrez System Manager.

2. Dans la fenétre System Manager, développez l'icone Integration Component
Libraries et mettez en évidence Connectors.

3. Dans la barre de menus de System Manager, cliquez sur Tools>Connector
Configurator. La fenétre Connector Configurator affiche la boite de dialogue
New Connector.

4. Quand vous cliquez sur le menu déroulant a co6té de System Connectivity
Integration Broker, vous pouvez sélectionner ICS, WebSphere Message Brokers
ou WAS, en fonction de votre courtier.

Pour modifier un fichier de configuration existant, procédez comme suit :

* Dans la fenétre System Manager, sélectionnez 1'un des fichiers de configuration
répertoriés dans le dossier du connecteur et cliquez dessus avec le bouton droit.
Connector Configurator affiche le fichier de configuration avec le type de
courtier d’intégration et le nom de fichier dans la partie supérieure.

* Dans Connector Configurator, sélectionnez File>Open. Sélectionnez le nom du
fichier de configuration du connecteur dans un projet ou dans le répertoire dans
lequel il est stocké.

* Cliquez sur 'onglet Standard Properties pour afficher les propriétés contenues
dans ce fichier de configuration.

Création d’un modele de propriété spécifique au connecteur

Pour créer un fichier de configuration pour votre connecteur, vous avez besoin
d’un modele de propriété spécifique au connecteur et des propriétés standard
fournies par le systéme.

Vous pouvez créer un nouveau modeéle pour les propriétés spécifiques au
connecteur ou utiliser comme modéle une définition de connecteur existante.
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* Pour créer un nouveau modéle, voir [«Création d’un nouveau modele» a la page
148

e Pour utiliser un fichier existant, il vous suffit de modifier un modele existant et
de 'enregistrer sous le nouveau nom. Vous pouvez trouver des modeles
existants dans le répertoire \WebSphereAdapters\bin\Data\App.

Création d’un nouveau modeéle

Cette section décrit comment créer des propriétés dans le modéle, définir les
valeurs et les caractéristiques générales de ces propriétés et indiquer toutes les
dépendances entre les propriétés. Ensuite, vous pouvez utiliser le modéle comme
base pour la création d’un nouveau fichier de configuration du connecteur.

Pour créer un modele dans Connector Configurator, procédez comme suit :
1. Cliquez sur File>New>Connector-Specific Property Template.
2. La boite de dialogue Connector-Specific Property Template s’affiche.

* Entrez le nom du nouveau modeéle dans la zone Name située sous Input a
New Template Name. Ce nom apparaitra quand vous ouvrirez la boite de
dialogue pour créer un nouveau fichier de configuration a partir d’'un
modele.

* Pour afficher les définitions de propriétés spécifiques au connecteur dans
n’importe quel modeéle, sélectionnez le nom de ce modéle dans 1’écran
Template Name. La liste des définitions de propriétés contenues dans ce
modele apparait dans ’écran Template Preview.

3. Vous pouvez utiliser un modele existant dont les définitions de propriétés sont
similaires a celles requises par votre connecteur comme point de départ pour
votre modele. Si vous ne voyez aucun modele contenant les propriétés
spécifiques de votre connecteur , vous devez créer un nouveau modele.

* Si vous prévoyez de modifier un modele existant, sélectionnez le nom de ce
modele dans la liste située dans le tableau Template Name sous Select the
Existing Template to Modify: Find Template.

* Ce tableau affiche les noms de tous les modeéles disponibles. Vous pouvez
également rechercher un modele.

Définition des caractéristiques générales: Lorsque vous cliquez sur Next pour
sélectionner un modele, la boite de dialogue Properties - Connector-Specific
Property Template s’affiche. Cette boite de dialogue contient des onglets pour les
caractéristiques générales des propriétés définies et pour les restrictions liées aux
valeurs. L’écran General contient les zones suivantes :

* General:
Property Type
Property Subtype
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

La zone Property Subtype peut étre sélectionnée lorsque Property Type a la valeur
String. 1l s’agit d’une valeur facultative qui permet une vérification de la syntaxe
lors de la sauvegarde du fichier de configuration. La valeur par défaut est un
espace, ce qui signifie qu’aucun sous-type n’a été attribué a la propriété.
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Une fois que vous avez sélectionné les caractéristiques générales de la propriété,
cliquez sur I'onglet Value.

Définition des valeurs: L’onglet Value vous permet de définir la longueur
maximum, le nombre maximum de valeurs multiples, une valeur par défaut ou un
intervalle de valeurs pour la propriété. Il autorise également les valeurs
modifiables. Pour ce faire, procédez comme suit :

1. Cliquez sur l'onglet Value. Le panneau d’affichage des valeurs remplace le
panneau d’affichage général.

2. Sélectionnez le nom de la propriété dans 1'écran Edit properties.

3. Entrez les valeurs de votre choix dans les zones Max Length et Max Multiple
Values.

Pour créer une valeur de propriété, procédez comme suit :

1. Cliquez avec le bouton droit de la souris sur le carré a gauche de 'en-téte de
colonne Value.

2. Dans le menu contextuel, sélectionnez Add pour afficher la boite de dialogue
Property Value. Selon le type de propriété, la boite de dialogue vous permet de
saisir une valeur ou a la fois une valeur et un intervalle.

3. Entrez la valeur de propriété puis cliquez sur OK. Cette valeur s’affiche dans
le panneau Value a droite.

Le panneau Value affiche un tableau comprenant trois colonnes :

La colonne Value contient la valeur que vous avez saisie dans la boite de dialogue
Property Value ainsi que les autres valeurs créées auparavant.

La colonne Default Value vous permet de désigner n’importe laquelle de ces
valeurs comme valeur par défaut.

La colonne Value Range montre l'intervalle que vous avez saisi dans la boite de
dialogue Property Value.

Quand une valeur a été créée et qu’elle apparait dans la grille, elle peut étre
modifié depuis la table.

Pour modifier une valeur contenue dans la table, sélectionnez toute une ligne en
cliquant sur son numéro. Puis cliquez avec le bouton droit dans la zone Value et
cliquez sur Edit Value.

Définition des dépendances: Une fois les modifications faites dans les onglets
General et Value, cliquez sur Next. La boite de dialogue Dependencies -
Connector-Specific Property Template s’affiche.

Une propriété dépendante est une propriété qui est incluse dans le modele et
utilisée dans le fichier de configuration uniquement si la valeur d’une autre
propriété respecte une condition spécifique. Par exemple, Pol1Quantity apparait
dans le modele uniquement si le mécanisme de transfert est JMS et que
DuplicateEventElimination a la valeur True .

Pour désigner une propriété comme dépendante et définir la condition dont elle
dépend, procédez comme suit :

1. Dans 'écran Available Properties, sélectionnez la propriété qui doit devenir
dépendante.

Chapitre 7. Configuration des connecteurs 149



2. Dans la zone Select Property, utilisez le menu déroulant pour sélectionner la
propriété qui conservera la valeur conditionnelle.

3. Dans la zone Condition Operator, sélectionnez ['une des valeurs suivantes :
== (égal a)
I= (différent de)
> (supérieur a)
< (inférieur a)
>= (supérieur ou égal a)
<=(inférieur ou égal a)
4. Dans la zone Conditional Value, entrez la valeur requise pour que la propriété
dépendante soit incluse dans le modeéle.

5. La propriété dépendante est mise en évidence dans 1’écran Available Properties
; cliquez sur une fleche pour la déplacer vers 1’écran Dependent Property.

6. Cliquez sur Finish. Connector Configurator stocke les informations que vous
avez entrées sous la forme d'un document XML, sous \data\app dans le
répertoire \bin o1 vous avez installé Connector Configurator.

Configuration des noms de chemin: Voici quelques régles générales de
configuration des noms de chemin :

* La longueur maximale d’'un nom de fichier sous Windows et UNIX est de 255
caracteres.

* Sous Windows, le nom de chemin absolu doit respecter le format
[Unité:][Répertoire] \nom_fichier, par exemple
C:\WebSphereAdapters\bin\Data\Std \StdConnProps.xml.

Sous UNIX le premier caractére doit étre /.

* Les noms de file d’attente ne doivent pas commencer par un espace ni contenir
d’espace imbriqué.

Création d’un fichier de configuration

Lorsque vous créez un fichier de configuration, vous devez lui attribuer un nom et
sélectionner un courtier d’intégration.

Vous devez également sélectionner un systéeme d’exploitation pour permettre la
validation étendue du fichier. La barre d’outils dispose d'une liste déroulante
appelée Target System qui permet de sélectionner le systéme d’exploitation cible
pour la validation étendue des propriétés. Les options disponibles sont les
suivantes : Windows, UNIX, Other (s'il ne s’agit pas de Windows ni d’UNIX) et
None-no extended validation (désactivation de la validation étendue). L’option
définie par défaut au démarrage est Windows.

Pour lancer Connector Configurator, procédez comme suit :

* Dans la fenétre System Manager, sélectionnez Connector Configurator dans le
menu Tools. Connector Configurator s’ouvre.

* Lancez Connector Configurator en mode autonome.

Pour configurer le systeme d’exploitation pour la validation étendue du fichier de
configuration, procédez comme suit :

* Développez la liste déroulante Target System: de la barre de menus.
* Sélectionnez le systeme d’exploitation utilisé.
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Ensuite, sélectionnez File>New>Connector Configuration. Dans la fenétre New
Connector, entrez le nom du nouveau connecteur.

Vous devez également sélectionner un courtier d’intégration. Le courtier que vous
sélectionnez détermine les propriétés qui apparaitront dans le fichier de
configuration. Pour sélectionner un courtier, procédez comme suit :

* Dans la zone Integration Broker, sélectionnez ICS, WebSphere Message Brokers
ou WAS.

* Remplissez les autres zones de la fenétre New Connector comme décrit dans la
suite de ce chapitre.

Création d’un fichier de configuration a partir d’'un modele
spécifique a un connecteur

Une fois que vous avez créé un modele spécifique au connecteur, vous pouvez
l'utiliser pour créer un fichier de configuration :

1. Configurez le systeme d’exploitation pour la validation étendue du fichier de
configuration a l’aide de la liste déroulante Target System: de la barre de
menus (voir “Création d"un fichier de configuration” ci-dessus).

2. Cliquez sur File>New>Connector Configuration.

3. La boite de dialogue New Connector s’affiche. Elle contient les zones suivantes

e Name

Entrez le nom du connecteur. Les noms font la différence entre les
majuscules et les minuscules. Le nom que vous entrez doit étre unique et
cohérent avec le nom de fichier d'un connecteur installé sur le systeme.

Important : Connector Configurator ne controle pas l'orthographe du nom
que vous entrez. Vous devez vérifier que le nom est correct.

* System Connectivity
Cliquez sur ICS, WebSphere Message Brokers ou WAS.
* Select Connector-Specific Property Template

Tapez le nom du modele congu pour votre connecteur. Les modeles
disponibles s’affichent dans 1’écran Template Name. Lorsque vous
sélectionnez un nom dans I'écran Template Name, ’écran Property Template
Preview affiche les propriétés spécifiques au connecteur qui ont été définies
dans ce modeéle.

Sélectionnez le modeéle a utiliser et cliquez sur OK.

4. Un écran de configuration apparait pour le connecteur que vous configurez. La
barre de titre contient le nom du courtier d’intégration et du connecteur. Vous
pouvez entrer les valeurs de toutes les zones pour parcourir la définition
maintenant ou enregistrer le fichier et renseigner les zones ultérieurement.

5. Pour enregistrer le fichier, cliquez sur File>Save>To File ou File>Save>To
Project. Pour exécuter un enregistrement dans un projet, System Manager doit
étre en cours d’exécution.

Si vous enregistrez un fichier, la boite de dialogue Save File Connector
s’affiche. Sélectionnez *.cfg comme type de fichier, vérifiez dans la zone File
Name que le nom est correctement orthographié et que sa casse est correcte,
accédez au répertoire dans lequel vous souhaitez enregistrer le fichier et cliquez
sur Save. L’écran d’état affiché dans le panneau de message de Connector
Configurator indique que le fichier de configuration a été créé.
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Important: Le nom et le chemin du répertoire que vous avez définis ici
doivent correspondre au nom et au chemin du fichier de
configuration du connecteur que vous indiquez dans le fichier de
démarrage du connecteur.

6. Pour remplir la définition du connecteur, entrez des valeurs dans les zones de
chacun des onglets de la fenétre Connector Configurator, comme décrit plus
loin dans ce chapitre.

Utilisation d’un fichier existant

Vous disposez peut-étre d'un fichier existant dans un ou plusieurs des formats
suivants :

* Fichier de définition de connecteur
Il s’agit d"un fichier texte qui répertorie les propriétés et les valeurs par défaut
applicables d'un connecteur spécifique. Certains connecteurs posseédent ce fichier
dans un répertoire \repository fourni dans leur package d’origine (en général,
le fichier a l'extension .txt ; par exemple, CN_XML.txt pour le connecteur
XML).

* Fichier référentiel 1CS
Les définitions utilisées dans une implémentation ICS précédente du connecteur
peuvent étre accessibles dans un fichier référentiel qui a été utilisé pour la
configuration de ce connecteur. En général, ce type de fichier a 1’extension .in
ou .out .

* Fichier de configuration précédent pour le connecteur
En général, ce type de fichier a I'extension *.cfg.

Bien que certaines de ces sources de fichier puissent contenir tout ou partie des
propriétés spécifiques au connecteur, le fichier de configuration du connecteur ne
sera pas complet tant que vous n’aurez pas ouvert le fichier et défini les propriétés,
comme décrit plus loin dans ce chapitre.

Pour utiliser un fichier existant afin de configurer un connecteur, vous devez
ouvrir le fichier dans Connector Configurator, réviser la configuration et enregistrer
de nouveau le fichier.

Pour ouvrir un fichier *.txt, *.cfg ou *.in dans un répertoire, procédez comme suit :
1. Dans Connector Configurator, cliquez sur File>Open>From File.

2. Dans la boite de dialogue Open File Connector, sélectionnez I'un des types de
fichier suivants pour afficher les fichiers disponibles :
* Configuration (x.cfg)
* Référentiel ICS (*.in, *x.out )
Sélectionnez cette option si vous avez utilisé un fichier référentiel pour
configurer le connecteur dans un environnement ICS. Un fichier référentiel

peut contenir plusieurs définitions de connecteur, qui apparaissent toutes
lorsque vous ouvrez ce fichier.

* Tous les fichiers (*.*)

Sélectionnez cette option si un fichier *.txt a été fourni dans le package de
I'adaptateur pour le connecteur ou qu’'un fichier de définition avec une autre
extension est disponible.

3. Dans l'écran du répertoire, accédez au fichier de définition du connecteur
approprié, sélectionnez-le et cliquez sur Open.
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Pour ouvrir une configuration de connecteur a partir d’un projet System Manager,
procédez comme suit :

1.

2.
3.

Démarrez System Manager. Vous pouvez ouvrir une configuration dans System
Manager ou 'y enregistrer uniquement si vous avez démarré System Manager.

Démarrez Connector Configurator.

Cliquez sur File>Open>From Project.

Remplissage d’un fichier de configuration

Lorsque vous ouvrez un fichier de configuration ou un connecteur a partir d'un
projet, la fenétre Connector Configurator affiche 1’écran de configuration qui
contient les valeurs et les attributs courants.

Le titre de I’écran de configuration affiche le courtier d’intégration et le nom du
connecteur, comme indiqué dans le fichier. Vérifiez que votre courtier est correct.
Dans le cas contraire, modifiez la valeur du courtier avant de configurer le
connecteur. Pour ce faire, procédez comme suit :

1.

Dans 'onglet Standard Properties, sélectionnez la zone de valeur pour la
propriété BrokerType. Dans le menu déroulant, sélectionnez la valeur ICS , WMQI
ou WAS.

L’onglet Standard Properties affiche les propriétés du connecteur associées au
courtier sélectionné. Le tableau indique les propriétés Property name, Value,
Type, Subtype (si la propriété Type est une chaine), Description et Update
Method.

Vous pouvez enregistrer le fichier maintenant ou renseigner les autres zones
relatives a la configuration, comme décrit dans [«Indication des définitions|
[d’objets métier pris en charge» a la page 157]

Une fois la configuration faite, cliquez sur File>Save>To Project ou
File>Save>To File.

Si vous enregistrez dans un fichier, sélectionnez *.cfg comme extension,
sélectionnez I'emplacement correct pour le fichier et cliquez sur Save.

Si plusieurs configurations de connecteur sont ouvertes, cliquez sur Save All to
File pour enregistrer toutes les configurations dans un fichier ou cliquez sur
Save All to Project pour enregistrer toutes les configurations du connecteur
dans un projet System Manager.

Avant de créer le fichier de configuration, vous devez avoir utilisé la liste
déroulante Target System qui permet de sélectionner le systeme d’exploitation
cible pour la validation étendue des propriétés.

Avant d’enregistrer le fichier, Connector Configurator vérifie que vous avez
défini des valeurs pour toutes les propriétés standard requises. Si vous n’avez
pas défini de valeur pour I'une des propriétés standard requises, Connector
Configurator affiche un message indiquant 1’échec de la validation. Vous devez
attribuer une valeur a la propriété pour pouvoir enregistrer le fichier de
configuration.

Si vous avez choisi d’utiliser la fonction de validation étendue en sélectionnant
la valeur Windows, UNIX ou Other dans la liste déroulante Target System, le
systeme validera le sous-type de la propriété ainsi que le type, et affichera un
message d’avertissement en cas d’échec de la validation.

Définition des propriétés d’un fichier de configuration

Lorsque vous créez et que vous nommez un nouveau fichier de configuration du
connecteur, ou que vous ouvrez un fichier de configuration existant du connecteur,
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Connector Configurator affiche un écran de configuration avec des onglets pour les
catégories des valeurs de configuration requises.

Connector Configurator requiert des valeurs pour les propriétés dans ces catégories
pour les connecteurs s’exécutant sur tous les courtiers :

Propriétés standard

Propriétés spécifiques au connecteur

Objets métier pris en charge

Valeurs des fichiers journaux/fichiers de trace

Gestionnaire de données (applicable pour les connecteurs qui utilisent la
messagerie JMS avec une livraison des événements garantie)

Remarque : Pour les connecteurs utilisant la messagerie JMS, une catégorie

supplémentaire peut s’afficher ; elle est associée a la configuration des
gestionnaires de données qui convertissent les données en objets
métier.

Pour les connecteurs qui s’exécutent sur ICS, des valeurs sont également requises
pour ces propriétés :

Mappes associées
Ressources

Messagerie (le cas échéant)
Sécurité

Important : Connector Configurator accepte des valeurs de propriété exprimées

dans des jeux de caracteres anglais et des jeux de caractéres non
anglais. Cependant, les noms des propriétés standard et des propriétés
spécifiques au connecteur ainsi que les noms des objets métier pris en
charge doivent uniquement utiliser le jeu de caractéres anglais.

Les différences entre les propriétés standard et les propriétés spécifiques au
connecteur sont les suivantes :

Les propriétés standard d'un connecteur sont partagées par le composant
spécifique a I'application d’un connecteur et son courtier. Tous les connecteurs
ont le méme jeu de propriétés standard. Ces propriétés sont décrites dans
I’Annexe A de chaque guide de l'adaptateur. Vous pouvez modifier une partie
de ces valeurs uniquement.

Les propriétés spécifiques a l'application s’appliquent uniquement au composant
spécifique a I'application d’un connecteur, c’est-a-dire au composant qui interagit
directement avec 'application. Chaque connecteur a des propriétés spécifiques a
I'application qui sont propres a cette application. Certaines de ces propriétés
fournissent des valeurs par défaut, et d’autres non ; vous pouvez modifier
certaines des valeurs par défaut. Les chapitres relatifs a 1'installation et a la
configuration de chaque guide de 'adaptateur décrivent les propriétés
spécifiques a l’application et les valeurs recommandées.

Les zones relatives aux propriétés standard et aux propriétés spécifiques au
connecteur sont codées en couleur pour indiquer les éléments configurables :

Une zone avec un arriere-plan gris indique une propriété standard. Vous pouvez
modifier la valeur, mais vous ne pouvez pas modifier le nom ou supprimer la
propriété.
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* Une zone avec un arriere-plan blanc indique une propriété spécifique a
l'application. Ces propriétés varient en fonction des besoins spécifiques de
l'application ou du connecteur. Vous pouvez modifier la valeur et supprimer ces
propriétés.

* Les zones de valeurs sont configurables.

* La zone Update Method s’affiche pour chaque propriété. Elle indique si le
redémarrage d'un composant ou d’un agent est nécessaire a 1’activation des
valeurs modifiées. Il est impossible de configurer ce parametre.

Définition des propriétés standard du connecteur
Pour modifier la valeur d'une propriété standard, procédez comme suit :

1. Cliquez dans la zone dont vous souhaitez définir la valeur.

2. Entrez une valeur ou sélectionnez-en une dans le menu déroulant le cas
échéant.

Remarque : Si la propriété est de type String, elle peut disposer d’une valeur
de sous-type dans la colonne Subtype. Ce sous-type est utilisé
pour la validation étendue de la propriété.

3. Une fois que vous avez entré toutes les valeurs pour les propriétés standard,
vous pouvez exécuter les opérations suivantes :

* Pour ignorer les modifications, conserver les valeurs d’origine et quitter
Connector Configurator, cliquez sur File>Exit (ou fermez la fenétre) et
cliquez sur No lorsquun message vous demande si vous souhaitez
enregistrer les modifications.

* Pour entrer les valeurs des autres catégories dans Connector Configurator,
sélectionnez l'onglet relatif a la catégorie. Les valeurs que vous entrez pour
la catégories Standard Properties (ou n'importe quelle autre catégorie) sont
conservées lorsque vous passez a la catégorie suivante. Lorsque vous fermez
la fenétre, vous étes invité a enregistrer ou a annuler les valeurs que vous
avez entrées dans toutes les catégories.

* Pour enregistrer les valeurs révisées, cliquez sur File>Exit (ou fermez la
fenétre) et sur Yes lorsqu'un message vous demande si vous souhaitez
enregistrer les modifications. Vous pouvez également cliquer sur Save>To
File dans le menu File ou la barre d’outils.

Pour plus d’informations sur une propriété standard spécifique, cliquez avec le
bouton gauche de la souris sur I'entrée de cette propriété dans la colonne
Description de la page a onglets Standard Properties. Si la fonction d’aide étendue
est installée, un bouton en forme de fleche s’affiche a droite. Lorsque vous cliquez
dessus, une fenétre d’aide s’affiche avec les caractéristiques de la propriété
standard.

Remarque : Si le bouton actif ne s’affiche pas, cela signifie que la fonction d’aide
étendue est introuvable pour cette propriété.

Une fois installés, les fichiers de la fonction d’aide étendue se trouvent dans le
répertoire <ProductDir>\bin\Data\Std\Help\<RegionalSetting>\.

Définition des propriétés de configuration spécifiques au
connecteur

Pour les propriétés de configuration spécifiques au connecteur, vous pouvez
ajouter ou modifier les noms des propriétés, définir des valeurs, supprimer et
chiffrer une propriété. La longueur par défaut d’une propriété est de 255
caracteres.
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1. Cliquez avec le bouton droit dans la partie supérieure gauche de la grille. Une
barre de menus contextuelle apparait. Cliquez sur Add pour ajouter une
propriété. Pour ajouter une propriété enfant, cliquez avec le bouton droit sur le
numéro de la ligne parent et cliquez sur Add child.

2. Entrez une valeur pour la propriété ou la propriété enfant.

Remarque : Si la propriété est de type String, vous pouvez sélectionner un
sous-type dans la liste déroulante Subtype. Ce sous-type est utilisé
pour la validation étendue de la propriété.

3. Pour chiffrer une propriété, cochez la case Encrypt.

4. Pour plus d'informations sur une propriété standard spécifique, cliquez avec le
bouton gauche de la souris sur 'entrée de cette propriété dans la colonne
Description. Si la fonction d’aide étendue est installée, un bouton actif s’affiche.
Lorsque vous cliquez dessus, une fenétre d’aide s’affiche avec les
caractéristiques de la propriété standard.

Remarque : Si aucun bouton actif ne s’affiche, cela signifie que la fonction
d’aide étendue est introuvable pour cette propriété.
5. Vous pouvez enregistrer ou ignorer les modifications, comme décrit pour
[«Définition des propriétés standard du connecteur» a la page 155|

Si les fichiers de la fonction d’aide étendue sont installés et qu’aucune valeur n’a
été attribuée a la propriété AdapterHelpName, Connector Configurator désigne les
fichiers d’aide étendue spécifiques a I'adaptateur qui se trouvent dans le répertoire
<ProductDir>\bin\Data\ App \Help\ <RegionalSetting>\. Dans le cas contraire,
Connector Configurator désigne les fichiers d’aide étendue spécifiques a
I'adaptateur qui se trouvent dans le répertoire
<ProductDir>\bin\Data\ App \Help\ <AdapterHelpName>\ <RegionalSetting>\. Voir
la propriété AdapterHelpName décrite dans I’annexe Propriétés standard.

La zone Update Method affichée pour chaque propriété indique si le redémarrage
d’un composant ou d'un agent est nécessaire a 1’activation des valeurs modifiées.

Important : La modification du nom prédéfini d"une propriété de connecteur
spécifique a l’application peut entrainer I’échec d’un connecteur. Le
connecteur peut nécessiter certains noms de propriété pour se
connecter a une application ou s’exécuter correctement.

Chiffrement des propriétés du connecteur: Pour chiffrer les propriétés
spécifiques a I'application, cochez la case Encrypt dans la fenétre
Connector-specific Properties. Pour déchiffrer une valeur, décochez la case Encrypt,
entrez la valeur appropriée dans la boite de dialogue Verification et cliquez sur
OK. Si la valeur entrée est correcte, elle est déchiffrée et s’affiche.

Le guide de l'utilisateur de 1’adaptateur associé a chaque connecteur contient la
liste et la description de chaque propriété ainsi que sa valeur par défaut.

Si une propriété a plusieurs valeurs, la case Encrypt apparait pour la premiere
valeur de la propriété. Lorsque vous sélectionnez Encrypt, toutes les valeurs de la
propriété sont chiffrées. Pour déchiffrer plusieurs valeurs d'une propriété, décochez
la case Encrypt pour la premiére valeur de la propriété, puis entrez la nouvelle
valeur dans la boite de dialogue Verification. Si la valeur entrée est une
correspondance, toutes les valeurs multiples sont déchiffrées.

IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



Méthode de mise a jour: Reportez-vous aux descriptions des méthodes de mise a
jour contenues dans I’annexe Propriétés standard, sous [«Présentation des valeurg
[des propriétés de configuration» a la page 165}

Indication des définitions d’objets métier pris en charge

Utilisez I'onglet Supported Business Objects dans Connector Configurator pour
indiquer les objets métier que le connecteur utilisera. Vous devez indiquer les
objets métier génériques et les objets métier spécifiques a l'application, et indiquer
les associations pour les mappes entre les objets métier.

Remarque : Certains connecteurs nécessitent que des objets métier soient indiqués
comme étant pris en charge pour pouvoir exécuter la notification des
événements ou une configuration supplémentaire (a 'aide des
méta-objets) avec leurs applications. Pour plus d’informations, voir
Connector Development Guide for C++ ou Connector Development Guide
for Java.

Si votre courtier est ICS: Pour indiquer qu’une définition d’objet métier est prise
en charge par le connecteur ou modifier les parametres de prise en charge d'une
définition d’objet métier existante, cliquez sur I'onglet Supported Business Objects
et utilisez les zones suivantes :

Business object name : Pour indiquer qu'une définition d’objet métier est prise en
charge par le connecteur, avec System Manager en cours d’exécution, procédez
comme suit :

1. Cliquez dans une zone vide de la liste Business Object Name. Une liste
déroulante affiche toutes les définitions d’objet métier qui existent dans le
projet System Manager.

2. Cliquez sur un objet métier pour l'ajouter.

w

Définissez la zone Agent Support (décrite plus bas) pour 1'objet métier.

4. Dans le menu File de la fenétre Connector Configurator, cliquez sur Save to
Project. La définition révisée du connecteur, qui contient la prise en charge
sélectionnée pour la définition de 1’objet métier ajouté, est enregistrée dans un
projet ICL (Integration Component Library) de System Manager.

Pour supprimer un objet métier dans la liste des objets métier pris en charge,
procédez comme suit :

1. Pour sélectionner la zone d’un objet métier, cliquez sur le numéro situé a
gauche de 1’objet métier.

2. Dans le menu Edit de la fenétre Connector Configurator, cliquez sur Delete
Row. L’objet métier est supprimé de la liste.

3. Dans le menu File, cliquez sur Save to Project.

La suppression d’un objet métier dans la liste des objets métier pris en charge
modifie la définition du connecteur et rend 1’objet métier supprimé inutilisable
dans cette implémentation du connecteur. Elle n’affecte pas le code du connecteur
et ne supprime pas la définition de 1’objet métier dans System Manager.

Prise en charge de I'agent : Si un objet métier dispose de la prise en charge de
l'agent, le systeme tente d’utiliser cet objet métier pour fournir des données a une
application via l’agent du connecteur.

En général, les objets métier spécifiques a 1’application pour un connecteur sont
pris en charge par 1’agent de ce connecteur, mais les objets métier génériques ne le
sont pas.

Chapitre 7. Configuration des connecteurs 157



Pour indiquer que 1'objet métier est pris en charge par 1'agent du connecteur,
cochez la case Agent Support. La fenétre Connector Configurator ne valide pas vos
sélections pour Agent Support.

Niveau de transaction maximum : Le niveau de transaction maximum d’un
connecteur correspond au niveau de transaction le plus élevé pris en charge par le
connecteur.

Pour la plupart des connecteurs, Best Effort est la seule valeur possible.
Vous devez redémarrer le serveur pour que les modifications prennent effet.

Si votre courtier est WebSphere Message Broker: Si vous utilisez le mode
autonome (non connecté a System Manager), vous devez entrer manuellement le
nom de l'objet métier.

Si System Manager est en cours d’exécution, vous pouvez cocher la case située
sous la colonne Business Object Name dans 1’onglet Supported Business Objects.
Une boite de dialogue mixte affiche la liste des objets métier disponibles dans le
projet Integration Component Library auquel le connecteur appartient. Dans cette
liste, sélectionnez 1’objet métier de votre choix.

La zone Message Set ID est facultative pour WebSphere Business Integration
Message Broker 5.0, et sa valeur ne doit pas nécessairement étre unique le cas
échéant. Cependant, pour WebSphere MQ Integrator et Integrator Broker 2.1, vous
devez indiquer un ID unique.

Si votre courtier est WAS : Lorsque vous sélectionnez WebSphere Application
Server comme type de courtier, Connector Configurator ne nécessite pas les ID
d’ensemble de messages. L'onglet Supported Business Objects contient la colonne
Business Object Name pour les objets métier pris en charge uniquement.

Si vous utilisez le mode autonome (non connecté a System Manager), vous devez
entrer manuellement le nom de 'objet métier.

Si System Manager est en cours d’exécution, vous pouvez cocher la case située
sous la colonne Business Object Name dans 'onglet Supported Business Objects.
Une boite de dialogue mixte affiche la liste des objets métier disponibles dans le
projet Integration Component Library auquel le connecteur appartient. Dans cette
liste, sélectionnez 1’objet métier de votre choix.

Mappes associées (ICS)

Chaque connecteur prend en charge la liste des définitions des objets métier et
leurs mappes associées actives dans WebSphere InterChange Server. Cette liste
apparait lorsque vous sélectionnez 1’'onglet Associated Maps.

La liste des objets métier contient 1’objet métier spécifique a l'application pris en
charge par 1'agent et 1'objet générique correspondant que le contrdleur envoie a la
collaboration de souscription. L’association d'une mappe détermine la mappe qui
sera utilisée pour transformer 1’objet métier spécifique a 1’application en objet
métier générique, ou inversement.

Si vous utilisez des mappes uniquement définies pour des objets métier source et
cible spécifiques, les mappes sont déja associ€es aux objets métier appropriés
lorsque vous affichez 1’écran, et vous n’avez pas besoin de (ou ne pouvez pas) les
modifier.
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Si plusieurs mappes sont disponibles pour un objet métier pris en charge, vous
devez lier de maniére explicite cet objet métier a la mappe qu’il doit utiliser.

L’onglet Associated Maps affiche les zones suivantes :
* Business Object Name

I s’agit des objets métier pris en charge par ce connecteur, comme indiqué dans
l'onglet Supported Business Objects. Si vous indiquez des objets métier
supplémentaires dans 1’onglet Supported Business Objects, ils sont reflétés dans
cette liste une fois que vous avez enregistré les modifications en sélectionnant
Save to Project dans le menu File de la fenétre Connector Configurator.

* Associated Maps

L’écran affiche toutes les mappes installées sur le systeme a utiliser avec les
objets métier pris en charge du connecteur. L’objet métier source pour chaque
mappe s’affiche a gauche du nom de la mappe, dans 'écran Business Object
Name.

 Explicit Binding
Dans certains cas, vous devrez peut-étre lier de maniére explicite une mappe
associée.

Une liaison explicite est requise uniquement lorsque plusieurs mappes existent
pour un objet métier pris en charge spécifique. Lorsque ICS s’amorce, il tente de
lier automatiquement une mappe a chaque objet métier pris en charge pour
chacun des connecteurs. Si plusieurs mappes prennent le méme objet métier
comme entrée, le serveur tente de localiser et de lier une mappe qui correspond
au sur-ensemble des autres.

Si aucune mappe n’est le sur-ensemble des autres, le serveur ne peut pas lier
I'objet métier a une seule mappe et vous devrez définir la liaison de maniere
explicite.

Pour lier une mappe de maniere explicite, procédez comme suit :

1. Dans la colonne Explicit, cochez la case correspondant a la mappe a lier.
2. Sélectionnez la mappe que vous souhaitez associer a ’objet métier.

3. Dans le menu File de la fenétre Connector Configurator, cliquez sur Save to
Project.

4. Déployez le projet sur ICS.

5. Réamorcez le serveur pour que les modifications prennent effet.

Ressources (ICS)

L’onglet Resource vous permet de définir une valeur qui détermine si I'agent du
connecteur gérera plusieurs processus simultanément, et dans quelle mesure, a
l'aide du parallélisme de 1'agent du connecteur.

Tous les connecteurs ne prennent pas en charge cette fonction. Si vous exécutez un
agent de connecteur congu dans Java pour étre multithread, nous vous
recommandons de ne pas utiliser cette fonction dans la mesure ot il est
généralement plus efficace d’utiliser plusieurs unités d’exécution plutdt que
plusieurs processus.

Messagerie (ICS)

L’onglet Messaging permet de configurer les propriétés de messagerie. Les
propriétés de messagerie sont disponibles uniquement si vous avez choisi MQ
comme valeur de la propriété standard DeliveryTransport et ICS comme type de
courtier. Ces propriétés déterminent la maniére dont le connecteur utilisera les files
d’attente.
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Validation des files d’attente de messages: Avant de valider une file d’attente de
messages, vous devez procéder comme suit :

* Veillez a ce que WebSphere MQ Series soit installé.

* Créez une file d’attente de messages avec un canal et un port sur la machine
héte.

¢ Définissez une connexion vers la machine hote.

Pour valider la file d’attente, utilisez le bouton Validate a droite des zones
Messaging Type et Host Name dans I'onglet Messaging.

Sécurité (ICS)

L’onglet Security dans Connector Configurator permet de définir plusieurs
niveaux de confidentialité d’un message. Vous pouvez uniquement utiliser cette
fonction lorsque la propriété DeliveryTransport a la valeur JMS.

Par défaut, 'option de confidentialité est désactivée. Cochez la case Privacy pour
I'activer.

Le nom de chemin absolu du systéme cible du magasin de clés est le suivant :

¢ Pour Windows :
<ProductDir>\connectors\security\<connectorname>.jks

e Pour UNIX :
opt/IBM/WebSphereAdapters/connectors/security/<connectorname>.jks

Ce chemin d’acces et ce fichier doivent se trouver sur le systéme sur lequel vous
envisagez de lancer le connecteur, en d’autres termes le systéme cible.

Vous pouvez utiliser le bouton Browse a droite uniquement si le systéme cible
correspond au systeme en cours d’exécution. Ce bouton est grisé sauf si la case
Privacy est activée et que 1'option Target System de la barre de menus a la valeur
Windows.

L’option Message Privacy Level doit étre définie comme suit pour les trois
catégories de message (All Messages, All Administrative Messages et All Business
Object Messages) :

"

. est la valeur par défaut utilisée lorsqu’aucun niveau de confidentialité n’a été
défini pour une catégorie de message.

* None
Différente de la valeur par défaut, cette valeur est utilisée pour définir
volontairement un niveau de confidentialité de type None a une catégorie de
message.

* Integrity
* Privacy
* Integrity plus Privacy

La fonction Key Maintenance permet de créer, d'importer et d’exporter des clés
publiques pour le serveur et 'adaptateur.

* Lorsque vous sélectionnez Generate Keys, la boite de dialogue Generate Keys
s’affiche avec les valeurs par défaut attribuées a 1’outil qui générera les clés.

* La valeur du magasin de clés correspond par défaut a la valeur saisie pour
l'option Keystore Target System Absolute Pathname dans 'onglet Security.
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* Lorsque vous sélectionnez OK, les entrées sont validées, le certificat de clés est
créé et le résultat est envoyé a 1'écran de journalisation de Connector
Configurator.

Avant de pouvoir importer un certificat dans le magasin de clés de 'adaptateur,
vous devez l'exporter depuis le magasin de clés du serveur. Lorsque vous
sélectionnez Export Adapter Public Key, la boite de dialogue Export Adapter
Public Key s’affiche.

* La valeur par défaut du certificat d’exportation est identique a celle du magasin
de clés mais son extension de fichier est <nom_fichier>.cer.

Lorsque vous sélectionnez Import Server Public Key, la boite de dialogue Import
Server Public Key s’affiche.

* La valeur par défaut du certificat d'importation est <ProductDir>\bin\ics.cer (si
le fichier existe sur le systeme).

* L’association des certificats d’importation doit correspondre au nom du serveur.
Si un serveur est enregistré, vous pouvez le sélectionner dans la liste déroulante.

La fonction Adapter Access Control est activée uniquement lorsque la valeur de la
propriété DeliveryTransport est IDL. Par défaut, 'adaptateur se connecte en
utilisant 1'identité hote. Si la case Use guest identity n’est pas cochée, les zones
Adapter Identity et Adapter Password sont activées.

Définition des valeurs du fichier de trace/fichier journal

Lorsque vous ouvrez le fichier de configuration ou le fichier de définitions d'un
connecteur, Connector Configurator utilise les valeurs de journalisation et de trace
de ce fichier comme valeurs par défaut. Vous pouvez modifier ces valeurs dans
Connector Configurator.

Pour modifier les valeurs de journalisation et de trace, procédez comme suit :
1. Cliquez sur l'onglet Trace/Log Files.

2. Pour la journalisation ou la fonction de trace, vous pouvez envoyer les
messages vers les composants suivants :

* la console (STDOUT) :
Affiche les messages de journalisation ou de trace a I'écran STDOUT.

Remarque : Vous pouvez utiliser I'option STDOUT de 1'onglet Trace/Log
Files pour les connecteurs s’exécutant sur la plate-forme
Windows uniquement.

* un fichier :
Ecrit les messages de journalisation ou de trace dans un fichier indiqué. Pour
indiquer le fichier, cliquez sur le bouton du répertoire (ellipse), accédez a
I'emplacement de votre choix, indiquez un nom de fichier et cliquez sur
Save. Les messages de journalisation ou de trace sont écrits dans le fichier et
I'emplacement indiqués.

Remarque : Les fichiers de journalisation et de trace sont de simples fichiers
texte. Vous pouvez utiliser 1’extension de votre choix lorsque
vous définissez les noms de fichier. Cependant, pour les fichiers
de trace, nous vous recommandons d’utiliser 1’extension .trace
plutdt que l'extension .trc, afin d’éviter toute confusion avec les
autres fichiers pouvant résider sur le systeme. Pour les fichiers
de journalisation, les extensions classiques sont .log et .txt.
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Gestionnaires de données

La section des gestionnaires de données est disponible pour la configuration
uniquement si vous avez indiqué la valeur JMS pour DeliveryTransport et
ContainerManagedEvents. Tous les adaptateurs n’utilisent pas les gestionnaires de
données.

Pour connaitre les valeurs a utiliser pour ces propriétés, reportez-vous aux
descriptions sous ContainerManagedEvents dans I’Annexe A, Propriétés standard.
Pour plus d’informations, voir Connector Development Guide for C++ ou Connector
Development Guide for Java.

Enregistrement de votre fichier de configuration

Une fois que vous avez configuré votre connecteur, enregistrez son fichier de
configuration. Connector Configurator enregistre le fichier dans le mode de
courtier que vous avez sélectionné pendant la configuration. La barre de titre de
Connector Configurator affiche toujours le mode de courtier (ICS, WMQI ou WAS)
en cours d’utilisation.

Le fichier est enregistré en tant que document XML. Pour enregistrer le document
XML, vous avez trois possibilités :

* dans System Manager, en tant que fichier avec l'extension *.con dans un projet
ICL ;

* dans un répertoire que vous avez indiqué ;

* en mode autonome, en tant que fichier avec l'extension *.cfg dans un
répertoire. Par défaut, le fichier est enregistré dans le répertoire
\WebSphereAdapters\bin\Data\App.

* Vous pouvez également l'enregistrer dans un projet WebSphere Application
Server si vous en avez configuré un.

Pour plus d’informations sur l'utilisation des projets dans System Manager et sur
le déploiement, voir les guides d’implémentation suivants :

e Pour ICS : Implementation Guide for WebSphere InterChange Server

* Pour les courtiers de message WebSphere : Implementing Adapters with WebSphere
Message Brokers

e Pour WAS : Implementing Adapters with WebSphere Application Server

Modification d’un fichier de configuration

Vous pouvez modifier les paramétres du courtier d’intégration dans un fichier de
configuration existant. Cela vous permet d’utiliser le fichier comme modele pour

créer un nouveau fichier de configuration que vous pourrez utiliser avec un autre
courtier.

Remarque : Vous devrez modifier d’autres propriétés de configuration ainsi que la
propriété du mode courtier si vous changez de courtiers d’intégration.

Pour modifier votre sélection de courtier dans un fichier de configuration existant
(facultatif), procédez comme suit :

* Ouvrez le fichier de configuration existant dans Connector Configurator.
» Sélectionnez 'onglet Standard Properties.

* Dans la zone BrokerType de l'onglet Standard Properties, sélectionnez la valeur
appropriée pour votre courtier.
Lorsque vous modifiez la valeur courante, les onglets et les zones disponibles
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dans la fenétre des propriétés changent immédiatement, et seuls les onglets et

les zones appartenant au nouveau courtier sélectionné apparaissent.

Achévement de la configuration

Une fois que vous avez créé un fichier de configuration pour un connecteur et que

vous l'avez modifié, assurez-vous que le connecteur peut localiser le fichier de
configuration lorsqu’il démarre.

Pour ce faire, ouvrez le fichier de démarrage utilisé pour le connecteur et vérifiez
que le nom de fichier et I'emplacement utilisés pour le fichier de configuration du
connecteur correspondent exactement au nom attribué au fichier et au répertoire

ou au chemin d’acces dans lequel vous l'avez placé.

Utilisation de Connector Configurator dans un environnement

globalisé

Connector Configurator est globalisé et peut gérer la conversion des caracteres

entre le fichier de configuration et le courtier d’intégration. Connector Configurator
utilise le codage natif. Lorsqu’il écrit dans le fichier de configuration, il utilise le

codage UTE-8.

Connector Configurator prend en charge les caractéres non anglais dans :

* toutes les zones de valeur ;

* le chemin d’acces au fichier journal et au fichier de trace (indiqué dans 'onglet

Trace/Log files).

La liste déroulante pour les propriétés de configuration standard
CharacterEncoding et Locale affiche uniquement un sous-ensemble des valeurs

prises en charge. Pour ajouter d’autres valeurs a cette liste, vous devez modifier

manuellement le fichier \Data\Std\stdConnProps.xml dans le répertoire produit.

Par exemple, pour ajouter I'environnement local en_GB a la liste des valeurs pour la
propriété Locale, ouvrez le fichier stdConnProps.xml et ajoutez la ligne en caractere
gras comme indiqué ci-dessous :

<Property name="Locale"
isRequired="true"

updateMethod="component restart">
<ValidType>String</ValidType>

<ValidValues>

<DefaultValue>en US</DefaultValue>

</ValidValues>
</Property>

<Value>ja_JP</Value>
<Value>ko KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>
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Propriétés standard des connecteurs

164

Cette annexe présente les propriétés de configuration standard du connecteur des
adaptateurs WebSphere Business Integration. Les informations couvrent les
connecteurs qui s’exécutent avec les courtiers d’intégration suivants :

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker et WebSphere
Business Integration Message Broker, désignés collectivement sous 1’appellation
WebSphere Message Brokers (et sous le nom WMQI dans Connector
Configurator)

* Information Integrator (II)

* WebSphere Application Server (WAS)

Si votre adaptateur prend en charge DB2 Information Integrator, utilisez les options
WMOI et les propriétés standard DB2 II (voir la colonne Remarques dans le
ftableau 13 a la page 166).

Les propriétés définies pour I'adaptateur dépendent du courtier d'intégration
utilisé. Pour choisir le courtier d’intégration, utilisez Connector Configurator. Une
fois le courtier sélectionné, Connector Configurator répertorie les propriétés
standard a configurer pour 1’adaptateur.

Pour plus d’informations sur les propriétés spécifiques au connecteur, voir la
section appropriée dans ce guide.

Nouvelles propriétés

Les propriétés standard suivantes ont été ajoutées dans cette version :
* AdapterHelpName

* BiDi.Application

* BiDi.Broker

* BiDi.Metadata

* BiDi.Transformation

* CommonEvent-
Infrastructure

¢ CommonEvent-
InfrastructureContextURL

* ControllerEven-
tSequencing

* jms.Listener- Concurrency
* jms.Transport- Optimized
* ResultsSetEnabled

* ResultsSetSize

¢ TivoliTransactionMonitor-
Performance

Présentation des propriétés standard du connecteur

Les connecteurs ont deux types de propriété de configuration :
* les propriétés de configuration standard utilisées par la structure ;

* les propriétés de configuration standard spécifiques a 'application ou au
connecteur utilisées par l'agent.
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Ces propriétés déterminent la structure de 'adaptateur et le comportement
d’exécution de l'agent.

Cette section explique comment démarrer Connector Configurator et décrit les
caractéristiques communes a toutes les propriétés. Pour plus d’informations sur les
propriétés de configuration spécifiques a un connecteur, voir le guide d’utilisateur
correspondant.

Démarrage de Connector Configurator

Vous pouvez configurer les propriétés du connecteur a partir de Connector
Configurator, accessible via System Manager. Pour plus d’informations sur
l"utilisation de Connector Configurator, voir les sections relatives & Connector
Configurator dans ce guide.

Connector Configurator et System Manager s’exécutent uniquement sur Windows.
Si vous exécutez le connecteur sur un systeme UNIX, vous devez posséder une
machine Windows sur laquelle ces outils sont installés.

Pour configurer les propriétés d'un connecteur exécuté sur UNIX, vous devez
démarrer System Manager sur la machine Windows. Vous devez ensuite vous
connecter au courtier d’intégration UNIX et démarrer Connector Configurator pour
le connecteur.

Présentation des valeurs des propriétés de configuration
Le connecteur utilise 1’ordre suivant pour déterminer la valeur d’une propriété :

1. valeur par défaut ;

2. référentiel (valide uniquement si WebSphere InterChange Server (ICS) est le
courtier d’intégration) ;

3. fichier de configuration locale ;
4. ligne de commande.

La longueur par défaut d’une propriété est de 255 caracteres. Il n’existe aucune
limite de longueur pour une propriété de type STRING. Par contre, la longueur
d’une propriété de type INTEGER est déterminée par le serveur sur lequel
I'adaptateur s’exécute.

Un connecteur obtient ses valeurs de configuration au cours du démarrage. Si vous
modifiez la valeur d"une ou plusieurs propriétés du connecteur lors d"une session
d’exécution, la méthode de mise a jour de la propriété détermine la maniere dont
les modifications prennent effet.

Les caractéristiques de mise a jour d’une propriété, c’est-a-dire le mode et la date
d’entrée en vigueur des propriétés du connecteur, dépendent de la nature de la
propriété.

Il existe quatre méthodes de mise a jour pour les propriétés standard du

connecteur :

* Dynamique
La nouvelle valeur prend effet immédiatement apres son enregistrement dans
System Manager. Toutefois, si le connecteur est en mode autonome
(indépendamment de System Manager), par exemple s’il s’exécute avec 1'un des
courtiers de messages WebSphere, vous pouvez modifier les propriétés
uniquement dans le fichier de configuration. Dans ce cas, une mise a jour
dynamique n’est pas possible.
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* Redémarrage de I'agent (ICS uniquement)
La nouvelle valeur prend effet uniquement une fois que vous avez arrété et
redémarré l'agent du connecteur.

* Redémarrage du composant
La nouvelle valeur prend effet uniquement une fois que vous avez arrété et
redémarré le connecteur dans System Manager. Vous n’avez pas besoin d’arréter
et de redémarrer I'agent ou le processus du serveur.

* Redémarrage du systéeme
La nouvelle valeur prend effet uniquement une fois que vous avez arrété et
redémarré l'agent du connecteur et le serveur.

Pour déterminer comment une propriété est mise a jour, voir la colonne Update
Method dans la fenétre Connector Configurator ou la colonne Méthode de mise a
jour dans le [tableau 13 a la page 166|

Une propriété standard peut se trouver dans trois emplacements. Certaines
propriétés peuvent également se trouver dans plusieurs emplacements a la fois.

* ReposController
Cette propriété réside dans le contréleur du connecteur et ne fonctionne qu’a cet
emplacement. Si vous modifiez la valeur du c6té de 1’agent, cela n’affecte pas le
controleur.

* ReposAgent
Cette propriété réside dans 1’agent et ne fonctionne qu’a cet emplacement. Une
configuration locale peut remplacer cette valeur selon la propriété.

* LocalConfig
Cette propriété réside dans le fichier de configuration du connecteur et peut
uniquement agir via le fichier de configuration. Le contréleur ne peut pas
modifier la valeur de la propriété et n’a pas connaissance des modifications
apportées au fichier de configuration sauf si le systeme est redéployé pour
mettre explicitement a jour le contrdleur.

Récapitulatif des propriétés standard

Le [tableau 13| contient un récapitulatif des propriétés de configuration standard du
connecteur. Tous les connecteurs n’utilisent pas toutes ces propriétés, et les
parametres des propriétés peuvent différer d’un courtier d’intégration a 1’autre.

Pour obtenir une description de chaque propriété, voir la section sous le tableau.

Remarque : Dans la colonne Remarques du la phrase “Le répertoire du
référentiel est <REMOTE>" indique que le courtier est InterChange
Server. Lorsque le courtier est WMQI ou WAS, le répertoire du
référentiel a la valeur <ProductDir>\repository.

Tableau 13. Récapitulatif des propriétés de configuration standard

Méthode de
Nom de la propriété | Valeurs possibles Valeur par défaut mise a jour Remarques
AdapterHelpName | Un des Nom du modele, Redémarrage Parametres régionaux
sous-répertoires si approprié, du composant pris en charge.
valides dans ou zone vide Notamment chs_chn,
<ProductDir>\bin\Data cht_twn, deu_deu,
\App\Help\ qui esn_esp, fra_fra,
contient un répertoire ita_ita, jpn_jpn,
<RegionalSetting> kor_kor, ptb_bra
correct et enu_usa (par défaut).
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Nom de la propriété

Valeurs possibles

Valeur par défaut

Méthode de
mise a jour

Remarques

AdminInQueue Nom de file d’attente JMS <CONNECTORNAME> Redémarrage Cette propriété est valide
correct /ADMININQUEUE du composant uniquement lorsque la valeur
de DeliveryTransport
est JMS
AdminOutQueue Nom de file d’attente J]MS <CONNECTORNAME> Redémarrage Cette propriété est valide
correct /ADMINOUTQUEUE du composant uniquement lorsque la valeur
de DeliveryTransport
est JMS
AgentConnections Delad 1 Redémarrage Cette propriété est valide
du composant uniquement lorsque la valeur
de DeliveryTransport
est MQ ou IDL, que la valeur
de RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
AgentTraceLevel De0ab 0 Dynamique
si le courtier est
1CS,
sinon
redémarrage
du composant
ApplicationName Nom de I'application Valeur spécifiée pour Redémarrage
le nom de l'application |du composant
du connecteur
BiDi.Application Toute combinaison valide ILYNN (cing lettres) Redémarrage Cette propriété est valide
des attributs bidirectionnels du composant uniquement si la
suivants : valeur
de BiDi.Transformation
Premiere lettre : I,V est true
Deuxiéme lettre : L,R
Troisiéme lettre : Y, N
Quatrieme lettre : S, N
Cinquiéme lettre : H, C, N
BiDi.Broker Toute combinaison valide ILYNN (cing lettres) Redémarrage Cette propriété est valide
des attributs bidirectionnels du composant uniquement si la
suivants : valeur de
BiDi.Transformation
Premidre lettre : I,V est true. Si la valeur de
Deuxieme lettre : L,R BrokerType est
Troisieme lettre : Y, N ICS, la propriété
Quatriéme lettre : S, N est en lecture seule.
Cinquiéme lettre : H, C, N
BiDi.Metadata Toute combinaison valide ILYNN (cing lettres) Redémarrage Cette propriété est valide

des attributs bidirectionnels
suivants :

Premiere lettre : I,V
Deuxiéme lettre : L,
Troisiéme lettre : Y,
Quatrieme lettre : S, N

Cinquiéme lettre : H, C, N

R
N

du composant

uniquement si la
valeur de
BiDi.Transformation
est true.

BiDi.Transformation

trueou false

false

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de

BrokerType n’est

pas WAS
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Méthode de

Nom de la propriété | Valeurs possibles Valeur par défaut mise a jour Remarques
BrokerType ICS, WMQI, WAS ICS Redémarrage
du composant
CharacterEncoding | Tout code pris en charge. |ascii7 Redémarrage Cette propriété est valide
La liste suivante présente du composant uniquement pour les
ce sous-ensemble : connecteurs C++.
ascii7, ascii8, SJIS,
Cp949, GBK, Big5,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
CommonEvent- trueou false false Redémarrage
Infrastructure du composant
CommonEvent- Chaine URL, par Aucune valeur par Redémarrage Cette propriété est valide
InfrastructureURL exemple, défaut. du composant uniquement si la
corbaloc:iiop: valeur de
host:2809. CommonEvent
Infrastructure est true.
ConcurrentEvent- De 1 a 32,767 1 Redémarrage Cette propriété est valide
TriggeredFlows du composant uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
Container- Aucune valeur ou JMS Aucune valeur Redémarrage Cette propriété est valide
ManagedEvents du composant uniquement lorsque la valeur
de DeliveryTransport
est JMS.
ControllerEvent- trueou false true Dynamique Cette propriété est valide
Sequencing uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
Controller- true ou false true Dynamique Cette propriété est valide
StoreAnd- uniquement si la
ForwardMode valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
ControllerTraceLevel [De 0 a 5 0 Dynamique Cette propriété est valide
uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
DeliveryQueue Nom de file d’attente <CONNECTORNAME> Redémarrage Cette propriété est valide
JMS correct /DELIVERYQUEUE du composant uniquement lorsque la valeur
de DeliveryTransport
est JMS.
DeliveryTransport MQ, IDL ou JMS IDL lorsque la valeur Redémarrage Si la valeur de
de RepositoryDirectory |du composant RepositoryDirectory n’est
est <REMOTE>, pas <REMOTE>,
sinon JMS la seule valeur valide pour
cette propriété est JMS.
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Nom de la propriété

Valeurs possibles

Valeur par défaut

Méthode de
mise a jour

Remarques

DuplicateEvent- trueou false false Redémarrage Cette propriété est valide
Elimination du composant uniquement si la

valeur de

DeliveryTransport est JMS.
EnableOidFor- trueou false false Redémarrage Cette propriété est valide
FlowMonitoring du composant uniquement si la

valeur de

BrokerType est ICS.
FaultQueue Nom de file d’attente correct | <CONNECTORNAME> Redémarrage Cette propriété est

/FAULTQUEUE du composant valide uniquement si la

valeur
de DeliveryTransport
est JMS.

jms.Factory-

CxCommon.Messaging.jms

CxCommon.Messaging.

Redémarrage

Cette propriété est

ClassName . IBMMQSeriesFactory, jms . IBMMQSeries- du composant valide uniquement si
CxCommon.Messaging Factory la valeur
.jms.SonicMQFactory, de DeliveryTransport
ou n'importe quel nom de est JMS.
classe Java

jms.Listener- De 1 a 32767 1 Redémarrage Cette propriété est

Concurrency

du composant

valide uniquement si la
valeur de
jms.Transport-
Optimized

est true.

jms.Message-
BrokerName

Si la valeur de
jms.FactoryClass-

crossworlds.queue.
manager

Redémarrage
du composant

Cette propriété est valide
uniquement si la

Name valeur de
est IBM, utilisez DeliveryTransport
crossworlds.queue. est JMS
manager.
jms NumConcurrent- | Nombre entier positif 10 Redémarrage Cette propriété est valide
Requests du composant uniquement si la
valeur de
DeliveryTransport
est JMS
jms.Password Mot de passe correct Redémarrage Cette propriété est valide
du composant uniquement si la
valeur de
DeliveryTransport
est JMS
jms.Transport- trueou false false Redémarrage Cette propriété est valide

Optimized

du composant

uniquement si la

valeur de
DeliveryTransport

est JMS et que la valeur de
BrokerType est ICS.

jms.UserName

Nom correct

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
DeliveryTransport est JMS.
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Nom de la propriété

Valeurs possibles

Valeur par défaut

Méthode de
mise a jour

Remarques

JvmMaxHeapSize

Taille de segment en
mégaoctets

128 mo

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
RepositoryDirectory

est <REMOTE>

et que la valeur de
BrokerType est ICS.

JvmMaxNativeStack-
Size

Taille de I'espace mémoire
en kilooctets

128 ko

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
RepositoryDirectory

est <REMOTE>

et que la valeur de
BrokerType est ICS.

JvmMinHeapSize

Taille de segment en
mégaoctets

1 mo

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
RepositoryDirectory

est <REMOTE>

et que la valeur de
BrokerType est ICS.

ListenerConcurrency

De 14100

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
DeliveryTransport est MQ.

Locale

Sous-ensemble des
environnements locaux
pris en charge :
en_US, ja_JP, ko_KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,

es_ES, pt_BR

en_US

Redémarrage
du composant

LogAtInterchange-
End

trueou false

false

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
RepositoryDirectory

est <REMOTE>

et que la valeur de
BrokerType est ICS.

MaxEventCapacity

De 1 a 2147483647

2147483647

Dynamique

Cette propriété est valide
uniquement si la

valeur de
RepositoryDirectory

est <REMOTE>

et que la valeur de
BrokerType est ICS.

MessageFileName

Nom de fichier correct

InterchangeSystem.txt

Redémarrage
du composant

MonitorQueue

Nom de file d’attente correct

<CONNECTORNAME>
/MONITORQUEUE

Redémarrage
du composant

Cette propriété est valide
uniquement si la

valeur de
DuplicateEventElimination
est trueet que
ContainerManagedEvents
n’‘a aucune valeur.
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Nom de la propriété

Valeurs possibles

Valeur par défaut

Méthode de
mise a jour

Remarques

OADAutoRestart- trueou false false Dynamique Cette propriété est valide
Agent uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
OADMaxNumRetry | Nombre entier positif 1000 Dynamique Cette propriété est valide
uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
OADRetryTime- Nombre entier positif 10 Dynamique Cette propriété est valide
Interval en minutes uniquement si la
valeur de
RepositoryDirectory
est <REMOTE>
et que la valeur de
BrokerType est ICS.
PollEndTime HH =0 a 23 HH:MM Redémarrage
MM =0 a 59 du composant
PollFrequency Nombre entier positif 10 000 Dynamique
(en millisecondes) si le courtier est
1CS,
sinon
redémarrage
du composant
PollQuantity De 1 a 500 1 Redémarrage de |Cette propriété est valide
l'agent uniquement si la
valeur de
ContainerManagedEvents
est JMS.
PollStartTime HH =0a 23 HH:MM Redémarrage
MM =0 a 59 du composant
RepositoryDirectory | <REMOTE> si le courtier Pour ICS, la valeur est |Redémarrage
est ICS, sinon n’importe <REMOTE> de l'agent
quel
répertoire local correct. Pour WMQI et WAS,
la valeur est
<ProductDir
\repository
RequestQueue Nom de file d’attente JMS <CONNECTORNAME> Redémarrage Cette propriété est valide
correct /REQUESTQUEUE du composant uniquement si la
valeur de
DeliveryTransport
est JMS
ResponseQueue Nom de file d’attente JMS <CONNECTORNAME> Redémarrage Cette propriété est valide
correct /RESPONSEQUEUE du composant uniquement si la
valeur de
DeliveryTransport est JMS.
RestartRetryCount De 0a 99 3 Dynamique
si le courtier
est ICS,
sinon
redémarrage

du composant
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Méthode de

Nom de la propriété | Valeurs possibles Valeur par défaut mise a jour Remarques
RestartRetryInterval | Valeur en minutes 1 Dynamique
de 1 a 2147483647 si le courtier
est ICS,
sinon
redémarrage
du composant
ResultsSetEnabled trueou false false Redémarrage Utilisée uniquement par
du composant les connecteurs
prenant en charge DB2II.
Cette propriété est valide
uniquement si la
valeur de
DeliveryTransport
est JMS et que la valeur de
BrokerType est WMQI.
ResultsSetSize Nombre entier positif 0 (indique que la taille |Redémarrage Utilisée uniquement par les
définie pour du composant connecteurs
les résultats prenant en charge DB2IL
est illimitée)
Cette propriété est valide
uniquement si la
valeur de
ResultsSetEnabled
est true.
RHF2Message- mrm ou xml mrm Redémarrage Cette propriété est valide
Domain du composant uniquement si la
valeur
de DeliveryTransport
est JMS et que la valeur de
WireFormat est CwXML.
SourceQueue Nom de file d’attente <CONNECTORNAME> Redémarrage Cette propriété est valide
WebSphere MQ correct /SOURCEQUEUE de l'agent uniquement si la
valeur de
ContainerManagedEvents
est JMS.
SynchronousRequest- | Nom de file d’attente correct | <CONNECTORNAME> Redémarrage Cette propriété est valide
Queue /SYNCHRONOUSREQUEST du composant uniquement si la
QUEUE valeur
de DeliveryTransport
est JMS.
SynchronousRequest- | De 0 a n'importe nombre |0 Redémarrage Cette propriété est valide
Timeout (en millisecondes) du composant uniquement si la
valeur
de DeliveryTransport
est JMS.
Synchronous- Nom de file d’attente correct | <CONNECTORNAME> Redémarrage Cette propriété est valide
ResponseQueue /SYNCHRONOUSRESPONSE du composant uniquement si la
QUEUE valeur
de DeliveryTransport
est JMS.
TivoliMonitor- trueou false false Redémarrage
Transaction- du composant
Performance
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Tableau 13. Récapitulatif des propriétés de configuration standard (suite)

Nom de la propriété

Valeurs possibles Valeur par défaut mise a jour Remarques

Méthode de

WireFormat

CwXML ou CwBO CwXML Redémarrage La valeur de cette

de l'agent propriété doit étre CwXML
si la valeur

de RepositoryDirectory
n‘est pas <REMOTE>.
La valeur doit

étre CwBO si la valeur de
RepositoryDirectory est
<REMOTE>.

WsifSynchronous-
RequestTimeout

De 0 a n'importe quel 0 Redémarrage Cette propriété est valide
nombre (en millisecondes) du composant uniquement si la

valeur de
BrokerType est WAS.

XMLNameSpace-
Format

short ou long short Redémarrage Cette propriété est valide

de l'agent uniquement si la
valeur de
BrokerType est
WMQI ou WAS

Propriétés standard

Cette section présente les propriétés de configuration standard du connecteur.

AdapterHelpName

La propriété AdapterHelpName correspond au nom d’un répertoire dans lequel se
trouvent les fichiers d’aide étendue spécifiques au connecteur. Le répertoire doit
étre a I'emplacement <ProductDir>\bin\Data\App\Help et doit contenir au
minimum le répertoire de langue enu_usa. Il peut également contenir d’autres
répertoires en fonction de 1’environnement local.

La valeur par défaut est le nom du modele s’il est correct ou aucune valeur.

AdmininQueue
La propriété AdminInQueue indique la file d’attente utilisée par le courtier
d’intégration pour envoyer des messages administratifs au connecteur.

La valeur par défaut est <CONNECTORNAME>/ADMININQUEUE.

AdminOutQueue
La propriété AdminOutQueue indique la file d’attente utilisée par le connecteur
pour envoyer des messages administratifs au courtier d’intégration.

La valeur par défaut est <CONNECTORNAME>/ADMINOUTQUEUE.

AgentConnections
La propriété AgentConnections contrdle le nombre de connexions ORB (Object
Request Broker) ouvertes lors de l'initialisation du courtier ORB.

Elle est valide uniquement si la valeur de la propriété RepositoryDirectory est
<REMOTE> et que la valeur de la propriété DeliveryTransport est MQ ou IDL.

La valeur par défaut de cette propriété est 1.
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AgentTraceLevel

La propriété AgentTraceLevel définit le niveau des messages de trace pour le
composant spécifique a I'application. Le connecteur fournit tous les messages de
trace applicables au niveau de trace défini et a un niveau inférieur.

La valeur par défaut est 0.

ApplicationName

La propriété ApplicationName identifie de maniere unique le nom de l'application
du connecteur. Ce nom permet a I'administrateur systéme de controler
I'environnement d’intégration. Vous devez attribuer une valeur a cette propriété
pour exécuter le connecteur.

La valeur par défaut est le nom du connecteur.

BiDi.Application

La propriété BiDi.Application indique le format bidirectionnel des données
provenant d’une application externe dans 'adaptateur sous la forme d’un objet
métier pris en charge par cet adaptateur. La propriété définit les attributs
bidirectionnels des données de 'application. Ces attributs sont les suivants :

* Type de texte : implicite ou visuel (I ou V)

* Direction du texte : de gauche a droite ou de droite a gauche (L ou R)

* Echange symétrique : actif ou inactif (Y ou N)

* Mise en forme (Arabe) : active ou inactive (S ou N)

* Mise en forme numérique (Arabe) : Hindi, contextuelle ou nominale (H, C ou N)

Cette propriété est valide uniquement si la valeur de la propriété
BiDi.Transformation est true.

La valeur par défaut est ILYNN (implicite, de gauche a droite, actif, inactive,
nominale).

BiDi.Broker

La propriété BiDi.Broker indique le format bidirectionnel des données envoyées
depuis l'adaptateur vers le courtier d’intégration sous la forme dun objet métier
pris en charge. Elle définit les attributs bidirectionnels des données, répertoriés
sous la propriété BiDi.Application ci-dessus.

Cette propriété est valide uniquement si la valeur de la propriété
BiDi.Transformation est true. Si la valeur de la propriété BrokerType est ICS, la
propriété est en lecture seule.

La valeur par défaut est ILYNN (implicite, de gauche a droite, actif, inactive,
nominale).

BiDi.Metadata

La propriété BiDi.Metadata définit le format bidirectionnel ou les attributs des
métadonnées, utilisés par le connecteur pour établir et maintenir un lien avec
I'application externe. Les parametres des attributs sont spécifiques a chaque
adaptateur a l'aide des fonctions bidirectionnelles. Si votre adaptateur prend en
charge le traitement bidirectionnel, consultez la section relative aux propriétés
spécifiques a 1'adaptateur pour plus d’informations.

Cette propriété est valide uniquement si la valeur de la propriété
BiDi.Transformation est true.
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La valeur par défaut est ILYNN (implicite, de gauche a droite, actif, inactive,
nominale).

BiDi.Transformation
La propriété BiDi.Transformation définit si le systéme réalise une transformation
bidirectionnelle lors de 1’exécution.

Si la valeur de la propriété est true, les propriétés BiDi.Application, BiDi.Broker et
BiDi.Metadata sont disponibles. Si la valeur de la propriété est false, elles sont
masquées.

La valeur par défaut est false.

BrokerType

La propriété BrokerType identifie le type de courtier d’intégration que vous
utilisez. Les valeurs possibles sont : ICS, WMQI (pour WMQI, WMQIB ou WBIMB) ou
bien WAS.

CharacterEncoding

La propriété CharacterEncoding indique le jeu de codes de caracteres utilisé pour
mapper un caractére (comme une lettre de 1’alphabet, une représentation
numérique ou un signe de ponctuation) a une valeur numérique.

Remarque : Les connecteurs Java n’utilisent pas cette propriété. Les connecteurs
C++ utilisent la valeur ascii7 pour cette propriété.

Par défaut, seul un sous-ensemble des codages de caracteres pris en charge
s’affiche. Pour ajouter a cette liste d’autres valeurs prises en charge, vous devez
modifier manuellement le fichier \Data\Std\stdConnProps.xml dans le répertoire
produit (<ProductDir>). Pour plus d’informations, voir I’annexe relative a
Connector Configurator dans ce guide.

CommonEventinfrastructure

L’infrastructure Common Event Infrastructure (CEI) est une fonction simple de
gestion des événements créés. La propriété CommonEventInfrastructure indique si
l'infrastructure CEI doit étre appelée au moment de 1'exécution.

La valeur par défaut est false.

CommonEventinfrastructureContextURL

La propriété CommonEventInfrastructureContextURL est utilisée pour accéder au
serveur WAS qui exécute I'application serveur de l'infrastructure CEI. Cette
propriété indique 1’'URL a utiliser.

Cette propriété est valide uniquement si la valeur de la propriété
CommonEventInfrastructure est true.

La valeur par défaut est une zone vide.

ConcurrentEventTriggeredFlows

La propriété ConcurrentEventTriggeredFlows détermine le nombre d’objets métier
pouvant étre traités simultanément par le connecteur pour la transmission des
événements. La valeur de cet attribut doit correspondre au nombre d’objets métier
mappés et transmis simultanément. Par exemple, si vous affectez a cette propriété
la valeur 5, cinq objets métier sont traités simultanément.
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La définition de cette propriété sur une valeur supérieure a 1 permet au
connecteur d’une application source de mapper plusieurs objets métier
d’événement en méme temps et de les transmettre simultanément a plusieurs
instances de collaboration. Cela augmente la rapidité de transmission des objets
métier au courtier d’intégration, en particulier si les objets métier utilisent des
mappes complexes. L’augmentation du taux d’arrivée des objets métier aux
instances de collaboration peut améliorer les performances générales du systeme.

Pour implémenter le traitement simultané d’un flux entier (d’une application
source vers une application cible), les propriétés suivantes doivent étre configurées

* La collaboration doit étre configurée en attribuant a sa propriété Maximum number
of concurrent events une valeur suffisamment élevée pour qu’elle utilise
plusieurs unités d’exécution.

* Le composant d’application cible doit étre configuré de sorte qu’il puisse
exécuter les requétes simultanément. C’est-a-dire qu’il doit avoir plusieurs unités
d’exécution ou étre capable d’utiliser le parallélisme de 'agent du connecteur et
étre configuré pour traiter plusieurs processus. La valeur de la propriété de
configuration Parallel Process Degree doit étre supérieure a 1.

La propriété ConcurrentEventTriggeredFlows n’a aucun effet sur l'interrogation du
connecteur, laquelle n’a qu'une seule unité d’exécution et est exécutée en série.

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE>.

La valeur par défaut est 1.

ContainerManagedEvents

La propriété ContainerManagedEvents permet a un connecteur compatible JMS
utilisant un magasin d’événements JMS d’effectuer une transmission d’événement
garantie, dans laquelle un événement est retiré de la file d’attente source et placé
dans la file d’attente cible en tant que transaction JMS.

Lorsque cette propriété a la valeur JMS, les propriétés suivantes doivent également
étre configurées pour activer la transmission d’événement garantie :

* PollQuantity = 1 a 500
* SourceQueue = /SOURCEQUEUE

Vous devez aussi configurer un gestionnaire de données avec les propriétés
MimeType et DHClass (classe de gestionnaire de données). Vous pouvez également
ajouter la propriété DataHandlerConfigMOName (nom du métaobjet, facultatif).
Pour définir ces valeurs, utilisez 'onglet Data Handler dans Connector
Configurator.

Bien que ces propriétés soient spécifiques a l'adaptateur, voici quelques exemples
de valeurs :

* MimeType = text\xml
e DHClass = com.crossworlds.DataHandlers.text.xml
* DataHandlerConfigMOName = MO_DataHandler_Default

Les zones de ces valeurs s’affichent dans I'onglet Data Handler uniquement si la
propriété ContainerManagedEvents a la valeur JMS.
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Remarque : Lorsque ContainerManagedEvents a la valeur JMS, le connecteur
n’appelle pas sa méthode pollForEvents(), désactivant ainsi la
fonctionnalité de celle-ci.

La propriété ContainerManagedEvents est valide uniquement si la valeur de la
propriété DeliveryTransport est JMS.

Il n’existe pas de valeur par défaut.

ControllerEventSequencing
La propriété ControllerEventSequencing active ’organisation des événements dans
le contréleur du connecteur.

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE> (et que BrokerType a la valeur ICS).

La valeur par défaut est true.

ControllerStoreAndForwardMode

La propriété ControllerStoreAndForwardMode définit le comportement du
contrdleur du connecteur apres avoir détecté I'indisponibilité du composant
spécifique a l'application cible.

Si cette propriété a la valeur true et que le composant spécifique a l’application
cible n’est pas disponible lorsqu'un événement atteint 1I'ICS, le controleur du
connecteur empéche la requéte d’accéder au composant spécifique a 1’application.
Lorsque le composant spécifique a ’application redevient opérationnel, le
controleur lui envoie la requéte.

Toutefois, si le composant d’application cible devient indisponible apres que le
contrdleur du connecteur lui a envoyé la requéte d’appel de service, celle-ci
échoue.

Si cette propriété a la valeur false, le contréleur du connecteur met toutes les
requétes d’appels de service en échec des qu’il détecte 1'indisponibilité du
composant spécifique a 1’application.

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est ICS).

La valeur par défaut est true.

ControllerTracelLevel
La propriété ControllerTraceLevel définit le niveau des messages de trace pour le
contrdleur du connecteur.

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE>.

La valeur par défaut est 0.

DeliveryQueue
La propriété DeliveryQueue définit la file d’attente utilisée par le connecteur pour
envoyer des objets métier au courtier d’intégration.
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Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est <CONNECTORNAME>/DELIVERYQUEUE.

DeliveryTransport

La propriété DeliveryTransport spécifie le mécanisme de transfert pour la
transmission des événements. Les valeurs possibles sont MQ pour WebSphere MQ,
IDL pour CORBA IIOP ou JMS pour Java Messaging Service.

* Si la valeur de la propriété RepositoryDirectory est <REMOTE>, la valeur de la
propriété DeliveryTransport peut étre MQ, IDL ou JMS, et la valeur par défaut est
IDL.

* Sila valeur de la propriété RepositoryDirectory représente un répertoire local, la
valeur associée ne peut étre que JMS.

Le connecteur envoie les requétes d’appel de service et les messages administratifs
via CORBA IIOP si la valeur de la propriété RepositoryDirectory est MQ ou IDL.

La valeur par défaut est JMS.

WebSphere MQ et IDL: Utilisez WebSphere MQ plutdt que IDL pour le transfert
d’événement, sauf si vous ne devez avoir qu'un seul produit. WebSphere MQ
présente les avantages suivants par rapport a IDL :

* Communication asynchrone :
WebSphere MQ permet au composant spécifique a 1’application d’interroger et
de stocker de maniére permanente les événements, méme lorsque le serveur
n’est pas disponible.

* Performance coté serveur :
WebSphere MQ offre plus de rapidité du coté du serveur. En mode optimisé,
WebSphere MQ ne stocke que le pointeur désignant un événement dans la base
de données du référentiel, tandis que 1’'événement correspondant reste dans la
file d’attente de WebSphere MQ. Cela permet d’éviter I'écriture d’événements
pouvant étre volumineux dans la base de données du référentiel.

* Performance coté agent :
WebSphere MQ offre plus de rapidité du c6té du composant spécifique a
l'application. Avec WebSphere MQ, 1'unité d’exécution d’interrogation du
connecteur sélectionne un événement, le place dans la file d’attente du
connecteur, puis sélectionne 1’'événement suivant. Cette méthode est plus rapide
que celle d'IDL, dans laquelle l'unité d’exécution d’interrogation du connecteur
doit sélectionner un événement, accéder au réseau dans le processus du serveur,
stocker 1'événement de maniére permanente dans la base de données du
référentiel, puis sélectionner I'événement suivant.

JMS: Le mécanisme de transfert JMS permet la communication entre le
connecteur et la structure du connecteur client a 1’aide de Java Messaging Service
(JMS).

Si vous sélectionnez JMS en tant que protocole de transfert, des propriétés JMS
supplémentaires telles que jms.MessageBrokerName, jms.FactoryClassName,
jms.Password et jms.UserName sont répertoriées dans Connector Configurator. Les
propriétés jms.MessageBrokerName et jms.FactoryClassName sont obligatoires pour
ce transfert.

II peut y avoir une limitation de mémoire si vous utilisez le mécanisme de
transfert JMS pour un connecteur dans l'environnement suivant :
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* AIX5.0
* WebSphere MQ 5.3.0.1

* lorsqu’ICS est le courtier d'intégration

Dans cet environnement, vous rencontrerez peut-étre des difficultés pour démarrer
simultanément le contrdleur du connecteur (du coté du serveur) et le connecteur
(du coté du client), en raison de 1'utilisation de la mémoire dans le client
WebSphere MQ. Si votre installation utilise moins de 768 Mo en taille de segment
de processus, définissez les variables et propriétés suivantes :

* Définissez la variable d’environnement LDR_CNTRL dans le script
CWSharedEnv.sh.

Ce script se trouve dans le répertoire \bin sous le répertoire produit
(<ProductDir>). A 'aide d'un éditeur de texte, ajoutez la ligne suivante a la
premiere ligne du script CWSharedEnv.sh :

export LDR_CNTRL=MAXDATA=0x30000000

Cette ligne de commande restreint 'utilisation du segment de mémoire a un
maximum de 768 Mo (3 segments * 256 Mo). Si la mémoire du processus
dépasse cette limite, un remplacement des pages peut se produire, ce qui peut
affecter les performances de votre systéme.

 Affectez la valeur 11 ou 12 a la propriété IPCCBaseAddress. Pour plus

d’informations sur cette propriété, voir le document System Installation Guide for
UNIX.

DuplicateEventElimination

Lorsque vous affectez a cette propriété la valeur true, un connecteur compatible
JMS peut vérifier que des doublons ne sont pas transmis a la file d’attente de
transmission. Pour utiliser cette fonction lors du développement d’un connecteur,
ce dernier doit avoir un identificateur d’événement unique défini en tant
qu’attribut ObjectEventld de 1'objet métier dans le code spécifique a 1’application.

Remarque : Lorsque vous affectez a cette propriété la valeur true, la propriété
MonitorQueue doit étre activée pour effectuer une transmission
d’événement garantie.

La valeur par défaut est false.

EnableOidForFlowMonitoring

Lorsque vous affectez a cette propriété la valeur true, le contexte d’exécution de
I'adaptateur utilise 1’attribut ObjectEventID entrant en tant que clé étrangere pour
le controle des flux.

Cette propriété est valide uniquement si la valeur de la propriété BrokerType est
ICS.

La valeur par défaut est false.

FaultQueue

Si le connecteur rencontre une erreur lors du traitement d’un message, il transmet
ce message (accompagné d’'un indicateur d’état et d'une description de l'incident) a
la file d’attente spécifiée dans la propriété FaultQueue.

La valeur par défaut est <CONNECTORNAME>/FAULTQUEUE.
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jms.FactoryClassName

La propriété jms.FactoryClassName indique le nom de classe a instancier pour un
fournisseur JMS. Cette propriété doit étre définie si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

La propriété jms.ListenerConcurrency indique le nombre de modules d’écoute
simultanés pour le contrdleur JMS. Elle indique le nombre d’unités d’exécution qui
extraient et traitent les messages simultanément dans un controleur.

Cette propriété est valide uniquement si la valeur de la propriété
jms.OptimizedTransport est true.

La valeur par défaut est 1.

jms.MessageBrokerName

La propriété jms.MessageBrokerName indique le nom du courtier a utiliser pour le
fournisseur JMS. Vous devez définir cette propriété de connecteur si vous indiquez
JMS comme mécanisme de transfert (dans la propriété DeliveryTransport).

Lorsque vous vous connectez a un courtier de messages distant, cette propriété
requiert les valeurs suivantes :

QueueMgrName : Channel :Hos tName : PortNumber

ou :

QueueMgrhNameest le nom du gestionnaire de files d’attente ;

Channelest le canal utilisé par le client ;

HostNameest le nom de la machine sur laquelle le gestionnaire de files d’attente doit
résider ;

PortNumberest le numéro de port utilisé par le gestionnaire de files d’attente pour
écouter.

Par exemple :
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

La valeur par défaut est crossworlds.queue.manager. Utilisez la valeur par défaut
lorsque vous vous connectez a un courtier de messages local.

jms.NumConcurrentRequests

La propriété jms.NumConcurrentRequests indique le nombre maximal de requétes
d’appel de service pouvant étre envoyées simultanément a un connecteur. Lorsque
ce nombre maximal est atteint, les nouveaux appels de service sont bloqués et
doivent attendre la fin d’une autre requéte avant de poursuivre.

La valeur par défaut est 10.

jms.Password
La propriété jms.Password indique le mot de passe défini pour le fournisseur JMS.
Cette valeur est facultative.

Il n’existe pas de valeur par défaut.

jms.TransportOptimized
La propriété jms.TransportOptimized détermine si 'opération en cours est
optimisée. Un fournisseur WebSphere MQ doit étre installé pour permettre cette
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optimisation. Pour parvenir a une optimisation de 1’opération en cours, le
fournisseur de messagerie doit étre capable :

1. de lire un message sans 'extraire de la file d’attente ;

2. de supprimer un message doté d'un ID spécifique sans transférer 1'intégralité
du message dans 1’espace mémoire du destinataire ;

3. de lire un message en utilisant un ID spécifique (nécessaire en cas de reprise) ;
4. d’analyser I'endroit ou les événements non lus s’affichent.

Les API JMS ne peuvent pas étre utilisées dans le cadre d’une optimisation de
l'opération en cours car elles ne répondent pas aux conditions 2 et 4 ci-dessus. En
revanche, les API MQ Java répondent aux quatre conditions et sont, par
conséquent, requises pour 1'optimisation de 1’opération en cours.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS et que la valeur de la propriété BrokerType est ICS.

La valeur par défaut est false.

jms.UserName
La propriété jms.UserName indique le nom d’utilisateur défini pour le fournisseur
JMS. Cette valeur est facultative.

Il n’existe pas de valeur par défaut.

JvmMaxHeapSize
La propriété JvmMaxHeapSize indique la taille de segment maximale pour 'agent
(en mégaoctets).

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE>.

La valeur par défaut est 128 Mo.

JvmMaxNativeStackSize
La propriété JvmMaxNativeStackSize indique 'espace mémoire natif maximal pour
I'agent (en kilo-octets).

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE>.

La valeur par défaut est 128 Ko.

JvmMinHeapSize
La propriété JvmMinHeapSize indique la taille de segment minimale pour I’agent
(en mégaoctets).

Cette propriété est valide uniquement si la valeur de la propriété
RepositoryDirectory est <REMOTE>.

La valeur par défaut est 1 Mo.

ListenerConcurrency
La propriété ListenerConcurrency prend en charge le traitement de plusieurs unités
d’exécution dans WebSphere MQ Listener lorsqu’ICS est le courtier d’intégration.

Chapitre 7. Configuration des connecteurs 181



Elle permet l'écriture par lots de plusieurs événements sur la base de données,
améliorant ainsi les performances du systeme.

Cette propriété est valide uniquement avec des connecteurs utilisant le transfert
MQ. La valeur de la propriété DeliveryTransport doit étre MQ.

La valeur par défaut est 1.

Locale

La propriété Locale indique le code de langue, le pays ou le territoire et, le cas
échéant, le jeu de codes de caracteres associé. La valeur de cette propriété
détermine les conventions culturelles telles que le classement et 1'ordre de tri des
données, les formats de date et d’heure, ainsi que les symboles monétaires utilisés.

Le format d’un nom d’environnement local est le suivant :
Ul _TT.codeset

ol :

Il correspond a un code de langue a deux caracteres (en minuscule) ;

TT correspond a un code territoire ou pays a deux caracteres (en majuscule) ;
codeset correspond au nom du jeu de codes de caracteres associé (peut étre
facultatif).

Par défaut, seul un sous-ensemble de parametres nationaux pris en charge
apparait. Pour ajouter a cette liste d’autres valeurs prises en charge, modifiez le
fichier \Data\Std\stdConnProps.xml dans le répertoire <ProductDir>\bin. Pour
plus d’informations, voir I'annexe relative & Connector Configurator dans ce guide.

Si le connecteur n’a pas été internationalisé, la seule valeur correcte pour cette
propriété est en_US. Pour déterminer si un connecteur a été internationalisé,
reportez-vous au guide de l'utilisateur de 1’adaptateur.

La valeur par défaut est en_US.

LogAtinterchangeEnd
La propriété LogAtInterchangeEnd indique si les erreurs doivent étre consignées
dans la cible du journal du courtier d’intégration.

La consignation des erreurs dans la cible du journal active également la notification
par courrier électronique qui, lorsque des erreurs ou des erreurs fatales ont lieu,
génére des messages électroniques pour le destinataire précisé par la valeur du
parametre MESSAGE_RECIPIENT dans le fichier InterchangeSystem.cfg. Par
exemple, lorsque la connexion entre un connecteur et ’application est interrompue,
si la propriété LogAtinterChangeEnd a la valeur true, un courrier électronique est
envoyé au destinataire du message spécifié.

Cette propriété est valide uniquement si la valeur de la propriété
RespositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est ICS).

La valeur par défaut est false.

MaxEventCapacity

La propriété MaxEventCapacity indique le nombre maximal d’événements
contenus dans la mémoire tampon du controleur. Cette propriété est utilisée par la
fonction de controle des flux.
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Cette propriété est valide uniquement si la valeur de la propriété
RespositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est ICS).

II peut s’agir d'un nombre entier positif compris entre 1 et 2147483647.

La valeur par défaut est 2147483647.

MessageFileName

La propriété MessageFileName indique le nom du fichier de messages du
connecteur. L’emplacement standard de ce fichier de messages est
\connectors\messages dans le répertoire produit. Indiquez le nom du fichier des
messages dans un chemin d’accés absolu si le fichier de messages n’est pas situé a
I'emplacement standard.

S’il n’existe pas de fichier de messages, le connecteur utilise
InterchangeSystem.txt comme fichier de messages. Ce fichier est situé dans le
répertoire produit.

Remarque : Pour déterminer si un connecteur a son propre fichier de messages,
reportez-vous au guide de l'utilisateur de 1’adaptateur.

La valeur par défaut est InterchangeSystem.txt.

MonitorQueue
La propriété MonitorQueue indique la file d’attente logique utilisée par le
connecteur pour contrdler les événements en double.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS et que la valeur de la propriété
DuplicateEventElimination est true.

La valeur par défaut est <CONNECTORNAME>/MONITORQUEUE.
OADAutoRestartAgent

La propriété OADAutoRestartAgent indique si le connecteur utilise la fonction de
redémarrage automatique et a distance. Cette fonction utilise le démon d’activation
d’objets (OAD, Object Activation Daemon) déclenché par WebSphere MQ pour
redémarrer le connecteur aprés un arrét anormal ou pour démarrer un connecteur
distant a partir de System Monitor.

Cette propriété doit avoir la valeur true pour que la fonction de redémarrage
automatique et a distance soit activée. Pour plus d’informations sur la
configuration de la fonction de I'OAD déclenché par WebSphere MQ, voir le
document Installation Guide for Windows ou for UNIX.

Cette propriété est valide uniquement si la valeur de la propriété
RespositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est ICS).

La valeur par défaut est false.
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OADMaxNumRetry

La propriété OADMaxNumRetry indique le nombre maximal de tentatives de
redémarrage automatique du connecteur par I'OAD déclenché par WebSphere MQ
apres un arrét anormal. La propriété OADAutoRestartAgent doit avoir la valeur
true pour prendre effet.

Cette propriété est valide uniquement si la valeur de la propriété
RespositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est 1CS).

La valeur par défaut est 1000.

OADRetryTimelnterval

La propriété OADRetryTimelnterval indique la durée en minutes entre les
tentatives de relance pour I'OAD déclenché par WebSphere MQ. Si I'agent du
connecteur ne redémarre pas durant cet intervalle, le contréleur du connecteur
demande a I'OAD de redémarrer I'agent du connecteur. L'OAD répéte cette
opération autant de fois que le nombre spécifié par la propriété
OADMaxNumRetry. La propriété OADAutoRestartAgent doit avoir la valeur true
pour prendre effet.

Cette propriété est valide uniquement si la valeur de la propriété
RespositoryDirectory est <REMOTE> (et que la valeur de la propriété BrokerType
est ICS).

La valeur par défaut est 10.

PollEndTime

La propriété PollEndTime définit I’heure d’arrét de l'interrogation de la file
d’attente des événements. Le format est HH: MM, o1 HH représente les heures (de 0 a
23) et MM les minutes (de 0 a 59).

Vous devez indiquer une valeur correcte pour cette propriété. La valeur par défaut
est HH:MM sans valeur, mais elle doit étre modifiée.

Si le contexte d’exécution de 1'adaptateur détecte :

* que la propriété PollStartTime est définie et que la propriété PollEndTime ne
l'est pas, ou

* que la propriété PollEndTime est définie et que la propriété PollStartTime ne
'est pas,

il émet une interrogation a 1’aide de la valeur configurée pour la propriété
PollFrequency.

PollFrequency

La propriété PollFrequency indique l'intervalle (en millisecondes) compris entre la
fin de la derniere interrogation et le début de l'interrogation suivante. Il ne s’agit
pas de l'intervalle compris entre chaque interrogation. Plus précisément, la logique
est la suivante :

e Emettez une interrogation pour obtenir le nombre d’objets spécifié par la valeur
de la propriété PollQuantity.

* Traitez ces objets. Pour certains connecteurs, cela peut étre en partie effectué sur
des unités d’exécution séparées, qui s’exécutent de maniére asynchrone jusqu’a
I'interrogation suivante.

* Attendez pendant l'intervalle indiqué par la propriété PollFrequency.
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* Répétez le cycle.

Les valeurs suivantes sont valides pour cette propriété :
* Le nombre de millisecondes entre les interrogations (nombre entier positif).

* Le mot no, qui indique au connecteur de ne pas émettre d’interrogation. Entrez
la lettre en minuscule.

* Le terme key, qui indique au connecteur d’émettre une interrogation uniquement
lorsque vous entrez la lettre p dans l'invite du connecteur. Entrez la lettre en
minuscule.

La valeur par défaut est 10000.

Important: Certains connecteurs sont limités dans l'utilisation de cette propriété.
Ces restrictions sont décrites dans le chapitre sur l'installation et la
configuration de 1’adaptateur.

PollQuantity

La propriété PollQuantity désigne le nombre d’éléments de 1’application pour
lesquels le connecteur doit émettre des interrogations. Si l'adaptateur dispose d"une
propriété spécifique au connecteur pour la définition du nombre d’interrogations,
la valeur définie dans cette propriété spécifique remplace la valeur de la propriété
standard.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS et que la propriété ContainerManagedEvents a une
valeur.

Un courrier électronique est également considéré comme un événement. Lorsqu’il
est interrogé sur un courrier électronique, le connecteur agit comme suit :

* Lorsqu'’il est interrogé pour la premiere fois, le connecteur détecte le corps du
message, qu’il considére comme une piece jointe. Si aucun gestionnaire de
données n’a été spécifié pour ce type mime, il ignore le message.

* Le connecteur traite la premiere piece jointe de 1’objet métier. Si le gestionnaire
de données est disponible pour ce type MIME, le connecteur envoie 1’objet
métier a Visual Test Connector.

* Lorsqu’il est interrogé pour la seconde fois, le connecteur traite la deuxieme
piece jointe de 1'objet métier. Si le gestionnaire de données est disponible pour ce
type MIME, le connecteur envoie 1'objet métier a Visual Test Connector.

* Une fois acceptée, la troisieme piéce jointe de 1'objet doit étre transmise.

PollStartTime

La propriété PollStartTime définit ’heure de début de l'interrogation de la file
d’attente des événements. Le format est HH: MM, our HH représente les heures (de 0 a
23) et MM les minutes (de 0 a 59).

Vous devez indiquer une valeur correcte pour cette propriété. La valeur par défaut
est HH:MM sans valeur, mais elle doit étre modifiée.

Si le contexte d’exécution de 1’adaptateur détecte :

* que la propriété PollStartTime est définie et que la propriété PollEndTime ne
I'est pas, ou

* que la propriété PollEndTime est définie et que la propriété PollStartTime ne
l'est pas,
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il émet une interrogation a 1’aide de la valeur configurée pour la propriété
PollFrequency.

RepositoryDirectory

La propriété RepositoryDirectory est I'emplacement du référentiel a partir duquel
le connecteur lit les schémas XML qui stockent les métadonnées pour la définition
des objets métier.

Lorsque le courtier d’intégration est ICS, cette valeur doit étre <REMOTE> car le
connecteur obtient ces informations a partir du référentiel d’InterChange Server.

Lorsque le courtier d’intégration est un courtier de messages WebSphere ou WAS,
cette valeur est <ProductDir>\repository par défaut. Toutefois, cette valeur peut
correspondre a n'importe quel nom de répertoire correct.

RequestQueue
La propriété RequestQueue indique la file d’attente utilisée par le courtier
d’intégration pour envoyer des objets métier au connecteur.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

La propriété ResponseQueue désigne la file d’attente de réponses JMS, qui
transmet un message de réponse depuis la structure du connecteur vers le courtier
d’intégration. Lorsqu’ICS est le courtier d’intégration, le serveur envoie la requéte
et attend un message de réponse dans la file d’attente de réponses JMS.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

La propriété RestartRetryCount indique le nombre de tentatives de redémarrage du
connecteur. Lorsque cette propriété est utilisée pour un connecteur connecté en
parallele, elle indique le nombre de tentatives de redémarrage du composant
spécifique a I’application du connecteur client par le composant spécifique a
I'application du connecteur maitre.

La valeur par défaut est 3.

RestartRetrylInterval

La propriété RestartRetryInterval indique l'intervalle en minutes pendant lequel le
connecteur tente de redémarrer. Lorsque cette propriété est utilisée pour un
connecteur relié en parallele, elle indique l'intervalle de temps pendant lequel le
composant spécifique a I'application du connecteur maitre tente de redémarrer le
composant spécifique a I'application du connecteur client.

Les valeurs possibles pour cette propriété sont comprises entre 1 et 2147483647.

La valeur par défaut est 1.
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ResultsSetEnabled

La propriété ResultsSetEnabled active ou désactive la prise en charge de 1’ensemble
de résultats lorsqu’Information Integrator est actif. Cette propriété peut étre utilisée
uniquement si 'adaptateur prend en charge DB2 Information Integrator.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS et que la valeur de la propriété BrokerType est WMQI.

La valeur par défaut est false.

ResultsSetSize

La propriété ResultsSetSize définit le nombre maximal d’objets métier pouvant étre
renvoyés a Information Integrator. Cette propriété peut étre utilisée uniquement si
I'adaptateur prend en charge DB2 Information Integrator.

Cette propriété est valide uniquement si la valeur de la propriété
ResultsSetEnabled est true.

La valeur par défaut est 0. Cela signifie que la taille de I’'ensemble de résultats est
illimitée.

RHF2MessageDomain

La propriété RHF2MessageDomain permet de configurer la valeur du nom de
domaine de la zone dans 'en-téte J]MS. Lorsque les données sont envoyées au
courtier de messages WebSphere par transfert JMS, la structure de 1’adaptateur
écrit les informations de 'en-téte JMS, avec un nom de domaine et une valeur fixe
mrm. Un nom de domaine configurable permet aux utilisateurs de suivre le mode
de traitement des données du message par le courtier de messages WebSphere.

Voici un exemple d’en-téte :

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek _POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

Cette propriété est valide uniquement si la valeur de la propriété BrokerType est
WMQI ou WAS. De méme, elle n’est valide que si la valeur de la propriété
DeliveryTransport est JMS et que la valeur de la propriété WireFormat est CwXML.

Les valeurs possibles sont mrm et xm1. La valeur par défaut est mrm.

SourceQueue

La propriété SourceQueue désigne la file d’attente source JMS de la structure du
connecteur qui assure la transmission d’événement garantie pour les connecteurs
compatibles JMS qui_utilisent un magasin d’événements JMS. Pour plus
d’informations, voir [«ContainerManagedEvents» a la page 176

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS et qu'une valeur est spécifiée pour la propriété
ContainerManagedEvents.

La valeur par défaut est <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequest- Queue

La propriété SynchronousRequestQueue transmet les messages de requéte qui
requierent une réponse synchrone de la structure du connecteur vers le courtier.
Cette file d’attente est nécessaire uniquement si le connecteur utilise 1’exécution
synchrone. Avec l'exécution synchrone, la structure du connecteur envoie un
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message a la file d’attente de requétes synchrones et attend une réponse de la part
du courtier sur la file d’attente de réponses synchrones. Le message de réponse
envoyé au connecteur est doté d'un ID de corrélation qui correspond a I'ID du
message d’origine.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE.

SynchronousRequestTimeout

La propriété SynchronousRequestTimeout indique la durée d’attente en
millisecondes d"une réponse a une requéte synchrone. Si la réponse n’est pas regue
dans l'intervalle de temps indiqué, le connecteur transfere le message de requéte
synchrone original (ainsi qu'un message d’erreur) dans la file d’attente des erreurs.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est 0.

SynchronousResponseQueue

La propriété SynchronousResponseQueue transmet les messages de réponse a une
requéte synchrone entre le courtier et la structure du connecteur. Cette file
d’attente est nécessaire uniquement si le connecteur utilise 1’exécution synchrone.

Cette propriété est valide uniquement si la valeur de la propriété
DeliveryTransport est JMS.

La valeur par défaut est <CONNECTORNAME>/SYNCHRONOUSRESPONSEQUEUE.

TivoliMonitorTransactionPerformance

La propriété TivoliMonitorTransactionPerformance indique si la solution IBM Tivoli
Monitoring for Transaction Performance (ITMTP) est appelée au moment de
I'exécution.

La valeur par défaut est false.

WireFormat
La propriété WireFormat indique le format de message lors du transfert :

* Sila valeur de la propriété RepositoryDirectory représente un répertoire local, la
valeur associée est CwXML.

* Si la valeur de la propriété RepositoryDirectory représente un répertoire distant,
la valeur associée est CwBO.

WsifSynchronousRequestTimeout

La propriété WsifSynchronousRequestTimeout indique la durée d’attente en
millisecondes d’une réponse a une requéte synchrone. Si la réponse n’est pas regue
dans l'intervalle de temps indiqué, le connecteur transfere le message de requéte
synchrone original (ainsi qu'un message d’erreur) dans la file d’attente des erreurs.

Cette propriété est valide uniquement si la valeur de la propriété BrokerType est
WAS.

La valeur par défaut est 0.
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XMLNameSpaceFormat
La propriété XMLNameSpaceFormat indique s’il s’agit d’espaces nom courts ou
longs dans le format XML des définitions d’objets métier.

Cette propriété est valide uniquement si la valeur de la propriété BrokerType est
WMOQI ou WAS.

La valeur par défaut est short.
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Chapitre 8. Configuration des pools de connexion a une base
de données

Lors de I'exécution, les processus permettant d’établir de nouvelles connexions a la
base de données prennent un certain temps. Vous pouvez réduire cette durée en
préparant les pools de connexion a une base de données a 1’avance pour une
utilisation dans les processus de collaboration et de mappe. Les pools de connexion
a une base de données permettent d’accroitre les performances et fournissent un
acces direct a une base de données a partir d’une collaboration.

Un pool de connexion a une base de données est utilisable par de multiples
collaborations et mappes, de méme que chaque collaboration ou mappe peut

recourir a plusieurs pools de connexion a une base de données.

Ce chapitre contient les sections suivantes :

+ |«Cas d’utilisation des pools de connexion a une base de données|

+ |«Cas de non-utilisation des pools de connexion a une base de données» a ld|

page 194

+ |«Création de pools de connexion a une base de données et de connexions a une|
base de données» a la page 195|

[«Validation des pools de connexion a une base de données» a la page 198|

* [«Modification des pools de connexion a une base de données» a la page 198|

+ |«Utilisation des pools de connexion a une base de données dans les modeéles déf
collaboration et les mappes» a la page 201

+ |«Configuration de la mise entre parenthéses des transactions» a la page 201

Cas d’utilisation des pools de connexion a une base de données

Cette section décrit différents cas de figure dans lesquels vous pourriez étre amené
a utiliser les pools de connexion a une base de données.

Exécution du routage

La logique d"un processus métier peut exiger qu'un objet métier soit routé vers
différentes applications cibles en fonction de la valeur d’une ou plusieurs zones de
I'objet métier.

En l'occurrence, un site peut stocker et traiter des entités client dans différentes
applications selon la valeur d’un attribut, telle que CustomerType. Le modele de
collaboration pourra avoir besoin d’extraire et d’analyser la valeur de 'attribut
pour décider vers quelle application cible envoyer 1'objet métier. Bien que cela soit
permis par les structures du flux de contrdle sous Java, les paires de valeurs et
d’applications cible sont codées en dur dans le modéle de collaboration. Qu'il
s’agisse d"une modification pour répondre a une modification de la procédure ou
d’un ajout suite a 'intégration d"une nouvelle valeur et d"une nouvelle application
dans l'interface, les modeles de collaboration doivent étre modifiés, recompilés,
redéployés, etc. Une implémentation beaucoup plus flexible consiste a stocker les
paires de valeurs et d’applications cible dans une table de base de données. Pour
ce faire, procédez comme suit :

1. Créez une table de base de données dont une colonne contiendra les valeurs de
routage et une autre colonne des informations permettant d’associer a chaque
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valeur une application cible appropriée. Le est un exemple de table

représentatif.

Tableau 14. Exemple de table de routage

Valeur de routage Valeur de l'application cible
Client AppA
Federal AppB
Reseller AppC
Academic AppD

2. Créez un pool de connexion a une base de données et une connexion a une
base de données dans System Manager, comme décrit dans la section |<<Créatioﬁ|
de pools de connexion a une base de données et de connexions & une base de|
données» a la page 195

3. Dans le modeéle de collaboration, concevez la logique pour procéder aux
opérations suivantes :

a. Récupérer la valeur de l'attribut a utiliser pour le routage et stocker cette
valeur dans une variable.

Obtenir une connexion a une base de données.

Exécuter une requéte SQL permettant d’extraire la valeur de la colonne
destinée aux valeurs des applications cible a I’endroit ot la valeur de la
colonne destinée aux valeurs de routage est égale a celle contenue dans la
variable du modele de collaboration.

d. Utiliser un noeud de décision pour créer une branche a partir de la logique
de collaboration en fonction de la valeur renvoyée par la table de la base de
données. Les différentes branches doivent mener a différents noeuds
d’appel de service chargés d’envoyer 1'objet métier vers le connecteur
approprié, et par conséquent de 'envoyer a 'application cible
correspondante.

Consultation des tables de bases de données

Vous pourriez avoir besoin de convertir une valeur en une autre valeur en
cherchant son équivalent dans une table. Souvent, vous effectuez ces opérations en
implémentant des relations de recherche, méme si leur utilisation n’est pas toujours
pertinente. Les relations de recherche sont prévues pour les cas ott chaque
application impliquée dans une interface a sa maniére de représenter un élément
de données (un participant est créé pour chaque application et la relation de
recherche connecte elle—méme tous les participants, tout comme un courtier
d’intégration connecte les applications). Il vous faut parfois convertir une valeur en
une autre, sans nécessairement gérer une représentation séparée de ces données
pour chaque application impliquée dans l'interface. Si tel est le cas, vous devez
créer une table dans le référentiel pour stocker les valeurs associées, puis utiliser
une connexion a une base de données et des instructions de sélection SQL pour
extraire la valeur souhaitée.

En outre, I’API fournie pour les relations de recherche facilite I’extraction des
données associées entre les applications mais complique les requétes plus
complexes. L’API des relations de recherche est congue pour prélever un élément
de données et renvoyer la valeur clé que les données partagent avec les autres
éléments de données d’application de la relation ou pour prendre une valeur clé et
renvoyer un élément de données particulier lui étant associé. Toutefois, I’API des
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relations de recherche ne peut pas renvoyer plusieurs valeurs de colonne ni
exécuter des procédures stockées, contrairement aux API de la classe
CwDBConnection.

Vous pouvez également remplir cette condition avec du code Java plutoét qu'avec
une requéte de base de données en utilisant des structures de contréle telles que
les instructions “if/else” et “switch/case”. Tenez compte des avantages et des
inconvénients des différentes approches et choisissez la solution la plus adaptée a
la situation :

* Il est plus facile d’ajouter de nouveaux enregistrements (comme une nouvelle
valeur de routage appariée avec une nouvelle application cible) lors de
l"utilisation d’une connexion a une base de données car il vous suffit d’ajouter
une ligne a la base de données, sans aucune modification de composant et
l'appariement est immédiat. Cependant, 1’ajout de nouvelles associations en code
Java est moins pratique car vous devez modifier le code du composant, le
recompiler, voire l'arréter et le relancer (si le composant est une collaboration).
Vous devez également interrompre au préalable les composants de l'interface
pour vous assurer qu’aucune transaction n’est en cours pendant la compilation
du composant, sous peine d'un échec.

* Une recherche en code Java doit étre plus rapide que la connexion a la base de
données et I'exécution d’une requéte bien que cette procédure dépende du
nombre d’associations que la structure de contrdle Java doit itérer.

¢ Il est moins pratique de migrer une interface utilisant une connexion de base de
données vers un autre environnement que de migrer une interface reposant
uniquement sur du code Java. En effet, il faut non seulement penser a migrer la
mappe ou la collaboration permettant la connexion, mais également a recréer les
tables impliquées dans le nouvel environnement.

Conservation des informations

Certains clients souhaitent conserver les informations relatives aux opérations du
systéeme d’intégration métier en les stockant dans la base de données afin de les
référencer lors d'une résolution d’incident ou d’une analyse d’historique.

Pour ce faire, procédez comme suit :

1. Créez une table de base de données comportant autant de colonnes que
nécessaire pour stocker les données souhaitées.

2. Créez un pool de connexion a une base de données et une connexion a une
base de données dans System Manager, comme décrit dans la section [«Création]
de pools de connexion & une base de données et de connexions & une base de]
données» a la page 195|

3. Dans le modele de collaboration, concevez la logique pour établir une
connexion a la base de données et exécutez une requéte SQL permettant
d’insérer les données souhaitées dans la colonne appropriée.

Généralement, une telle configuration implique la conservation des informations
contenues dans 1'objet métier traité par la collaboration (comme la clé primaire de
I'entité traitée) ou des informations relatives au systeme lui-méme (telles que
l'aboutissement du traitement d'une requéte d’objet métier). Dans la version 4.2.0,
vous pouvez conserver des données d’objets métier comme des valeurs de clé
primaire a 1’aide de la fonction Business Object Probe. Pour plus d’informations,
voir le document Collaboration Development Guide. Dans la version 4.2.0, vous
pouvez conserver certaines informations relatives au systeme a l'aide de la fonction
Persistent Monitoring. Pour plus d’informations, voir le document System
Administration Guide.
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Cas de non-utilisation des pools de connexion a une base de données

Vous ne devez pas utiliser les pools de connexion a une base de données pour
vous connecter directement a la base de données d’une application. Pour
communiquer avec une base de données d’application, vous devez uniquement
faire appel aux composants IBM WebSphere Business Integration Adapter. Les
connexions doivent uniquement s’effectuer aux bases de données qui ne prennent
pas d’application en charge, car les adaptateurs utilisent la logique applicative
fournie par les interfaces de programmation de 'application. En vous connectant
directement a une base de données d’application pour exécuter par exemple une
instruction de mise a jour SQL, vous contournez la logique que I’API aurait suivi
en réponse a une telle opération. Ce type de procédure viole l'intégrité de
I'application et le processus métier.

Si vous souhaitez extraire des informations a partir d"une application, sans pour
autant utiliser d’adaptateur (en raison des effets produits sur les performances lors
de I'envoi d"une requéte d’objet métier a une application et de la réception de la
réponse), plusieurs possibilités s’offrent a vous :

* Vous pouvez créer un objet métier personnalisé qui ne possede que les attributs
pour les zones concernées par 1’opération. En 'occurrence, vous pouvez disposer
d’un objet métier complexe propre a 'application, congu pour une entité
d’application impliquée dans un processus métier spécifique. Si vous devez
uniquement extraire un sous-ensemble d’informations sur l'entité dans le cadre
d’un autre processus métier, vous risquez de réduire les performances
d’extraction de I'objet métier complet, simplement a cause de ces quelques
zones. Pour limiter I'impact de cette opération, vous pouvez réaliser une copie
de 'objet métier spécifique a 'application et réduire sa structure aux seules
zones concernées. Cela permettra ainsi de ne traiter qu'une petite quantité
d’informations.

Cette approche est la mieux adaptée pour l'extraction d’informations
fréquemment modifiées dans la base de données de 'application car chaque
requéte extrait uniquement les informations courantes au moment opportun.

* Vous pouvez répliquer les informations de l’application sur le méme serveur qui
héberge les bases de données d'IBM WebSphere InterChange Server. Vous
pouvez utiliser les utilitaires livrés par le fournisseur de la base de données pour
générer le script de la structure et des données de la table dans un fichier, puis
reproduire la table et ses données dans une base de données différente de celle
utilisée par l'application elle-méme.

Cette approche s’avere plus adaptée a des informations statiques et de faible
volume, telles qu'une table de recherche. En revanche, elle n’est pas adaptée
pour des entités importantes intégrant plusieurs tables, car elle compliquerait la
création et la gestion des requétes, tandis que l'utilisation d’objets métier pour
représenter l'entité faciliterait la mise en oeuvre et la gestion. Cela n’est pas non
plus recommandé dans le cas de tables tres dynamiques, auxquelles s’ajoutent
fréquemment des nouvelles tables : vous devrez souvent mettre a jour
manuellement les tables répliquées ou risquerez de trouver des informations
obsolétes dans l'interface.
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Création de pools de connexion a une base de données et de
connexions a une base de données

Un pool de connexion a une base de données consiste en un nombre de
connexions réservées a une base de données. Les connexions réservées a une base
de données sont dédiées exclusivement aux processus de collaboration et de
mappe créés pour l'utilisation du pool.

Pour créer un pool de connexion a une base de données, définissez au préalable les
valeurs nécessaires a 1'établissement d'une connexion a une base de données. Le
systeme IBM WebSphere InterChange Server enregistre les informations de
connexion a une base de données et les utilise au moment de I'exécution pour
accélérer 1'établissement des connexions pour les processus de collaboration et de
mappage préalablement définis.

La configuration des valeurs de connexion a une base de données peut servir a
d’autres pools. Pour chaque pool, déterminez un nombre précis de connexions ;
celles-ci seront allouées, utilisées, puis restituées au pool.

Remarque : Avant de créer le pool, il est préférable de se connecter a l'instance

d’InterChange Server qui utilisera le pool de connexion a une base de
données dans System Manager : vous pourrez ainsi valider la
connexion.

Pour créer un pool de connexion a une base de données, procédez comme suit :

1.

Cliquez avec le bouton droit de la souris sur le dossier Database Connection
Pools contenu dans la bibliotheque de composants d’intégration de System
Manager, puis sélectionnez Create New Database Connection dans le menu
contextuel.

La boite de dialogue “Database Connection” s’affiche.

Remarque : Bien que le nom de la boite de dialogue semble indiquer que
vous étes en train de créer une connexion a une base de données,
il s’agit bien en réalité d’un pool de connexion a une base de
données. Les étapes suivantes vous permettront de définir les
connexions a une base de données dans le pool.

Sélectionnez la valeur correcte dans le menu déroulant Database Driver
(DB2 (Type 2), MS SQL Server(Type 4) ou Data Direct Oracle(Type 4)) selon
le fournisseur de la base de données.

Si vous sélectionnez MS SQL Server(Type 4) ou Data Direct Oracle(Type 4)
dans le menu déroulant Database Driver, vous devez saisir le nom de
l'ordinateur sur lequel réside le serveur de base de données, dans la zone
Host name.

Entrez le nom de la base de données dans la zone Database.

Si vous sélectionnez MS SQL Server(Type 4) ou Data Direct Oracle(Type 4)
dans le menu déroulant Database Driver, vous devez saisir le numéro de port
par lequel les clients communiquent avec le serveur de base de données, dans
la zone Port number.

Si vous étes connecté a l'instance d’InterChange Server qui utilisera le pool,
sélectionnez-la dans le menu déroulant Connected Servers.
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7. Entrez le nombre de tentatives de connexion que WebSphere InterChange
Server doit effectuer pour restaurer la connexion a une base de données
lorsqu’elle est interrompue ou qu’elle ne peut pas étre établie dans la zone
Max connect retries.

8. Entrez le nom du pool dans la zone DBConnection Name. Indiquez ce nom
lorsque vous écrivez le code Java pour établir la connexion dans les mappes
ou dans les modeles de collaboration.

9. Entrez le nom d’utilisateur qu'InterChange Server doit utiliser pour se
connecter a la base de données indiquée dans la zone Login.

10. Entrez le mot de passe utilisateur indiqué a I'étape |6d a la page 113|dans la
zone Password.

11. Entrez le nombre de connexions maximales que le pool doit établir pour tous
les objets individuels de connexion a une base de données que vous envisagez
de créer dans la zone Maximum connections, ou bien cochez la case
Unlimited pour permettre d’établir autant de connexions que possible, dans la
limite de la configuration du serveur et des licences accordées.

Avertissement : Soyez prudent lorsque vous intervenez dans cette zone. La
zone de saisie ne tient pas sur une seule et méme ligne,
comme cela devrait étre le cas : vous risquez d’appuyer par
mégarde sur la touche Entrée. Cela aurait pour effet de
masquer la valeur que vous venez d’entrer et vous inciterait a
réitérer la saisie. De ce fait, lorsque vous arriveriez a la fin de
la procédure de création de la base de données, un message
d’erreur s’afficherait et vous inviterait a entrer une valeur
correcte pour la zone en question. N'appuyez pas sur la
touche Entrée dans cette zone.

12. Dans la zone Connect retry interval, entrez le temps d’attente (en secondes)
entre chaque tentative d'InterChange Server pour restaurer la connexion a une
base de données.

Lalfigure 50 & la page 197| présente 1'assistant New Database Connection Pool.
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Create new database connection x|

Database connection ﬁﬁ#
Create a new database connection, ﬁ

Database driver |DBZ (Type 22 ﬂ DECannection name | uliosTestPool
Host name | Login | admi|
Database | testdatabase] Passward [ronr]
Part number | Maximum connections | 10] [ Unlimited
Connected servers |QTZID11CS ﬂ
Max connect retries | 30| Conneck retry inkerval |30|7 Secondis)

e conneckion pool

lame | Minimurm conneckions

dl 2
‘alidate Connection

Finizh | Cancel

Figure 50. Assistant Create New database Connection

13. Pour créer un nouvel objet de connexion a une base de données dans le pool,
cliquez avec le bouton droit de la souris sur une ligne de la table New
Connection Pool située dans la partie inférieure de 'assistant, puis
sélectionnez New Connection Pool dans le menu contextuel.

Remarque : Bien que le nom de la boite de dialogue semble indiquer que
vous étes en train de créer un pool de connexion a une base de
données, il s’agit bien en réalité d’un objet de connexion a une
base de données, qui sera contenu dans le pool que vous venez
de créer.

La boite de dialogue “Connection Pool” s’affiche.
14. Entrez le nom de l'objet de connexion a une base de données dans la zone
Name.

15. Dans la zone Minimum connections, entrez le nombre de connexions
minimales que 1’objet de connexion a une base de données doit établir. La
somme des valeurs minimales de tous les pools créés dans le pool ne peut pas
excéder la valeur maximale attribuée au seul objet de connexion a une base de
données. System Manager ne vous permet pas d’ajouter ni de modifier un
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objet de connexion, empéchant ainsi le dépassement du nombre maximal de
connexions pour le pool. La présente la boite de dialogue
“Connection Pool”.

. ¥ Connection Pool ] x|

Mame: Connectiont

Minimum connections: I 10

Cancel |

Figure 51. Boite de dialogue “Connection Pool”

16. Cliquez sur Finish.

System Manager enregistre 1'objet du pool de connexion a une base de
données et une icone apparait sous le dossier Database Connection Pools
dans la bibliotheque de composants d’intégration.

17. Utilisez a présent l'assistant pour créer un autre pool de connexion a une base
de données ou cliquez sur Cancel pour fermer 1’assistant.

Validation des pools de connexion a une base de données

Apres avoir créé un pool de connexion a une base de données, vous devez le
valider pour pouvoir l'utiliser avec les mappes et les collaborations au moment de
I'exécution.

Pour valider un pool de connexion a une base de données, procédez comme suit :
1. Démarrez l'instance d’InterChange Server.

2. Connectez System Manager a l'instance d’InterChange Server, comme décrit
dans la section [«Connexion a InterChange Server» a la page 32

3. Effectuez I'une des opérations suivantes :

* Cliquez avec le bouton droit de la souris sur 1’objet du pool de connexion a
une base de données dans une bibliothéque de composants d’intégration ou
cliquez sur le raccourci correspondant dans un projet utilisateur, sélectionnez
Validate Connection dans le menu contextuel, puis sélectionnez le nom de
I'instance d’InterChange Server a partir du sous-menu.

* Cliquez avec le bouton droit de la souris sur 1’objet du pool de connexion a
une base de données dans le référentiel du serveur dans la vue Interchange
Server Component Management, puis sélectionnez Validate Connection dans
le menu contextuel.

4. Sile pool de connexion a une base de données est valide, System Manager
affiche une invite indiquant que la validation a abouti.

Si System Manager indique que la validation a échoué, tentez de résoudre le
probleme en vérifiant la disponibilité de la base de données, les autorisations
du compte d’utilisateur indiqué et I'exactitude des informations de
configuration.

Modification des pools de connexion a une base de données

Vous pouvez a la fois modifier certaines propriétés des pools de connexion a une
base de données et des objets de connexion a une base de données.
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Pour modifier un pool de connexion a une base de données, effectuez 1'une des
opérations suivantes :

* Cliquez avec le bouton droit de la souris sur le composant du pool de connexion
a une base de données dans une bibliotheque de composants d’intégration ou
cliquez sur le raccourci correspondant dans un projet d’utilisateur, puis
sélectionnez Properties dans le menu contextuel.

* Sélectionnez le composant du pool de connexion a une base de données dans
une bibliotheque de composants d’intégration ou cliquez sur le raccourci
correspondant dans un projet d’utilisateur, puis effectuez 1'une des opérations
suivantes :

— Sélectionnez Component > Properties dans la barre de menus.

— Appuyez sur Alt+Entrée.

Les sections suivantes renseignent sur les propriétés des pools de connexion a une
base de données et des objets de connexion a une base de données pouvant étre
modifiés.

+ [«Modification des informations de connexion»|

+ |«Modification du nombre de connexions»|

Modification des informations de connexion

Un grand nombre de sociétés ont coutume de modifier régulierement leurs mots
de passe afin de se protéger contre les anciens comptes utilisés pour enfreindre la
sécurité. Si tel est le cas sur le site, vous pourriez avoir besoin de modifier les
informations de connexion au pool de connexion a une base de données.

Pour modifier le nom de connexion utilisé pour accéder aux ressources d'une base
de données, entrez la nouvelle valeur dans la zone Login de I'écran “Database
Connection”.

Pour modifier le mot de passe de la connexion indiquée, cliquez sur Change dans
I’écran “Database Connection” puis, a I'invite “Password Change”, procédez
comme suit :

1. Entrez le mot de passe actuel dans la zone Old Password.
2. Entrez le nouveau mot de passe dans la zone New Password.
3. Entrez a nouveau le nouveau mot de passe dans la zone Confirm Password.

Modification du nombre de connexions

Vous pouvez modifier le nombre maximal de connexions pour un pool de
connexion a une base de données, et le nombre minimal de connexions pour un
objet de connexion a une base de données. La somme des connexions minimales
de tous les objets de connexion a une base de données définis dans un pool de
connexion a une base de données ne doit pas dépasser le nombre maximal de
connexions indiqué pour le pool lui-méme.

Modification du nombre maximal de connexions pour un pool de
connexion a une base de données

Pour modifier le nombre maximal de connexions pour un pool de connexion a une
base de données, procédez comme suit :

1. Accédez aux propriétés du pool de connexion a une base de données que vous
voulez éditer, comme décrit dans la section [«<Modification des pools d
[connexion a une base de données» a la page 198
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3.

Pour modifier le nombre maximal de connexions pouvant étre établies par le
nombre total d’objets de connexions dans le pool, procédez comme suit :

* Entrez le nombre maximal de connexions pouvant étre établies par le pool
dans la zone Maximum connections.

* Cochez la case Unlimited pour autoriser autant de connexions que possible,
dans la limite de la configuration du serveur de base de données et des
licences accordées.

Cliquez sur OK.

Modification des connexions minimales d’un objet de connexion
a une base de données

Pour modifier le nombre maximal de connexions pour un objet de connexion,
procédez comme suit :

1.

3.
4.

Accédez aux propriétés du pool de connexion a une base de données que vous
voulez éditer, comme décrit dans la section |«Modification des pools d
[connexion a une base de données» a la page 198

Dans le panneau “New Connection Pool”, cliquez avec le bouton droit de la
souris sur 1'objet de connexion pour lequel vous voulez modifier le nombre
minimal de connexions, puis sélectionnez Edit dans le menu contextuel.

Entrez la nouvelle valeur dans la zone Minimum connections.
Cliquez sur OK.

Modification des parameétres de résilience des connexions a une
base de données

Pour modifier les parametres de résilience des connexions a une base de données
d’un pool de connexion a une base de données, procédez comme suit :

1.

3.

Accédez aux propriétés du pool de connexion a une base de données que vous
voulez éditer, comme décrit dans la section <Modification des pools d
[connexion & une base de données» a la page 198

Entrez le nombre de tentatives de connexion que WebSphere InterChange
Server doit effectuer pour restaurer la connexion a une base de données
lorsqu’elle est interrompue ou qu’elle ne peut pas étre établie dans la zone
Maximum connect retries. Dans la zone Connect retry interval, entrez le temps
d’attente (en secondes) entre deux tentatives d’InterChange Server pour
restaurer la connexion a une base de données.

Cliquez sur OK.

Suppression d’objets de connexion a une base de données

Pour supprimer un objet de connexion a une base de données, procédez comme
suit :

1.

Accédez aux propriétés du pool de connexion a une base de données, comme
décrit dans la section [<Modification des pools de connexion a une base de|
[données» a la page 198]

Dans le panneau “New Connection Pool”, cliquez avec le bouton droit de la
souris sur 1'objet de connexion a supprimer, puis sélectionnez Delete dans le
menu contextuel.

Cliquez sur OK.
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Utilisation des pools de connexion a une base de données dans les
modeéles de collaboration et les mappes

Pour utiliser les pools de connexion a une base de données dans les mappes et les
modeles de collaboration, utilisez la méthode getDBConnection() dans la classe
BaseCollaboration :

CwDBConnection getDBConnection(String ConnectionPoolName) ;

La chaine ConnectionPoolName doit correspondre exactement au nom d'un pool
que vous avez créé ou que vous allez créer dans System Manager. Si le nom n’est
pas strictement identique ou que vous définissez des noms de pool de connexion
dans un modele de collaboration ou une mappe sans pour autant créer de pool de
connexion a une base de données dans System Manager, 1’objet de collaboration ou
la mappe échouera.

Pour les collaborations, vous pouvez définir des noms de pool dans un modele
avant ou apres avoir créé les objets de collaboration a partir de ce modele ; vous
n’avez pas besoin de reconfigurer de nouveaux objets de collaboration pour faire
correspondre un nouveau nom de pool de connexion.

Pour plus d’informations sur le développement de modeles de collaboration
permettant d’utiliser des pools de connexion a une base de données, voir le
document Collaboration Development Guide.

Pour plus d’informations sur le développement de mappes permettant d'utiliser
des pools de connexion a une base de données, voir le document Map Development
Guide.

Configuration de la mise entre parenthéses des transactions

Vous pouvez configurer une collaboration ou une mappe pour utiliser des pools de
connexion a une base de données en mode Implicit Database Transaction (dans
lequel la transaction se lance une fois la connexion établie et s’interrompt a la fin
du processus) ou en mode Explicit Database Transaction (dans lequel vous
programmez vous-méme le début et la fin de la transaction).

Pour configurer la mise entre parentheses des transactions pour les objets de
collaboration, voir kImplicit database transaction» a la page 220}

Pour configurer la mise entre parentheses des transactions pour les mappes, voir le
document Map Development Guide.
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Chapitre 9. Configuration des objets de collaboration

Ce chapitre décrit la configuration d’un objet de collaboration et comporte les
sections suivantes :

+ [«Objets de collaboration et groupes»|

+ |«Création d’un objet de collaboration» a la page 204

» |«Modification des objets de collaboration» a la page 209|

Pour plus d’informations sur la conception et la création d’un modele de
collaboration et sur l'utilisation de la solution Process Designer, voir le document
Collaboration Development Guide.

Objets de collaboration et groupes

Un objet de collaboration est une instance d’un modele de collaboration. Pour
configurer une collaboration, procédez comme suit :

1. Créez un objet de collaboration a partir d’'un modeéle de collaboration. Pour
plus d’informations, voir [«Création d’un objet de collaboration» a la page 204

2. Associez les ports de 1'objet de collaboration de maniére interne (a un
connecteur ou a une autre collaboration) ou de maniere externe (& un processus
externe qui appelle la collaboration, tel qu'un servlet d’application Web
e-business). Pour plus d’informations, voir [«Association des ports d’un objet de|
[collaboration» a la page 212}

3. Configurez les propriétés générales de 1'objet de collaboration. Pour plus
d’informations, voir [«Configuration des propriétés générales d’un objet de|
[collaboration» a la page 215|

4. Configurez les propriétés spécifiques a la collaboration de 1'objet de
collaboration. Pour plus d’informations, voir [«Configuration des propriétég
[spécifiques a une collaboration» a la page 222]

Lorsque vous créez une liaison interne, vous pouvez le faire uniquement avec des
connecteurs ou des collaborations qui prennent en charge 1’objet métier attendu
par le port de la collaboration. La communication entre les composants reliés est
ainsi établie, permettant a la collaboration d’envoyer et de recevoir des objets
métier mais aussi de recevoir les réponses aux requétes. Une collaboration ne peut
pas fonctionner tant que vous n’avez pas relié tous ses ports.

Vous pouvez créer plusieurs objets de collaboration a partir d'un seul modele de
collaboration. Par exemple, deux collaborations d’un méme modeéle peuvent
implémenter la méme logique a travers deux ensembles d’applications sur votre
site.

Groupes d’objets de collaboration

Un groupe d’objets de collaboration est un ensemble de deux objets de
collaboration ou plus reliés les uns aux autres.

Lorsque vous configurez le port d”un objet de collaboration de sorte qu’il recoive

un objet métier entrant provenant d’un autre objet de collaboration ou qu’il envoie
un objet métier sortant a un autre objet de collaboration, I'association des objets de
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collaboration forme un groupe d’objets de collaboration. La quantité d’objets de
collaboration associés dans un groupe importe peu.

Le comportement des objets de collaboration appartenant a un groupe d’objets de
collaboration est différent du comportement des objets n’appartenant pas a un
groupe. Lorsque vous appliquez une commande de type démarrage, pause ou arrét
a un objet de collaboration qui est membre dun groupe, la commande affecte tous
les membres de ce groupe.

Tous les membres d’un groupe d’objets de collaboration doivent prendre en charge
le méme niveau de transaction pour permettre a chaque membre du groupe de
s’exécuter de maniére transactionnelle. Si vous associez un objet de collaboration
doté du niveau de transaction None a un objet de collaboration doté du niveau de
transaction Best Effort, les deux objets s’exécutent au niveau None.

Création d’un objet de collaboration

204

Cette section décrit comment créer un objet de collaboration a 1’aide de 1’assistant
de System Manager. Elle décrit le flux général de l'assistant et fait référence a
d’autres sections dans ce chapitre pour 1’analyse des spécificités de la configuration
des objets de collaboration. Procédez comme suit pour créer un objet de
collaboration a I'aide de assistant :

1. Dans System Manager, cliquez avec le bouton droit de la souris sur le dossier
Collaboration Objects dans une bibliotheque de composants d’intégration, puis
sélectionnez Create New Collaboration Object dans le menu contextuel.

L’assistant “Create New Collaboration” s’affiche et indique les modeles installés
dans la colonne Template Name ainsi qu'une description (si celle-ci est fournie
par le fournisseur) dans la colonne Description. La boite de dialogue constitue
le premier écran de l'assistant qui vous indique les étapes initiales de la
création et de la configuration d’un objet de collaboration. Vous pouvez par la
suite modifier les valeurs de configuration. La [figure 52 a la page 205| présente
I’écran “Select collaboration template” :
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Create New Collaboration

Select collaboration template
Select the collaboration template you want to use for the collaboration.

Fingt: | | -
Template rame | Description |
Cortact¥rapper Comact Verapper.

CustomerPartnerrapper Customer Partnery\rapper .
CustomerSync Used to sync Customers.
Customerrapper Customer¥Wrapper
EmailTemplate Email Collaboration
temSync Collaboration to sync Material Master (tem) records
temvirapper Collsboration used to delegate verify f sync of Rems.
PazsThroughTest
PriceManager Price Manager Ver 2.0.0
SalesOrderProcessing Collaboration used to process Sales Orders.
SiteVirapper WVirapper collaboration to delegate sync or verification of Sites
YendorPartnerwirapper Allovws other collaborations to call the YendorPartnerSyne
YendorSync Vendor Sync Collaboration (UPGRADED).
Collaborstion temy |
Collaboration ohject name: I

= Back Cancel

hiext = || Firiish |

Figure 52. Sélection d’'un modéle de collaboration

2. Sélectionnez le modele de collaboration a partir duquel vous souhaitez créer
I'objet dans la liste des modéles. Le nom sélectionné s’affiche dans la zone
Selected Collaboration template sous la liste.

Vous pouvez également entrer du texte dans la zone Find : la boite de dialogue
sélectionnera un modele de collaboration dont le nom commence par les
caractéres entrés dans cette zone. Vous pouvez ensuite utiliser les fleches de
direction pour accéder aux modeles qui partagent la méme combinaison de
caracteres si plusieurs d’entre eux correspondent.
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Create New Collaboration

Create New Collaboration
Specify how to bind ports to connectors and collaboration objects.

Fingt: | customers ;l ;l
Template name | Description |
Cortactrapper Contact Virapper.

CustomerPartnerrapper Customer Partnefvirapper .
Customersync Used to sync Customers.
Customerirapper Customer¥Wrapper
EmailTemplate Email Collaboration
temSync Collsboration to sync Material Master (tem) records
temvirapner Colisboration used to delegate verify f sync of Rems.
PassThroughTest
PriceManager Price Manager Ver 2.0.0
SalesOrderProcessing Collsboration used to process Sales Orders.
SiteVWirapper Wrapper collaboration to delegate sync or verification of Sites
YendorPartnerWirapper Allowes other collaborstions to call the VendorPartnerSync
YendorSyne Vendor Sync Collaboration (UPGRADED).
Selected Collsboration template: [ Cuisiomeryne
Collaboration object name: | CustomerSync:Clarify ToSAP
= Back hlext = Firitsh Cancel

Figure 53. Utilisation de la zone Find

3. Entrez un nom pour l'objet de collaboration dans la zone Collaboration object

name.

Pour connaitre les conditions requises et les conventions relatives aux noms des

objets de collaboration, voir le document Naming Components Guide.

Cliquez sur Next pour accéder a ’écran Bind ports de 1’assistant.

L’écran “Bind ports” affiche les ports définis dans le modele de collaboration,
la définition d’objet métier prise en charge par chaque port, le type de

composant auquel le port peut étre associé ainsi que les composants spécifiques
du type spécifié auxquels chaque port peut étre associé. La [figure 54 a la page]
présente I'écran “Bind ports” :
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Select collaboration template I

Bind ports i3
Specify how to bind ports to connectors and collaboration objects . a
| Port | Business Object Defintion | Type | Bintvith |
1 DestinationdppRe...  Customer Connector PortConnector
2 From Customer Connector ClarifyConnector
3 To Customer Connector | SAPConnector ~|
4 ToCustomerPartn...  CustomerPartner Connectar none

< Back Neodt = || fish | concel

Figure 54. Association de ports de collaboration

Selon la valeur indiquée dans la colonne Type, la colonne Bind With affiche les
connecteurs ou les collaborations qui prennent en charge le type d’objet métier
indiqué dans la zone Business Object Definition. Pour chaque port affiché,
sélectionnez Collaboration, Connector ou Web Service dans la colonne Type,
puis sélectionnez le composant souhaité dans la colonne Bind With.

Pour configurer un port de sorte qu’il puisse recevoir des requétes d’objet
métier en provenance d’une entité par programmation externe (par exemple un
servlet), vous devez suivre les instructions de la section [«Configuration des|
[liaisons de ports externes» a la page 214}

Vous pouvez relier tout ou partie des ports affichés a I’écran de l'assistant ou
aucun d’entre eux. Si vous n’associez pas tous les ports a ce stade, vous pouvez
toujours modifier votre sélection a la fin de l’assistant. De cette maniere, si un
composant spécifique associé a un port ne prend pas en charge la définition
d’objet métier requise, vous pouvez terminer l'assistant de 1'objet de
collaboration, ajouter une prise en charge de la définition d’objet métier au
composant requis puis reconfigurer 1’objet de collaboration.

Pour plus d’informations sur les liaisons de ports et sur leur modification, voir
[«Association des ports d’un objet de collaboration» a la page 212}

5. Cliquez sur Next pour accéder a 1’écran “Collaboration General Properties” de
l'assistant. Cet écran vous permet de configurer les propriétés appartenant a
tous les modeles de collaboration définis dans le systéme d’intégration métier
de WebSphere InterChange Server. La [figure 55 a la page 208| présente 1’écran
“Collaboration General Properties” :
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roperties

Collaboration general properties l Properties

Create from kemplate; |

Effective transaction lewvel |None ﬂ Mlinirum transaction level
System trace level |EI - Mo bracing ﬂ Collaboration trace lewvel o

E-rnail notification address

[ Pause when a critical error gccurs,  Maximum number of concurrent events |1 4
[ Persist service call in kransit state  Recovery mode Aluays | ¥
v Implicit database transaction faxirmum event capacity 2147483647

[ Blocking tvpe

[ Event isolation

OF | Cancel

Figure 55. Configuration des propriétés générales d’un objet de collaboration

Affectez a chaque propriété la valeur souhaitée.

Pour plus d’informations sur les propriétés générales des objets de
collaboration et sur la maniére de les modifier pour un objet de collaboration
existant, voir [«Configuration des propriétés générales d’un objet de]
[collaboration» a la page 215|

6. Cliquez sur Next pour accéder a I’écran Properties de l'assistant. Cet écran
vous permet de configurer les propriétés spécifiques a un modele de
collaboration spécifique.
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Select collaboration template ¥
Properties e
Set Properties a
| Property name | vaiue |
1 WERIFY _SYNC_CUSTOMERPARTNERS neither
2 1_FILTER_ATTRIBUTE Cortroller ObjectEvertid
3 1_INCLUDE_vA&LUES all
4 1 _FAIL_ON_INYALID _VALUE true
-] USE_RETRIEYE false
6 CONVERT_UPDATE false
7 SEND_EMAIL none
G ADDITIONAL _RETRIEYE tfalse
9 COMNVERT_CREATE false
10 SYNC_PARENT_FIRST false
1 1_EXCLUDE _VALUES none
12 INFORMATIOMAL _EXCEPTIONS 1000, 2000, 2005, 2010, 2015, 2020, 3000, 3010, 3020
= Back | et Cancel

Figure 56. Configuration des propriétés spécifiques a un modéle de collaboration

Entrez une valeur pour chaque propriété ou acceptez la valeur par défaut. Pour
plus d’informations sur chaque propriété, consultez la documentation du
modele de collaboration concerné.

Cliquez sur Finish pour mettre fin a l'assistant de création d’objets de
collaboration. Le nouvel objet de collaboration s’affiche dans I'onglet Graphical
View. Pour plus d’informations sur la représentation graphique et
l’arborescence de I'objet de collaboration, voir [«<Représentations de 1’objet de|
[collaboration» a la page 210}

Modification des objets de collaboration

Cette section décrit comment modifier un objet de collaboration. Il se peut que
vous deviez modifier les liaisons ou les propriétés de port d"un objet de
collaboration pour les raisons suivantes :

* Vous avez créé 'objet de collaboration a l'aide de l'assistant comme indiqué
dans la section |[«Création d’un objet de collaboration» a la page 204, mais vous
avez été contraint de relier un port a une entité par programmation externe,
opération qui ne peut pas étre réalisée via l’assistant.

* Vous avez créé 'objet de collaboration a l'aide de l'assistant comme indiqué
dans la section [«Création d’un objet de collaboration» a la page 204} mais les
composants requis ne prenant pas en charge les définitions d’objets métier
associées aux ports, vous avez été contraint de modifier les définitions des
composants.

* Vous avez importé la définition de 1’objet de collaboration depuis une autre
bibliotheque de composants d’intégration ou depuis InterChange Server et vous
devez apporter des modifications spécifiques a I'environnement.

* Vous devez modifier un objet de collaboration qui fonctionnait correctement
dans un environnement de production mais qui nécessite une modification
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administrative, par exemple une modification de 1’adresse de messagerie a
laquelle les notifications par courrier électronique sont envoyées en cas d’erreur.

Pour modifier un objet de collaboration, cliquez deux fois dessus dans le dossier
Collaboration Objects contenu dans le dossier Integration Component Libraries ou
dans le dossier User Projects dans System Manager.

Représentations de I’objet de collaboration

I existe deux modes de représentation d’un objet de collaboration : la
représentation graphique et 1’arborescence. Les sections suivantes décrivent chacun
d’eux et présentent leurs avantages.

Représentation graphique d’un objet de collaboration

La représentation graphique d'un objet de collaboration est la vue affichée par
défaut suite a la création d'un objet de collaboration. Comme le montre la section
figure 57 a la page 211} la représentation graphique symbolise 1’objet de
collaboration par une icone au centre de la vue et d’autres icones représentant
chaque port de la collaboration développé vers I'extérieur. Cette vue est tres utile
pour indiquer le “flux” du processus métier : vous pouvez glisser-déplacer les
ports dans le panneau d’affichage pour les placer a des endroits suggérant la
directionnalité de la communication des collaborations. Par exemple, vous pouvez
placer le port qui recoit I'objet métier de déclenchement dans la partie gauche du
panneau et placer le port qui envoie 1'objet métier a 1’application cible dans la
partie droite.

Remarque : Il n’existe aucun moyen pour permettre au systeme d’afficher
automatiquement les ports qui regoivent les objets métier de
déclenchement d'un coté et les ports qui envoient les objets métier aux
applications cible de 'autre. Le développeur d'un modele de
collaboration détermine la désignation et la fonction de ses ports mais
le systeme n’a aucun moyen de connaitre le role que le développeur
destinait a un port spécifique. Nous vous conseillons de consulter la
documentation relative au modéle de collaboration et de replacer les
ports dans la représentation graphique des objets de collaboration
basés sur le modele de maniere a vous faciliter 'utilisation des outils.
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Figure 57. Représentation graphique d’un objet de collaboration

Arborescence d’un objet de collaboration

Pour passer de la représentation graphique a 'arborescence d’un objet de
collaboration, il suffit de cliquer sur 'onglet Tree View. Comme le montre la
fficure 58 & la page 212} 1’arborescence symbolise 1’objet de collaboration par une
icone dans la partie supérieure d'une arborescence hiérarchique et les ports par des
icones reliées a l'objet de collaboration par une branche. Bien que cette vue ne
suggere pas le “flux” du processus métier de maniere tres évidente, elle présente
les ports et les composants associés de maniere trés organisée, facilitant ainsi la
recherche d’un port spécifique a reconfigurer. Cela peut étre particulierement utile
lors de l'utilisation d’objets de collaboration basés sur des modeles dotés de
nombreux ports, contrairement a la représentation graphique qui peut s’avérer
confuse. L’arborescence d’un objet de collaboration ne vous permet cependant pas
de réorganiser les icones.
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Figure 58. Arborescence d’un objet de collaboration

Association des ports d’un objet de collaboration

Les ports de collaboration sont les interfaces utilisées par les collaborations pour
envoyer et recevoir des objets métier. Les ports d’un objet de collaboration doivent
étre reliés a différents composants pour étre configurés pour 1'échange du type
d’objet métier pris en charge par le port.

Vous pouvez relier les ports d’un objet de collaboration lors de la création initiale
de l'objet de collaboration a 1’aide de 'assistant décrit dans la section
[d’un objet de collaboration» a la page 204] Vous pouvez également modifier les
liaisons de port apres la création de 1’objet de collaboration. Pour modifier les
liaisons de port dans la représentation graphique, cliquez deux fois sur 'icone d'un
port ou cliquez avec le bouton droit de la souris sur l'icone d"un port, puis
sélectionnez Bind Port dans le menu contextuel. Pour modifier les liaisons de port
dans l'arborescence, cliquez avec le bouton droit de la souris sur 1'icone d'un port,
puis sélectionnez Bind Port dans le menu contextuel.

Pour relier un port de collaboration a un composant interne tel qu'un connecteur
ou au port d’un autre objet de collaboration, activez le bouton radio intitulé

Internal dans le panneau Type et consultez la section [«Configuration des liaisons|
|de ports internes»|

Pour relier un port de collaboration a une entité par programmation externe telle
qu'un servlet Web, activez le bouton radio intitulé External dans le panneau Type
et consultez la section [«Configuration des liaisons de ports externes» a la page 214}

Configuration des liaisons de ports internes
Pour relier un port de collaboration a un connecteur ou au port d’un autre objet de
collaboration, procédez comme suit :

1. Activez le bouton radio intitulé Internal dans le panneau Type de la boite de
dialogue de configuration du port.
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2. Sélectionnez le type de composant approprié, Connector ou Collaboration,
dans le panneau Bind With.

3. Sélectionnez le composant spécifique dans la liste.
4. Cliquez sur OK.

La présente la boite de dialogue de configuration du port définie avec un
type de liaison interne.

. % Configure Port CustomerSync_Clarify ToSAP.From =10 x|
none
PortConnector
ClarifyConnector
SAPConnector

Business Object Definitior: Customer

~Type — Bincith
{* Internal (O o r
" External " Collaboration

OK | Cancel |

Figure 59. Configuration des ports internes d’un objet de collaboration

Seuls les composants prenant en charge le type de définition d’objet métier indiqué
dans la zone Business Object Definition sont répertoriés dans la boite de
dialogue. Si le composant que vous souhaitiez n’apparait pas dans la liste, cela
indique qu’il ne correspond peut-étre pas au type spécifié (vous devez par
conséquent modifier la sélection du bouton radio Bind With) ou qu’il ne prend pas
en charge la définition d’objet métier. Si vous avez affecté le type de composant
approprié au bouton radio Bind With et que le composant que vous souhaitiez
voir s’afficher n’est pas répertorié, modifiez la définition qui lui est associée pour
ajouter la prise en charge de la définition d’objet métier puis lancez la boite de
dialogue de configuration du port.

Pour pouvoir démarrer un objet de collaboration, veillez a relier tous les ports qui
lui sont associés.

Les ports définis pour certains modeles de collaboration prennent en charge une
fonction facultative de logique applicative. Par exemple, un certain nombre de
modeles de collaboration sont congus de telle sorte qu’ils peuvent tenter d’extraire
I'entité qu’ils viennent de créer dans 1’application cible pour veiller au bon
déroulement de l'opération. Ce type de comportement est généralement facultatif
et configurable par l'intermédiaire des propriétés spécifiques a la collaboration.
Tous les ports d"un objet de collaboration doivent étre reliés a un composant pour
qu’il puisse démarrer, comme indiqué précédemment. Par conséquent, méme si
vous n’avez pas l'intention de tirer profit du comportement facultatif, vous devez
configurer les ports existants uniquement pour prendre en charge cette fonction.
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Dans ce cas, il vous suffit d’ajouter la prise en charge de la définition d’objet
métier a un composant non utilisé (tel que PortConnector) et de veiller a
configurer les propriétés de collaboration de maniére a ne pas utiliser la fonction
facultative.

Configuration des liaisons de ports externes
Pour relier un port de collaboration a un connecteur ou au port d'un autre objet de
collaboration, procédez comme suit :

1.

Activez le bouton radio intitulé External dans le panneau Type de la boite de
dialogue de configuration du port.

Dans le panneau Configure As, sélectionnez le bouton radio Incoming si les
requétes d’objet métier sont recues par le port ou sélectionnez le bouton radio
Outgoing si les réponses d’objet métier sont envoyées depuis le port.
Effectuez I'une des opérations suivantes pour relier les composants souhaités
au port :

* Effectuez un glisser-déplacer de la définition d’objet métier depuis la

bibliotheque de composants d’intégration vers le panneau contenant la
colonne Incoming Maps ou Outgoing Maps, selon que les requétes d’objet
métier sont recues par le port ou que les réponses d’objet métier sont
envoyées depuis le port.

Lorsque la boite de dialogue Business Object Type s’affiche, sélectionnez le
bouton radio Source Business Object ou Destination Business Object, selon
que l'objet métier que vous venez de glisser-déplacer est un objet source ou
cible dans la mappe en charge de le transformer.

Effectuez un glisser-déplacer d’une définition de la mappe en charge de
transformer le type d’objet métier pris en charge par le port depuis la
bibliotheque de composants d’intégration vers le panneau contenant la
colonne Incoming Maps ou Outgoing Maps, selon que les requétes d’objet
métier sont recues par le port ou que les réponses d’objet métier sont
envoyées depuis le port.

4. Cliquez sur OK.

La[figure 60 a la page 215 présente la boite de dialogue de configuration du port

définie avec un type de liaison externe.
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. % Configure Port OrderStatusQuery_WebToCaesar -0l x|

Source BO [ Incoming Maps | Destination BO I Type
WiehOrderStatusRequest  WebOrderStatu...  OrderStatusReq..  Native

4] |

Source BO | outgoing Maps Destination BO | Type

Business Object Definition: OrderStatusRequest

~Type — Configure As
(" Internal * Incoming;
¥ External

OK | Cancel

Figure 60. Configuration des ports externes d’un objet de collaboration

Pour plus d’informations sur I'implémentation d’intégrations avec des entités par
programmation externes, voir le document Access Development Guide.

Configuration des propriétés générales d’un objet de
collaboration

Les propriétés de collaboration générales sont des propriétés appartenant a tous les
objets de collaboration, quelle que soit la maniere dont le développeur a congu le
modele sur lequel les objets sont basés. Elles affectent le comportement de
I'ensemble de 1'objet de collaboration dans le systeme.

Pour modifier les propriétés générales d'un objet de collaboration, procédez
comme suit :

1. Accédez a la boite de dialogue Properties de 'objet de collaboration en
procédant de I'une des manieres suivantes :

* Cliquez avec le bouton droit de la souris sur 1'objet de collaboration dans
une bibliothéque de composants d'intégration, puis sélectionnez Properties
dans le menu contextuel : la boite de dialogue affiche 1’onglet Collaboration
General Properties par défaut.

* Cliquez deux fois sur 'icone de 1’objet de collaboration dans la
représentation graphique : la boite de dialogue affiche I'onglet Collaboration
General Properties par défaut.

* Cliquez avec le bouton droit de la souris sur 1'icone de I'objet de
collaboration dans la représentation graphique ou dans 'arborescence, puis
sélectionnez Properties dans le menu contextuel : la boite de dialogue affiche
I'onglet Collaboration General Properties par défaut.

2. Affectez a la propriété la valeur souhaitée. Pour obtenir une description de
chaque propriété et des valeurs possibles, voir [tableau 15 a la page 216 et les
sections suivantes.

3. Cliquez sur OK.
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Tableau 15. Propriétés générales d’un objet de collaboration

Nom de la propriété

Valeurs possibles

|Create from template

Nom en lecture seule du modele sur lequel 'objet de
collaboration est basé

[Effective transaction levell

None, Minimal Effort, Best Effort ou Stringent

[Minimum transaction level|

None, Minimal Effort, Best Effort ou Stringent

selon la conception du modele de collaboration

- No Tracing,

- Collaboration operations,

And collaboration events,

- And state transactions,

- And incoming/outgoing messages,
- And detailed message contents

[System trace levell

OB wWw N = o

[Collaboration trace levell De0ab

[Email notification addresd

N’importe quelle adresse de messagerie valide

[IPause when critical error occurs| Activée ou désactivée
[

[Maximum number of concurrent] De 0 a 9999

||events|

Activée ou désactivée

[IPersist service call in transit state|

Always ou Deferred

| Recovery mode)

[Implicit database transaction| Activée ou désactivée

[Max event capacity]

Nombre entier entre 1 et 2147483647

Activée ou désactivée

[Blocking type]

Activée ou désactivée

| Event isolatio

Create from template
Cette zone de texte en lecture seule affiche le nom du modéle de collaboration sur
lequel I’objet de collaboration est basé.

Effective transaction level

Le niveau de transaction effectif se situe entre le plus haut niveau de transaction
maximale de tous les objets de collaboration et le plus bas niveau de transaction
maximale de tous les connecteurs reliés a 1’objet.

Vous pouvez diminuer le niveau de transaction effectif d'une collaboration si vous
devez la relier a un connecteur qui ne prend pas en charge un certain niveau de
transaction.

Pour modifier le niveau de transaction effectif, sélectionnez la valeur appropriée
dans la liste déroulante Effective transaction level, puis cliquez sur OK.

Remarque : Vous ne pouvez pas relier des objets dont les niveaux de transaction
sont incompatibles. Si vous devez relier de tels objets a une
collaboration, vous devez ajuster les niveaux de transaction pris en
charge en conséquence.

Minimum transaction level
Le niveau de transaction minimal indique le niveau de transaction le plus bas du
modele de collaboration et de tous les objets de collaboration associés.
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Par exemple, si le développeur a affecté la valeur Best Effort au niveau de
transaction minimal du modele de collaboration, tous les objets basés sur ce
modele doivent s’exécuter avec le niveau Best Effort ou Stringent. Comme le
montre la section relative a la propriété [«Effective transaction level» a la page 216}
tous les composants reliés a ’objet de collaboration doivent prendre en charge le
niveau de transaction effectif qui lui est associé. Le niveau de transaction minimal
est, par conséquent, un moyen pour le développeur du modele de collaboration de
déterminer le niveau de transaction le plus bas auquel les objets de collaboration
basés sur le modele et contenus dans l'interface s’exécuteront.

La zone Minimum transaction level est en lecture seule lors de la configuration
d’un objet de collaboration : elle peut uniquement étre modifiée dans le modele de
collaboration.

Pour plus d’informations sur I'apport de modifications aux modeles de
collaboration, voir le document Collaboration Development Guide.

System trace level

Vous pouvez configurer les objets de collaboration de sorte que les informations
relatives a I’exécution de la collaboration soient signalées dans la sortie du serveur.
Pour ce faire, sélectionnez la valeur appropriée dans le menu déroulant System
trace level. Le décrit les différents niveaux et les types d’informations
signalés :

Tableau 16. Niveaux de trace du systeme

Niveau de trace du systeme Informations signalées
0 - No Tracing Aucune information n’est suivie a ce niveau
1 - Collaboration operations Suit la réception des objets métier depuis

les connecteurs et le début des scénarios

2 - And collaboration events Affiche les messages du niveau 1, ainsi que
le début et la fin de chaque scénario, y
compris l'exécution et I’annulation en aval

3 - And state transactions Affiche les messages des niveaux 1 et 2,
ainsi que 1’exécution du bloc de décisions
ou du noeud d’actions de chaque scénario

4 - And incoming/outgoing messages Affiche les messages des niveaux 1 a 3,
ainsi que 1’envoi et la réception de chaque
objet métier par chaque scénario

5 - And detailed message contents Affiche les messages des niveaux 1 a 4,
ainsi que la structure de 1’objet métier en
cours de traitement avec la valeur de
chaque attribut

Collaboration trace level

Les développeurs de collaborations peuvent coder les modeles de collaboration
avec une fonction de trace spécifique au modele. Tandis que la fonction de trace du
systéme (décrite a la section [«System trace level») fournit des informations de
tragage sur 'exécution des collaborations en général, la fonction de trace de la
collaboration fournit des informations relatives a une collaboration spécifique. Par
exemple :

* Le développeur peut configurer la collaboration de sorte qu’elle signale les
décisions stratégiques prises en fonction des données contenues dans 1’objet
métier en cours de traitement par la collaboration.
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* Le développeur peut fournir une fonction de trace du type de systéme mais
uniquement a un moment donné dans 1’exécution de la collaboration. Par
exemple, le niveau de trace 5 du systeme fournit un vidage complet des données
de l'objet métier dans la sortie du serveur. Cette fonction peut étre
particulierement utile pour résoudre les incidents mais également difficile a
analyser lorsqu’elle intervient a plusieurs reprises au cours d’'une méme
exécution de collaboration. Un développeur de collaborations peut fournir un
vidage complet de 1'objet métier exécuté pendant un niveau de la fonction de
trace de la collaboration, et ce uniquement a un moment particuliérement
problématique dans le flux de la collaboration de sorte que l'utilisateur ne puisse
trouver et lire dans la sortie du serveur qu'un seul vidage de 1'objet métier.

Pour définir le niveau de trace de la collaboration, sélectionnez la valeur
appropriée entre 0 et 5 dans le menu déroulant Collaboration trace level.

Pour déterminer le type d’information signalé aux différents niveaux de trace
d’une collaboration spécifique, consultez la documentation relative au modele de
collaboration concerné.

Pour plus d’informations sur 'apport de modifications aux modeles de
collaboration pour implémenter le tracage d'une collaboration, voir le document
Collaboration Development Guide.

Email notification address

Vous pouvez configurer un objet de collaboration de sorte que des notifications par
courrier électronique soient envoyées en cas d’erreur associée a cet objet spécifique.
Cette fonction permet de faciliter 'administration spécifique aux interfaces lorsque
cela est nécessaire. Par exemple, un site peut disposer d'un seul administrateur en
charge des erreurs associées a WebSphere InterChange Server lui-méme, un autre
administrateur spécifiquement chargé de l'interface de synchronisation des
comptes client et un autre administrateur spécifiquement chargé de l'interface de
traitement des commandes.

Entrez les adresses e-mail compatibles SMTP auxquelles vous souhaitez que les
notifications d’erreur soient envoyées dans la zone Email notification address.
Vous pouvez entrer plusieurs adresses tant que celles-ci sont séparées par des
virgules. Pour plus d’informations sur la configuration du systeme pour 'envoi de
notifications par courrier électronique, voir [«Configuration des propriétés de|
inotification par courrier électronique a I'aide de System Manager» a la page 122
ainsi que le document System Administration Guide.

De nombreux modeles de collaboration fournissent une configurabilité plus
développée quant a 'envoi de notifications par courrier électronique, bien au-dela
de la simple définition d'une valeur pour la zone Email notification address. Le
niveau de configurabilité dépend intégralement de la conception du modele de
collaboration. Par conséquent, consultez la documentation d’un modeéle de
collaboration spécifique pour obtenir des informations sur son approche des
notifications par courrier électronique.

Pause when critical error occurs

Certaines erreurs peuvent empécher le traitement des requétes d’objet métier d'une
collaboration par les connecteurs auxquels ces requétes sont envoyées. Voici des
exemples d’erreurs :

* incapacité du connecteur de se connecter a l’application ;

* délai d’expiration de la communication entre le connecteur et I'application ;
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* modification de 1’état de I'agent du connecteur par un état inconnu.

Si ce type d’erreur intervient, la collaboration envoie la requéte au connecteur mais
le flux échoue en raison de l'incident. Cela se produit lorsqu’une requéte est
envoyée alors que l'incident n’est pas résolu et peut entrainer I'échec répété des
flux de l'interface si le volume de transaction est élevé et que l'erreur persiste dans
la durée.

Vous pouvez configurer un objet de collaboration de sorte qu’il cesse d’envoyer
des requétes a un connecteur lorsqu’une requéte échoue suite a une erreur critique.
Pour ce faire, activez la case a cocher Pause when critical error occurs.

Pour plus d’informations sur les erreurs critiques, la réponse de 1'objet de
collaboration a ces erreurs et 1'utilisation de cette fonction, voir le document System
Administration Guide.

Maximum number of concurrent events

Vous pouvez configurer les objets de collaboration de sorte qu’ils traitent plusieurs
flux d’événements déclenchés simultanément afin d’améliorer la capacité de
traitement de l'interface. Pour ce faire, définissez le nombre d’événements que
vous souhaitez que I'objet de collaboration traite simultanément en choisissant une
valeur entre 0 et 9999 dans le menu déroulant Maximum number of concurrent
events.

Pour bénéficier pleinement de cette fonction, vous devez également configurer
d’autres composants associés a l'interface pour qu’ils se comportent de maniére
identique. Pour plus d’informations, voir [<Implémentation du traitement simultané|
[des flux déclenchés par un événement» a la page 335

Persist service call in transit state

II est possible qu'une erreur intervienne aprés qu'une collaboration ait envoyé une
requéte d’objet métier a des connecteurs cible auxquels elle est associée et avant
qu’elle ait regu une réponse de leur part indiquant si la requéte a abouti ou non
dans leurs applications respectives. Si les connecteurs ne sont pas parvenus a
traiter la requéte, cette derniere doit étre traitée de nouveau une fois l'erreur
résolue. Toutefois, si les connecteurs parviennent a traiter la requéte et qu’ils sont
en cours d’envoi d'une notification a InterChange Server indiquant 1’aboutissement
du traitement lorsque l’erreur intervient, cette notification n’est pas envoyée a
InterChange Server. Le dernier enregistrement d’état de la requéte indique alors
que la requéte doit encore étre traitée. Suite a cet enregistrement d’état inexact, la
requéte doit étre traitée une seconde fois, impliquant la duplication des données.

Pour éviter ce type d’incident lors de la configuration de collaborations non
transactionnelles, vous pouvez activer la case a cocher Persist service call in
transit state. InterChange Server poursuit alors le traitement de toute requéte
d’objet métier en direction des applications cible méme en cas d’erreur. Les
requétes ne sont pas envoyées lors de la restauration du systéme, réduisant ainsi le
risque pour la requéte d’étre traitée deux fois dans les applications cible. Vous
pouvez ensuite utiliser Flow Manager pour examiner les requétes et analyser les
applications cible afin de déterminer si les requétes ont abouti ou non avant que
l'erreur ne se produise. Vous devez éliminer les requétes ayant abouti et soumettre
de nouveau celles qui ont échoué.
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Certaines mesures par programmation peuvent également étre prises pour gérer
ces types d’échec associés au transfert. Pour plus d’informations sur la gestion des
exceptions du transfert d’appel de service, voir le document Collaboration
Development Guide.

Recovery mode

Dans les versions précédentes, lorsqu’une erreur systeme fatale intervenait, tous les
flux en cours de traitement au moment de ’échec étaient restaurés lors du
redémarrage du systeme. Les flux étaient tous lus a partir d’'une mémoire
persistante et soumis une nouvelle fois au traitement. Si le nombre de ces flux était
important, la mémoire du systéeme pouvait étre utilisée dans son intégralité par
I'extraction des événements dans la mémoire et entrainer ainsi une nouvelle erreur
systéme fatale en raison d’une quantité de mémoire insuffisante. De plus, vous ne
pouviez pas gérer efficacement le systéme avec les outils fournis tant
qu’InterChange Server n’avait pas terminé son processus de reprise apres incident.

Grace a la version 4.0.0, il est possible de retarder la reprise apres incident d'un
objet de collaboration en affectant au menu déroulant Recovery mode la valeur
Deferred. Si vous configurez un objet de collaboration pour une reprise apres
incident différée de cette manieére, tous les flux en cours au moment de l'erreur
systeme fatale sont traités en tant que flux ayant échoué et ne sont pas restaurés
immédiatement lors du redémarrage du systéme. L’administrateur peut alors
utiliser Flow Manager pour soumettre a nouveau les flux apres le redémarrage du
systeme et prendre toutes les décisions administratives souhaitées avant tout effort
de reprise apres incident.

Important: Certaines interfaces requierent que les événements soient traités dans
I'ordre dans lequel ils sont regus. Si l'ordre des événements importe
peu pour l'intégrité d'une interface, vous pouvez alors implémenter
une reprise apres incident différée sans tenir compte de 'ordre dans
lequel les nouveaux flux ou ceux ayant échoué sont traités. Si toutefois
I'ordre des événements est important et que vous devez implémenter
une reprise apres incident différée, vous devez alors étudier et suivre
les procédures administratives pour veiller a ce que l'ordre des
événements soit conservé. Par exemple, 'administrateur doit veiller a
ce que la collaboration ne regoive ni ne traite les nouveaux flux lors du
redémarrage du systeme tant que les flux ayant échoué n’ont pas été
résolus. Pour ce faire, il doit gérer le démarrage ou l'interrogation des
agents du connecteur susceptibles d’envoyer de nouveaux événements
a la collaboration en question.

La nécessité d'une reprise apres incident différée a été atténuée grace a
Iintroduction de mesures de reprise apres incident optimisées dans la version
4.2.0. Au lieu de lire I'intégralité des données d’objet métier relatives aux
transactions en cours dans la mémoire, le serveur lit uniquement les informations
nécessaires pour localiser ’objet métier dans une mémoire persistante. Bien que la
reprise apres incident différée soit encore disponible, elle ne vous sera
probablement plus utile grace a cette nouvelle approche de reprise apres incident
optimisée.

Implicit database transaction

Si le modele de collaboration sur lequel est basé 1’objet de collaboration en cours
de configuration implémente une logique de base de données transactionnelle,
vous devez alors configurer 1'objet de collaboration pour la mise entre parentheses
implicite ou explicite des transactions. Si la collaboration a été développée de sorte
que la sémantique des transactions est gérée explicitement par le code créé par le
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développeur, vous devez alors désactiver la case a cocher Implicit database
transaction. Par contre, si la collaboration n’a pas été développée avec la gestion
explicite des transactions de la base de données, vous devez activer la case a
cocher Implicit database transaction.

Pour plus d’informations sur la mise entre parentheses implicite et explicite des
transactions, voir le document Collaboration Development Guide

Max event capacity

Dans la mesure ol les objets métier sont envoyés a InterChange Server, ils sont mis
en file d’attente dans la mémoire avant d’étre traités. Dans les versions antérieures
a la version 4.2.0, les interfaces dotées d’un important volume de transactions et
d’un faible taux de traitement pouvaient mettre en file d’attente une quantité
d’objets métier si grande que la mémoire d’InterChange Server devenait
insuffisante.

Vous pouvez réduire le risque de mémoire insuffisante en configurant une capacité
d’événements maximale pour un objet de collaboration. Pour ce faire, affectez a la
zone Max event capacity une valeur indiquant le nombre maximal d’événements
que vous souhaitez mettre en file d’attente pour un objet de collaboration. Le
systéme ne mettra pas en file d’attente plus d’événements que le nombre indiqué
pour cette propriété en mémoire. Selon la maniére dont vous configurez la
propriété [Blocking type»| de 'objet de collaboration, le systeme répond
différemment a la réception de nouveaux objets métier pour la collaboration.

La plage valide de valeurs pour cette propriété se situe entre 1 et 2147483647.

Pour plus d’informations sur la propriété Blocking type, voir [«Blocking type»]

Pour plus d’informations sur les propriétés de contrdle du flux des définitions du
connecteur et sur la maniére d’utiliser Connector Configurator pour modifier ces
définitions, voir [Chapitre 7, «Configuration des connecteurs», a la page 145

Pour plus d’informations sur les propriétés systeme associées au contrdle du flux,
voir le document System Administration Guide.

Blocking type
Utilisez la propriété [«Blocking type»|avec la propriété [«<Max event capacity» pour
réguler le flux des objets métier vers une collaboration.

Si vous activez la case a cocher Blocking Type lors de la configuration d’un objet
de collaboration et que le nombre d’événements dans la file d’attente de la
collaboration atteint le nombre indiqué pour la propriété Max event capacity, le
controleur du connecteur en charge d’envoyer les objets métier a la collaboration
cesse son activité. Lorsque le nombre d’événements contenus dans la file d’attente
de la collaboration n’est plus égal au nombre indiqué pour la propriété Max event
capacity, le contréleur du connecteur reprend alors 1’envoi des événements a la
collaboration.

Si vous désactivez la case a cocher Blocking Type lors de la configuration d'un
objet de collaboration et que le nombre d’événements dans la file d’attente de la
collaboration atteint le nombre indiqué pour la propriété Max event capacity, les
nouveaux événements soumis a la collaboration par le controleur du connecteur
sont stockés en permanence dans la base de données. Les événements sont ensuite
lus a partir de la base de données dans la mémoire tandis que les événements
actuellement contenus dans la file d’attente de la collaboration sont traités.
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Pour plus d’informations sur la propriété Max event capacity, voir
fcapacity» a la page 221|

Pour plus d’informations sur les propriétés systeme associées au controle du flux,
voir le document System Administration Guide.

Event isolation

L’isolation des événements permet de s’assurer que les deux collaborations
n’utilisent pas les mémes données simultanément. Il arrive parfois que plusieurs
collaborations gerent les mémes types d’objet métier. Un événement arrive et
déclenche une collaboration spécifique. Cette collaboration s’exécute et, pendant ce
temps, dispose d’un acces unique a cette instance de 1'objet métier dans
InterChange Server. Si un autre événement associé aux mémes données arrive,
InterChange Server met en file d’attente le dernier événement arrivé jusqu’a ce que
la collaboration en cours d’exécution termine le traitement du premier événement.

Remarque : Pour plus d’informations sur l'isolation des événements, voir le
document Collaboration Development Guide.

La case a cocher Event isolation est activée par défaut. Les parametres peuvent
étre modifiés au moment de 1’exécution. Toutefois, les propriétés mises a jour ne
seront effectives que pour les nouveaux événements n’ayant pas été traités, par
exemple les événements se trouvant encore dans WebSphere MQ ou WIPQ. Pour

zes 2

les événements ayant déja été traités, la nouvelle valeur ne s’appliquera pas.

Dans la mesure ou l'isolation des événements implique plusieurs objets de
collaboration, si I'isolation est désactivée pour un événement, l'isolation des autres
événements ne fonctionnera pas correctement. Pour étre efficace, I'isolation des
événements doit étre activée pour tous les objets de collaboration ayant la méme
source, les mémes connecteurs cible et les mémes références aux objets métier.

Configuration des propriétés spécifiques a une collaboration

Les développeurs de collaboration peuvent créer des modeéles de collaboration de
maniere a ce qu'ils aient leurs propres propriétés individuelles et qu’ils puissent les
utiliser pour affecter la logique du processus métier lancée au moment de
I'exécution. Cette fonction fournit une architecture trés souple permettant une
personnalisation des modeles de collaborations en accord avec les conditions
spécifiques a 'implémentation.

Pour modifier les propriétés spécifiques aux modeles d'un objet de collaboration,
procédez comme suit :

1. Accédez a la boite de dialogue Properties de I'objet de collaboration en
procédant de I'une des manieres suivantes :

* Cliquez avec le bouton droit de la souris sur 'objet de collaboration dans
une bibliotheque de composants d’intégration, sélectionnez Properties dans
le menu contextuel, puis cliquez sur l'onglet Properties.

* Cliquez deux fois sur l'icone de 1’objet de collaboration dans la
représentation graphique, puis cliquez sur 1’onglet Properties.

* Cliquez avec le bouton droit de la souris sur 1'icone de 1'objet de
collaboration dans la représentation graphique ou dans I'arborescence,
sélectionnez Properties dans le menu contextuel, puis cliquez sur 'onglet
Properties.

2. Entrez la valeur souhaitée dans la zone Value pour la propriété indiquée dans
la zone Property name.
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3. Cliquez sur OK.

Pour plus d’informations sur les propriétés spécifiques a un modele de
collaboration et les valeurs valides, voir la documentation relative au modeéle de
collaboration.

Pour plus d’informations sur 'ajout de propriétés a un modele ou la modification

de l'utilisation des propriétés existantes dans un modéle de collaboration, voir le
document Collaboration Development Guide.
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Chapitre 10. Utilisation de Relationship Manager

Relationship Manager vous permet de visualiser et de réaliser des opérations sur
les données d’exécution des relations, y compris sur les participants et les données
qui y sont liées. Pour plus d'informations sur les relations, voir le document Map
Development Guide.

Créez des définitions de relation avec Relationship Designer. Pendant I'exécution,
les instances des relations sont renseignées avec les données associant des
informations en provenance de différentes applications. Ces données d’instance de
relation sont créées lors de 1’exécution des mappes utilisant les relations. Les
données sont stockées dans les tables de relations spécifiées dans la définition de
relation. Relationship Manager fournit une interface graphique capable d’interagir
avec les tables de relations, quel que soit le fournisseur de la base de données.

Pour chaque instance de relation, Relationship Manager affiche une liste
hiérarchique des définitions et des instances des participants, constituant un
ensemble d’attributs de clé et d’attributs non clés. L’arborescence des relations
fournit également des informations détaillées sur chacun des participants dans
I'instance de relation, telles que le type d’entité, sa valeur, sa date de modification.
Un ID d’instance de relation est automatiquement généré lorsque l'instance de
relation est enregistrée dans la table des relations. Relationship Manager affiche cet
ID d’instance dans la partie supérieure de I'arborescence des relations.

Lalfigure 61 a la page 226 présente un exemple d’arborescence des relations dans
Relationship Manager pour une relation d’identité.
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Figure 61. Relationship Manager

Vous pouvez utiliser Relationship Manager pour travailler avec les entités a tous
les niveaux : instance des relations, instance des participants, niveaux d’attributs.
Relationship Manager vous permet par exemple d’effectuer les opérations
suivantes :

* Créer et supprimer des instances de relation

* Modifier le contenu d’une instance de relation, notamment par 1’ajout et la
suppression de participants

* Ajouter et enregistrer les données d’un participant, charger les données d'un
participant a partir d’un fichier ou enregistrer les données dans un fichier,
copier/coller les données d’un participant d"une relation vers l'instance de la
relation, créant ainsi un nouveau participant (tant que les types de participant
sont identiques)

* Activer et désactiver des participants

¢ Extraire des participants en fonction d'ID d’instance, de valeurs d’attribut
d’objets métier ou de données

* Filtrer l'activité d'un participant dans un intervalle de temps

* Récupérer une situation en cas de problemes liés aux données. Par exemple,
lorsque des données incohérentes ou corrompues ont été transmises d'une
application source aux tables des relations d’une application cible générique,
vous pouvez utiliser Relationship Manager pour restaurer (ou nettoyer) des
données en revenant a un point o1 vous savez que celles-ci sont fiables.

Démarrage de Relationship Manager

Pour démarrer Relationship Manager, procédez de I'une des deux manieres
suivantes :
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¢ Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server >
IBM WebSphere Business Integration Toolset > Administrative > Relationship
Manager

* Dans Relationship Designer, sélectionnez une définition de relation, puis Tools >
Relationship Manager a partir de la barre de menus

Relationship Manager démarre. A ce stade, il est déconnecté du serveur ; vous
devez vous connecter a I'instance InterChange Server comme décrit dans la section
l<Connexion a InterChange Server»| pour pouvoir continuer.

Connexion a un serveur et déconnexion

Vous devez connecter Relationship Manager a InterChange Server pour pouvoir
utiliser les instances et les données de relation. Suivez les instructions détaillées
dans les sections suivantes pour connecter Relationship Manager a un serveur, puis
le déconnecter :

+ [«Connexion a InterChange Server»|

+ |«Déconnexion d’InterChange Server» a la page 228]

Connexion a InterChange Server
Pour connecter Relationship Manager a InterChange Server, procédez comme suit :

1. Sélectionnez Server > Connect to Server a partir de la barre de menus de
Relationship Manager.

2. Procédez de I'une des deux manieres suivantes pour indiquer le nom de
I'instance d’InterChange Server a laquelle vous voulez vous connecter dans la
zone Server Name :

* Entrez le nom de l'instance d’'InterChange Server dans la zone Server Name.

Important: Le nom de l'instance d'InterChange Server doit respecter la casse
: vous devez donc indiquer scrupuleusement le nom.

¢ Sélectionnez un nom de serveur mis en cache a partir dans le menu
déroulant.

* Pour accéder a I'instance d’InterChange Server sur le réseau, procédez
comme suit :

a. Cliquez sur le bouton de navigation.

b. Dans la boite de dialogue “Servers”, sélectionnez l'instance d’InterChange
Server souhaitée a partir de la liste.

c. Cliquez sur OK.

3. Entrez le nom d’utilisateur destiné a communiquer avec l'instance
d’InterChange Server dans la zone User Name.

4. Entrez le mot de passe utilisateur indiqué a 1’étape El dans la zone Password.

5. Si vous ne voulez pas avoir a fournir de nom d’utilisateur ni de mot de passe a
chaque connexion a l'instance d’InterChange Server dans System Manager,
cochez la case Remember user name and password.

6. Si vous voulez ouvrir une relation a ce stade, entrez le nom de la définition de
la relation dans la zone Relationship.

Si vous ne voulez pas ouvrir de relation a ce stade, vous pouvez le faire apres
vous étre connecté au serveur. Pour plus d’informations, voir la section
[«Ouverture d’une relation» a la page 228}

N

Cliquez sur Connect.
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Si vous vous connectez a InterChange Server dans Relationship Manager et que
vous indiquez une relation a ouvrir, comme décrit a I'étape |6 a la page 227
Relationship Manager affichera la fenétre “retrieve relationships”, décrite dans

la section [«Extraction d’instances de relation» a la page 229
présente la boite de dialogue “Connect to InterChange Server”.

Connect to InterChange Server E]

Server Name; [WebSphEieIES 421DEVS erver [ |

User Name: ladmiﬂ =]

s

Password: I

¥ Remember user name and password
Relatianship : ’Eustumer

Connect I Cancel

Figure 62. Connexion a InterChange Server

Déconnexion d’InterChange Server

Pour déconnecter Relationship Manager d’'InterChange Server, sélectionnez Server
> Disconnect dans la barre de menus de Relationship Manager.

Utilisation des relations

Une fois que vous avez démarré Relationship Manager et que vous 'avez connecté
a une instance d’'InterChange Server, vous pouvez l'utiliser pour travailler avec des
données de relation, comme décrit dans les sections suivantes.

Ouverture d’une relation

Pour ouvrir une définition de relation dans Relationship Manager lorsque celui-ci
est déja connecté au serveur :

1. Sélectionnez File > Open dans la barre de menus de Relationship Manager.

2. Dans la fenétre “Open Relationship” , sélectionnez le nom de la relation a
ouvrir.

La [figure 63 a la page 229 présente la fenétre “Open Relationship”.
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Open Relationship 1’

Select the name of the relatiohship from the list of type a
partial name in the text box below to find it;

Shatelk
Custamer
Order
OrdiLine

Cancel | | oK I

Figure 63. Ouverture d’une relation

3. Cliquez sur OK.

Lorsque vous ouvrez une relation, Relationship Manager affiche la fenétre
“retrieve relationships”, décrite dans la section Extraction d’instances de

relation»

Extraction d’instances de relation

Sélectionnez File > Retrieve Relationship dans la barre de menus de Relationship
Manager pour extraire des instances de relation ou afficher le total des instances
contenues dans une relation. Cela permet d’afficher la fenétre “retrieve
relationships” illustrée par la figure ci-apres.

La [figure 64 a la page 230| présente la fenétre “retrieve relationships”.
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If there are more than 500 instances, not all of them may be retrieved.

Please use qualifiers to namow the search,

(¢ Retrieve All:

" Retrieve by 1D:
From: To:

" Retrieve by Value:
Participants: Altributes:
I j Aftribute Name Walue

Get Count | Get Relationships Cancel |

Figure 64. Extraction d’instances de relation

La fenétre “retrieve relationships” est également affichée lorsque vous ouvrez une
relation ou que vous vous connectez a InterChange Server et que vous spécifiez
une relation a ouvrir.

Vous pouvez effectuer les opérations suivantes dans la fenétre “retrieve
relationships” :

» Extraction des 500 premiéres instances de la relation, comme décrit dans
[«Extraction de toutes les instances»}

* Récupération d'une plage d’instances de la relation en fonction des ID
d’instances de relation, comme décrit dans la section |[«Extraction par ID de]

* Extraction d’une instance de relation contenant un participant d'une valeur

particuliere que vous indiquez, comme décrit dans la section [«Extraction pa

[données du participant» a la page 231}

e Totalisation du nombre d’instances de la relation, comme décrit dans la section
[«Totalisation des instances de relation» a la page 231}

En fonction du nombre de participants dans la définition des relations et du
nombre d’instances de participants dans chaque instance de relation, ces requétes
d’extraction peuvent prendre un certain temps.

Extraction de toutes les instances
Pour extraire les 500 premieres instances d’une relation, procédez comme suit :

1. Dans la fenétre “retrieve relationships”, cliquez sur Retrieve All.
2. Cliquez sur Get Relationships.

Relationship Manager affiche les 500 premieres instances de la relation.

Extraction par ID de relation
Pour extraire une plage comportant jusqu’a 500 instances, procédez comme suit :

1. Dans la fenétre “retrieve relationships”, cliquez sur Retrieve by ID.
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2. Entrez I'ID de la premiere instance de la plage a extraire dans la zone From.

w

Entrez I'ID de la derniére instance de la plage a extraire dans la zone To.
4. Cliquez sur Get Relationships.

Relationship Manager affiche jusqu’a 500 instances dans une plage d'ID que
vous spécifiez.

Extraction par données du participant

Pour extraire une instance de relation en fonction de la valeur des attributs de clé

ou des attributs non clés des participants sélectionnés, procédez comme suit :

1. Dans la fenétre “retrieve relationships”, cliquez sur Retrieve by Value.

2. Sélectionnez le participant dont vous voulez rechercher la valeur dans le menu
déroulant Participants.

Pour les relations d’identité, le menu déroulant contient les noms des
participants, suivis de la définition d’objet métier auquel le participant est
associé.

Pour les relations de recherche, le menu déroulant contient les noms des
participants suivis du mot “Data”.

3. Entrez le nom des types de valeurs répertoriées dans le [tableau 17} dans la
colonne Value du panneau “Attributes”.

Tableau 17. Valeurs prises en charges pour I'extraction d’instances de relation par données
de participant

Valeur Description
Données de Données du participant sélectionné.
participant

Par exemple, si la relation est une relation d’identité, il vous faut
indiquer I'ID connue de l'instance du participant pour trouver
lI'instance de relation correspondante.

Si la relation est une relation de recherche, il vous faut indiquer la
valeur des données non clés de l'instance du participant.

o

Toute chaine de caracteres. Cette option distingue les majuscules et
les minuscules ; le jeu de caractéres comprend des chiffres.

Par exemple, si la chaine %A était indiquée pour retrouver un
participant qui enregistre les abréviations de noms des Etats-Unis,
cela renverrait les valeurs CA, GA, IA, LA, MA, PA, VA et WA.

Tout caractere seul.

Par exemple, _00 renverrait a 100, 200, a00, b00, etc.

4. Cliquez sur Get Relationships.

Relationship Manager affiche les 500 premieres instances de relation qui
correspondent aux valeurs indiquées.

Totalisation des instances de relation

Pour afficher la totalisation des instances de relation répondant a des criteres
d’extraction, sélectionnez les options correspondant aux critéres, comme décrit
dans les sections |[«Extraction de toutes les instances» a la page 230} [<Extraction par]
D de relation» a la page 230 ou [«Extraction par données du participant»} puis
cliquez sur Get Count au lieu de Get Relationships.
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Création d’instances de relation
Pour créer une instance de relation, procédez comme suit :
1. Créez l'instance de relation en exécutant I'une des taches suivantes :
» Sélectionnez File > New dans la barre de menus.
» Utilisez le raccourci clavier Ctrl+N.
* Cliquez sur New Relationship dans la barre d’outils.
Relationship Manager affiche la nouvelle instance de relation.

L’espace réservé a I'ID de I'instance de relation apparait en surbrillance, dans la
partie supérieure de 'arborescence des relations, sur la ligne de saisie avec
licone de relation. Il contient trois points d’interrogation (???). Une fois que
vous avez enregistré 1'instance de relation ou n’importe lequel de ses
participants, InterChange Server génére automatiquement le nouvel ID de
lIinstance de relation et Relationship Manager remplace les points
d’interrogation par cet ID d’instance.

2. Développez la nouvelle instance de relation en cliquant sur le signe plus (+) en
regard de l'icone d’espace réservé ?77.
L’arborescence des relations affiche les définitions de participants, les instances
de participants, ainsi que les attributs clé et les attributs non clés des
participants sous l'instance de relation, par ordre décroissant.

3. Pour créer une nouvelle instance de participant dans 'instance de relation,
procédez comme suit :

a. Dans l'arborescence des relations, sélectionnez la définition de participant
pour laquelle vous voulez créer une instance.

b. Pour ajouter une instance de participant, effectuez 1'une des opérations
suivantes :

* Cliquez avec le bouton droit de la souris sur une définition de participant
dans la liste, puis sélectionnez Add Participant a partir du menu
contextuel.

¢ Cliquez sur Add Participant dans la barre d’outils standard.

c. Développez l'instance du nouveau participant en cliquant sur le signe plus
(+) en regard de celle-ci.
Sélectionnez l'instance du nouveau participant.

Cliquez une seule fois sur la colonne Value correspondant a I'instance du
participant, puis entrez la valeur souhaitée dans la cellule.

Remarque : Si la zone Value correspondant a l'attribut affiche trois points
d’interrogation (??? ), le participant est géré par InterChange
Server. Vous ne pouvez pas entrer de valeurs pour ces
participants car InterChange Server les génere
automatiquement lorsque vous enregistrez l'instance de
relation. La valeur correspond a celle de 1'ID de l'instance de
relation.

A ce stade, vous pouvez exécuter n'importe quelle tache répertoriée dans le
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Tableau 18. Taches associées aux données de participant

TAache

Enregistrement de I'instance du
participant.

Ajout d’instances de participant.

Suppression d'un participant.

Enregistrement de 'instance de la

relation.

Enregistrement de toutes les
instances de relation.

Action

Pour enregistrer la nouvelle instance du participant, cliquez dessus avec le
bouton droit de la souris et sélectionnez Save Participant a partir du menu
contextuel. Relationship Manager enregistre les données de ce participant dans
la table des relations correspondante. La colonne Modified correspondant aux
instances de participant affiche la date d’enregistrement, en 'occurrence ici, la
date de création.

Remarque : Une fois que les données du participant ont été enregistrées, elles
ne peuvent pas étre modifiées. Pour modifier ses données, il faut supprimer le
participant pour en créer un nouveau.

Répétez 1'étape de la liste précédente.

Remarque : Si vous utilisez une relation d’identité, vous ne pouvez pas créer
plusieurs instances de participant pour une définition de participant.

Au besoin, vous pouvez supprimer une instance de participant enregistrée en
cliquant dessus avec le bouton droit et en sélectionnant Delete Participant a
partir du menu contextuel. Relationship Manager supprime l'instance du
participant de la table des relations. Si vous ne voulez pas supprimer 'instance
du participant de la base de données, utilisez I'option Deactivate Participant
(voir la section [«Désactivation et activation de participants» a la page 233). Un
participant désactivé conserve son ID d’instance et ses valeurs.

Enregistrez 'instance de la relation en procédant de 1'une des maniéres
suivantes :

e Sélectionnez File > Save dans la barre de menus (activée lorsqu’une instance
de relation est sélectionnée).

* Cliquez avec le bouton droit de la souris sur l'instance de relation et
sélectionnez Save Relationship a partir du menu contextuel.

InterChange Server génére I'ID de l'instance de relation et Relationship
Manager remplace 1'espace réservé ??? par ce nouvel ID. Relationship Manager
met a jour la nouvelle date sur toutes les instances de participant enregistrées a
cette date.

Remarque : Au moins une instance de participant et toutes les données
d’attribut de clé doivent étre créées pour que l'instance de relation puisse étre
enregistrée.

Sélectionnez File > Save All dans la barre de menus. InterChange Server génere
les ID d’instance de relation pour les instances de relation qui n’en n’ont pas.
Relationship Manager remplace chaque espace réservé “???” par les nouveaux
ID. Relationship Manager met a jour la date modifiée sur toutes les instances de
participant enregistrées a cette date.

Suppression d’instances de relation

Pour supprimer une instance de relation de tables de relation, sélectionnez
I'instance de relation que vous souhaitez supprimer et procédez de I'une des
maniéres suivantes :

* Sélectionnez File > Delete Relationship dans la barre de menus.

* Cliquez avec le bouton droit de la souris sur l'instance de relation et sélectionnez
Delete a partir du menu contextuel.

L’instance de relation et ses données sont supprimées des tables de relation de la
relation en cours.

Désactivation et activation de participants

Une instance de participant peut étre désactivée, c’est-a-dire rendue inactive. La
désactivation d’une instance de participant supprime celui-ci de I'instance de
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relation et fait en sorte de ne ne plus l'afficher dans la fenétre de Relationship
Manager, bien que l’enregistrement reste dans la table de relation pour permettre
une future réactivation.

Désactivation d’un participant

Pour désactiver une instance de participant, cliquez dessus avec le bouton droit de
la souris et sélectionnez Deactivate Participant a partir du menu contextuel. Le
participant est supprimé de l’affichage de Relationship Manager mais pas des
tables de relation.

Activation d’un participant
Pour activer une instance de participant, procédez comme suit :

1. Sélectionnez View > Deactivated Participants dans la barre de menus.
La fenétre Deactivated Participants s’affiche, comme illustré dans la .

: Deactivated Participants [ CaState ]

RelationParticipart Madifiec
= CaState Data
LG8 0] ldaho 07/30/2003 0... | Deactivate
=B (23]
05" caState Data
}” o] Minnesota 075052003 0., | Deactivate
4| |+

Figure 65. Désactivation des participants

2. Sélectionnez dans la liste I'instance de relation qui contient le participant
désactivé a activer.

3. Développez cette instance de relation jusqu’a ce que 'instance du participant
désactivé s’affiche dans la liste.

4. Cliquez avec le bouton droit de la souris sur l'instance de participant a
réactiver et sélectionnez Activate a partir du menu contextuel.

5. Sélectionnez Edit > Refresh dans la barre de menus.

L’instance de participant s’affiche en tant qu’instance de relation dans la fenétre
de Relationship Manager.

Remarque : Si une instance de participant d"une relation d’identité est
désactivée et qu'un autre participant est ajouté a sa place
(c’est-a-dire qu’il possede le méme ID d’instance), le participant
original est supprimé de la liste Deactivated Participants mais reste
dans la base de données.

Copie de participants

Vous pouvez créer une nouvelle instance de participant en copiant une instance de
participant existante. Pour copier une instance de participant, procédez comme suit

1. Dans l'instance de relation, cliquez avec le bouton droit de la souris sur la
définition du participant et sélectionnez Add Participant a partir du menu
contextuel.

2. Cliquez avec le bouton droit de la souris sur l'instance de participant a copier
et sélectionnez Copy Participant a partir du menu contextuel.
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3. Cliquez avec le bouton droit de la souris sur 'instance de participant
nouvellement créée et sélectionnez Paste Participant a partir du menu
contextuel.

Chargement et déchargement de fichiers d’objets métier

Vous pouvez charger un fichier d’objets métier du méme type dans un participant.

Pour charger un fichier d’objets métier dans un participant, procédez comme suit :

1. Cliquez avec le bouton droit de la souris sur l'instance du participant dans
laquelle vous voulez charger le fichier d’objets métier, puis sélectionnez Load
Participant with Business Object.

La fenétre Participant affiche 1’objet métier associé a I'instance du participant,
comme illustré dans la

| Participant N x|

Parkicipant

Participant Name

Caesar_Customer

Altributes

Cancel |

Figure 66. Chargement de participants avec des objets métier

2. Sélectionnez Participant > Load dans la barre de menus.
3. Accédez au fichier d’objets systéme a charger et ouvrez-le.
4. Cliquez sur OK.

Remarque : Seule la premiere instance d’une relation est chargée si plusieurs
instances existent dans le fichier.

Utilisation des données de relation

Une caractéristique importante de Relationship Manager est sa capacité a accéder
aux données d’exécution des relations contenues dans les tables de relation et a les
manipuler. Cette section décrit comment utiliser Relationship Manager pour
accéder aux données d’exécution et les manipuler.
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Recherche de participants

Vous pouvez rechercher des instances de participant en fonction de différents
critéres. Selon la précision des critéres de recherche, vos recherches peuvent
localiser une seule instance de participant ou un groupe d’instances de participant.
Vous pouvez trouver des instances de plusieurs maniéres :

Recherche d’instances par objets métier
Cette option recherche les instances dont le type de données est un attribut d’objet
métier.

Pour rechercher des instances par objet métier, procédez comme suit :
1. Sélectionnez une instance de participant dans Relationship Manager.
2. Sélectionnez Edit > Find Instances by Business Object dans la barre de menus.

Relationship Manager affiche la fenétre “Participant”, comme illustré dans la
[figure 66 a la page 235}

3. Entrez la valeur du participant a rechercher dans la cellule Value.
4. Cliquez sur OK.

Relationship Manager affiche toutes les instances correspondantes dans une
boite de dialogue.

5. Cliquez deux fois sur l'une des instances dans la boite de dialogue affichée par
Relationship Manager pour accéder a l'instance et la mettre en surbrillance.

Recherche d’instances par données
Cette option recherche des instances avec le type Données.

Pour rechercher des instances par données, procédez comme suit :
1. Sélectionnez une instance de participant dans Relationship Manager.
2. Sélectionnez Edit > Find Instances by Data dans la barre de menus.

Relationship Manager affiche la fenétre “Find Instances by Data”, comme
illustré dans la

Find Instances by data '

The data entered here will be uzed to search against all
relationships of the current relationship definition containing
patticipants associated with the specified data

Enter the data: It;alifomia

Ok I Cancel

Figure 67. Recherche d’instances par données

3. Entrez la valeur du participant a rechercher dans la cellule Enter the data.
4. Cliquez sur OK.

Relationship Manager affiche toutes les instances correspondantes dans une
boite de dialogue.

5. Cliquez deux fois sur l'une des instances dans la boite de dialogue affichée par
Relationship Manager pour accéder a l'instance et la mettre en surbrillance.
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Filtrage

des participants affichés

Vous pouvez filtrer les participants pour n’afficher que ceux créés ou modifiés
entre certaines dates. Pour filtrer les participants affichés, procédez comme suit :

1.
2.

Sélectionnez un participant dans Relationship Manager.
Sélectionnez View > Filter dans la barre de menus.

Relationship Manager affiche la boite de dialogue “Filter”, comme illustré dans
la figure 63.

Show all participant created or modified:

hom: [ Sundsy . Juy 27,2003 = =]
tor  [Wednesday, Juy 30,2003 = =] Cancel |

[~ Include inactive participant as well

Figure 68. Filtrage des résultats des participants

3

. Dans la boite de dialogue “Filter”, entrez la date de création ou de modification

du participant la plus ancienne dans la zone from et la date de création ou de
modification du participant la plus récente dans la zone to.

Pour entrer une valeur de date, procédez comme suit :

* Entrez une lettre dans la zone de texte pour faire défiler les jours de la
semaine. Par exemple, entrez S pour faire défiler les dates correspondant aux
samedis et aux dimanches.

* Cliquez sur les petites fleches vers le haut et vers le bas pour incrémenter ou
décrémenter la date d'un jour.

* Cliquez sur la grande fleche vers le bas pour afficher un calendrier & partir
duquel sélectionner une date.

Cochez la case Include inactive participants as well pour inclure les
participants inactifs dans l'affichage du résultat.

Cliquez sur OK.

Relationship Manager affiche 1'historique des activités des intervalles filtrés
dans la boite de dialogue “Filter Results”. L’affichage en mode filtre inclut les

participants inactifs si I’option Include inactive participants as well est cochée.
La [figure 69 a la page 238 présente la boite de dialogue “Filter Results”.
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: Filter Results [Cistate] 3 =100 x]

Relation/Participant Type YValue Maodified Action
E]....‘ {1]
. [ ClState Data

0] aY 07/3012003 ... | Create

4] | ¥

Figure 69. Visualisation des données des participants filtrés

Retour a I'état initial des participants

Pour rétablir I’état initial des participants suite a des données incohérentes ou
corrompues dans l'application source ou dans I'objet générique :

1. Sélectionnez un participant dans Relationship Manager.
2. Sélectionnez View > Clean Up Participants dans la barre de menus.

Relationship Manager affiche la boite de dialogue “Clean up Participants”,
comme illustré dans la

Clean Up Participants : x|

This clean-up will affect all changes to all participants in the current relationship, These
changes cannot be undone.

Below, enter a time to which wou want to revert the values of the patticipants and dlick
Ok,

Cleanup from: [october  »| [5 =] [2003 :I IF::i ’ IT::”F‘M vI
Cancel

Figure 70. Retour a I'état initial des participants

3. Dans la boite de dialogue “Clean Up Participants”, entrez la date a laquelle
vous voulez retrouver les valeurs de participant dans la zone Clean up from.

Pour entrer une valeur de date, procédez comme suit :

* Entrez une lettre dans la zone de texte pour faire défiler les jours de la
semaine. Par exemple, entrez S pour faire défiler les dates correspondant aux
samedis et aux dimanches.

* Cliquez sur les petites fleches vers le haut et vers le bas pour incrémenter ou
décrémenter la date d'un jour.

* Cliquez sur la grande fleche vers le bas pour afficher un calendrier a partir
duquel sélectionner une date.

4. Cliquez sur OK.
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Toutes les opérations d’ajout, de désactivation et d’activation des participants
effectuées a partir de cette date seront effacées de la base de données. Un
participant qui a été supprimé ou dont les valeurs ont été modifiées ne peut
pas retourner a l’état initial.

Impression de données de relation

Relationship Manager vous permet d’imprimer des informations sur des données
d’exécution d'une relation. Il crée une représentation des données d’exécution sous
forme d’arborescence, telle que les données apparaissent dans la fenétre principale
de l'outil. Vous pouvez gérer I'impression de cette arborescence grace aux fonctions
d’impression suivantes :

¢ Print : envoie les données d’exécution formatées a votre imprimante.

e Print Preview : envoie les données d’exécution formatées vers une fenétre de
Relationship Manager.

* Page Setup : modifie la présentation des données d’exécution pour que celles-ci
tiennent sur une page.

Envoi de données de relation vers une imprimante

La capacité d'impression de Relationship Manager envoie le contenu courant de
I'arborescence des relations de la fenétre principale vers I'imprimante. Pour
imprimer des données d’exécution de relation, procédez comme suit :

1. Développez l'arborescence des relations de Relationship Manager afin d’afficher
les informations a imprimer.

2. Lancez l'impression des données d’exécution de relation de 1'une des manieres
suivantes :

* Sélectionnez File > Print dans la barre de menus.
e Utilisez le raccourci clavier Ctrl+P.
* Cliquez sur Print dans la barre d’outils.

Utilisation de Print Preview avec des données de relation
Pour obtenir un aper¢u avant impression du résultat des données de relation,
procédez comme suit :

1. Développez l'arborescence des relations de Relationship Manager afin d’afficher
les informations a imprimer.

2. Lancez l'aperqu avant impression de l'une des manieres suivantes :
* Sélectionnez File > Print Preview.
* Utilisez le raccourci clavier Ctrl+Alt+P.
* Cliquez sur Print Preview dans la barre d’outils.

Paramétrage de la page

Relationship Manager tente d'imprimer 1’arborescence de sortie telle qu’elle
apparait dans la fenétre principale de l'outil. Si I’arborescence de sortie est
suffisamment étroite pour tenir sur la page, vous n’aurez pas besoin d’intervenir
sur la mise en forme. En revanche, si elle ne tient pas sur la page, vous pouvez
définir des options pour modifier sa présentation afin qu’elle puisse y loger.

La fonction “Print Page Setup” vous permet de définir le format d’impression ; elle
s’exécute de I'une des maniéres suivantes :

 Sélectionnez File > Page Setup dans la barre de menus pour afficher la boite de
dialogue “Print Page Setup”, d’ou1 vous pouvez configurer les informations
comme le paramétrage de I'imprimante, la taille et I’orientation du papier.

 Utilisez le raccourci clavier Maj+Alt+P.
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Toutes les commandes suivantes appellent la boite de dialogue “Print Page Setup”.

A partir de la boite de dialogue “Print Page Setup”, vous pouvez fournir les
informations de mise en forme suivantes :

* Les options de mise en forme des colonnes figurent dans la zone “Column
Settings” de la boite de dialogue “Print Page Setup”. Le [tableau 19| répertorie les
options contenues dans cette zone.

Tableau 19. Options de mise en forme des colonnes

Option de mise en forme des
colonnes Description

Column headers on every page Lorsque cette option est activée, les en-tétes de
colonne (tels que Relation, Type, Valeur)
n’apparaissent pas uniquement sur la premiere page,
mais sur chaque page.

Resize columns to fit all data Lorsque cette option est activée, Relationship
Manager tente d’élargir la taille des colonnes pour
s’adapter a la taille supérieure des chaines. Si
I’arborescence résultante ne tient pas sur la page
imprimée, Relationship Manager tente de supprimer
les espaces superflus dans chaque colonne. Si cette
zone et ses sous-zones sont grisées, leur valeur est
celle que Relationship Manager utilise par défaut
pour mettre en forme l’arborescence. Laissez ces
zones en grisé si vous voulez confirmer la mise en
forme chaque fois que Relationship Manager génere
I’arborescence de sortie. Si vous activez ces zones,
Relationship Manager utilisera les options définies
pour chaque arborescence générée.

Use smaller font if necessary =~ Lorsque cette option est activée, Relationship
Manager tente de réduire la taille de la police si les
données dépassent toujours de la page. Elle réduit la
taille de la police en trois étapes. A chaque étape, elle
réduit la taille de la police de 20 %.

Confirm new font size Lorsque cette option est activée, Relationship
Manager vous demande de choisir la maniere de
poursuivre lorsqu’il a suffisamment réduit la taille de
la police pour que l’arborescence de sortie puisse
tenir sur la page. Il vous offre plusieurs possibilités :

* Imprimer avec cette police

* Restaurer le document et I'imprimer dans la police
originale
* Annuler I'impression

Lors de la réduction de la police, la taille de celle-ci
peut étre réduite de moitié. Si cette option est
désactivée, I'impression démarre lorsque Relationship
Manager trouve une taille de police qui permet a
l'arborescence de sortie de tenir sur une page.

If altered during print/preview, Lorsque cette option est activée, Relationship

adjust column widths Manager enregistre les modifications de taille des
colonnes qu’il a effectuées pour faire tenir
I'arborescence résultante sur une page. Il se servira
des parametres en mémoire pour les futures
impressions de l’arborescence.
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La zone Resize columns to fit data et les sous-zones associées indiquent les
actions que Relationship Manager réalise lorsqu’il met en forme I’arborescence de
sortie. Ces zones peuvent prendre 1'un des trois états suivants :

* Option non sélectionnée (la zone est vide) : indique que Relationship Manager
n’exécute pas la tache associée lorsqu’il met en forme l’arborescence de sortie.

* Option sélectionnée et grisée : indique que Relationship Manager exécute de
maniére conditionnelle la tache associée lorsqu’il met en forme 1’arborescence de
sortie : en d’autres termes, il affiche une boite de dialogue de confirmation avant
d’effectuer I'action associée.

* Option sélectionnée : indique que Relationship Manager exécute sans conditions
la tache associée lorsqu’il formate 1’arborescence de sortie : en d’autres termes,
Relationship Manager n’affiche aucune boite de dialogue de confirmation avant
d’effectuer une action associée.

Comme le montre le ces zones s’affichent a l'origine en grisé. Vous
pouvez définir ces zones a partir des boites de dialogue de confirmation qui
s’affichent au cours de la mise en forme. Par exemple, si les valeurs d’une colonne
ne tiennent pas dans celle-ci, Relationship Manager affichera une boite de dialogue
de confirmation avec les options Yes et No associées a une zone Make this the
default choice. Si vous cochez Make this the default choice, Relationship Manager
définira la zone Resize columns to fit data en fonction de I'option que vous avez
sélectionnée dans la boite de dialogue de confirmation, comme suit :

* Yes : Relationship Manager décoche les cases associées et n’exécute donc pas
l'action associée.

* No : Relationship Manager sélectionne les cases associées et exécute donc sans
conditions 1’action associée.

* Les options de mise en forme des marges apparaissent dans la zone Margin
Settings de la boite de dialogue “Print Page Setup”. Le [tableau 20| affiche les

options contenues dans cette zone.

Tableau 20. Options de mise en forme des marges

Option de mise en forme des marges Description

Use maximum page area Lorsque cette option est activée, Relationship
Manager utilise la surface maximale de la
page (selon les capacités de I'imprimante).

Use these margins (inches) Lorsque cette option est activée, vous pouvez
définir les valeurs des marges gauche, droite,
haut et bas.

* Les options de mise en forme des pages apparaissent dans la zone “Page
Settings” de la boite de dialogue “Print Page Setup”. Le [tableau 21| affiche les
options contenues dans cette zone.

Tableau 21. Options de mise en forme de la page

Option de mise en forme de la
page Description

Print page header on every page Lorsque cette option est activée, Relationship Manager
place le nom de la relation et le temps d’impression en
haut de chaque page, pas seulement sur la premiére.

Print page footer Lorsque cette option est activée, Relationship Manager
insere le numéro des pages au bas de chaque page.

Chapitre 10. Utilisation de Relationship Manager 241



242

Tableau 21. Options de mise en forme de la page (suite)

Option de mise en forme de la

page Description
Synchronize document with Lorsque cette option est activée, Relationship Manager
print preview affiche dans sa fenétre principale les derniéres données

de relation visualisées dans 1’aperqu avant impression.
Par exemple, si vous avez fait défiler les pages dans
I'apercu avant impression jusqu’a la troisieme “page” des
instances, puis que vous avez quitté I'apercu avant
impression, Relationship Manager parcourt les données
de relation pour afficher la méme “page” d’instance dans
sa fenétre principale. Lorsque cette option est désactivée,
Relationship Manager affiche dans sa fenétre principale
les mémes données que celles affichées avant d’exécuter
I'aper¢u avant impression.

* Les options de mise en forme de la grille apparaissent dans la zone “Grid
Settings” de la boite de dialogue “Print Page Setup”. Le [tableau 22| affiche les

options contenues dans cette zone.

Tableau 22. Options de mise en forme de la grille

Option de mise en forme de la
grille Description

Print grid (uncheck to reset) Lorsque cette option est activée, Relationship Manager
insere une grille dans I'arborescence pour séparer les
lignes et les colonnes. Lorsque vous cliquez deux fois sur
cette zone, vous insérez a la fois des lignes verticales et
horizontales dans 1’arborescence de sortie.

Horizontal grid only Lorsque cette option est activée, Relationship Manager
n’insére qu'une grille horizontale (séparant les lignes)
dans l’arborescence de sortie. Si I’arborescence de sortie
ne contient pas de grille horizontale, chaque page
imprimée pourra faire comporter 2 ou 3 lignes de
données supplémentaires.

Vertical grid only Lorsque cette option est activée, Relationship Manager
n’inseére qu’une grille verticale (séparant les colonnes)
dans l’arborescence de sortie.
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Chapitre 11. Utilisation de Test Connector

Test Connector simule les activités d'un connecteur afin que vous puissiez tester
vos composants d’intégration en évitant la complexité d’exécution d'un connecteur
réel. Ce chapitre comporte les sections suivantes :

«Procédure de test recommandée»|

«Démarrage de Test Connector» a la page 244|

«Arrét de Test Connector» a la page 244

«Création et modification des profils de connecteur» 2 la page 244|

«Emulation d’un connecteur» a la page 246,

«Utilisation des objets métier» a la page 246

Procédure de test recommandée

La procédure recommandée pour tester les composants dans le systéeme
d’intégration métier WebSphere est la suivante :

1.

Si le courtier d’intégration est InterChange Server, envisagez d’utiliser la fenétre
System View, qui peut permettre de déterminer si un flux de données que vous
avez envoyé a abouti ou échoué.

Pour plus d’informations, voir System Administration Guide.

onfigurez Test Connector de sorte qu’il émule un connecteur source.
Conf Test C tor d t il 1 t

a. Lancez Test Connector, comme décrit dans [«Démarrage de Test Connector»|

b. Créez un profil pour le connecteur source dans l'interface, comme décrit
dans |«Création d’un profil» a la page 245|

c. Connectez Test Connector a 1’agent pour commencer a émuler le connecteur
source, comme décrit dans [<Emulation d’un connecteur» a la page 246/

Configurez les instances de Test Connector afin d’émuler chaque connecteur
cible présent dans l'interface.

a. Lancez Test Connector, comme décrit dans [«Démarrage de Test Connector»|

b. Créez un profil pour le connecteur cible, comme décrit dans

[profil» a la page 245

c. Connectez Test Connector a I'agent de sorte qu’il commence a émuler le
connecteur cible, comme décrit dans [<Emulation d’un connecteur» a la page|

d. Répétez les étapes a [3d pour tous les connecteurs cible présents dans
l'interface.

Disposez les instances de Test Connector a I'écran de maniére a repérer
rapidement le connecteur émulé dans chaque fenétre Test Connector.
Envoyez un objet métier de requéte depuis le connecteur source. A partir du
connecteur test source, procédez comme suit :

a. Créez un objet métier géré par l'interface que vous devez tester, comme
décrit dans|[«Création d’objets métier de requéte» a la page 246,

b. Enregistrez I'objet métier dans un fichier afin de l'utiliser dans des tests
ultérieurs, comme décrit dans [«Enregistrement d’un objet métier» a la pagel
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c. Envoyez l'objet métier, comme décrit dans |[«<Envoi d’objets métier de|
frequéte» a la page 247}

6. Simulez la réponse envoyée a 1'objet métier de requéte depuis le connecteur
cible. A partir du connecteur test cible, procédez comme suit :

a. Acceptez 'objet métier de requéte, comme décrit dans |«Validation d’unl
[objet métier de requéte» a la page 251}

b. Envoyez l'objet métier en tant que réponse, comme décrit dans
[objet métier de réponse» a la page 252,

7. Répétez les étapesE a la page 243| a El autant de fois que nécessaire pour tester
chaque interface.

Démarrage de Test Connector

Pour démarrer Test Connector, effectuez 1'une des opérations suivantes en fonction

du courtier d’intégration installé :

* Si le courtier d’intégration est InterChange Server, sélectionnez Démarrer >
Programmes > IBM WebSphere InterChange Server > IBM WebSphere
Business Integration Toolset > Development > Test Connector.

* Si votre courtier d’intégration est WebSphere Application Server ou un courtier
de messages WebSphere (WebSphere MQ Integrator, WebSphere MQ
IntegratorBroker ou WebSphere Business Integration Message Broker),
sélectionnez Démarrer > Programmes > IBM WebSphere Business Integration
Adapters > Tools > Test Connector.

La fenétre Test Connector comprend les panneaux suivants :

* le panneau Business Object Editor dans lequel vous pouvez créer des instances
d’objet métier a envoyer ;

* le panneau Business Object Request List, qui affiche les requétes d’objet métier
que le connecteur a regues ;

* le panneau Output, qui affiche les messages relatifs aux opérations de Test
Connector, par exemple, lorsqu'un objet métier a été envoyé.

Arrét de Test Connector

Pour arréter Test Connector et mettre fin a I'émulation d’'un agent de connecteur,
sélectionnez File > Exit dans la barre de menus. Lorsque l'invite d"“arrét” s’affiche,
cliquez sur Yes.

Création et modification des profils de connecteur

Test Connector utilise des profils pour stocker les informations dont il a besoin
pour émuler un connecteur. Vous devez créer un profil pour chaque connecteur
que vous voulez émuler. Vous pouvez modifier et supprimer les profils existants.

Enregistrement de la définition d’'un connecteur dans un
fichier
Pour émuler un connecteur a 1’aide de Test Connector, vous devez enregistrer la

définition du connecteur dans un fichier. Procédez comme suit pour enregistrer la
définition d’un connecteur dans un fichier :

1. Ouvrez la définition du connecteur dans Connector Configurator.

2. Sélectionnez File > Save As > To File dans la barre de menus.
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3.

Accédez au répertoire dans lequel vous voulez enregistrer le fichier, entrez un
nom dans le champ File name, vérifiez que l'extension Configuration (*.cfg)
est affichée dans le menu déroulant Save as type, puis cliquez sur Save.

Connector Configurator enregistre la définition du connecteur dans un fichier
sous le nom indiqué.

Création d’un profil

Vous devez créer un profil pour chaque connecteur que vous voulez émuler dans
Test Connector. Le profil contient des informations telles que le nom du
connecteur, le fichier de configuration a utiliser et le type de courtier d’intégration
avec lequel le connecteur communique. Pour créer un profil de connecteur,
procédez comme suit :

1.

8.

Sélectionnez File > Create/Select Profile dans la barre de menus pour afficher
la fenétre “Connector Profile”.

Dans la fenétre “Connector Profile”, sélectionnez File > New Profile dans la
barre de menus.

Dans la fenétre “New Profile”, cliquez sur Browse, puis accédez au fichier de
configuration du connecteur que vous préparez dans la section [<Enregistrement]
[de 1a définition d’un connecteur dans un fichier» a la page 244

Entrez le nom du connecteur dans le champ Connector Name. Vous devez
indiquer le nom exact de la définition du connecteur tel qu’il apparait dans le
référentiel du courtier d’intégration. Pour 'adaptateur de JText, par exemple,
vous devez entrer JTextConnector, sans inclure d’espace entre les mots JText et
Connector et en respectant la casse des lettres.

Sélectionnez le courtier d’intégration approprié dans le menu déroulant Broker
Type —ICS, WMQI ou WAS.

Remarque : Sélectionnez WMQI si le courtier est un courtier de messages
WebSphere.

Si vous avez sélectionné ICS comme courtier a 1’étape El procédez comme suit :
a. Indiquez le nom de l'instance d’InterChange Server dans le champ Server.

Veillez a indiquer précisément le nom ; ce champ distingue les majuscules
des minuscules et Test Connector ne sera pas en mesure de communiquer
avec InterChange Server si le nom est incorrect.

b. Les champs User ID et Password sont utilisés et validés uniquement si vous
utilisez le type de courtier ICS avec la fonction de sécurité activée. Dans le
cas contraire, ces champs sont facultatifs.

Cliquez sur OK pour fermer la fenétre “New Profile”.

La fenétre “Connector Profile” affiche le nom du connecteur dans la colonne
Connector, le nom de l'instance d'InterChange Server dans la colonne Server
(si le courtier d’intégration est ICS), et le chemin d’acces et le nom du fichier de
configuration du connecteur dans la colonne Configuration File.

Cliquez sur OK pour fermer la fenétre “Connector Profile”.

Modification d’un profil

Suivez les étapes ci-dessous pour modifier un profil de connecteur existant :

1.

Sélectionnez File > Create/Select Profile dans la barre de menus de Test
Connector ou utilisez le raccourci clavier Ctrl+N pour afficher la fenétre
Connector Profile.

Dans la fenétre “Connector Profile”, sélectionnez le profil a modifier, puis la
commande Edit > Edit Profile dans la barre de menus.
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3. Entrez de nouvelles valeurs dans les champs de la fenétre “New Profile” et
utilisez le bouton Browse pour changer de fichier de configuration autant de
fois que nécessaire pour effectuer les modifications.

4. Cliquez sur OK pour fermer la fenétre “New Profile”.

Suppression d’un profil
Pour supprimer un profil, procédez comme suit :

1. Sélectionnez File > Create/Select Profile dans la barre de menus de Test
Connector ou utilisez le raccourci clavier Ctrl+N pour afficher la fenétre
“Connector Profile”.

2. Dans la fenétre “Connector Profile”, sélectionnez le profil a supprimer, puis la
commande Edit > Delete Profile dans la barre de menus.

Emulation d’un connecteur

Une fois que vous avez créé un profil pour un connecteur, vous pouvez utiliser ce
profil pour connecter Test Connector a I'agent. Ceci fait, Test Connector commence
a émuler le connecteur défini dans le profil sélectionné.

Pour connecter Test Connector a I'agent, procédez comme suit :

1. Sélectionnez File > Create/Select Profile dans la barre de menus de Test
Connector.

2. Dans la fenétre “Connector Profile”, sélectionnez le nom du connecteur dont
vous voulez ouvrir le profil.

3. Cliquez sur OK.

4. Sélectionnez File > Connect dans la barre de menus.

Test Connector affiche des messages dans le panneau “Output” lorsqu’il tente
d’émuler le connecteur. Lorsqu’il parvient a se connecter, il affiche un message
dans le panneau Output indiquant qu’il est actif et remplit la liste Business
Object Type dans le panneau Business Object Editor.

Utilisation des objets métier

Pour vérifier que l'interface d'un processus métier a été correctement développée,
vous devez vous assurer que ’échange et le traitement des objets métier peuvent
étre correctement assurés. Cette section explique comment effectuer les opérations
suivantes :

* Créer, modifier, supprimer et enregistrer les données de test des objets métier

e Comparer les valeurs d’attribut des objets métier pour visualiser rapidement les
modifications apportées pendant le traitement

* Echanger des objets métier

Utilisation des objets métier de requéte

Les objets métier de requéte sont envoyés depuis Test Connector lorsque ce dernier
tente d’émuler un connecteur qui est la source des événements déclenchés par une
interface. L’utilisation des objets métier de requéte consiste a créer une instance
d’objet métier, a ajouter des données et a envoyer la requéte.

Création d’objets métier de requéte
Pour créer un objet métier dans Test Connector, procédez comme suit :

1. Dans le panneau Business Object Editor, sélectionnez le nom de I'objet métier
que vous voulez créer dans le menu déroulant Business Object Type.
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2. Cliquez sur Create en regard du champ Business Object Instance.

3. Lorsque la boite de dialogue New Instance s’affiche, entrez un nom pour
I'instance dans le champ Enter Name.

4. Sélectionnez l'instruction de votre choix dans le menu déroulant Verb.

5. Sélectionnez 1’environnement local de votre choix dans le menu déroulant
Business Object Locale.

6. Indiquez des valeurs pour les attributs simples et les objets métier enfant dans
I'objet de niveau supérieur, comme décrit dans |<<Définition des valeurs affectées|
[aux attributs d’objet métier» a la page 249]

7. Cliquez sur OK.

Envoi d’objets métier de requéte

Une fois que vous avez créé ou chargé un objet métier et indiqué des valeurs pour
ses attributs, vous avez différentes possibilités pour envoyer I'objet métier en tant
que requéte au courtier d’intégration.

Envoi d’objets métier de requéte en mode asynchrone: Lorsqu'un connecteur
source envoie un objet métier en mode asynchrone, il ne s’attend pas a recevoir un
objet métier de réponse. Une fois que 1'objet métier de requéte est envoyé, le role
du connecteur source dans la transaction est terminé. L’objet métier de réponse est
généralement traité par le courtier d’intégration. Le mode par défaut utilisé pour
Test Connector est asynchrone.

Pour envoyer un objet métier en mode asynchrone, procédez comme suit :
1. Sélectionnez Request > Mode >Asynchronous dans la barre de menus.

Remarque : Test Connector s’exécute par défaut en mode “Asynchrone”. Par
conséquent, vous devez suivre cette procédure uniquement si vous
envoyiez auparavant des requétes synchrones depuis le connecteur.
Par ailleurs, vous n’avez pas besoin d’activer ce mode chaque fois
que vous envoyez des requétes.

2. Sélectionnez Request > Send dans la barre de menus.

Si le courtier indiqué dans la définition du connecteur est InterChange Server,
I'objet métier de requéte est envoyé au serveur afin d’y étre traité.

Si le courtier indiqué dans la définition du connecteur est 'un des courtiers de
messages pris en charge ou WebSphere Application Server, 1'objet métier est placé
dans la file d’attente indiquée dans la propriété standard RequestQueue.

Envoi d’objets métier de requéte en mode synchrone: Lorsqu'un connecteur
source envoie un objet métier de requéte en mode synchrone, il s’attend a recevoir
un objet métier de réponse de la part du courtier d’intégration une fois que les
applications cibles ont traité la requéte. En mode synchrone, Test Connector place
I'objet métier de requéte dans la file d’attente indiquée par la propriété
Synchronous Request Queue du connecteur source. Le mode par défaut utilisé
pour Test Connector est asynchrone.

1. Configurez Test Connector en mode synchrone en sélectionnant la commande
Request > Mode > Synchronous dans la barre de menus.

2. Sélectionnez Request > Send dans la barre de menus.

3. Si le courtier indiqué dans la définition du connecteur est InterChange Server,
la boite de dialogue “Select Collaboration” s’affiche. Sélectionnez la
collaboration a laquelle 1’objet métier doit étre envoyé dans le menu déroulant
Collaboration, puis cliquez sur OK.
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Si le courtier indiqué dans la définition du connecteur est InterChange Server,
I'objet métier de requéte est envoyé au port configuré de 1'objet de collaboration
choisi pour le traitement.

Si le courtier indiqué dans la définition du connecteur est 1'un des courtiers de
messages pris en charge ou WebSphere Application Server, I'objet métier est placé
dans la file d’attente indiquée dans la propriété standard SynchronousRequestQueue.

Envoi d’objets métier de requéte en mode de traitement par lots : En mode de
traitement par lots, Test Connector vous permet d’indiquer le nombre d’instances
d’un objet métier que vous voulez envoyer, ainsi qu'un attribut dans 1’objet de
niveau supérieur (un attribut de clé primaire, par exemple) que vous voulez
affecter a une valeur unique pour chaque instance. Test Connector copie 1’objet
métier autant de fois que vous avez l'indiqué, en incrémentant la valeur de
I'attribut simple indiquée, et envoie chaque objet métier. Cette option vous permet
de créer rapidement un grand nombre d’objets métier.

Si lattribut sélectionné est un champ clé qui participe au référencement croisé
dynamique dans une relation d’identité, vous devez vous assurer que la valeur
initiale et toutes celles qui suivent sont uniques. Dans le cas contraire, la logique
du référencement croisé échouera et avec elle, les objets métier de requéte.

Pour s’assurer que les valeurs sont uniques, vous pouvez utiliser Relationship
Manager ou exécuter des instructions SQL au niveau de la table du participant de
la relation, comme suit.

* Déterminez la valeur courante la plus élevée pour le participant et affectez au
champ Initial Value une valeur encore plus élevée. La premiére instance de
I'objet métier dans le lot et toutes celles qui suivent seront uniques.

* Supprimez les entrées de la table correspondant au participant. De cette maniére,
vous garantissez qu’aucune entrée n’a la méme valeur d’attribut qu'un objet
métier du lot.

Pour envoyer les objets métier en mode de traitement par lots, procédez comme

suit :

1. Sélectionnez le nom de l'objet métier que vous voulez envoyer dans le menu
déroulant Business Object Type.

2. Sélectionnez Request > Send Batch dans la barre de menus.

3. Dans la fenétre “Batch Mode”, sélectionnez l'instruction souhaitée dans le menu
déroulant Verb.

4. Sélectionnez 1’environnement local de votre choix dans le menu déroulant
Business Object Locale.

5. Sélectionnez dans la liste Attribute 1’attribut dans 'objet métier de niveau
supérieur que vous voulez incrémenter avec chaque requéte d’objet métier dans
le lot.

L’attribut sélectionné doit généralement identifier I’objet métier de maniére
unique, comme une clé primaire, par exemple.

6. Dans le champ Initial Value, entrez la valeur de début pour l'attribut a
incrémenter.

7. Dans le champ No. of Business Objects, entrez le nombre d’instances de 1'objet
métier que vous voulez créer puis envoyer.

8. Cliquez sur OK.
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Test Connector crée le nombre d’objets métier que vous avez indiqué. Ils sont
tous identiques, hormis l'attribut indiqué, dont la valeur est incrémentée pour
chaque instance.

Si le courtier indiqué dans la définition du connecteur est InterChange Server,
I'objet métier de requéte est envoyé au serveur afin d’y étre traité.

Si le courtier indiqué dans la définition du connecteur est l'un des courtiers de
messages pris en charge ou WebSphere Application Server, 1’objet métier est
placé dans la file d’attente indiquée dans la propriété standard RequestQueue.

Définition des valeurs affectées aux attributs d’objet métier

Les sections suivantes présentent les différentes méthodes qui permettent de
définir les valeurs des attributs simples et composés dans une instance d’objet
métier :

» |«Définition des valeurs affectées aux attributs simples»|

« |«Ajout d’objets métier enfant»|

« |«Suppression d’objets métier enfant»|

+ |«Configuration de l'instruction d’un objet métier enfant»|

Définition des valeurs affectées aux attributs simples
Pour indiquer une valeur pour un attribut simple, cliquez sur sa cellule dans la
colonne Value, puis entrez une valeur.

Ajout d’objets métier enfant

Pour ajouter une instance d’objet métier enfant, cliquez avec le bouton droit de la
souris sur l'attribut qui représente 1’objet enfant et sélectionnez Add Instance dans
le menu contextuel.

Un signe plus (+) est ajouté en regard de l'attribut qui représente 1'objet métier
enfant pour indiquer qu’il contient au moins une instance d’objet métier enfant. Si
vous développez l'attribut de 'objet enfant, des numéros s’affichent pour chaque
instance. Les instances seules comportent également un signe plus (+). Vous
pouvez ainsi les développer et affecter des valeurs pour leurs attributs.

Pour ajouter d’autres instances d’objet métier enfant, cliquez avec le bouton droit
de la souris sur l'attribut qui représente I'objet enfant et sélectionnez Add Instance
dans le menu contextuel.

Remarque : Si la propriété Card de I'attribut qui référence I'objet métier enfant a la
valeur 1 (qui indique le type de cardinalité simple), vous ne pourrez
ajouter qu'une seule instance de 1’objet enfant.

Suppression d’objets métier enfant
Pour supprimer une instance d’objet métier enfant, cliquez avec le bouton droit de
la souris sur l'instance et sélectionnez Remove Instance dans le menu contextuel.

Pour supprimer toutes les instances d’un objet métier enfant, cliquez avec le
bouton droit de la souris sur l'attribut qui représente 1’objet métier enfant et
sélectionnez Delete All Instances dans le menu contextuel.

Configuration de I'instruction d’un objet métier enfant

Vous pouvez configurer l'instruction d’un objet métier enfant pour tester 1'effet que
sa valeur a sur le processus métier. Cela peut s’avérer utile lorsque vous essayez
de résoudre des incidents liés a la logique de référencement croisé des objets
métier.
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Pour configurer 'instruction d’une instance d’objet métier, cliquez dessus avec le
bouton droit de la souris et sélectionnez Set Verb dans le menu contextuel.
Lorsque l'invite “Select Verb” s’affiche, sélectionnez l'instruction souhaitée, puis
cliquez sur OK.

Utilisation de la barre d’outils Response BO

Vous pouvez modifier les attributs d’un objet métier qu'un connecteur cible a requ
avant de I'envoyer en réponse. La barre d’outils de la boite de dialogue “Response
BO” que vous utilisez pour cette opération comporte plusieurs boutons permettant
de définir les valeurs de 1’objet métier. Pour plus d’informations, voir
lModification des objets métier de réponse» a la page 251

Enregistrement d’un objet métier

Vous pouvez enregistrer un objet métier dans Test Connector de maniére a l'utiliser
ensuite dans des tests, pour le partager avec le support technique (pour aider a
résoudre les incidents), ou 'envoyer en tant que réponse. Vous pouvez enregistrer
n’importe quel objet métier, notamment ceux que vous avez créés et ceux qui
s’affichent en tant que requétes dans la fenétre Test Connector d’un connecteur
cible. Par défaut, les objets métier sont enregistrés dans un fichier portant
I'extension d’un objet métier (.bo).

Il est préférable de créer un répertoire ou une arborescence spécifique pour les
fichiers de données de test contenant des sous-répertoires pour chaque interface ou
chaque connecteur, le cas échéant. Cette organisation facilite le repérage des
fichiers requis et rend les tests plus efficaces. Par ailleurs, il est conseillé d’attribuer
au fichier de données de test d'un objet métier le méme nom que la définition de
'objet métier.

Enregistrement d’un objet métier de requéte
Pour enregistrer une instance d’objet métier que vous avez créée en tant que
requéte, procédez comme suit :

1. Sélectionnez 1'objet métier que vous voulez enregistrer.
2. Dans la barre de menus, sélectionnez Edit > Save Business Object.

3. Accédez au répertoire de votre choix et indiquez un nom pour le fichier dans le
champ File name.

4. Cliquez sur Save.

Enregistrement d’un objet métier de réponse
Pour enregistrer une instance d’objet métier qu’une instance cible de Test
Connector a regue et qui sera envoyée en tant que réponse, procédez comme suit :

1. Sélectionnez l'instance de 'objet métier dans le panneau “BO Request List”.
2. Sélectionnez Request > Edit Response dans la barre de menus.

3. Cliquez sur Save Business Object.
4

Accédez au répertoire de votre choix et indiquez un nom pour le fichier dans le
champ File name.

5. Cliquez sur Save.

Chargement d’un objet métier

Pour charger un objet métier qui a été enregistré dans un fichier, procédez comme
suit :

1. Sélectionnez Edit > Load Business Object dans la barre de menus de Test
Connector.
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2. Accédez au fichier de données de test de 1’objet métier et ouvrez-le.

3. Lorsque la boite de dialogue “New Instance” s’affiche, entrez un nom pour
I'instance dans le champ Enter Name.

4. Cliquez sur OK.

Suppression d’un objet métier

Pour supprimer un objet métier de Test Connector, sélectionnez la commande Edit
> Delete Business Object dans la barre de menus.

Remarque : Cette action supprime uniquement 1’objet métier de Test Connector.
Cela ne supprime pas la prise en charge du connecteur pour la
définition de I'objet métier.

Validation d’un objet métier de requéte

Lorsque vous envoyez un objet métier en tant que requéte, 1’objet métier s’affiche
dans le panneau “BO Request List” des instances de Test Connector qui émulent
les connecteurs cible dans l'interface, a condition que la transaction n’échoue pas.

Une fois que vous avez validé 1’objet métier de requéte, vous pouvez, le cas
échéant, le modifier, comme décrit dans [<Modification des objets métier del

réponse»

Utilisation des objets métier de réponse

Les objets métier de réponse sont envoyés depuis Test Connector lorsque ce
dernier tente d’émuler un connecteur qui est le destinataire des requétes d’objet
métier dans une interface. Utiliser des objets métier de réponse consiste a modifier
les valeurs contenues dans les instances d’objet métier et a renvoyer la réponse au
courtier.

Modification des objets métier de réponse

Lorsque vous recevez une requéte d’objet métier dans une instance cible de Test
Connector, vous souhaitez généralement modifier les valeurs des attributs. Par
exemple, vous voudrez indiquer des valeurs uniques pour les attributs de clé
primaire qui participent aux relations, ou modifier les valeurs des autres attributs
afin de tester la mappe ou la logique de collaboration qui répond différemment
selon les valeurs contenues dans 1’objet métier.

Des réception d’'un objet métier de requéte, Test Connector affiche la fenétre
Response Business Object.

Pour définir les valeurs des attributs d’objet métier, procédez comme suit :
1. Sélectionnez l'instance de 1’objet métier dans le panneau Business Object Editor.
2. Sélectionnez Request > Edit Response dans la barre de menus.

3. Pour modifier les attributs d'un objet métier, procédez comme suit :

* Utilisez 'une des méthodes décrites dans la section |[«Définition des valeurg
[affectées aux attributs d’objet métier» a la page 249| pour modifier les valeurs
des attributs d’objet métier.

* Cliquez sur Reset Business Object to default pour restaurer les valeurs par
défaut des attributs d’objet métier telles qu’elles sont indiquées dans la
définition de I'objet métier.

* Cliquez sur Clear Business Object values pour effacer les valeurs de tous les
attributs de 1’objet métier.
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Envoi d’un objet métier de réponse

* Cliquez sur Load Business Object pour ajouter les données de test aux
attributs de 1’objet métier a partir d’un fichier.

Pouvoir charger des données enregistrées dans un objet métier de requéte est
tres utile dans les cas olt vous devez ajouter des données dans un objet
métier de réponse avant de 1’envoyer en tant que réponse. Au lieu d’entrer
manuellement une valeur pour chaque attribut qui requiert des données de
réponse, vous pouvez entrer les valeurs une fois, enregistrer ’objet métier

(comme décrit dans [«Enregistrement d’un objet métier» a la page 250), puis

charger les données enregistrées lors des tests suivants.

Apres avoir validé un objet métier de requéte, modifiez I'objet métier, si nécessaire,
puis renvoyez-le en tant que réponse.

Le affiche les options de réponse de Test Connector et indique les codes
retour correspondants pour les connecteurs C++ et Java. Pour plus d’informations
sur les codes retour des connecteurs C++ ou Java, voir le document Connector

Development Guide for Java or C++.

Tableau 23. Types de réponse de Test Connector et codes retour des connecteurs

Type de réponse de Test
Connector

Code retour du connecteur C++

Code retour du connecteur Java

Success

BON_SUCCESS

SUCCESS

Fail

BON_FAIL

FAIL

Multiple Hits

BON_MULTIPLE_HITS

MULTIPLE_HITS

Retrieve By Content Fail

BON_FAIL_RETRIEVE_BY_CONTENT

RETRIEVEBYCONTENT_FAILED

Not Found

BON_BO_DOES_NOT_EXIST

BO_DOES_NOT_EXIST

Value Duplicate

BON_VALDUPES

VALDUPES

Pour répondre a un objet métier de requéte, procédez comme suit :

1.

Sélectionnez 1'objet métier dans le panneau “BO Request List”.

2. Dans la barre de menus, sélectionnez Request > Reply.

3. Sélectionnez une option dans le sous-menu Reply.

Comparaison des instances d’objet métier

Test Connector peut comparer deux objets métier du méme type et afficher les
attributs dont les valeurs sont différentes. Vous pouvez utiliser cette fonction pour
afficher les modifications apportées a un objet métier a différents stades de
I'exécution d'une transaction (par exemple, vous pouvez comparer un objet métier
qui a été envoyé au courtier d’intégration avec le méme objet métier apres que le
courtier d’intégration 1’a mis a jour). Pour comparer deux objets métier, procédez
comme suit :

1.

Créez une instance d’objet métier en suivant les instructions de la section

«Création d’objets métier de requéte» a la page 246| ou [«Chargement d’un objef]

métier» a la page 250}

2. Sélectionnez l'instance de 1'objet métier dans le panneau “BO Request List” que
vous voulez comparer a l'instance de 'objet métier de requéte.

3.

Dans la barre de menus, sélectionnez Edit > Compare Business Objects.

Test Connector ouvre la fenétre “Compare Business Objects” qui contient un
tableau dans lequel figurent les attributs qui ont des valeurs différentes dans

les deux objets métier.
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4. Cliquez sur OK pour fermer la fenétre.

Chapitre 11. Utilisation de Test Connector 253



254 IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



Chapitre 12. Utilisation d’Integrated Test Environment

Integrated Test Environment est une perspective de 'atelier qui permet de tester
l'intégralité d’une interface de processus métier. Comme l'explique la section
l<Interfaces» a la page 1} une interface est le coeur d’un objet de collaboration. Par
conséquent, un test réalisé dans Integrated Test Environment vise également 1'objet
de collaboration.

Pour réaliser un test dans Integrated Test Environment, vous devez effectuer un
certain nombre de taches parmi lesquelles I'enregistrement d’InterChange Server en
tant que serveur test, la création d’une unité de test, le déploiement des
composants de l'interface sur le serveur, le démarrage du serveur, I'émulation des
connecteurs dans l'interface et 'échange des objets métier entre les connecteurs.
L’utilisation d’'Integrated Test Environment présente les caractéristiques suivantes :

* Certaines taches n’ont pas besoin d’étre effectuées plusieurs fois. Par exemple,
vous n’avez pas besoin de créer plusieurs fois une unité de test pour une
interface.

* En revanche, d’autres taches doivent étre effectuées plusieurs fois. Par exemple,
vous pouvez tester le comportement d’une interface lorsque vous modifiez la
valeur d'un attribut. Ainsi, vous devrez envoyer plusieurs fois des requétes
d’objet métier a I'interface.

* Vous pouvez effectuer certaines taches de différentes manieres. Par exemple,
vous pouvez déployer des composants sur le serveur avant de préparer l'unité
de test, ou vous pouvez déployer tous les composants pour une unité de test a
l'aide de la vue Task Manager. Vous pouvez aussi déployer des composants
séparément a 1'aide de la vue Test Unit.

La plupart des sections de ce chapitre décrivent les taches que vous devez effectuer
dans le cadre de I'exécution d'un test ou présentent les différents éléments qui
composent l'interface d'Integrated Test Environment.

La section |[«Exécution d’un test a I'aide d’Integrated Test Environment» a la page|
décrit le flux de travaux nécessaire pour tester une interface. Elle contient la
liste des références aux sections de ce chapitre qui expliquent les sous-taches et les
éléments de l'interface, et présente une structure des taches requises pour utiliser
Integrated Test Environment. Les autres sections de ce chapitre traitent plutdt de
I'interface. Dans les cas ot il existe plusieurs manieres d’effectuer une tache, cette
section indique la méthode la plus efficace. Pour exploiter au mieux les
informations de ce chapitre, il est conseillé de suivre le flux de travaux décrit dans
l<Exécution d’un test a 'aide d’Integrated Test Environment» a la page 309} En
revanche, il est préférable d’utiliser les méthodes expliquées dans les autres
sections lorsque la procédure décrite n’est pas appropriée pour la situation ou pour
votre environnement.

Enregistrement d’InterChange Server en tant que serveur test

Pour tester une interface a I'aide d’Integrated Test Environment, vous devez
enregistrer 1'instance d’InterChange Server de sorte qu’elle démarre en mode test.
Ce mode permet a Integrated Test Environment d’effectuer les opérations suivantes

* Rechercher le fichier de traitement par lots qui démarre InterChange Server afin
qu’il puisse étre lancé depuis l'interface d'Integrated Test Environment
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* Rediriger les informations de journalisation et de trace d’InterChange Server
vers une vue d’'Integrated Test Environment plutot que vers la console

Pour enregistrer InterChange Server en mode test, reportez-vous a la section
[«<Enregistrement d’une instance d’InterChange Server» a la page 30| et effectuez les
opérations requises pour enregistrer l'instance du serveur en tant que serveur test
local. Integrated Test Environment s’exécutera avec une instance de serveur
installée sur la méme machine ou sur une machine a distance.

Démarrage d’Integrated Test Environment

Pour démarrer Integrated Test Environment, procédez comme suit :

1. Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server
> IBM WebSphere Business Integration Toolset > Administrative > System
Manager.

2. Sélectionnez Window > Open Perspective > Other dans la barre de menus.

3. Sélectionnez Integrated Test Environment dans la liste des perspectives, puis
cliquez sur OK.

L’atelier démarre et s’affiche. La [ficure 2 a la page 27| illustre la perspective

Integrated Test Environment, tandis que la figure|«1nterface d’Integrated Test]
représente lI'interface et ses éléments.

Interface d’Integrated Test Environment

La perspective Integrated Test Environment contient plusieurs vues et un éditeur
dans la configuration par défaut avec laquelle elle s’ouvre. La [figure 2 a 1a page 27|
illustre la perspective Integrated Test Environment :
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Figure 71. Perspective Integrated Test Environment
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Le [tableau 24| contient les éléments de l'interface de la perspective Integrated Test
Environment, représentés par des numéros dans la [figure 71 a la page 256|:

Tableau 24. Eléments d'interface de la perspective Integrated Test Environment

Numéro de I’élément
d’interface Nom de I’élément d’interface

1 [«Vue Integrated Test Environment Navigator»|

«Vue Outline»

[<Editeur Test Unit»|

|«Vue Task Manager»|

«Vue Properties»

l«Vue BO Inspector» a la page 258

N[ |G| W [N

[«Vue Integrated Test Environment Console» a la page 258]

Vue Integrated Test Environment Navigator

Cette vue contient les projets et les unités de test que vous créez. Pour plus
d’informations sur l'utilisation de ces types de projet et les unités de test, voir
[Utilisation des projets et des unités de test» a la page 261}

Vue Outline

Cette vue répertorie les composants et les éléments qui composent l'interface. Ils
s’affichent dans la section [«Editeur Test Unit»| Lorsque vous sélectionnez des
éléments dans cette vue, leurs propriétés s’affichent dans la [«Vue Properties»} Cette
vue vous permet également de déterminer si les dépendances de l'interface ont été
résolues, et si d’autres conditions requises ont été remplies avant de procéder au
test.

I s’agit d'une vue par défaut de 1'atelier.

Editeur Test Unit

Cet éditeur contient une représentation graphique de l'interface. Il permet
d’effectuer les opérations suivantes :

+ Déployer des composants, comme décrit dans|«Gestion du référentiel dans la
[vue Test Unit» a la page 283

 Gérer I’état des composants, comme décrit dans [«Gestion état des composants
[dans la vue Test Unit» a la page 283

* Afficher les données des objets métier, comme décrit dans [«Utilisation de la vue
[BO Inspector» a la page 302

Vue Task Manager

La vue Task Manager permet d’exécuter des taches inhérentes a une procédure de
test, comme le démarrage d’InterChange Server et des vues Client Simulator. Pour
plus d’informations sur cette vue, voir |[«Utilisation de la vue Task Manager» a lal

Vue Properties

Vous pouvez sélectionner des éléments dans les vues ITE Navigator, Outline et Test
Unit pour afficher les propriétés des éléments contenus dans cette vue. Ces
informations ne vous seront pas tres utiles. Vous pouvez dans ce cas recouvrir
cette vue par une vue Client Simulator ou BO Inspector.
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Pour plus d’informations sur la vue Client Simulator, voir [«Utilisation de la vue]
[Client Simulator» a la page 287}

Pour plus d’informations sur la vue BO Inspector, voir |«Utilisation de la vue BO|
[nspector» a la page 302}

11 s’agit d'une vue par défaut de l'atelier.

Vue BO Inspector

Cette vue permet d’afficher les données relatives aux objets métier. Pour plus
d’informations, voir [«Utilisation de la vue BO Inspector» a la page 302}

Vue Integrated Test Environment Console

La vue Integrated Test Environment Console contient des informations sur les tests.
Par exemple, les entrées y sont enregistrées lorsque vous démarrez l'instance
d’InterChange Server et que vous démarrez les vues Client Simulator. Utilisez les
informations de cette vue pour résoudre les incidents du processus de test.

Si vous démarrez InterChange Server depuis Integrated Test Environment, un
second onglet nommé InterChange Server Console est ajouté a cette vue. La vue
InterChange Server Console contient des informations sur la journalisation et le
tracage d’'InterChange Server. Utilisez les informations de cette vue pour résoudre
les incidents liés a l'interface que vous testez.

Il s’agit d'une vue par défaut de 1'atelier.

Sélection d’une configuration de serveur

Si vous avez enregistré plusieurs instances d’InterChange Server en tant que
serveurs test locaux, vous devez sélectionner la configuration de serveur que vous
voulez utiliser dans Integrated Test Environment. Pour sélectionner une
configuration de serveur, procédez comme suit :

Remarque : Assurez-vous qu’InterChange Server est enregistré dans la perspective
System Manager avant de procéder a ces étapes. Pour plus
d’informations, voir [«Enregistrement d’une instance d’InterChange]
[Server» a la page 30

1. Pour afficher la fenétre InterChange Server Configuration, procédez comme suit

¢ Sélectionnez Integrated Test Environment > Test Server Configuration dans
la barre de menus d’Integrated Test Environment.

* Développez le noeud “InterChange Server” dans la vue Outline, puis cliquez
avec le bouton droit sur le noeud “Registration” et sélectionnez la commande
Show test server configuration dans le menu contextuel.

2. Dans la fenétre InterChange Server Configuration, sélectionnez le serveur test
que vous voulez utiliser dans le panneau de gauche.

Lorsque vous sélectionnez un serveur, les informations de configuration
correspondantes s’affichent dans le panneau situé sur le c6té droit de la fenétre.
Le champ en lecture seule situé en haut de la fenétre indique si le serveur est
actif, et si Integrated Test Environment y est connecté.

La [figure 72 a la page 259 représente la fenétre InterChange Server
Configuration.

258 IBM WebSphere InterChange Server : Guide d’implémentation de WebSphere InterChange Server



_:Ef‘iidlnl:erl:hange Server configuration g x|

Current best server: QTZIDIICS Funning: Yes Connecked: Yes

Select a besk server From the reqistered tesk servers,

OTZIDLICS

Server name QTZIDIICS
ser name adrnin
Passwiord itk

Installation path
Confiqurakion File
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Figure 72. Fenétre de configuration du serveur test

3. Cliquez sur OK.

Configuration d’InterChange Server pour démarrer en mode

conception

Si vous envisagez de déployer les composants que vous allez tester par le biais
d’Integrated Test Environment, vous devez modifier le fichier de traitement par
lots start_server.bat de sorte que l'instance d’InterChange Server démarre en
mode conception. En effet, Integrated Test Environment peut déployer les
composants dans un ordre tel que les dépendances ne sont pas immédiatement
résolues. Dans ce cas, pour que le déploiement aboutisse, le serveur doit s’exécuter
en mode conception.

Comme décrit dans [<Modes d’InterChange Server» a la page 34 vous démarrez
généralement InterChange Server en mode conception en exécutant la commande
-design sur la ligne de commande ou dans le champ Target du raccourci. Lorsque
vous utilisez Integrated Test Environment, vous démarrez le serveur dans la
perspective Integrated Test Environment, si bien que le raccourci n’est pas utilisé.
Par conséquent, méme si vous modifiez le raccourci d’'InterChange Server pour
utiliser 'option -design, le serveur ne démarrera pas en mode conception.

Pour démarrer le serveur en mode conception lorsque vous utilisez Integrated Test
Environment, vous pouvez ajouter 'option -design au fichier de traitement par
lots start_server.bat ou configurer Integrated Test Environment pour qu’il utilise
un fichier de traitement par lots temporaire auquel il ajoute lui-méme 1'option.
Suivez les instructions contenues dans une des sections suivantes selon vos
préférences :

Edition manuelle du fichier start_server.bat

Procédez comme suit pour modifier le fichier de traitement par lots
start_server.bat et y ajouter 'option -design :

1. Utilisez un éditeur de texte pour ouvrir le fichier de traitement par lots
start_server.bat dans le répertoire bin du répertoire d'installation du produit.

Chapitre 12. Utilisation d’Integrated Test Environment 259



2. Ajoutez l'option -design a la ligne dans le fichier de traitement par lots ou le
programme Java est exécuté pour démarrer le serveur. Vous devez ajouter
I'option -design apreés 'option
-s%SERVERNAME%. L’exemple suivant représente la sortie du fichier de
traitement par lots :

%CWJAVA% -Djava.ext.dirs=%JRE_EXT_DIRS%;"%MQ_LIB%";"%DB2_LIB%"
-Duser.home="%CROSSWORLDS%" -mx%CW_MEM_HEAP%m -DTEAgent=1200

-DCW_MEMORY_MAX=%CW_MEM_HEAP% %ORB:PROPERTY% -classpath %JCLASSES%
ServerWrapper -s%SERVERNAME% -design %2 %3

3. Enregistrez et fermez le fichier.

Activation d’Integrated Test Environment pour créer un fichier
de traitement par lots personnalisé

Vous pouvez configurer Integrated Test Environment pour démarrer
automatiquement InterChange Server en mode conception. Dans cette méthode,
Integrated Test Environment lit le fichier start_server.bat et détermine si 'option
-design a été correctement indiquée. Il crée un fichier start_server_ite_tmp.bat
en tant que copie du fichier start_server.bat et ajoute 'option -design si elle n’a
pas été correctement indiquée. Si vous démarrez le serveur a partir d’Integrated
Test Environment, il utilise ce fichier temporaire.

Procédez comme suit pour configurer les préférences d’'Integrated Test
Environment de maniére a créer un fichier de traitement par lots temporaire :

1. Sélectionnez la commande Window > Preferences dans la barre de menus de
I’atelier.

2. Développez Integrated Test Environment.
3. Sélectionnez Test Server.

4. Cochez la case Verify server launch script (start_server.bat) pour qu'Integrated
Test Environment utilise un fichier de traitement par lots personnalisé auquel il
ajoute les informations de configuration nécessaires.

Si vous n‘envisagez pas d’utiliser le fichier de traitement par lots personnalisé
qu’Integrated Test Environment peut créer, laissez 1'option Verify server launch
script (start_server.bat) désactivée.

5. Cliquez sur OK.

Important : Pour que cette procédure aboutisse, vous devez démarrer le serveur
depuis Integrated Test Environment. Si vous démarrez le serveur a
'aide du raccourci du groupe de programmes ou de la ligne de
commande, cette procédure ne fonctionnera pas car les méthodes de
démarrage n’utilisent pas le script de démarrage temporaire.

Démarrage d’un serveur en mode test

260

Un serveur local peut étre lancé a partir du gestionnaire de taches ITE. Pour ce
faire, il suffit d’appeler un processus local pour exécuter le script de démarrage a
partir du répertoire d’installation obtenu depuis le panneau d’enregistrement. Le
script de démarrage du serveur local peut étre modifié automatiquement afin de
veiller a ce que le serveur soit lancé en tant que serveur test avec les indicateurs
-design et -test. Un serveur distant ne peut pas étre démarré de cette fagon. Par
conséquent, I'option de lancement du serveur est désactivée si le serveur enregistré
est un serveur distant. Dans ce cas, le serveur doit étre lancé manuellement a partir
d’une ligne de commande.
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Remarque : Si un serveur (qu’il soit local ou distant) est lancé de maniere externe
a partir d’une ligne de commande, ITE interroge le serveur pour
connaitre son mode d’exécution (test, conception ou les deux a la fois)
et s’ajuste en conséquence pour satisfaire le serveur.

Les serveurs locaux et distants peuvent étre arrétés depuis ITE car l'arrét du
serveur est implémenté sous forme d’appel IDL. Cela implique que le serveur soit
connecté et qu'une session soit ouverte avant toute demande d’arrét.

Utilisation du résultat de la console

Le résultat de la console du serveur est redirigé depuis le processus du serveur
vers la fenétre de la console InterChange Server dans ITE pour les serveurs locaux
si le serveur est lancé depuis ITE. Pour les serveurs distants et les serveurs locaux
lancés a partir d'une ligne de commande en dehors d'ITE, le résultat de la console
ne peut pas étre saisi de cette maniére. Pour y faire face, le résultat de la console
du serveur est transmis via CORBA. ITE émet explicitement une requéte a la
redirection de console avec un descripteur de rappel, ce qui lui permet de terminer
le service par un autre appel IDL. Le serveur informe ITE de chaque message
transmis.

La redirection de console distante peut étre activée ou désactivée si vous constatez
une baisse des performances due a la journalisation de la console. Par défaut, la
redirection de console est activée.

Remarque : Le résultat de la console par transmission est uniquement destiné aux
serveurs démarrés manuellement (et non par l'intermédiaire d'ITE).
Pour les serveurs lancés par ITE (serveurs locaux), la console est
redirigée vers l'afficheur de console.

Utilisation des projets et des unités de test

Toutes les ressources présentes sur une plate-forme Eclipse sont contenues dans
des projets, comme décrit dans|«Projets» a la page 24] Vous devez créer des projets
ICL (Integration Component Library) destinés a contenir des composants
d’intégration, créer des projets utilisateur contenant des raccourcis vers les
composants et créer des projets test dans Integrated Test Environment devant
contenir des définitions de test.

Une unité de test est une ressource créée dans l'atelier qui définit un test.
Integrated Test Environment est congu pour vous permettre de tester l'intégralité
d’une interface. Dans la mesure ou1 une interface représente généralement un objet
de collaboration, comme l’explique |[«Interfaces» a la page 1} une unité de test vise
également un objet de collaboration. Vous pouvez définir toutes les unités de test
que vous voulez exécuter dans un projet de test, ou vous pouvez créer plusieurs
projets de tests et y ajouter les unités de test en les organisant selon vos
préférences.

Configuration des préférences des projets de test

Pour pouvoir créer des projets de test ou des unités de test, vous devez configurer
les préférences associées. Pour configurer les préférences relatives aux projets et
aux unités de test, procédez comme suit :

1. Sélectionnez la commande Window > Preferences dans la barre de menus de
I’atelier.

2. Sélectionnez Integrated Test Environment.
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La représente les préférences d’'Integrated Test Environment.

o ][5
~ Workbench Integrated Test Environment
i Adapter Monitor Preferences
fgent Contraller ~Integrated Test Environment: project
[ Ank [w Create a default Integrated Test Environment project automatically if none exists.
-+ Build Order [ After the new test unit is created, open it in the editor,
Callaboration Debugger
[ Always show Server Context Overlay
—Inteqgrated Test Environment console colars
Morrmal kext | ] |
‘Warming ket ] |
. Test server Error text | |
- Java
[+ LPE Editor
[#- Plug-In Developrent
[+ Profiling and Logging
[#]- Remaoke Systerms
- Zympkom Database
[#]- Syskem Manager
[#- Team
Restare Defaults | Apply |
Import... Export... Ok, I Cancel |

Figure 73. Préférences d’Integrated Test Environment

3. Cochez la case Create a default Integrated Test Environment project
automatically if none exists pour qu’Integrated Test Environment crée un
projet par défaut nommé DefaultITEProject si vous créez une unité de test et
qu’aucun projet n’existe déja.

4. Cochez la case Open the new test unit in the editor upon creation pour ouvrir
automatiquement une définition d'unité de test dans Test Unit Editor apres sa
création.

Pour plus d’informations sur I'ouverture des unités de test si vous choisissez
de ne pas activer cette option, voir [<Ouverture d’une unité de test» a la page]

5. Cochez la case Show Server Context Overlay always pour que le contexte du
serveur soit toujours masqué.

Pour plus d’informations sur 'option Server Context Overlay, voir |«Utilisation|
[de Server Context Overlay» a la page 281}

6. Cliquez sur OK.

Création d’un projet de test

Procédez comme suit pour créer un projet de test destiné a recevoir les unités de
test que vous allez créer :
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1. Sélectionnez la commande File > New > Integrated Test Environment Project
dans la barre de menus.

2. Dans l'écran “New Integrated Test Environment Project”, entrez un nom pour
le projet de test dans le champ Project name.

Les noms de projet peuvent comprendre des caracteres alphanumériques et des
traits de soulignement et doivent étre indiqués en anglais.

3. Pour créer le dossier de la bibliotheque a I'emplacement par défaut (votre
espace de travail) et lui affecter un nom identique au nom indiqué pour la
bibliotheque, activez la case a cocher Use default location.

Si vous voulez spécifier le nom et le répertoire du dossier de la bibliotheque,
procédez comme suit :

a. Désactivez la case a cocher Use default location.

b. Indiquez le chemin d’accés complet et le nom du répertoire que vous
voulez utiliser pour la bibliothéque dans le champ Location, ou cliquez sur
Browse pour sélectionner un répertoire existant.

Remarque : Il n’existe pas d’autre méthode pour créer le dossier d'une
bibliotheque dans le chemin de l'espace de travail que de laisser
System Manager le faire au moyen de la case a cocher Use default
location.

La représente l'assistant “New Integrated Test Environment Project”.

New Integrated Test Environment Project

New Integrated Test Environment Project
Select the name of the new Integrated Test Environment project %

Project name: | WICS422DEV

Project contents:
[V Use default

Directory: I'SZ:'l,lEiM'I,Wet-Sphe;'elCS'I,Tcu:is'l,w5WE:2El3‘5W,-\fx3r'lfspace\,'-p'\-’lf:i

Browse. .,

| Finish I Cancel

Figure 74. Création d’un projet WBI ITE

4. Cliquez sur Finish.

Le projet est créé et un dossier associé est ajouté dans la vue “Integrated Test
Environment Navigator”.
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Création d’unités de test

Une unité de test est une ressource d’atelier qui contient les informations de
configuration d’un test que vous voulez réaliser. Vous pouvez créer une unité de
test dans Integrated Test Environment ou dans System Manager.

Si vous avez coché la case Open the new test unit in the editor upon creation
dans les préférences d'Integrated Test Environment, 1'unité de test s’ouvre apres sa
création. Si vous n’avez pas activé cette préférence, vous devez ouvrir 'unité de
test en suivant les instructions indiquées dans la section [«Ouverture d’une unité de|
|test» a la page 265| Pour plus d’informations sur les préférences d'Integrated Test
ﬁ/ironmer\t, voir [«Configuration des préférences des projets de test» a la pagd
261

Création d’une unité de test dans Integrated Test Environment

Pour créer une unité de test dans Integrated Test Environment, procédez comme

suit :

1. Sélectionnez la commande File > New > Integrated Test Environment Test
Unit dans la barre de menus.

2. Dans l'écran “Select Collaboration”, sélectionnez 'objet de collaboration que
vous voulez tester dans la liste des objets de collaboration présents dans toutes
les bibliotheques de composants d’intégration définies dans le systéme.

La représente 1'écran “Select Collaboration”.

New Integrated Test Environment Collaboration Unit I

Select Collaboration

Select a collaboration object to test from the list %

~Selected Collaboration
Collaboration: | CustomerSync_ClarifyToCae  CSM Project: | WiebSpherelCS420DEVICL

Collabaration | Project [«
CustomersSync_Clarify ToSAP Staging
RequistionSplitter_PordToCaesar DOCUMENT ATIOMNDT DEY 420I1CL
PazsThroughTest_PordToCaesar DOCUMENT ATIONDT DEV420I1CL
Order StatusQuery_WebToCaesar DOCUMENTATIOND DEY 4201CL
PurchasingPro_RequisitionPassThrough_PortTodTesxt DOCUMEMTATICONDT DEY 420I1CL
CustomerSync_Clarify ToS&P DOCUMENTATIONDT DEY 4201CL
RequistionSplitter PortToCaesar ‘WekSpherelCS420DEVICL
PassThroughTest_PordToCaesar WehSpherelCS420DEVICL
OrderStatusQuery_WebToCaesar WehSpherelCS420DEWVICL
PurchasingPro_RequisitionPassThrough_PorTodTexdt  WebSpherelCS420DEVICL
Customersync_ClarifyToCaesar WehSpherelCS420DEVICL o
CustomerSync_ClarifyToSAP WebhSpherelC54200EWVICL
ReguistionSpltter_PordToCaesar DOCUMENTATIONOZ2DEY 420I1CL
PassThroughTest_PortToCaesar DOCUMEMTATIONOZDEY 420I1CL :J

= Back Firnisty Cancel

Figure 75. Sélection d’une collaboration a tester

3. Cliquez sur Next.

4. Dans l'écran “Create Integrated Test Environment Test Unit”, procédez comme
suit :

a. Indiquez un nom pour l'unité de test dans la champ Test Unit.
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b. Sélectionnez le projet de test dans lequel 1'unité de test doit étre créée dans
le menu déroulant ITE Project.

La représente 1'écran “Create Integrated Test Environment Test Unit”.

[ iNew Integrated Test Environment collaboration unit e x|

Create an Integrated Test Environment test unit.
Select an Integraked Test Environment test unit name and project name. %

—Selected collaboration to kesk
Collaborakion: I SwstemTestObject Swstem Manager project: I Samples_ICL

—Mew Integrated Test Environment test unik

Test unit: | SwstemTestobject

Integrakted Test Environment Project: [WICS4300EY j

< Back Mexh = | Finish I Zancel

Figure 76. Indication du nom de I'unité de test et du projet

5. Cliquez sur Finish.

Création d’une unité de test dans System Manager
Pour créer une unité de test dans System Manager, procédez comme suit :

1. Créez un projet de test destiné a contenir l'unité de test, comme décrit dans
[«Création d’un projet de test» a la page 262|

2. Cliquez avec le bouton droit de la souris sur l'objet de collaboration que
représente l'interface, puis sélectionnez la commande Debug in Integrated Test
Environment dans le menu contextuel.

3. Dans l'écran “Create Integrated Test Environment Test Unit”, indiquez un nom
pour 'unité de test dans le champ Test Unit, puis sélectionnez le projet de test
devant étre créé dans le menu déroulant ITE Project.

La représente I'écran “Create Integrated Test Environment Test Unit”.
4. Cliquez sur Finish.

Ouverture d’une unité de test

Une fois que vous avez créé une unité de test, vous pouvez l'ouvrir pour afficher
sa présentation et la configurer. Pour ouvrir une unité de test, procédez comme
suit :
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1.

Développez le projet de test qui contient 'unité de test dans la vue “Integrated
Test Environment Navigator”.

our ouvrir une unité de test, effectuez 1'une des opérations suivantes :
P té de test, effect I d t t

* Cliquez avec le bouton droit de la souris sur 1'unité de test que vous voulez
utiliser et sélectionnez la commande Open dans le menu contextuel.

* Cliquez deux fois sur l'unité de test que vous voulez utiliser.
L’unité de test s’ouvre. Elle contient une représentation de 1’objet de
collaboration dans I’éditeur Test Unit et affiche les informations spécifiques a

l'interface dans les vues de la perspective. La ffigure 71 a la page 256/ représente
la perspective Integrated Test Environment apres avoir ouvert une unité de test.

Utilisation de la vue Outline

266

La vue Outline permet d’effectuer plusieurs opérations, décrites dans les sections
suivantes :

[«Utilisation d’unités dépendantes dans la vue Outline» 2 la page 267

[«Gestion du référentiel dans la vue Outline» a la page 269

[«Gestion de 1’état des composants dans la vue Outline» a la page 269

[«Exécution des taches dans la vue Outline» a la page 269|

[«Vérification de la disponibilité du test dans la vue Outline» a la page 270|

«Affichage et fermeture des vues Client Simulator dans la vue Outline» a la|

[page 271|

«Affichage et fermeture des vues BO Inspector dans la vue Outline» a la pagel
271

«Régénération des indicateurs des objets métier dans la vue Outline» a la page]
27

La représente la vue Outline.

=3 outline

B e

=1+ # IrkerChange Server [Ready]

£l @ Artifacts [Ready]

=@ Client Simulators [Ready]

q BO Inspection Markers [Ready]

2k [ ed - x

i # CSM Project: ‘WICS422DEVICL
.l Collaboration Mame: CustomerSyne_ClarifyToCaesar

b <[E]] ITE Project: 1TEDefaultProject
L] ITE Test Unit: CustomerSync_ClarifyToCaesar

- @ Registration [Server Name: WICS422DEY]
i @ Rurning State [Running]
- @ Connection State [Connected]

-4 Dependents

(- % Optional Maps

- Caesar_~Custorner_to_CwCustomer [Running]
#  CwCustomer_to_Caesar_Customer [Running]

-8 User Artifacts

: td, Customer [Running]

_;_, StateLk [Running]

o @ 1CS_420_Pool [Deploved]

- @ DestinationAppRetrieve [Ready]
@ From [Ready]
- @ To[Ready]

Outline ‘Z:Cbent Sinnulatar

Figure 77. Vue Outline affichant les artefacts utilisateur
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Utilisation d’unités dépendantes dans la vue Outline

Comme 'explique la section [<Dépendances et références» a la page 86, les
composants d'IBM WebSphere InterChange Server dépendent des autres
composants pour fonctionner. Pour tester une interface, vous devez vérifier que
toutes ses dépendances sont résolues.

La vue Outline dans Integrated Test Environment contient les dépendances des
composants qui doivent étre résolues afin de tester l'interface. Le systeme est
capable d’identifier plusieurs dépendances parmi les composants et les regroupe
sous le noeud Dependents sous le noeud Artifacts dans la vue Outline.

La [<Dépendances ne pouvant pas étre détectées par le systeme» a la page 87|décrit
les cas dans lesquels certains composants ne peuvent pas étre automatiquement
détectés par le systeme. Si vous utilisez les vues Integrated Test Environment pour
déployer des composants lorsque vous testez une interface, vous devez vous
assurer que méme les dépendances qui ne peuvent pas étre détectées par le
systéeme sont résolues. Pour ce faire, vous pouvez indiquer ces dépendances
indétectables manuellement. Ceci fait, les composants sont regroupés sous le noeud
User Atrtifacts sous Artifacts dans la vue Outline.

Ajout d’unités dépendantes utilisateur
Pour ajouter un composant a une unité de test en tant qu'unité dépendante
utilisateur, effectuez 1'une des opérations suivantes :

1. Dans la vue Outline, développez le noeud Artifacts.

2. Cliquez avec le bouton droit de la souris sur le noeud User Artifacts et
sélectionnez la commande Add User Artifacts dans le menu contextuel.

3. Dans la fenétre User Dependents, sélectionnez les composants a ajouter. Vous
pouvez utiliser les méthodes de sélection multiple, par exemple, en maintenant
la touche Maj enfoncée pour sélectionner des lignes contigués et la touche Ctrl
pour sélectionner des lignes non contigués. La|figure 78 a la page 268|
représente la boite de dialogue “User Dependents” :
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#9 user Dependents : i‘

Select dependent objects to add.

Marne l Type | Project I :_]
@7 vendorPartnerwrapper Template WICS422DEVICL
& sits\Wrapper Template WICS422DEVICL
& ContactWrapper Template WICS422DEVICL
L siebelCannector Connector WICS4Z2DEVICL
L wMLConnector Connector WICS4Z2DEVICL
L JTextConnectar Connector WICS422DEVICL
<4 SAPConnector Connectar WICS422DEVICL
=4 JDECConnector Connector WICS422DEVICL
L Emailconnector Connector WICS422DEVICL
o, Order Dynamic Relationship  WICS422DEVICL
T, Ordrline Dynamic Relationship  WICS422DEVICL
ﬂ C ¢ nanic Relat i

2

L JIC

Figure 78. Ajout d’'unités dépendantes utilisateur

4. Cliquez sur OK.

Remarque : La liste ne contient que les composants qui ne sont pas déja
enregistrés en tant qu'unités dépendantes.

Suppression d’unités dépendantes utilisateur

Développez le noeud Artifacts dans la vue Outline et effectuez 1'une des

opérations suivantes pour supprimer des composants de la liste des artefacts

utilisateur :

* Cliquez avec le bouton droit de la souris sur le noeud User Artifacts et
sélectionnez la commande Remove All User Artifacts pour supprimer tous les
artefacts utilisateur de la liste.

* Développez le noeud User Artifacts, puis sélectionnez les artefacts utilisateur
que vous voulez supprimer, cliquez avec le bouton droit sur 'un des artefacts et
sélectionnez Remove dans le menu contextuel.

Vous pouvez utiliser les méthodes de sélection standard de Windows pour
sélectionner simultanément plusieurs projets utilisateur en vue de les déployer,
comme suit :

— Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.

— Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

Enregistrement des unités dépendantes utilisateur

Vous pouvez enregistrer les unités dépendantes utilisateur que vous ajoutez a une
unité de test afin de ne pas avoir a le faire a chaque fois. Pour enregistrer les
unités dépendantes, effectuez 1'une des opérations suivantes :

1. Développez le noeud Artifacts dans la vue Outline.

2. Cliquez avec le bouton droit de la souris sur le noeud User Artifacts et
sélectionnez la commande Save User Dependents dans le menu contextuel.
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Gestion du référentiel dans la vue Outline

Tous les composants requis pour une interface doivent étre déployés dans le
référentiel du serveur afin de tester l'interface. La vue Outline permet de gérer le
référentiel d'InterChange Server de maniere a s’assurer qu’il contient les
composants requis.

Lorsque vous déployez des composants, vous pouvez soit utiliser I'option Deploy,
qui permet de déployer le composant, soit I'option Deploy with overwrite, qui
permet de déployer le composant méme s’il est déja présent dans le référentiel du
serveur. Si les composants sélectionnés figurent déja dans le référentiel du serveur
et que vous utilisez I'option Deploy, le déploiement échouera.

Effectuez I'une des opérations ci-dessous et sélectionnez la commande Deploy ou
Deploy with overwrite dans le menu contextuel pour déployer les composants
souhaités :

* Cliquez avec le bouton droit sur le noeud “Artifacts” pour déployer tous les
composants.

a7

* Cliquez avec le bouton droit sur les noeuds “Dependents”, “Optional Maps” ou
“User Artifacts” pour déployer tous les composants situés sous ces noeuds.

* Cliquez avec le bouton droit sur un composant.

Pour supprimer un composant du référentiel du serveur a l'aide de la vue Outline,
cliquez avec le bouton droit sur le composant, puis sélectionnez la commande
Remove from server dans le menu contextuel.

Remarque : Vous pouvez utiliser les méthodes de sélection standard de Windows
pour sélectionner simultanément plusieurs composants, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments
contigus.

* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments
non contigus.

Les entrées sont enregistrées dans Integrated Test Environment Console et
InterChange Server Console et indiquent si le déploiement a abouti ou non.

Gestion de I’état des composants dans la vue Outline

Vous pouvez modifier 'état d"un composant dans Integrated Test Environment.
Cette opération permet de résoudre les incidents rencontrés lors d’un test ; vous
pouvez, par exemple, désactiver le composant, le modifier, le redéployer et le
réactiver sans utiliser System Manager, la commande repos_copy, ni System
Monitor.

Pour modifier I'état d'un composant, cliquez dessus avec le bouton droit dans la
vue Outline et sélectionnez 1'opération souhaitée—Start, Pause ou Stop. Tous les
types de composant ne disposent pas d’opérations inhérentes a I'état.

Pour plus d’informations sur I'état des composants, voir le document Systemn
Administration Guide.

Exécution des taches dans la vue Outline
Vous pouvez exécuter certaines taches du processus de test dans la vue Outline.

Pour plus d’informations sur les taches et les groupes de taches, voir tableau 25

page 273(
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Pour exécuter toutes les taches du groupe “Start Server”, cliquez avec le bouton
droit sur les noeuds “InterChange Server” ou “Running State” dans la vue Outline
et sélectionnez la commande Start Server dans le menu contextuel.

Pour exécuter la tache “Shutdown Server”, cliquez avec le bouton droit sur les
noeuds “InterChange Server” ou “Running State” dans la vue Outline et
sélectionnez la commande Stop Server dans le menu contextuel.

Pour exécuter la tiche “Connect To Server”, cliquez avec le bouton droit sur le
noeud “Connection State” dans la vue Outline et sélectionnez la commande
Connect To Server dans le menu contextuel.

Pour exécuter la tache “Disconnect Server”, cliquez avec le bouton droit sur le
noeud “Connection State” dans la vue Outline et sélectionnez la commande
Disconnect Server dans le menu contextuel.

Pour exécuter toutes les tdches du groupe “Start Client Simulators”, cliquez avec le
bouton droit sur le noeud “Client Simulators” dans la vue Outline et sélectionnez
la commande Start client simulators dans le menu contextuel.

Pour exécuter toutes les taches du groupe “Start BO Trace”, cliquez avec le bouton
droit sur le noeud “BO Inspection Markers” dans la vue Outline et sélectionnez la
commande Start BO Trace dans le menu contextuel.

Pour exécuter la tache “Stop BO Trace”, cliquez avec le bouton droit sur le noeud
“BO Inspection Markers” dans la vue Outline et sélectionnez la commande Stop
BO Trace dans le menu contextuel.

Vérification de la disponibilité du test dans la vue Outline

La vue Outline affiche un indicateur visuel de I'état des conditions qui doivent étre
réunies pour effectuer un test. Cet indicateur vous permet de vérifier rapidement si
vous étes prét a effectuer les tests dans Integrated Test Environment sans avoir a
rechercher les indicateurs dans le journal. Chaque condition qui doit étre remplie
apparait sur un fond vert si elle a effectivement été remplie et sur un fond rouge
dans le cas contraire. Chaque condition est également accompagnée d’un message
indiquant son état. Ci-dessous figure une liste des différents noeuds dont les
conditions doivent étre remplies. Ils contiennent une description des conditions
requises et des messages indiquant si les conditions ont été remplies :

* Le noeud “InterChange Server” doit avoir 1'état “Ready” pour tester une
interface. Ce noeud représente I'état du serveur et la connexion d’Integrated Test
Environment’ correspondante. Il regroupe les noeuds suivants :

— Le noeud “Registration” contient l'instance d'InterChange Server pour
laquelle Integrated Test Environment a été configurée.
Pour plus d’informations sur l'indication de l'instance d’InterChange Server a
utiliser, voir [«Sélection d’une configuration de serveur» a la page 258

— Le noeud “Running State” indique si 'instance d’InterChange Server est
active ou non ; elle doit avoir 'état “Ready” pour effectuer un test.

— Le noeud “Connection State” indique si l'instance d’'Integrated Test

Environment est connectée a l'instance d’InterChange Server ; elle doit avoir
I'état “Connected” pour effectuer un test.

* Le noeud “Artifacts” doit avoir 1'état “Ready” pour tester une interface. Pour
que ce noeud ait 'état “Ready”, tous les composants de chacun des noeuds
situés en dessous doivent étre déployés sur le serveur et étre actifs.
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Les composants qui comportent un état, comme les connecteurs et les objets de
collaboration, doivent avoir 1’état “Running”. Les composants qui ne comportent
pas d’état mais qui sont requis pour l'interface, comme les définitions d’objet
métier et les modeles de collaboration, doivent avoir 1'état “Deployed”.

* Le noeud “Client Simulators” doit avoir 1’état “Ready” pour tester une interface.
Pour que ce noeud ait 'état “Ready”, tous les ports répertoriés suivants doivent
étre associés a des vues Client Simulator et étre connectés au serveur.

* Le noeud “BO Inspection Markers” doit avoir 1’état “Ready” pour que le tracage
des objets métier puisse s’exécuter pendant le test d'une interface. Pour que ce
noeud ait I'état “Ready”, la tache “Start BO Trace” doit étre correctement
exécutée.

Affichage et fermeture des vues Client Simulator dans la vue
Outline

Les vues Client Simulator permettent d’émuler des connecteurs et des clients
d’acces pendant le test d'une interface. Les vues Client Simulator fournissent des
interfaces qui permettent de créer des instances d’objet métier contenant des
données de test, de les envoyer en tant que requétes d’objet métier, et d'y répondre
avec des réponses d’objet métier.

Pour charger le profil d'un connecteur dans une vue Client Simulator spécifique,
cliquez avec le bouton droit sur le port de votre choix situé sous le noeud “Client
Simulators”, puis sélectionnez Use Client Simulator x, ol x correspond au numéro
de la vue Client Simulator que vous voulez utiliser pour ce connecteur.

Le [tableau 29 a la page 287] indique les positions par défaut des interfaces selon
lesquelles les différentes vues Client Simulator sont affichées.

Les vues figurant dans Integrated Test Environment peuvent étre masquées par
d’autres vues pendant les différentes étapes d’un test : par exemple, une vue Client
Simulator peut étre masquée par une vue BO Inspector. Pour afficher une vue
Client Simulator dissimulée sous une autre vue, cliquez avec le bouton droit de la
souris sur le port souhaité situé sous le noeud “Client Simulators” et sélectionnez
Show Client Simulator pour mettre en évidence la vue Client Simulator.

Pour fermer une vue Client Simulator, cliquez avec le bouton droit de la souris sur
le port souhaité situé sous le noeud “Client Simulators” et sélectionnez Close
Client Simulator.

Remarque : Non seulement cette option ferme la vue Client Simulator, mais elle
lui indique également d’arréter ’émulation du connecteur.

Pour plus d’informations sur 'utilisation des vues Client Simulator, voir
lUtilisation de la vue Client Simulator» a la page 287

Affichage et fermeture des vues BO Inspector dans la vue
Outline

Si vous utilisez la fonction de tragage des objets métier, Integrated Test
Environment enregistre les données des objets métier a certains stades de
I'exécution de l'interface.

Pour afficher les vues BO Inspector de tous les indicateurs des objets métier de
I'interface, cliquez avec le bouton droit sur le noeud “BO Inspection Markers” dans
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la vue Outline et sélectionnez la commande Show All BO Viewers dans le menu
contextuel. Les icones des indicateurs des objets métier sont représentées dans la
fficure 81 a la page 282}

Pour fermer toutes les vues BO Inspector affichées dans l'interface, cliquez avec le
bouton droit sur le noeud “BO Inspection Markers” dans la vue Outline et
sélectionnez la commande Close All BO Viewers dans le menu contextuel.

Le tableau 31 4 la page 303 indique les positions par défaut des interfaces selon
lesquelles les différentes vues BO Inspector sont affichées.

ﬁu plus d’informations sur le tracage des objets métier, voir [tableau 25 a la page|
273

Pour plus d’informations sur l'utilisation des vues BO Inspector, voir |[«Utilisation
[de la vue BO Inspector» a la page 302}

Régénération des indicateurs des objets métier dans la vue
Outline

Si vous utilisez le tracage des objets métier mais que vous avez désactivé la mise a
jour automatique des informations de trace, vous devez régénérer de maniere
explicite les indicateurs des objets métier afin de les mettre a jour.

Pour mettre a jour les indicateurs des objets métier, cliquez avec le bouton droit
sur le noeud “BO Inspection Markers” dans la vue Outline et sélectionnez Refresh
BO Markers dans le menu contextuel.

Utilisation de la vue Task Manager

La vue Task Manager permet d’automatiser la plupart des taches requises pour
tester une interface.

Différentes taches doivent étre exécutées a certains stades de 'exécution d'un test.
Par exemple, vous devez démarrer InterChange Server et connecter la perspective
Integrated Test Environment lorsque vous vous apprétez a effectuer un test. A un
stade plus avancé du test, vous devrez lancer les vues Client Simulator des
connecteurs et des clients d’acces de l'interface, puis les connecter a l'instance
d’InterChange Server. Pour faciliter I'exécution des taches inhérentes a un stade
particulier d'un test, Task Manager affiche les taches sous forme de groupes. Les
taches qui visent a lancer les vues Client Simulator et a les connecter a I'instance
d’InterChange Server, par exemple, sont réunies dans un groupe de tiches nommé
“Start Client Simulators”. Task Manager vous permet alors d’exécuter une seule
tache ou un groupe de taches entier.

La [figure 79 a la page 273 affiche la vue Task Manager dans laquelle plusieurs
taches et groupes de taches sont sélectionnés.
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Figure 79. Vue Task Manager

Le [tableau 25| détaille les taches et les groupes de taches présents dans la vue Task

Manager.

Tableau 25. Taches et groupes de taches présents dans la vue Task Manager

Nom de la tiche

Description de la tache

Start Server

Il s’agit du groupe contenant toutes les taches liées au
démarrage d’InterChange Server.

Launch Server

Cette tache permet de démarrer l'instance d’InterChange
Server. Cette tache appartient au groupe Start Server.

Connect to Server

Cette tache connecte Integrated Test Environment a
Iinstance d’InterChange Server afin que vous puissiez
gérer et déployer des composants et des données de vue.
Cette tache appartient au groupe Start Server.
Remarque : La fonction ORB (IBM Java Object Request
Broker) doit étre activée pour qu’'Integrated Test
Environment puisse se connecter au serveur.

Reset Server

Il s’agit du groupe associé a la tiche Clear Repository.

Clear Repository

Cette tache permet de supprimer le référentiel de l'instance
d’InterChange Server. Effectuez cette tache si vous
envisagez de déployer un grand nombre de composants
via Integrated Test Environment et que certains d’entre eux
existent déja dans le référentiel. Cette tache appartient au
groupe Reset Server.
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Tableau 25. Taches et groupes de tdches présents dans la vue Task Manager (suite)

Nom de la tiche

Description de la tiche

Deployment

11 s’agit du groupe contenant toutes les taches liées au
déploiement des composants dans le référentiel
d’InterChange Server dans la vue Task Manager.

Tous les composants dépendants d'une interface doivent
étre déployés pour pouvoir la tester.

Pour déployer des composants a I'aide d’Integrated Test
Environment, vous devez vous assurer que l'instance
d’InterChange Server démarre en mode conception. Pour
plus d’informations, voir [«Configuration d’'InterChange|
Berver pour démarrer en mode conception» & la page 259,

Pour plus d’informations sur la vue Dependency, voir
kUtilisation de la vue Outline» a la page 266}

Deploy Default Dependents

Cette tache déploie tous les composants que le systeme
détermine comme obligatoires pour 'exécution de
lI'interface et qui sont affichés sous le noeud Default
Dependents dans la vue Dependency.

Cette tache appartient au groupe Deployment.

Deploy Optional Artifacts

Deploy User Dependents

Cette tache déploie tous les composants que vous ajoutez
au noeud User Artifacts dans la vue Outline.

Cette tache appartient au groupe Deployment.

Start Client Simulators

Il s’agit du groupe contenant toutes les taches liées a
I’émulation des agents de connecteur et des clients d’acces.

Assign Client Simulator
Viewers

Cette tache lance les fenétres de la vue Client Simulator
pour tous les connecteurs et les clients d’acces de
I'interface.

Cette tache appartient au groupe Start Client Simulators.

Make server connection

Cette tache indique aux vues Client Simulator de se
connecter a l'instance d’InterChange Server.

Les agents de connecteurs et les clients d’acces doivent se
connecter a InterChange Server pour échanger des objets
métier.

Par défaut, un connecteur démarre en utilisant sa
définition dans le référentiel. Vous pouvez configurer la
vue Client Simulator pour qu’elle indique a I'agent de se
connecter a un fichier de configuration, comme décrit dans
<Emulation d’un connecteur a I'aide d’une définition de|
référentiel» a la page 288]

Les vues Client Simulator peuvent se connecter
uniquement au serveur de cette maniére si la propriété
DeliveryTransport du connecteur émulé a la valeur IDL.

Cette tache appartient au groupe Start Client Simulators.
Remarque : La fonction IBM ORB doit étre activée pour
qu’Integrated Test Environment puisse se connecter au
serveur.
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Tableau 25. Téches et groupes de taches présents dans la vue Task Manager (suite)

Nom de la tiche

Description de la tache

Start BO Trace

11 s’agit du groupe contenant toutes les taches liées au
tragage des objets métier.

Le tracage des objets métier enregistre les données des
objets métier lorsque ces derniers sont traités par les

composants dans le systéme. Pour plus d’informations,
voir [Utilisation de la vue BO Inspector» a la page 302}

Clear BO Trace Folder

Cette tache efface le contenu du dossier dans lequel les
données de trace des objets métier sont stockés. Vous
pouvez effacer le contenu du dossier de trace des objets
métier pour les raisons suivantes :

* Les fichiers trace des objets métier occupent de I'espace
disque et utilisent des ressources que vous devez
charger pour afficher la perspective Integrated Test
Environment. Vous pouvez effacer le contenu du dossier
pour libérer de 1’espace de stockage et des ressources.

* Il se peut que vous ne vouliez pas afficher les anciennes
données de test dans Integrated Test Environment. Vous
pouvez pour cela effacer les données de test des objets
métier des tests précédents pour n’afficher que les
données des nouveaux tests.

Cette tache appartient au groupe Start BO Trace.

Start BO Trace

Cette tache permet de démarrer le tragage des objets
métier. Vous devez démarrer le tracage des objets métier
pour qu’Integrated Test Environment stocke les données
des objets métier pendant les tests.

Cette tache appartient au groupe Start BO Trace.

Stop BO Trace

Cette tache arréte le tragage des objets métier.

Le tragage des objets métier peut utiliser les ressources de
maniere intensive. Par conséquent, selon vos besoins en
matiere de test, vous pouvez arréter le tragage des objets
métier si cette fonction est inutile.

Disconnect Server

Cette tache déconnecte Integrated Test Environment de
I'instance d’InterChange Server. Elle ne permet pas
d’arréter 'instance d’InterChange Server.

Shutdown Server

Cette tache permet d’arréter 'instance d’InterChange
Server.

Sélection des taches

Il existe différentes manieres de sélectionner les taches et les groupes de taches. Le
ableau 26|explique les différentes méthodes. Pour plus d’efficacité, il est conseillé
de combiner les différentes méthodes.

Tableau 26. Méthodes de sélection des taches et des groupes de taches dans la vue Task

Manager

Pour...

Vous devez...

Cocher une tache dans un groupe | Cochez la case en regard de la tache.

Cocher un groupe de taches

Cochez la case en regard du groupe de taches.
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Tableau 26. Méthodes de sélection des tdches et des groupes de taches dans la vue Task
Manager (suite)

Pour... Vous devez...
Cocher toutes les taches d'une Cliquez sur la fleche vers le bas située dans 'angle
vue droit de la barre de titre de la vue Task Manager et

sélectionnez Check All dans le menu.

Décocher toutes les taches d'une |Cliquez sur la fleche vers le bas située dans 1’angle
vue droit de la barre de titre de la vue Task Manager et
sélectionnez Uncheck All dans le menu.

Cocher les taches préférées Cliquez sur la fleche vers le bas située dans 'angle
droit de la barre de titre de la vue Task Manager et
sélectionnez Preference Selection dans le menu.

Pour plus d’informations, voir [«Configuration ded
[sélections de tAches préférées» a la page 278

Cocher les taches par défaut Cliquez sur la fleche vers le bas située dans 'angle
droit de la barre de titre de la vue Task Manager et
sélectionnez Default Selection dans le menu.

Les taches et les groupes de taches par défaut sont les
suivants :

» Start Server
— Launch Server
— Wait for server initialization
— Connect to Server
¢ Deployment
— Deploy Default Dependents
— Deploy Optional Artifacts
— Deploy User Dependents
+ Start Client Simulators
— Assign Client Simulator Viewers
» Start BO Trace
— Start BO Trace

Exécution de taches dans la vue Task Manager

Il existe différentes maniéres d’exécuter les tiches sélectionnées dans la vue Task
Manager. Les sections suivantes présentent les différentes méthodes :

+ |«Exécution des groupes de tiches sélectionnés»|

* [«Exécution d’un groupe de tiches» a la page 277|

+ |«Exécution d’une seule tiche» a la page 277

Exécution des groupes de taches sélectionnés

Vous pouvez exécuter simultanément toutes les taches contenues dans plusieurs
groupes. Cela permet de faciliter la préparation de l'interface en vue d’un test sans
avoir a suivre les différentes étapes.

La méthode appropriée, par exemple, consiste a exécuter toutes les taches
contenues dans les groupes Start Server, Start Client Simulators et Start BO
Trace.

Pour exécuter toutes les tdches dans une sélection de groupes, procédez comme
suit :
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1. Cochez les cases correspondant aux taches a exécuter.

2. Cochez les cases correspondant aux groupes de taches contenant les taches a
exécuter.

3. Pour exécuter les taches sélectionnées dans les groupes de taches sélectionnés,
procédez comme suit :

* Sélectionnez Integrated Test Environment > Run dans la barre de menus.

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre
de la vue Task Manager et sélectionnez Run dans le menu.

* Cliquez sur le bouton Execute tasks situé sur la barre de titre de la vue Task
Manager.

Veillez a ne pas cocher les cases en regard des taches ou des groupes de taches
dont les résultats sont contradictoires. Par exemple, ne cochez pas les cases des
taches Launch Server et Shutdown Server.

Exécution d’un groupe de taches

Pour exécuter un seul groupe de taches, cliquez dessus avec le bouton droit et
sélectionnez Run. Seules les taches du groupe sur lequel vous avez cliqué avec le
bouton droit s’exécuteront. La case associée au groupe de taches n’a pas besoin
d’étre cochée pour que ses taches soient exécutées. En revanche, les cases a cocher
correspondant aux taches a exécuter a l'intérieur du groupe doivent, elles, étre
cochées.

Vous pouvez étre amené a utiliser souvent cette méthode avec le groupe de taches
Start Client Simulators. Vous exécuterez réguliérement des groupes de taches pour
préparer un test, comme décrit dans [«Exécution des groupes de tiches|
lsélectionnés» a la page 276, Vous pouvez étre amené a fermer les vues Client
Simulator que vous avez ouvertes lors d'une série de tests et devoir les ouvrir et
les connecter a nouveau. Vous n’avez pas besoin d’exécuter toutes les taches qui
ont été effectuées, toutefois, vous pouvez exécuter le groupe de taches Start Client
Simulators.

Exécution d’une seule tache

Pour exécuter une seule tache, cliquez dessus avec le bouton droit et sélectionnez
Run. Seule la tache sur laquelle vous avez cliqué avec le bouton droit s’exécutera.
Vous n’avez pas besoin de cocher la case correspondant a la tache pour 'exécuter.

Vous pouvez utiliser cette méthode pour arréter le serveur. Vous pouvez
redémarrer immédiatement le serveur et ne pas cocher toutes les cases requises. 1l
suffit de cliquer avec le bouton droit sur la tiche Shutdown Server et de 1'exécuter
séparément.

Arrét des taches

Vous pouvez indiquer a Task Manager d’arréter la file d’attente contenant les
taches en cours d’exécution. La vue permettra a la tache en cours d’exécution
d’aboutir, mais n’exécutera pas les taches suivantes. Par exemple, si vous décidez
d’arréter les taches pendant 1'exécution de la tache Launch Server, Task Manager
laissera le serveur démarrer.

Pour arréter les taches en cours d’exécution, effectuez I'une des opérations
suivantes :

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Task Manager et sélectionnez Stop Tasks dans le menu.
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* Cliquez sur le bouton Stop tasks situé sur la barre de titre de la vue Task
Manager.

Suppression des taches

Vous pouvez indiquer a Task Manager de supprimer les taches en cours
d’exécution. Il n"achevera pas 1’'exécution de la tache en cours, ni des taches
suivantes. Par exemple, si vous décidez de supprimer les tiches pendant
I'exécution de la taiche Launch Server, Task Manager ne laissera le serveur
terminer son démarrage.

Pour supprimer les taches en cours d’exécution, cliquez sur la fleche vers le bas
située dans 1’angle droit de la barre de titre de la vue Task Manager et sélectionnez
Kill Tasks dans le menu.

Interruption des taches

Vous pouvez interrompre 1’exécution des taches afin que Task Manager termine
I'exécution de la tache en cours, mais n’exécute pas les autres taches tant que vous
ne reprenez pas son exécution. Cette fonction vous permet de démarrer une série
de taches et d’effectuer une action devant étre terminée avant qu'une tache que
vous aviez oubliée ne suive, sans arréter ni redémarrer les tiches restantes. Par
exemple, si vous voulez démarrer le serveur et déployer les unités dépendantes et,
que sans le savoir, certains composants existent déja dans le référentiel, vous
pouvez interrompre 'exécution des tiches avant que la phase de déploiement ne
commence. Vous pouvez ensuite utilisez la commande repos_copy pour supprimer
le référentiel avant le commencement du déploiement.

Pour interrompre les taches en cours d’exécution, effectuez 1'une des opérations
suivantes :

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Task Manager et sélectionnez Pause Tasks dans le menu.

* Cliquez sur le bouton Pause tasks situé sur la barre de titre de la vue Task
Manager.

Pour reprendre I'exécution des taches, effectuez 1'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans l'angle droit de la barre de titre de
la vue Task Manager et sélectionnez Pause Tasks dans le menu.

* Cliquez sur le bouton Pause tasks situé sur la barre de titre de la vue Task
Manager.

Configuration des sélections de taches préférées

Vous pouvez enregistrer les sélections en tant que préférence afin de pouvoir
réutiliser le modele de sélection.

Pour configurer les sélections de taches préférées, procédez comme suit :

1. Sélectionnez la commande Window > Preferences dans la barre de menus de
I’atelier.

2. Développez le noeud Integrated Test Environment.
3. Sélectionnez Task Manager.

4. Développez les groupes de taches et cochez les cases correspondant aux
différentes taches et groupes de taches que vous voulez sélectionner lorsque
vous appliquez vos préférences.

5. Cliquez sur OK.
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La représente l'interface de sélection des préférences de Task Manager.

Preferences _-_i.g.l_).q
[+ Warkbench Task Manager

- Adapker Monitor Preferences

. Agent Controller  Task Manager default selection
[+ Ant Task name | Description

- Build Order [=| Skart the server, Start up khe best InkerChange Server,
[#1- Caollabaration Debuager Launch server, Skart the test server iF it is nok running.
[+- Debug Connect to the se...  Login to tesk server,
[+-Help [ (= Reset server. Reset test sarver,
[+ Install{Update O clear repository. Clear all repositary tables,
=) Inkegrated Test Environment = Deployment Deploy all dependent objects,

- Main viewer Deploy default de...  Deploy dependent objects identified by the systen
Task Manager Deploy opkional ar... Deploy optional map artifacks
i Tk sepver Deploy user depe,..  Deploy dependent objects requested by users,

[+ Java [=] Start Client Simulators  Start Client Simulakars,
[+~ LPEX Editar Assign Client Simu,.. Assign Client Simulator viewers and ackivake themn,
[+ Plug-In Development [0 Make the connecti... Connect Client Simulators o InterChange Server.
[+ Profiling and Lagging [=| Skart the business ab... Request that the server skart business object trac
[+]- Remoke Jystems [0 clearthe busines...  Reset the business object trace by remowing all bu

+ Symptom Database Start the business,,,  Request that the server start business object trac
(¥ System Manager [0 Stopthe business ob... Askthe server to stop the business object tracing —
[#]- Teeamn [0 Disconnect the server. | Log out From kest server,

Shaik Aewsin bhs carvae | Taeroiaba ha back caear hd
4 T
¥ Deploy artifacks with the overwrite option,
Restore Defaults | Apply |
Import. .. Export... O I Cancel |

Figure 80. Taches préférées d’Integrated Test Environment

Configuration des sélections de taches par défaut

Procédez comme suit pour configurer les taches et les groupes de taches qui seront
cochés par défaut chaque fois que vous ouvrez une unité de test :

1.
2.

Ouvrez l'unité de test dont vous voulez enregistrer les sélections par défaut.

Développez les groupes de taches et cochez les cases correspondant aux
différentes taches et groupes de taches que vous voulez sélectionner par défaut
lorsque vous ouvrez une unité de test.

Pour stocker les sélections, effectuez 1'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans 'angle droit de la barre de titre
de la vue Task Manager et sélectionnez Store Selections dans le menu.

* Cliquez sur le bouton Store current selections situé sur la barre de titre de la

vue Task Manager.

La prochaine fois que vous ouvrirez ['unité de test, les taches que vous avez
choisies seront sélectionnées dans la vue Task Manager.
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Utilisation des vues Integrated Test Environment Console et
InterChange Server Console

Comme 'explique la section [«Interface d'Integrated Test Environment» a la page]
I'onglet Integrated Test Environment Console affiche les informations relatives
a I'exécution d’'Integrated Test Environment et InterChange Server Console affiche
des informations sur I'exécution d'InterChange Server.

Vous pouvez utiliser la vue Integrated Test Environment Console pour déterminer
quand les taches d’'Integrated Test Environment se sont terminées et si elles ont
abouti. Par exemple, des messages s’affichent lorsqu’Integrated Test Environment
se connecte a InterChange Server sans incident, ou lorsqu’Integrated Test
Environment démarre Map Designer pour déboguer une mappe.

Si vous avez démarré InterChange Server depuis Integrated Test Environment, la
vue InterChange Server Console affiche les informations de journalisation et de
tragage du serveur, comme une console MS-DOS. Vous pouvez utiliser ensuite la
vue pour identifier les incidents liés aux interfaces que vous testez. Dans la mesure
ot elle est contenue dans la perspective Integrated Test Environment, elle peut étre
recherchée facilement.

Les sections qui suivent présentent des taches que vous allez réguliérement
effectuer dans les vues Integrated Test Environment Console et InterChange Server
Console.

Recherche de texte

Vous pouvez rechercher des messages dans les vues Integrated Test Environment
Console ou InterChange Server Console. Par exemple, vous voulez avoir la
confirmation qu’InterChange Server a correctement démarré. Vous pouvez
rechercher dans la vue InterChange Server Console 1'expression “is ready”.

Pour rechercher des chaines de texte dans les vues Integrated Test Environment
Console ou InterChange Server Console, procédez comme suit :

1. Cliquez avec le bouton droit de la souris sur la vue Integrated Test
Environment Console or InterChange Server Console et sélectionnez la
commande Find/Replace dans le menu contextuel.

2. Entrez la chaine de texte que vous voulez rechercher dans le champ Find.

3. Cliquez sur Forward pour rechercher le texte situé apres le curseur ou sur
Backward pour rechercher le texte situé avant le curseur.

4. Activez les autres options telles que Case Sensitive.
5. Cliquez sur Find Next.

Copie de texte

Vous pouvez copier le texte contenu dans les vues de console pour le montrer aux
autres développeurs ou a l'assistance technique pour obtenir de 1'aide concernant
lI'identification des incidents.

Pour copier un texte de la vue de la console, sélectionnez le texte, puis cliquez
avec le bouton droit de la souris et sélectionnez Copy dans le menu contextuel.

Agrandissement de la fenétre de la vue

Comme pour tous les éditeurs et les afficheurs de l'atelier, vous pouvez agrandir
les vues Integrated Test Environment Console ou InterChange Server Console en
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cliquant avec le bouton droit sur leur barre de titre. Bien que cela ne soit pas utile
avec tous les afficheurs, cette option peut faciliter 'identification des incidents
grace a une meilleure lisibilité des informations dans la vue InterChange Server
Console.

Effacement de la fenétre de la vue

Vous pouvez effacer les vues Integrated Test Environment Console ou InterChange
Server Console afin de supprimer les informations qu’elles contiennent. Cela peut
étre utile lorsque vous voulez uniquement afficher les informations relatives a la
correction d'un incident dans l'interface. Vous pouvez effacer la vue de la console,
faire une copie de l'erreur et la corriger sans avoir a rechercher une explication
dans des informations qui ne concernent pas le probleme.

Configuration des préférences d’Integrated Test Environment
Console

Pour configurer les préférences de la vue Integrated Test Environment Console,
procédez comme suit :

1. Sélectionnez la commande Window > Preferences dans la barre de menus de
I’atelier.

2. Sélectionnez Integrated Test Environment.

La [figure 73 a la page 262 représente les préférences d’'Integrated Test
Environment.

3. Cliquez sur le bouton situé a droite de la zone “Normal text”.

4. Dans la boite de dialogue “Color”, sélectionnez la couleur que vous voulez
qu’Integrated Test Environment Console utilise pour les messages autres que
des messages d’erreur ou d’avertissement.

5. Cliquez sur OK.

6. Répétez les étapes Elé pour appliquer une couleur aux zones “Warning text”
et “Error text” pour ces types de message.

7. Cliquez sur OK.

Utilisation de la vue Test Unit

Comme 1'explique la section |[«Editeur Test Unit» a la page 257} la vue Test Unit
contient un affichage graphique des unités de disques de l'interface et permet de
manipuler les composants dans l'interface.

Utilisation de Server Context Overlay

Server Context Overlay affiche des informations sur les composants de l'interface
dans la vue Test Unit et active des options de menu contextuel afin de déployer
des composants et de gérer leurs états.

Pour activer ou régénérer Server Context Overlay, comme l'expliquent les sections
suivantes, Integrated Test Environment doit étre connecté au serveur. Pour plus
d’informations, voir la tiche Connect to Server dans [tableau 25 a la page 273

Lorsque l'option Server Context Overlay est activée, des icones sont ajoutées aux
icones représentant chaque composant dans la vue Test Unit pour indiquer son
état. Connaitre I'état d’un composant est important puisque tous les composants
d’une interface doivent étre exécutés pour pouvoir la tester.
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La représente une vue Test Unit dans laquelle 1'option Server Context
Overlay est activée. La plupart des icones des composants sont des fleches vertes,
indiquant qu’ils sont démarrés. Le composant ClarifyConnector possede un cercle
orange indiquant qu’il est a I'état de pause. L’objet de collaboration
CustomerSync_ClarifyToCaesar possede une icone représentant un carré rouge,
qui indique qu’il est a 1’état arrété. Le décrit les différentes icOones d’état
des composants et leurs significations.

Pour plus d’informations sur 1'état des composants, voir le document System
Administration Guide.

Icone de I'agent

Icone de la mappe
de connecteur\\r gi» |  Indicateur d'objet métier =

CwCustomer_to
 dabaiitod Collaboration: CustomerSync:_ClarifyTaCaesar |
Y
PoriConnector
Port: Destinationy Port: Ta
Binct: Internal Conr [——. Binc: Internal Conr
_(:aesarj?in";_ BO: Customer i 7 BO: Customer
Icone J—— tm
du connecteur —ff— ]
r":mlcwumer ; N
\ ——— 1| — Port:From y . Fort ToCustomer? | —
. . Binc: Internal Conr Bind: Internal Conr .
_ Lo BO: Customer BO: CustomerPartr Q\ a
ClarifyConnector L ] PortConnector
ClCwCustomer 1
~— e Ic6ne de I'objet
E— de collaboration

Icéne du port

Figure 81. Vue Test Unit avec I'option Server Context Overlay activée

Tableau 27. Icénes d’état des composants et leurs significations

Icone Signification

Fleche verte Le composant est démarré.

Cercle orange Le composant est en pause.

Carré rouge Le composant est arrété.

Point d’interrogation L’état du composant est inconnu.

Cercle rouge avec une “croix”  |Le composant n’existe pas dans le référentiel.

blanche

Coche bleue Le composant a été déployé.

“Croix” rouge Integrated Test Environment est déconnecté du serveur.

Par conséquent, 1’'option Server Context Overlay ne peut
pas afficher l'état en cours du composant.

Activation et désactivation de I'option Server Context Overlay
Pour activer I'option Server Context Overlay, cliquez avec le bouton droit sur
l'arriére-plan de la vue Test Unit et sélectionnez Server Context Overlay dans le
menu contextuel.

Lorsque l'option Server Context Overlay est activée, les icones d’état des

composants s’affichent dans la vue Test Unit et des options de menu contextuel
sont activées.
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Pour désactiver I'option Server Context Overlay, cliquez avec le bouton droit sur
I'arriere-plan de la vue Test Unit et sélectionnez Server Context Overlay dans le
menu contextuel.

Pour que I'option Server Context Overlay soit toujours affichée, activez 1'option
Show Server Context Overlay always dans les préférences d'Integrated Test
Environment. La [figure 73 4 la page 262 représente les préférences d’Integrated Test
Environment.

Régénération de I'option Server Context Overlay

Les informations d’état dans 1’option Server Context Overlay ne sont pas
dynamiques. Par conséquent, si I'état d"'un composant change aprés avoir activé
I'option Server Context Overlay en raison d’actions externes a Integrated Test
Environment, les informations d’état affichées par Server Context Overlay seront
inexactes. Par exemple, si vous changez 1’état d’'un composant dans la vue
InterChange Server Component Management dans System Manager, 1'option
Server Context Overlay continuera de refléter 1’état du composant avant le
changement. Vous devez régénérer 'option Server Context Overlay afin de la
mettre a jour avec les informations actuelles.

Pour régénérer 1'option Server Context Overlay, cliquez avec le bouton droit sur
l'arriére-plan de la vue Test Unit et sélectionnez Refresh Server Context Overlay
dans le menu contextuel.

Gestion du référentiel dans la vue Test Unit

Tous les composants requis pour une interface doivent étre déployés dans le
référentiel du serveur afin de tester l'interface. La vue Outline permet de gérer le
référentiel d'InterChange Server de maniere a s’assurer qu’il contient les
composants requis.

Pour déployer un composant qui existe déja dans le référentiel du serveur, cliquez
avec le bouton droit sur le composant dans la vue Test Unit et sélectionnez Deploy
with overwrite dans le menu contextuel.

Pour déployer un composant qui n’existe pas dans le référentiel du serveur, cliquez
avec le bouton droit sur le composant dans la vue Test Unit et sélectionnez Deploy
dans le menu contextuel. Si les composants sélectionnés figurent déja dans le
référentiel du serveur et que vous utilisez 1’option Deploy, le déploiement
échouera.

Pour supprimer un composant du référentiel du serveur a l'aide de la vue Test
Unit, cliquez avec le bouton droit sur le composant, puis sélectionnez la
commande Remove from server dans le menu contextuel.

Les entrées sont enregistrées dans Integrated Test Environment Console et
InterChange Server Console et indiquent si le déploiement a abouti ou non.

Gestion état des composants dans la vue Test Unit

Vous pouvez modifier 'état d'un composant dans la vue Test Unit. Cette opération
permet de résoudre les incidents rencontrés lors d’un test ; vous pouvez, par
exemple, désactiver le composant, le modifier, le redéployer et le réactiver sans
utiliser System Manager, la commande repos_copy, ni System Monitor.
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Pour modifier I’état d'un composant, cliquez dessus avec le bouton droit dans
l'option Server Context Overlay et sélectionnez 1'opération souhaitée : Start, Pause
ou Stop. Tous les types de composant ne disposent pas d’opérations inhérentes a
I'état.

Pour plus d’informations sur 1'état des composants, voir le document System
Administration Guide.

Utilisation, affichage et fermeture des vues Client Simulator
dans la vue Test Unit

Les vues Client Simulator permettent d’émuler des connecteurs et des clients
d’acces pendant le test d'une interface. Les vues Client Simulator fournissent des
interfaces qui permettent de créer des instances d’objet métier contenant des
données de test, de les envoyer en tant que requétes d’objet métier, et d'y répondre
avec des réponses d’objet métier.

Pour charger le profil d"un connecteur dans une vue Client Simulator spécifique,
cliquez avec le bouton droit sur 'icone du connecteur dans la vue Test Unit et
sélectionnez Use Client Simulator x, ol x correspond au numéro de la vue Client
Simulator que vous voulez utiliser pour ce connecteur.

Le [tableau 29 a la page 287 indique les positions par défaut des interfaces selon
lesquelles les différentes vues Client Simulator sont affichées.

Les vues figurant dans Integrated Test Environment peuvent étre masquées par
d’autres vues pendant les différentes étapes d’un test : par exemple, une vue Client
Simulator peut étre masquée par une vue BO Inspector. Pour afficher une vue
Client Simulator dissimulée sous une autre vue, cliquez avec le bouton droit de la
souris sur l'icone du connecteur et sélectionnez Show Client Simulator pour
mettre en évidence la vue Client Simulator.

Pour fermer une vue Client Simulator, cliquez avec le bouton droit de la souris sur
l'icone du connecteur et sélectionnez Close Client Simulator.

Remarque : Non seulement cette option ferme la vue Client Simulator, mais elle
lui indique également d’arréter 1'émulation du connecteur.

Pour plus d’informations sur 1'utilisation des vues Client Simulator, voir
[«Utilisation de la vue Client Simulator» a la page 287

Affichage des vues BO Inspector

Si vous utilisez la fonction de tragage des objets métier, Integrated Test
Environment enregistre les données des objets métier a certains stades de
I'exécution de l'interface.

Pour afficher les données d’un objet métier pour un indicateur d’objet métier dans
une vue BO Inspector, cliquez avec le bouton droit sur l'indicateur d’objet métier et
sélectionnez Show in BO Viewerx, ol x correspond au numéro de la vue BO
Inspector que vous voulez utiliser pour cet indicateur. Les icones des indicateurs
des objets métier sont représentées dans la [figure 81 a la page 282}

Le tableau 31 & la page 303 indique les positions par défaut des interfaces selon
lesquelles les différentes vues BO Inspector sont affichées.
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Pour plus d’informations sur le tracage des objets métier, voir [tableau 25 a la page]

Pour plus d’informations sur 'utilisation des vues BO Inspector, voir
[de la vue BO Inspector» a la page 302}

Régénération des indicateurs des objets métier

Si vous utilisez le tracage des objets métier mais que vous avez désactivé la mise a
jour automatique des informations de trace, vous devez régénérer de maniere
explicite les indicateurs des objets métier afin de les mettre a jour.

Pour mettre a jour les indicateurs des objets métier, cliquez avec le bouton droit
sur l'option Server Context Overlay et sélectionnez Refresh BO Markers dans le
menu contextuel.

Débogage des mappes dans la vue Test Unit

Si vous utilisez le tracage des objets métier, vous pouvez lancer Map Designer en
mode débogage pour les mappes qui transforment les objets génériques en objets
propres a une application, en utilisant les données générées pendant I'exécution du
test dans Integrated Test Environment.

Pour déboguer les mappes a l'aide de la vue Test Unit, procédez comme suit :

1. Activez l'option Server Context Overlay, comme décrit dans |«Activation eﬂ
[désactivation de 1’option Server Context Overlay» a la page 282

2. Exécutez la tiche Start BO Trace en suivant les instructions contenues dans une
des sections suivantes :

+ |«Exécution des tiches dans la vue Outline» a la page 269

+ |«Utilisation de la vue Task Manager» a la page 272

3. Lorsque vous avez envoyé un objet métier dans l'interface, cliquez avec le
bouton droit de la souris sur 1'icone correspondant a la mappe que vous voulez
déboguer et sélectionnez Debug Map dans le menu contextuel.

4. Dans la fenétre “Select a BO Instance”, sélectionnez l'instance de 1’objet métier
que vous voulez utiliser, puis cliquez sur OK.

Map Designer démarre en mode débogage et s'ouvre en affichant la mappe
indiquée ainsi que les données de test. Pour plus d’informations sur 1'utilisation
des fonctions de débogage de Map Designer, voir le document Map Development
Guide.

Remarque : Map Designer s’exécute indépendamment d’Integrated Test
Environment. Integrated Test Environment ne continue pas a
communiquer avec Map Designer une fois que 1’avez lancé.

Changement d’échelle de la vue Test Unit
Plusieurs options permettent de changer 1'échelle de la vue Test Unit.

Pour changer I'échelle de la vue Test Unit, cliquez avec le bouton droit sur 'option
Server Context Overlay et sélectionnez 1’échelle de votre choix dans le menu
contextuel. Le [tableau 28 a la page 286| présente les options d’échelle.
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Tableau 28. Descriptions et échelles de la vue Test Unit

Type d’échelle de la vue
Test Unit Description

Fit Window

Cette échelle modifie 'illustration de l'interface pour 'ajuster
a la vue Test Unit horizontalement.

Fill Window

icOnes verticalement.

Cette échelle modifie l'illustration de l'interface pour remplir
la vue Test Unit. Cela a généralement pour effet d’étirer les

View Normal Scale

11 s’agit de 1’échelle par défaut.

View Double Scale

pour cent.

Cette échelle agrandit l'illustration de l'interface de deux cents

Configuration des préférences de la vue Test Unit

Pour configurer les préférences de la vue Test Unit, procédez comme suit :

1. Sélectionnez la commande Window > Preferences dans la barre de menus de

l'atelier.
2. Développez Integrated Test Environment.
3. Sélectionnez Main Viewer.

La [figure 73 a la page 262| représente les préférences d’Integrated Test

Environment.

x|
[+ Workbench Main Yiewer
- Build Qrder :
- Collsboration Debugger (- Editor Companent Colars
[+ Debug Collaboration — Connection Line | — |
[+ External Tools
 Help Connector —1 Text for artifacts | |
- InstalliUpdate ; : i i ; |
3 Ir_ul:egrated Test Environmant Client Simulator {Alias) [ — Text for alias artifacts ]
B ain Yiewer Map — Text For ports - |
- Task Manager
i Test Server Client Simulator [——| Text for BO markers — |
# Java
[ Plug-In Developrent BO Marker  I— Background 1 |
- System M Pref
% oo AnagerTYETEEneEs. | collaboration Port T | selectonrectange  mumm |
Collaboration Container 1 Haowering rectanale —1 |
Collaboration Container Title —1
Restore Defauls | fpply |
Import.., Export... | QK I Cancel I

Figure 82. Préférences de Test Unit
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4. Cliquez sur le bouton situé a droite d’'un nom de composant dans le panneau
“Edit Component Colors”.

5. Dans la boite de dialogue “Color”, sélectionnez la couleur que vous voulez que
la vue Test Unit utilise pour l'arriere plan de ce type de composant.

6. Cliquez sur OK.
7. Répétez les étapes Elé EI pour les autres types de composant.
8. Cliquez sur OK.

Utilisation de la vue Client Simulator

La vue Client Simulator vous permet d’émuler les clients dans les interfaces, les
agents de connecteur et les clients d’acces d'IBM WebSphere InterChange Server.
La vue integre des interfaces permettant de connecter les clients au serveur, de
créer et d’envoyer des requétes d’objet métier et de répondre par le biais de
réponses d’objet métier.

Affichage et fermeture des vues Client Simulator

Les sections suivantes expliquent les différentes manieres d’afficher et de fermer les
vues Cient Simulator.

La colonne “Default interface position” dans la section [tableau 29| dresse la liste des
vues dont les positions par défaut dans 'interface sont masquées par les vues
Client Simulator dans la colonne “Client Simulator view number”.

Tableau 29. Positions de la vue par défaut de Client Simulator

Numéro de vue Client Simulator

Position par défaut de l’interface

Test Connector 1

ITE Navigator

Test Connector 2 Outline
Test Connector 3 Properties
Test Connector 4 Dependency

Test Connector 5

ITE Navigator

Test Connector 6 Outline
Test Connector 7 Properties
Test Connector 8 Dependency

Test Connector 9

ITE Navigator

Affichage des vues Client Simulator

Utilisez I'une des méthodes suivantes pour afficher les vues Client Simulator des
connecteurs et des clients d’acces de l'interface que vous testez :

+ |«Affichage et fermeture des vues Client Simulator dans la vue Outline» a la|
page 271] et le Jtableau 25 a la page 273

* |«Utilisation de la vue Task Manager» a la page 272 et le [tableau 25 a la page 273

« |«Utilisation, affichage et fermeture des vues Client Simulator dans la vue Test|
Unit» a la page 284|et le[tableau 25 a la page 273

¢ Sélectionnez Integrated Test Environment > Show All Client Simulator Views
dans la barre de menus pour afficher neuf vues Client Simulator.

* Sélectionnez Window > Show View > x:Client Simulator dans la barre de
menus pour lancer une vue Client Simulator, ou x correspond au numéro de la
position de la vue Client Simulator que vous voulez utiliser pour ce connecteur.
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Le [tableau 29 & la page 287]indique les positions par défaut des interfaces selon
lesquelles les différentes vues Client Simulator sont affichées.

Fermeture des vues Client Simulator
Utilisez 1'une des méthodes suivantes pour fermer les vues Client Simulator :

« |«Affichage et fermeture des vues Client Simulator dans la vue Outline» 2 la|
page 271 et le ftableau 25 a la page 273

« |«Utilisation, affichage et fermeture des vues Client Simulator dans la vue Test|
Unit» a la page 284

* Sélectionnez Integrated Test Environment > Close All Client Simulator Views
dans la barre de menus pour fermer les vues Client Simulator.

* Cliquez sur le bouton Close sur le c6té droit de la barre de titre d"une vue
Client Simulator ou cliquez avec le bouton droit de la souris sur la barre de titre
de la vue Client Simulator et sélectionnez Close dans le menu contextuel.

Connexion d’une vue Client Simulator au serveur

Vous devez connecter les vues Client Simulator au serveur pour émuler un
connecteur dans le cadre d'un test de l'interface.

Lorsque vous émulez la vue Client Simulator, vous pouvez soit émuler un
connecteur en utilisant la définition contenue dans le référentiel, soit un fichier de
configuration. Vous pouvez également utiliser la vue Client Simulator pour émuler
un client d’acces.

Notez que vous pouvez également utiliser la vue Task Manager pour connecter les
agents au serveur. Pour plus d’informations, voir [tableau 25 a la page 273

Emulation d’un connecteur a I'aide d’une définition de référentiel
Effectuez 1'une des opérations suivantes pour vous connecter au serveur a l'aide de
la définition de référentiel du connecteur :

* Cliquez sur le bouton Connect dans la barre d’outils.

* Cliquez sur la fleche vers le bas située dans 'angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Server > Connect.

Remarque : La propriété DeliveryTransport du connecteur que vous émulez doit
avoir la valeur IDL pour pouvoir se connecter au serveur a 'aide de la
définition de référentiel.

Emulation d’un connecteur a I'aide d’un fichier de configuration

Effectuez l'une des opérations suivantes pour vous connecter au serveur a l'aide

d’un fichier de configuration :

1. Cliquez sur la fleche vers le bas située dans 'angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Server > Connect with *.cfg.

2. Accédez au fichier de configuration et ouvrez-le.

Remarque : Si la propriété DeliveryTransport du connecteur que vous émulez n’a
pas la valeur IDL, sélectionnez Server > Connect dans le menu.
Integrated Test Environment affiche une boite de dialogue permettant
d’indiquer le fichier de configuration a utiliser.

Emulation d’un client d’accés

Pour émuler un client d’acces, cliquez sur la fleche vers le bas située dans 1’angle
droit de la barre de titre de la vue Client Simulator et sélectionnez Server >
Connect.
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Confirmation de la connexion d’un client au serveur

Utilisez les indicateurs suivants pour déterminer si une vue Client Simulator s’est
correctement connectée au serveur :

* Dans la vue Outline, le noeud correspondant au port sur lequel le client
communique devient vert et indique 1'état “Ready”.

* Sile client est un connecteur, le message “[AppConnector: Connector has
recovered]” s’affiche sur le panneau d’état de la vue Client Simulator.

* Si le client est un client d’acces, le message “Ready” s’affiche sur le panneau
d’état de la vue Client Simulator.

* Les menus déroulants BO Type et BO Instance deviennent actifs sur le panneau
d’entrée de la vue Client Simulator.

Pour plus d’informations sur le panneau d’état, voir |[«Utilisation du panneau]
[d’état» a la page 291}

Pour ilus d’informations sur le panneau d’entrée, voir [«Utilisation du panneaul

d’entrée»|

Déconnexion du serveur

Pour déconnecter une vue Client Simulator qui émule un connecteur depuis le
serveur, cliquez sur la fleche vers le bas située dans I'angle droit de la barre de
titre de la vue Client Simulator et sélectionnez Server > Disconnect.

Une vue Client Simulator est déconnectée du serveur lorsque vous la fermez. La
seule maniere de déconnecter une vue Client Simulator qui émule un client d’acces
depuis le serveur est de la fermer. Pour plus d’informations sur la fermeture des
vues Client Simulator, voir [«Fermeture des vues Client Simulator» a la page 288|

Disposition des panneaux de la vue Client Simulator

La vue Client Simulator comporte plusieurs panneaux que vous pouvez utiliser
pour simuler le comportement d"un connecteur ou d"un client d’acces.

Utilisation du panneau d’entrée

Le panneau d’entrée dans la vue Client Simulator permet d’utiliser et d’envoyer
des requétes d’objet métier. Vous pouvez créer des instances d’objet métier, ajouter
des données a leurs attributs et les envoyer en tant que requétes. Utilisez le
panneau d’entrée lorsque vous travaillez avec une vue Client Simulator qui émule
un client source dans une interface.

Lalfigure 83 a la page 290 représente le panneau d’entrée d’une vue Client
Simulator qui émule un connecteur source.
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Figure 83. Panneau d’entrée de la vue Client Simulator

Utilisation du panneau de résultat

Le panneau de résultat dans la vue Client Simulator permet d’utiliser des requétes
d’objet métier reques et d’envoyer des réponses d’objet métier. Utilisez le panneau
de résultat lorsque vous travaillez avec une vue Client Simulator qui émule un
client cible dans une interface.

La [figure 84 a la page 291 représente le panneau de sortie d'une vue Client
Simulator qui émule un connecteur cible.
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Figure 84. Panneau de résultat d’'une vue Client Simulator

Utilisation du panneau d’état

Le panneau d’état contient des messages sur l'exécution de la vue Client Simulator.
Par exemple, le message “[AppConnector: Connector has recovered]” s’affiche sur
le panneau d’état lorsqu'un connecteur s’est connecté au serveur.

Le panneau d’état permet principalement d’avoir confirmation de la connexion de
Client Simulator au serveur et d’identifier les incidents. Par exemple, si vous
envoyez une requéte d’objet métier a partir d'une vue Client Simulator et qu’aucun
enregistrement n’existe pour le type d’objet métier en question, un message
s’affiche sur le panneau d’état. Ce message peut vous aider a déterminer pourquoi
une requéte d’objet métier n’apparait pas dans le panneau de résultat d'une vue
Client Simulator qui émule un client cible dans une interface.

Lalfigure 85 a la page 292| représente le panneau d’état d’'une vue Client Simulator.
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Figure 85. Panneau d’état de la vue Client Simulator

Disposition verticale des panneaux

Vous pouvez disposer une vue Client Simulator de sorte qu’elle affiche
simultanément les panneaux d’entrée, de résultat et d’état en les superposant.
Cette disposition peut permettre a une vue Client Simulator qui émule un client de
gérer les taches de notification d’événement et de traitement de requétes.

Pour disposer les panneaux de la vue Client Simulator a la verticale, effectuez
l'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans 'angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Window > Arrange Vertical dans le
menu.

* Cliquez sur le bouton Show all vertically dans la barre de titre de la vue Client
Simulator.

Lalfigure 86 a la page 293 représente les panneaux de la vue Client Simulator
lorsqu’ils sont disposés verticalement.
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Figure 86. Disposition verticale des panneaux de la vue Client Simulator

Disposition horizontale des panneaux

Vous pouvez disposer une vue Client Simulator de sorte qu’elle affiche
simultanément les panneaux d’entrée, de résultat et d’état de gauche a droite. Cette
disposition peut permettre a une vue Client Simulator qui émule un client de gérer
les taches de notification d’événement et de traitement de requétes.

Pour disposer les panneaux de la vue Client Simulator a I'horizontale, effectuez

l"'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans l’angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Window > Arrange Horizontal dans le

menu.

* Cliquez sur le bouton Show all horizontally dans la barre de titre de la vue

Client Simulator.

La représente les panneaux de la vue Client Simulator lorsqu’ils sont

disposés horizontalement.
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Figure 87. Disposition horizontale des panneaux de la vue Client Simulator

Utilisation des requétes d’objet métier dans la vue Client
Simulator

Les objets métier de requéte sont envoyés depuis une vue Client Simulator lorsque
ce dernier tente d’émuler un connecteur qui est la source des événements
déclenchés par une interface. L'utilisation des objets métier de requéte consiste a
créer une instance d’objet métier, a ajouter des données, et a envoyer la requéte.

Création d’objets métier de requéte
Pour créer une instance d’objet métier, procédez comme suit :

1. Dans le panneau d’entrée, sélectionnez le nom de 1’objet métier que vous
voulez créer dans le menu déroulant BO Type.

2. Effectuez l'une des opérations suivantes :
* Cliquez sur Create en regard du champ BO Instance.

* Cliquez sur la fleche vers le bas située dans 'angle droit de la barre de titre
de la vue Client Simulator et sélectionnez Edit > Create BO.

3. Lorsque la boite de dialogue “New Instance” s’affiche, entrez un nom pour
I'instance dans le champ Enter Name.

4. Sélectionnez l'instruction de votre choix dans le menu déroulant Verb.

o

Sélectionnez I'environnement local dans le menu déroulant BO Locale.

6. Indiquez des valeurs pour les attributs simples et les objets métier enfant dans
1'objet de niveau supérieur, comme décrit dans |[<Définition des valeurs affectées|
[aux attributs d’objet métier» a la page 297}

7. Cliquez sur OK.

Envoi d’objets métier de requéte en mode asynchrone

Lorsqu’un client source envoie un objet métier de requéte en mode asynchrone, il
ne s’attend pas a recevoir un objet métier de réponse. Une fois 1’objet métier de
requéte envoyé, le role du client source dans la transaction est terminé. L’objet
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métier de réponse est généralement traité par le courtier d’intégration. Le mode
par défaut d’une vue Client Simulator est asynchrone.

Pour envoyer un objet métier en mode asynchrone, procédez comme suit :

1. Créez l'instance d’objet métier de requéte, comme décrit dans
[d’objets métier de requéte» a la page 294

2. Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Server > Mode > Asynchronous.

Remarque : La vue Client Simulator utilise par défaut le mode “asynchrone”.
Par conséquent, vous devez effectuer cette procédure uniquement
si vous envoyiez auparavant des requétes synchrones depuis la
vue. Par ailleurs, vous n’avez pas besoin d’activer ce mode chaque
fois que vous envoyez des requétes.

3. Pour envoyer la requéte, effectuez 1'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre
de la vue Client Simulator et sélectionnez Server > Send.

* Cliquez sur le bouton Send BO dans la barre d’outils de la vue Client
Simulator.

Envoi de requétes d’objet métier en mode synchrone

Lorsqu’un client source envoie un objet métier de requéte en en mode synchrone, il

s’attend a recevoir un objet métier de réponse de la part du courtier d’intégration

une fois que les applications cibles ont traité la requéte.

1. Créez l'instance d’objet métier de requéte, comme décrit dans
[d’objets métier de requéte» a la page 294

2. Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Server > Mode > Synchronous pour
activer le mode synchrone pour la vue.

3. Pour envoyer la requéte, effectuez 1'une des opérations suivantes :

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre
de la vue Client Simulator et sélectionnez Server > Send.

¢ Cliquez sur le bouton Send BO dans la barre d’outils de la vue Client
Simulator.

4. Lorsque la boite de dialogue “Select Collaboration” s’affiche, sélectionnez la
collaboration a laquelle 1'objet métier doit étre envoyé dans le menu déroulant
Collaboration, puis cliquez sur OK.

La requéte de 1'objet métier est envoyée au port configuré de 1’objet de
collaboration choisi pour le traitement.

Envoi de requétes d’objet métier en mode de traitement par lots
En mode de traitement par lots, la vue Client Simulator vous permet d’indiquer le
nombre d’instances d’un objet métier que vous voulez envoyer, ainsi qu’un attribut
dans l'objet de niveau supérieur (un attribut de clé primaire, par exemple) que
vous voulez affecter a une valeur unique pour chaque instance. La vue Client
Simulator copie I'objet métier autant de fois que vous avez l'indiqué, en
incrémentant la valeur de l'attribut simple indiquée pour chaque instance, et
envoie ensuite chaque instance. Cette option vous permet de créer rapidement un
grand nombre d’objets métier.

Si Iattribut sélectionné est un champ clé qui participe au référencement croisé
dynamique dans une relation d’identité, vous devez vous assurer que la valeur
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initiale et toutes celles qui suivent sont uniques. Dans le cas contraire, la logique
du référencement croisé échouera et avec elle, les objets métier de requéte.

Pour s’assurer que les valeurs sont uniques, vous pouvez utiliser Relationship
Manager ou exécuter des instructions SQL au niveau de la table du participant de
la relation, comme suit.

* Déterminez la valeur courante la plus élevée pour le participant et affectez au
champ Initial Value une valeur encore plus élevée. La premiere instance de
I'objet métier dans le lot et toutes celles qui suivent seront uniques.

e Supprimez les entrées de la table correspondant au participant. De cette maniére,
vous garantissez qu’aucune entrée n’a la méme valeur d’attribut qu'un objet
métier de lot.

Pour envoyer les objets métier en mode de traitement par lots, procédez comme

suit :

1. Cliquez sur la fleche vers le bas située dans I'angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Server > Send Batch.

2. Dans la fenétre “Batch Mode”, sélectionnez l'instruction souhaitée dans le menu
déroulant Verb.

3. Sélectionnez 1’environnement local dans le menu déroulant BO Locale.

4. Sélectionnez dans la liste Attribute 1’attribut dans 1'objet métier de niveau

supérieur que vous voulez voir incrémenté avec chaque objet métier de requéte
dans le lot.

L’attribut sélectionné doit généralement identifier I’objet métier de manieére
unique, comme une clé primaire, par exemple.

5. Dans le champ Initial Value, entrez la valeur de début pour l'attribut a
incrémenter.

6. Dans le champ No. of BO'’s, entrez le nombre d’instances de 1’objet métier que
vous voulez créer puis envoyer.

7. Cliquez sur OK.
La vue Client Simulator crée le nombre d’objets métier que vous avez indiqués.

IIs sont tous identiques, hormis l’attribut indiqué, dont la valeur est
incrémentée pour chaque instance.

La[figure 88 a la page 297 représente une configuration de mode de traitement par
lots dans laquelle :

* cinquante objets métier doivent étre envoyés ;
* la valeur de l’attribut OrgObjid doit étre incrémentée ;
e la valeur de début de l'attribut est 10 000.
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Batch Mode x|
BO Definition | Clarify_BusCrg
Yerb: ICreate 'I
BO Locale: Ien_LIS "I

Attribuke | OrgObiid =l

Initial Yalue | 100001

Mo, of BO's | 50l

Cancel I

Figure 88. Envoi de requétes d’objet métier en mode de traitement par lots

Définition des valeurs affectées aux attributs d’objet métier

Vous pouvez définir des valeurs pour les attributs d’objet métier lorsque vous
créez une requéte d’objet métier et lorsque vous modifiez une requéte d’objet
métier que vous avez recgue, de sorte qu’elle puisse étre renvoyée en réponse.

Pour définir des valeurs pour les attributs d’un objet métier que vous avez
Iintention d’envoyer en tant que réponse, utilisez le panneau d’entrée de la vue
Client Simulator. Pour plus d’informations, voir [«Utilisation du panneau d’entrée»|

la page 289

Pour définir des valeurs pour les attributs d"un objet métier que vous modifiez en
vue de l'envoyer comme réponse, utilisez la fenétre “Response BO”. Pour plus
d’informations, voir [«Modification des objets métier de réponse» a la page 299

Définition des valeurs affectées aux attributs simples

Pour indiquer une valeur pour un attribut simple, cliquez sur sa cellule dans la
colonne Value du panneau d’entrée ou dans la fenétre “Response BO”, puis entrez
une valeur.

Ajout d’objets métier enfant

Pour ajouter une instance d’un objet métier enfant, cliquez avec le bouton droit de
la souris sur l'attribut qui représente 1'objet enfant dans le panneau d’entrée ou
dans la fenétre “Response BO” et sélectionnez Add Instance dans le menu
contextuel.

Un signe plus (+) est ajouté en regard de l'attribut qui représente 1'objet métier
enfant pour indiquer qu’il contient au moins une instance d’objet métier enfant. Si
vous développez 'attribut de 1’objet enfant, des entrées numérotées s’affichent
pour chaque instance. Les instances seules comportent également un signe plus (+).
Vous pouvez ainsi les développer et affecter des valeurs pour leurs attributs.

Pour ajouter d’autres instance d’objet métier enfant, cliquez avec le bouton droit de
la souris sur l'attribut qui représente I'objet enfant et sélectionnez Add Instance
dans le menu contextuel.

Remarque : Si la propriété Card de l'attribut qui référence I'objet métier enfant a la

valeur 1 (qui indique le type de cardinalité simple), vous ne pourrez
ajouter qu’'une seule instance de 1’objet enfant.
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Suppression d’objets métier enfant

Pour supprimer une instance d'un objet métier enfant, cliquez avec le bouton droit
de la souris sur l'instance et sélectionnez Remove Instance dans le menu
contextuel.

Pour supprimer toutes les instances d'un objet métier enfant, cliquez avec le
bouton droit de la souris sur l'attribut qui représente 1'objet métier enfant et
sélectionnez Delete All Instances dans le menu contextuel.

Configuration de I'instruction d’un objet métier enfant

Vous pouvez configurer l'instruction d’un objet métier enfant afin de tester 1’effet
que sa valeur a sur le processus métier. Cela peut s’avérer utile lorsque vous
essayez de résoudre les incidents liés a la logique de référencement croisé des
objets métier.

Pour configurer 'instruction d’une instance d’objet métier, cliquez dessus avec le
bouton droit de la souris et sélectionnez Set Verb dans le menu contextuel.
Lorsque l'invite “Select Verb” s’affiche, sélectionnez l'instruction souhaitée, puis
cliquez sur OK.

Restauration des valeurs par défaut des attributs d’objet métier
Pour restaurer les valeurs par défaut des attributs d’une requéte d’objet métier,
cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de la
vue Client Simulator et sélectionnez Edit > Reset BO.

Pour restaurer les valeurs par défaut des attributs d’une réponse d’objet métier,
cliquez sur le bouton Reset BO to default dans la barre d’outils de la fenétre
“Response BO”.

Suppression des valeurs affectées aux attributs d’objet métier
Pour supprimer les valeurs des attributs d’une requéte d’objet métier, cliquez sur
la fleche vers le bas située dans 1’angle droit de la barre de titre de la vue Client
Simulator et sélectionnez Edit > Clear BO.

Pour supprimer les valeurs des attributs d'une réponse d’objet métier, cliquez sur
le bouton Clear BO values dans la barre d’outils de la fenétre “Response BO”.

Utilisation des objets métier de réponse

Les objets métier de réponse sont envoyés depuis une vue Client Simulator lorsque
ce dernier tente d’émuler un connecteur qui est le destinataire des requétes d’objet
métier dans une interface. Utiliser des objets métier de réponse consiste a modifier
les valeurs contenues dans l'instance d"un objet métier et a renvoyer la réponse au
serveur.

Si vous créez et envoyez une requéte d’objet métier, comme décrit dans
l<Utilisation des requétes d’objet métier dans la vue Client Simulator» a la page 294|
et qu’elle est correctement traitée par l'interface, I’objet métier s’affiche dans le
panneau de résultat des connecteurs cible dans 'interface. La [figure 84 4 la page]
représente un panneau de résultat contenant une requéte d’objet métier recue.

La section [«Modification des objets métier de réponse» a la page 299 explique
comment modifier une requéte d’objet métier qui a été recue, et la section |<<Envoi|
[des objets métier de réponse» a la page 299 explique comment envoyer l'instance
en réponse.
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Modification des objets métier de réponse

Lorsque vous recevez une requéte d’objet métier dans une instance cible de Test
Connector, vous souhaitez généralement modifier les valeurs des attributs. Par
exemple, vous voudrez indiquer des valeurs uniques pour les attributs de clé
primaire qui participent aux relations, ou modifier les valeurs des autres attributs
afin de tester la mappe ou la logique de collaboration qui répond différemment
selon les valeurs contenues dans 1’objet métier. Pour définir les valeurs des
attributs d’objet métier, procédez comme suit :

1. Effectuez I'une des opérations suivantes pour modifier la requéte d'un objet
métier dans une fenétre “Response BO” :
* Cliquez deux fois sur l'instance de 1’objet métier dans le panneau de résultat.
* Sélectionnez l'instance de 1'objet métier dans le panneau de résultat, puis
cliquez sur la fleche vers le bas dans I'angle droit de la barre de titre de la
vue Client Simulator et sélectionnez Reply > Edit Response.
2. Pour modifier les attributs d’un objet métier, effectuez 1'une des opérations
suivantes :

+ Utilisez I'une des méthodes expliquées dans Définition des valeurs affectées|
[aux attributs d’objet métier» a la page 297pour modifier les valeurs des
attributs d’objet métier.

* Importez les données de 'objet métier a partir d’un fichier, comme décrit
dans fKImportation d’un objet métier de réponse» a la page 301}

Pouvoir importer des données enregistrées dans un objet métier de requéte
est tres utile dans les cas o1 vous devez ajouter des données dans un objet
métier de réponse avant de 1’envoyer en tant que réponse. Au lieu d’entrer
manuellement une valeur pour chaque attribut qui requiert des données de
réponse, vous pouvez entrer les valeurs une fois, exporter 1’objet métier
comme décrit dans [«Exportation d’un objet métier de réponse» a la page|
300), puis importer les données enregistrées sur les tests suivants.

Envoi des objets métier de réponse
Une fois que vous avez modifié un objet métier de requéte (si des modifications
sont nécessaires), envoyez-le au serveur en tant que réponse.

Le [tableau 30| affiche les options de réponse ainsi que les codes retour

correspondants pour les connecteurs C++ et Java. pour plus d’informations sur les
codes retour des connecteurs C++ ou Java, voir le document Connector Development
Guide for C++ ou Connector Development Guide for Java Server.

Tableau 30. Types de réponse de la vue Client Simulator et codes retour des connecteurs

Type de réponse de la vue
Client Simulator

Code retour du connecteur C++

Code retour du connecteur Java

Success

BON_SUCCESS

SUCCESS

Fail

BON_FAIL

FAIL

Multiple Hits

BON_MULTIPLE_HITS

MULTIPLE_HITS

Retrieve By Content Fail

BON_FAIL_RETRIEVE_BY_CONTENT

RETRIEVEBYCONTENT_FAILED

Not Found

BON_BO_DOES_NOT_EXIST

BO_DOES_NOT_EXIST

Value Duplicate

BON_VALDUPES

VALDUPES

Pour répondre a un objet métier de requéte, procédez comme suit :

1.

2. Effectuez 'une des opérations suivantes :

Sélectionnez I'instance de 1’objet métier dans le panneau de requéte.
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* Cliquez sur les boutons Reply Success ou Reply Fail dans la barre d’outils
de la vue Client Simulator.

* Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre
de la vue Client Simulator et sélectionnez le sous-menu Reply, puis le type
de réponse souhaité.

Enregistrement des objets métier

Vous pouvez enregistrer une instance d’objet métier que vous avez créée dans le
panneau d’entrée de sorte qu’il soit disponible chaque fois que la vue Client
Simulator est ouverte pour émuler cette définition de connecteur. Vous pouvez
sélectionner l'instance par son nom dans le champ BO Instance au lieu
d’entreprendre de créer une nouvelle requéte.

Pour enregistrer les instances d’un objet métier affichées dans le champ BO
Instance, cliquez sur la fleche vers le bas située dans l’angle droit de la barre de
titre de la vue Client Simulator et sélectionnez Edit > Save All BO’s.

L’objet métier est enregistré dans un fichier sous le nom de I'instance d’objet
métier, sans extension, dans un répertoire nommé apres le type d’objet métier dans
le répertoire .bos du répertoire du projet test dans lequel 1'unité de test est définie.
Le fichier est enregistré dans le méme format que celui utilisé par Test Connector
et Map Designer afin qu’il puisse étre également utilisé a des fins de test dans ces
outils.

Suppression des objets métier

Pour supprimer une instance d’objet métier d'une vue Client Simulator, cliquez sur
la fleche vers le bas située dans 1’angle droit de la barre de titre de la vue Client
Simulator et sélectionnez Edit > Delete BO.

Exportation des objets métier

Vous pouvez exporter une instance d’objet métier dans un fichier pour pouvoir
archiver de maniére pratique les données et les partager avec le support technique.
Le fichier de données test est enregistré avec l’extension .bo et peut-étre utilisé a
des fins de test avec Test Connector, Map Designer ou Integrated Test
Environment.

Exportation d’un objet métier de requéte
Pour exporter une instance d’objet métier du panneau d’entrée de la vue Client
Simulator :

1. Sélectionnez l'instance d’objet métier que vous voulez exporter dans le champ
“BO Instance”.

2. Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Edit > Export BO.

3. Accédez au répertoire dans lequel vous voulez enregistrer le fichier et indiquez
un nom dans le champ File name.

4. Cliquez sur Save.

Exportation d’un objet métier de réponse

Pour exporter une instance d’objet métier depuis la fenétre “Response BO” lorsque
vous modifiez une réponse d’objet métier dans le panneau de résultat, procédez
comme suit :

1. Cliquez sur le bouton Save BO dans la barre d’outils de la fenétre “Response
BO”.
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2. Accédez au répertoire dans lequel vous voulez enregistrer le fichier et indiquez
un nom dans le champ File name.

3. Cliquez sur Save.

Importation des objets métier

Vous pouvez importer un fichier de données test préalablement enregistré a partir
de Map Designer ou Test Connector ou exporté depuis Integrated Test
Environment.

Importation d’un objet métier de requéte
Pour importer une instance d’objet métier du panneau d’entrée de la vue Client
Simulator, procédez comme suit :

1. Cliquez sur la fleche vers le bas située dans I'angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Edit > Import BO.

2. Accédez au fichier de données de test et ouvrez-le.

Importation d’un objet métier de réponse

Pour importer une instance d’objet métier dans la fenétre “Response BO” lorsque
vous modifiez une réponse d’objet métier dans le panneau de résultat, procédez
comme suit :

1. Cliquez sur le bouton Load BO dans la barre d’outils de la fenétre “Response
BO”.
2. Accédez au fichier de données de test et ouvrez-le.

Comparaison des instances d’objet métier

Une vue Client Simulator peut comparer deux objets métier du méme type et
afficher les attributs dont les valeurs sont différentes. Vous pouvez utiliser cette
fonction pour afficher les modifications apportées a un objet métier a différents
stades de 'exécution d'une transaction. Par exemple, vous pouvez comparer un
objet métier qui a été envoyé au serveur avec le méme objet métier apres avoir été
traité et renvoyé au connecteur source. Pour comparer deux instances d’objet
métier, procédez comme suit :

1. Sélectionnez l'instance de 1'objet métier a comparer dans le panneau d’entrée.
2. Sélectionnez l'objet métier de réponse a comparer dans le panneau d’entrée.

3. Cliquez sur la fleche vers le bas située dans 1’angle droit de la barre de titre de
la vue Client Simulator et sélectionnez Reply > Compare BO’s.

Tracage de la sortie des données de I’objet métier

Pour transférer la sortie des données de 1’objet métier, vous devez utiliser CORBA.
Dans la mesure ol cette solution peut étre problématique si la quantité de données
de 'objet métier est importante, le serveur place localement en mémoire cache les
données réelles de I'objet métier et fournit au client les métadonnées uniquement.
Etant donné que cet appel est restreint, les points de contrdle de I'objet métier
peuvent étre rapidement mis a jour. Les données placées dans la mémoire cache du
serveur sont effacées des lors que le serveur redémarre ou qu'ITE en fait la
demande.

Le transfert des données de 1'objet métier est uniquement destiné aux serveurs
distants. Pour les serveurs locaux, le partage du systeme de fichiers local doit étre
utilisé dans le seul but d’optimiser les performances. Lorsque le tragage de 'objet
métier est activé, ITE informe les serveurs locaux situés a I'emplacement du
systéeme de fichiers. Si le serveur s’exécute a distance, 'emplacement du systeme
de fichiers est vide.
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Utilisation de la vue BO Inspector

Si vous utilisez la fonction de tragage des objets métier, Integrated Test
Environment regroupe les informations sur un objet métier pendant que le systeme
traite 'objet métier. Integrated Test Environment capture une image de 1'objet
métier apres avoir été traité par une mappe, puis par une collaboration.

Par exemple, si vous testez une interface dans laquelle un connecteur envoie une

requéte d’objet métier a un objet de collaboration, qui 1’envoie a son tour a un

connecteur cible qui le traite et renvoie une réponse, Integrated Test Environment

capture les données de 'objet métier suivant :

* l'objet métier générique créé par la mappe qui est appelée par le connecteur
source lorsqu’il envoie la requéte d’objet métier a InterChange Server ;

* 1’objet métier générique fourni a la mappe qui est appelée par le connecteur
cible ;

* 1’objet métier générique créé par la mappe qui est appelée par le connecteur
cible lorsqu’il renvoie la requéte d’objet métier a InterChange Server.

* les messages d’erreur associés aux flux défaillants.

La représente une vue BO Inspector qui a capturé trois objets métier
d’entrée, deux objets métier de résultat et un message d’erreur.
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Figure 89. Vue Business object inspector

Cette section explique comment utiliser le tracage d'un objet métier et les vues BO

Inspector.
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Comportement de trace des objets métier

Les remarques suivantes décrivent le comportement des indicateurs des objets
métier dans I'éditeur Test Unit et les vues BO Inspector lorsqu'un objet métier est
traité par une interface :

* Lorsque vous envoyez une requéte d’objet métier d’un connecteur source,
Iindicateur d’objet métier associé a 'icone du connecteur dans 1’éditeur Test
Unit devient vert et le numéro 1 s’affiche au-dessus de la loupe dans l'indicateur
d’objet métier. Cela signifie qu’il a traité un objet métier.

Vous pouvez afficher a ce stade la vue BO Inspector de cet indicateur d’objet
métier et observer 1'objet métier générique créé par la mappe entrante. Il est
représenté par un préfixe “in” dans le menu déroulant de la partie supérieure
gauche de la vue BO Inspector.

* L’objet métier est traité par différents composants dans l'interface (comme !’objet
de collaboration) et si aucune erreur n’est signalée, il est traité par la mappe
sortante associée au connecteur cible dans l'interface.

Lors de cette opération, l'indicateur d’objet métier associé a l'icone du
connecteur cible dans l'option Server Context Overlay devient vert et le numéro
1 s’affiche au-dessus de la loupe dans l'indicateur d’objet métier, indiquant que
ce dernier a également traité 1’objet métier.

Vous pouvez afficher a ce stade la vue BO Inspector de cet indicateur et observer
I'objet métier générique traité par la mappe sortante. Il est représenté par un
préfixe “out” dans le menu déroulant de la partie supérieure gauche de la vue
BO Inspector.

* Si vous répondez a ce stade a 1’objet métier de requéte dans le connecteur cible,
I'interface termine son traitement. Le numéro 1 s’affiche sous la loupe dans
I'indicateur d’objet métier, ce qui signifie que 'objet générique créé par la mappe
entrante du connecteur cible a été traité.

A ce stade, vous pouvez afficher 1'objet métier générique dans la premiere vue
BO Inspector. Il est représenté par un préfixe “result” dans le menu déroulant de
la partie supérieure gauche de la vue BO Inspector. Etant donné que la vue BO
Inspector contient également des données de I'instance de 1’objet métier “in”,
vous devez sélectionner l'instance “result” dans le menu déroulant.

* Si une erreur se produit pendant 1’exécution de l'interface, une cercle rouge
apparait autour de la loupe de l'indicateur d’objet métier. Vous pouvez
sélectionner 'erreur représentée par le préfixe “exception” dans la vue BO
Inspector associée a 'indicateur d’objet métier. Vous devez basculer de la vue
BO Inspector a la vue Text afin d’afficher le texte de I’erreur.

Affichage et fermeture des vues BO Inspector

Les sections suivantes expliquent les différentes manieres d’afficher et de fermer les
vues BO Inspector.

La colonne “Default interface position” dans le ftableau 31| dresse la liste des vues
dont les positions par défaut dans l'interface sont masquées par les vues BO
Inspector dans la colonne “BO Viewer number”.

Tableau 31. Positions de la vue par défaut de BO Inspector

Numéro BO Viewer Position par défaut de l'interface
BO Viewer 1 Outline

BO Viewer 2 Properties

BO Viewer 3 Dependency
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Affichage des vues BO Inspector
Utilisez 1'une des méthodes suivantes pour afficher les vues BO Inspector :

* Suivez les instructions de la section [«Affichage et fermeture des vues BO|
[[nspector dans la vue Outline» a la page 271 pour afficher une vue BO Inspector
dans la vue Outline.

+ Suivez les instructions de la section |«Affichage des vues BO Inspector» a la page]|
pour afficher une vue BO Inspector dans la vue Test Unit.

* Sélectionnez Integrated Test Environment > Show All BO Views dans la barre
de menus pour afficher les trois vues BO Inspector.

* Sélectionnez Perspective > Show View > x:BO Inspector dans la barre de
menus pour lancer une vue BO Inspector, ot x correspond au numéro de
I'instance de la vue BO Inspector a afficher.

Fermeture des vues BO Inspector
Utilisez 'une des méthodes suivantes pour fermer toutes les vues BO Inspector :

* Suivez les instructions de la section [«Affichage et fermeture des vues BO|
[Inspector dans la vue Outline» a la page 271| pour fermer une vue BO Inspector
dans la vue Outline.

* Sélectionnez Integrated Test Environment > Close All BO Views dans la barre
de menus pour fermer les trois vues BO Inspector.

* Cliquez sur le bouton Close sur le coté droit de la barre de titre de la vue BO
Inspector ou cliquez avec le bouton droit de la souris sur la barre de titre de la
vue BO Inspector et sélectionnez Close dans le menu contextuel.

Régénération des données des objets métier

Lorsque les composants d’une interface traitent un objet métier, les compteurs des
indicateurs d’objet métier dans 1’éditeur Test Unit sont mis a jour. Cela signifie que
vous pouvez mettre a jour les données de 'objet métier dans la vue BO Inspector
associée a cet indicateur d’objet métier pour afficher I'objet métier le plus récent.

Effectuez l'une des opérations suivantes pour mettre a jour 1’objet métier dans une

vue BO Inspector :

* Cliquez sur le bouton Refresh BO data dans la barre d’outils de la vue BO
Inspector.

* Cliquez sur la fleche vers le bas située dans l'angle droit de la barre de titre de
la vue BO Inspector et sélectionnez Refresh.

Une fois I'objet métier régénéré, vous pouvez sélectionner l'instance de 1’objet
métier le plus récent dans le menu déroulant situé dans l'angle supérieur gauche
de la vue BO Inspector.

Régénération des indicateurs des objets métier

Pour plus d’informations sur la régénération des indicateurs des objets métier dans
l'option Server Context Overlay, voir <Régénération des indicateurs des objets|
Imétier» a la page 285|

Modes d’affichage des vues BO Inspector

Vous pouvez utiliser différents modes d’affichage avec les vues BO Inspector.
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Utilisation du mode d’affichage Table

Le mode d’affichage Table présente les données d’objet métier dans un tableau,
comme dans le panneau d’entrée de la vue Client Simulator ou de la fenétre
“Response BO”.

La [figure 89 a la page 302 représente la vue BO Inspector avec le mode d’affichage
Table.

Pour afficher le mode d’affichage Table, effectuez 1'une des opérations suivantes :

* Cliquez sur le bouton Show table view dans la barre d’outils de la vue BO
Inspector.

* Cliquez sur la fleche vers le bas située dans le c6té droit de la barre de titre de
la vue BO Inspector et sélectionnez Show Table View.

Utilisation du mode d’affichage Text

Le mode d’affichage Text présente les données d’objet au format de marquage de
texte dans lequel il est enregistré lors de son exportation depuis la vue Client
Simulator ou la fenétre “Response BO”.

La représente la vue BO Inspector avec le mode d’affichage Text.

=tarm v X |
& <4 |
|
[in 12351 bo =] |customer (16) ¥|  |customerSyne_clari
l=StartHeader= -
r=Yersion = 3.0=
l<EndHeader=
l=StartBO: Customer =

BusinessObject = Customer
‘erh = Create
Locale =en_US

Ohjectld = 25

Customerld = 13423

Customermumber = AN_CUSTS
l=StartChild=

Customer &ddress = 1

l=StartB0: Customer Address=
BusineszObject = CustomerAddress
Yerb = CxBlank
Locale = en_US

Chjectld = BEEEEE
Addresslinet = 1725 Learning Lane ==
. dhim ot im oA e . _I

Figure 90. Vue BO Inspector avec des données d’objet métier affichées en mode texte

Pour afficher un message d’erreur dans une vue BO Inspector, vous devez passer
en mode texte ; la vue BO Inspector ne peut pas afficher un message d’erreur en
mode Table.

La [figure 91 a la page 306 représente un message d’erreur dans la vue BO
Inspector avec le style d’affichage Text.
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at Collaboration.CollaborationManager§1 .callback( Collaborationhds
&t CxCommon. ThreadingServices ThreadPoolThread.runi ThreadP

i o

Figure 91. Vue BO Inspector avec un message d’erreur affiché en mode texte

Pour afficher le style d’affichage Text, effectuez I'une des opérations suivantes :
* Cliquez sur le bouton Show text view dans la barre d’outils de la vue BO
Inspector.

* Cliquez sur la fleche vers le bas située dans le c6té droit de la barre de titre de
la vue BO Inspector et sélectionnez Show Text View.

Disposition verticale des vues
Vous pouvez disposer une vue BO Inspector de sorte qu’elle affiche en méme
temps le texte sous la vue Table.

Pour disposer les panneaux de la vue BO Inspector verticalement, cliquez sur la
fleche vers le bas située dans 'angle droit de la barre de titre de la vue BO
Inspector et sélectionnez Arrange Vertical dans le menu.

La [figure 92 a la page 307 représente les panneaux de la vue BO Inspector
lorsqu’ils sont disposés verticalement.
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Figure 92. Panneaux de la vue BO Inspector disposés a la verticale

Disposition horizontale des vues

Vous pouvez disposer une vue BO Inspector de sorte qu’elle affiche en méme

temps la vue Text a droite de la vue Table.

Pour disposer les panneaux de la vue BO Inspector horizontalement, cliquez sur la

fleche vers le bas située dans 1’angle droit de la barre de titre de la vue BO
Inspector et sélectionnez Arrange Horizontal dans le menu.

La [figure 93 a la page 308 représente les panneaux de la vue BO Inspector

lorsqu’ils sont disposés horizontalement.
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Figure 93. Panneaux de la vue BO Inspector disposés a I'horizontale

Enregistrement des données de test a partir d’'une vue BO
Inspector

Bien qu'il n’existe pas d’outil intégré pour enregistrer les données de test dans une
vue BO Inspector, vous pouvez utiliser la solution suivante :

1. Basculez la vue BO Inspector en mode d’affichage Text, comme décrit dans
[«Utilisation du mode d’affichage Text» a la page 305|

2. Sélectionnez l'intégralité du texte dans le panneau de la vue Text.
3. Utilisez le raccourci clavier Ctrl+C pour copier le texte.
4. Collez le texte copié dans un fichier texte et enregistrez-le avec 1'extension .bo.

Vous pouvez utiliser le fichier texte enregistré dans Map Designer, Test
Connector et Integrated Test Environment.

Configuration des préférences de tracage des objets métier

Le tragage des objets métier peut consommer beaucoup de ressources. Par défaut,
cette tache est configurée pour s’arréter au bout de deux heures, mais vous pouvez
changer la valeur de ce délai. Par ailleurs, vous pouvez configurer Integrated Test
Environment pour qu’il ne mette pas automatiquement a jour les compteurs des
indicateurs d’objet métier lorsque les objets métier sont traités, ce qui peut
nécessiter une utilisation intensive des ressources dans les transactions
volumineuses. Pour configurer les préférences relatives au tracage des objets
métier, procédez comme suit :

1. Sélectionnez Window > Preferences dans la barre de menus.
2. Développez Integrated Test Environment, puis sélectionnez Test Server.

3. Pour configurer les préférences de tragage des objets métier, procédez comme
suit dans le panneau “BO Trace” :

a. Entrez la durée en minutes au bout de laquelle vous voulez que le tracage
des objets métier s’arréte dans le champ BO trace timeout.
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b. Pour qu'Integrated Test Environment mette a jour automatiquement les
compteurs des indicateurs d’objet métier lorsque les objets métier sont
traités, laissez 1’option Enable auto update activée.

4. Cliquez sur OK.

Exécution d’un test a I'aide d’Integrated Test Environment

Tandis que la plupart des sections de ce chapitre décrivent les taches secondaires
que vous réalisez dans le cadre d’un test ou les différents éléments de l'interface
de la perspective Integrated Test Environment, cette section présente le flux de
travail que vous suivez lorsque vous effectuez un test. Elle traite la majeure partie
des taches et détaille les éléments de 'interface les plus importants. Cette section
présente également les méthodes les plus efficaces dans les cas ot il existe
plusieurs manieres d’effectuer une tache. Procédez comme suit pour tester une
interface a 'aide d’'Integrated Test Environment :

1.

Bien que vous puissiez déployer des composants sur une instance
d’InterChange Server a 'aide d’Integrated Test Environment, il est préférable
d’effectuer au préalable toutes les opérations de déploiement pour les raisons
suivantes :

* Vous évitez de compiler les mappes et les modeles de collaboration pendant
le processus de test.

* Vous pouvez démarrer les composants avant le test. Les composants
doivent étre déployés avant de pouvoir étre démarrés. Lorsque vous
déployer des connecteurs, vous devez redémarrer le serveur pour les
exécuter. Or, presque toutes les interfaces comprennent un connecteur. Par
conséquent, il n’est généralement pas judicieux de déployer les composants
d’une interface au cours d'un processus de test.

* Si vous devez tester plusieurs interfaces, il vous suffit d’effectuer un seul
déploiement avant le test au lieu de vérifier le bon déroulement du
déploiement de chaque interface pendant le test.

Pour plus d’informations sur le déploiement a 'aide de System Manager, voir

[<Déploiement de composants sur un serveur» a la page 63|

Pour plus d’informations sur le déploiement de composants a l'aide de la
commande repos_copy, voir [Chapitre 6, «Utilisation de repos_copy», a la page|
131

Pour plus d’informations sur le déploiement de composants a 'aide
d’Integrated Test Environment (opération qui n’est pas recommandée),
reportez-vous aux sections suivantes :

* [«Gestion du référentiel dans la vue Outline» a la page 269

* [«Utilisation de la vue Task Manager» a la page 272

Gestion du référentiel dans la vue Test Unit» a la page 283

Vérifiez que tous les composants requis pour tester 1'interface sont a 1’état
actif.

Pour démarrer les composants, utilisez I'une des interfaces suivantes :
¢ System Monitor, comme décrit dans System Administration Guide ;

* la vue InterChange Server Component Management, comme décrit dans
[«Gestion de I'état des composants dans le référentiel» a la page 78);

* la vue Outline, comme décrit dans [«Gestion de I'état des composants dans|
la vue Outline» a la page 269

«Gestion état des composants dans la vue Test Unit» a la page 283

Chapitre 12. Utilisation d’Integrated Test Environment 309



310

10.

1.

12.

13.

Enregistrez l'instance d’InterChange Server que vous voulez tester avec un
“serveur test local”, comme décrit dans [«Enregistrement d’une instance|
[d'InterChange Server» a la page 30}

Démarrez la perspective Integrated Test Environment, comme décrit dans
[<Démarrage d’'Integrated Test Environment» a la page 256

Sélectionnez le serveur que vous voulez utiliser pour le test, comme décrit
dans|«Sélection d’une configuration de serveur» a la page 258,

Si I'instance du serveur que vous voulez utiliser ne figure pas dans la boite de
dialogue, essayez de la supprimer dans la vue Server Instances et
réenregistrez-la.

Créez un projet de test devant contenir 1’'unité de test. Pour plus
d’informations, voir [«Création d’un projet de test» a la page 262

Créez une unité de test pour l'interface que vous voulez tester. Pour plus
d’informations, voir [«Création d’une unité de test dans Integrated Test]
[Environment» a la page 264

Si vous envisagez de déployer les composants dans l'interface que vous testez

a l'aide d’Integrated Test Environment, procédez comme suit :

* Ajoutez les unités dépendantes utilisateur a l'interface, comme décrit dans
[«Ajout d’unités dépendantes utilisateur» a la page 267|

* Suivez les instructions de la section [«Configuration d’InterChange Server
[pour démarrer en mode conception» a la page 259

Vérifiez que le composant IBM Java Object Request Broker est démarré. Pour
plus d’informations, voir le document System Installation Guide for Windows ou
System Installation Guide for UNIX.

Utilisez la vue Task Manager pour démarrer le serveur, associez-lui l'agent
Integrated Test Environment, puis connectez Integrated Test Environment a
’agent, comme décrit dans [«Utilisation de la vue Task Manager» a la page
Activez l'option Server Context Overlay, comme décrit dans |<<Activation et|
[désactivation de I"option Server Context Overlay» a la page 282

Affichez les vues Client Simulator des clients dans l'interface.

I1 est conseillé d’organiser les vues Client Simulator selon vos besoins. Par
exemple, vous pouvez trouver plus pratique d’avoir la vue du connecteur
source en premiere position dans la perspective (partagée par la vue
Integrated Test Environment Navigator), et d’avoir la vue du connecteur cible
en quatrieme position dans la perspective (partagée par la vue Properties).
Vous pouvez effectuer I'une des opérations suivantes pour afficher et
organiser les vues Client Simulator pour l'interface :

* Exécutez la tdche “Start connector views”, comme expliqué dans [tableau 2

la page 273} puis faites glisser et déposez les vues dans les positions que
vous souhaitez.

* Suivez les instructions de la section |«Utilisation, affichage et fermeture des|
[vues Client Simulator dans la vue Test Unit» a la page 284 pour choisir
quelle vue de Client Simulator vous voulez utiliser pour les définitions de
connecteur.

Connectez les vues Client Simulator au serveur, comme décrit dans
[«Connexion d’une vue Client Simulator au serveur» a la page 288]

Vérifiez que les clients se connectent correctement au serveur, comme décrit
dans[«Confirmation de la connexion d’un client au serveur» a la page 289

Apres avoir vérifié que les clients se sont connectés au serveur, configurez la
vue Client Simulator du connecteur source afin d’utiliser le panneau d’entrée,
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14.

15.

16.

17.

18.

19.

20.

21.

comme décrit dans [«Utilisation du panneau d’entrée» a la page 289]
Configurez ensuite la vue Client Simulator du connecteur cible afin d’utiliser
le panneau de résultat, comme décrit dans [«Utilisation du panneau dé
[résultat» a la page 290}

Si vous voulez utiliser le tracage des objets métier, démarrez cette opération a
ce stade de maniére a capturer les données lorsque vous commencerez a
envoyer les objets métier lors des prochaines étapes. Pour plus d’informations
sur le démarrage de la fonction trace des objets métier, voir le
Utilisez la vue Outline pour vérifier que l'interface est préte pour le test,
comme décrit dans [«Vérification de la disponibilité du test dans la vue]
[Outline» a la page 270

Procédez comme suit pour créer et envoyer une requéte d’objet métier a partir
du connecteur source :

a. Créez une instance d’objet métier afin de 'envoyer en tant que requéte,
comme décrit dans Création d’objets métier de requéte» a la page 294

b. Définissez les valeurs des attributs de l'instance de 1'objet métier, comme
décrit dans [«Définition des valeurs affectées aux attributs d’objet métier» 2

|@a page 297|

c. Enregistrez l'instance de ’objet métier dans un fichier afin de 'utiliser
dans des tests ultérieurs, comme décrit dans [«Enregistrement des objetd
[métier» a la page 300]

d. Envoyez l'instance de I'objet métier en tant que requéte, comme décrit
dans |«Envoi d’objets métier de requéte en mode asynchrone» a la page 294|
ou kEnvoi de requétes d’objet métier en mode synchrone» a la page 295|

Utilisez la vue InterChange Server Console pour observer le traitement de
1’objet métier, comme décrit dans [«Utilisation des vues Integrated Test]
[Environment Console et InterChange Server Console» a la page 280

Pour examiner I'objet métier une fois que plusieurs composants ont terminé
de le traiter, procédez comme suit :

» Affichez les vues BO Inspector des indicateurs BO dans l'interface, comme
décrit dans [«Affichage des vues BO Inspector» a la page 304

* Examinez les instances de I'objet métier dans les vues BO Inspector, comme
décrit dans [«Utilisation du mode d’affichage Table» a la page 305

Modifiez I'objet métier de réponse dans le panneau de résultat de la vue
Client Simulator cible, comme décrit dans [<Modification des objets métier de|
[réponse» a la page 299

Envoyez 1'objet métier de réponse en tant que réponse, comme décrit dans
[<Envoi des objets métier de réponse» a la page 299}

Répétez les étapes [16] 2 20| pour tester a nouveau l'interface, ou répétez les
étapes |6 a la page 310[a 20| pour tester une autre interface.
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Chapitre 13. Utilisation de Collaboration Debugger

Collaboration Debugger est une perspective d’atelier qui permet de spécifier les
points auxquels le processus d'une collaboration doit s’arréter lors de 1’exécution et
d’analyser les données du flux en cours de traitement au niveau de ces points.

Pour exécuter le débogage d’une collaboration, vous devez réaliser un certain
nombre de taches telles que l'association de Collaboration Debugger a un objet de
collaboration, la configuration de points d’arrét, la gestion de la progression du
flux via la collaboration et 1’analyse des données du flux. Voici les caractéristiques
qui décrivent 'utilisation de 1’outil Collaboration Debugger :

* Certaines taches ne doivent étre réalisées qu’a une seule reprise. Par exemple, il
vous suffit généralement d’associer Collaboration Debugger a 'objet de
collaboration une seule fois.

* Certaines taches doivent généralement étre réalisées plusieurs fois. Par exemple,
vous devez habituellement gérer la progression du flux a plusieurs reprises au
cours de son traitement.

* Certaines taches ne sont pas a réaliser au cours du traitement de chaque flux.

En raison de la nature non linéaire du débogage d"une collaboration, les sections
contenues dans ce chapitre décrivent les interfaces de la perspective ou certaines
taches a réaliser dans l'ordre dans lequel vous utilisez généralement les interfaces
ou réalisez les tiches. La section [«Débogage d’une collaboration» a la page 334
décrit le flux de travail du débogage d’une collaboration afin de fournir un guide
plus linéaire concernant les interfaces et les taches.

Le présent chapitre contient les sections suivantes :

+ |«Lancement de Collaboration Debugger»|

¢ |«Interface de Collaboration Debugger» a la page 315|

* |«Association et dissociation de Collaboration Debugger» a la page 321|

« |«Utilisation de 1’éditeur du modele de collaboration» a la page 323

+ |«Utilisation des événements» a la page 325|

« |«Utilisation des points d’arrét» a la page 327

* |«Exécution d’opérations de débogage» a la page 330

« |«Utilisation des variables» a la page 333]

* [«<Débogage d’une collaboration» a la page 334

Lancement de Collaboration Debugger

Pour lancer Collaboration Debugger, procédez comme suit :

1. Sélectionnez Démarrer > Programmes > IBM WebSphere InterChange Server
> IBM WebSphere Business Integration Toolset > Administrative > System
Manager.

2. Sélectionnez Window > Open Perspective > Other dans la barre de menus.

3. Sélectionnez Collaboration Debugger dans la liste des perspectives, puis
cliquez sur OK.

L’atelier démarre et s’affiche. La |figure 2 a la page 27| présente la perspective
Collaboration Debugger et la section [«Interface de Collaboration Debugger» a la|
décrit I'interface et les éléments qui la composent.
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Configuration des préférences d’affichage de Collaboration
Debugger

Vous pouvez configurer Collaboration Debugger de sorte que ses interfaces soient
ouvertes dans la perspective en cours d’utilisation ou dans Collaboration Debugger
comme prévu initialement. L’ouverture des interfaces dans la perspective en cours
d’utilisation permet de vous éviter de naviguer entre les perspectives pour utiliser
les vues de Collaboration Debugger tout en vous donnant la possibilité de réaliser
certaines taches telles que le déploiement de composants ou l'envoi d’événements.
L’ouverture des interfaces dans Collaboration Debugger présente I’avantage de
réduire le nombre d’interfaces devant partager les mémes emplacements dans
l'atelier.

Procédez comme suit pour configurer vos préférences concernant les vues de
Collaboration Debugger :

1. Sélectionnez Window > Preferences dans la barre de menus de l'atelier.
2. Sélectionnez Collaboration Debugger.

La [figure 94 a la page 315 présente les préférences d’affichage de Collaboration
Debugger.
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Figure 94. Préférences d’affichage de Collaboration Debugger

3. Activez le bouton radio Display in Debugger Perspective pour ouvrir les vues
de Collaboration Debugger dans Collaboration Debugger lui-méme.

Activez le bouton radio Display in Current Perspective pour ouvrir les vues
de Collaboration Debugger dans la perspective active.

4. Cliquez sur OK.

Interface de Collaboration Debugger

La perspective Collaboration Debugger comporte plusieurs vues et un éditeur dans
la configuration affichée par défaut. La[figure 95 a la page 316|présente la
perspective Collaboration Debugger par défaut.
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Figure 95. Perspective Collaboration Debugger

Le [tableau 32 A la page 316|identifie les éléments d’interface de la perspective
Collaboration Debugger, représentés par des numéros dans la

Tableau 32. Eléments d’interface de la perspective Collaboration Debugger

Numéro de I’élément d’interface

Nom de I’élément d’interface

1

«Vue Events»

2

«Editeur du modeéle de collaboration» a lal

page 317]

|«Vue Breakpoints» a la page 318

|«Vue Variables» a la page 319|

Vue Events

La vue “Events” répertorie les flux transmis en vue de leur traitement a ’objet de
collaboration en cours de débogage. Elle indique les opérations permettant
d’affecter le traitement du flux et de localiser le noeud en cours d’exécution.

La [figure 96 a la page 317 présente la vue “Events”.
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Figure 96. Vue Events

Pour plus d’informations sur 1'utilisation des événements et de la vue “Events”,
voir [«Utilisation des événements» a la page 325

Editeur du modeéle de collaboration

L’éditeur “du modele de collaboration” est un éditeur en lecture seule qui affiche
les diagrammes du modele de collaboration sur lequel est basé 1’objet de
collaboration en cours de débogage. Il permet d’afficher la conception du processus
métier et de réaliser nombre des taches associées au débogage d'une collaboration.

La [figure 97 a la page 318| présente 1'éditeur “du modele de collaboration”.
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Figure 97. Editeur du modéle de collaboration

Les sections suivantes contiennent davantage d’informations sur 1'éditeur “du
modele de collaboration” ainsi que sur les taches qu’il vous permet de réaliser :

+ |«Utilisation de 1’éditeur du modéle de collaboration» a la page 323

+ |«Utilisation des points d’arrét» a la page 327

* |«Exécution d’opérations de débogage» a la page 330

Vue Breakpoints

La vue “Breakpoints” permet de gérer les points d’arrét dans 1'objet de
collaboration ainsi que le traitement du flux dans la mesure ol celui-ci interagit

avec ces points d’arrét.

La [figure 98 a la page 319 présente la vue “Breakpoints”.
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Figure 98. Vue Breakpoints

Pour plus d’informations sur les taches réalisées a 1'aide de la vue “Breakpoints”,
voir les sections suivantes :

+ |«Utilisation des points d’arrét» a la page 327

« |«Exécution d’opérations de débogage» a la page 330

Vue Variables

La vue “Variables” affiche les informations relatives au flux en cours de traitement
lors d’une pause en réponse aux opérations de débogage. Elle indique toutes les
variables de type BusObj ou Java primitive déclarées dans la section “Declarations’
du modele de collaboration. Lorsque vous réalisez des opérations de débogage
pour gérer un flux via la collaboration, la vue “Variables” met a jour les variables
répertoriées avec leurs valeurs au niveau du noeud en cours d’exécution a cet
instant.

7

La [figure 99 a la page 320| présente la vue “Variables”.
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Figure 99. Vue Variables

Pour plus d’informations sur la vue “Variables” et sur les taches qui affectent son
contenu, voir les sections suivantes :

» |«Utilisation des événements» a la page 325|

» [«Exécution d’opérations de débogage» a la page 330|

» |«Utilisation des variables» a la page 333]
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Association et dissociation de Collaboration Debugger

Vous devez associer Collaboration Debugger a un objet de collaboration pour
démarrer une session de débogage, définir des points d’arrét et gérer un flux via le
processus métier.

L’objet de collaboration doit étre actif pour pouvoir y associer Collaboration
Debugger. Pour plus d’informations sur 1’état des composants et sur la maniére de
le modifier, voir le document System Administration Guide.

Une fois le débogage d’un objet de collaboration terminé, dissociez Collaboration
Debugger pour reprendre le traitement normal des flux. Si vous arrétez un objet de
collaboration, Collaboration Debugger s’en dissocie automatiquement.

Association de Collaboration Debugger

Vous pouvez associer Collaboration Debugger a un objet de collaboration dans
System Manager ou dans Integrated Test Environment, comme indiqué dans les
sections suivantes :

+ |«Association de Collaboration Debugger dans System Manager»|

+ |«Association de Collaboration Debugger dans Integrated Test Environment»|

Association de Collaboration Debugger dans System Manager
Procédez comme suit pour associer Collaboration Debugger a un objet de
collaboration dans System Manager :

1. Dans la vue InterChange Server Component Management, développez
I'instance du serveur dans laquelle se trouve 1’objet de collaboration, puis
développez le dossier Collaboration Objects.

2. Sélectionnez les objets de collaboration auxquels vous souhaitez associer
Collaboration Debugger. Vous pouvez utiliser les techniques de sélection
standard de Windows pour sélectionner plusieurs projets utilisateur en méme
temps pour le déploiement, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.

* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

3. Cliquez avec le bouton droit de la souris sur 1I'un des objets de collaboration
sélectionnés, puis sélectionnez Attach Debugger dans le menu contextuel.

Association de Collaboration Debugger dans Integrated Test
Environment

Pour associer Collaboration Debugger a un objet de collaboration dans Integrated
Test Environment, cliquez avec le bouton droit de la souris sur 1'icone centrale de
I'objet de collaboration dans la vue Test Unit, puis sélectionnez Attach Debugger
dans le menu contextuel.

Pour plus d’informations sur la vue Test Unit, voir |«Utilisation de la vue Test|
[Unit» a la page 281}

Association de Collaboration Debugger dans Collaboration
Debugger

Effectuez I'une des opérations suivantes pour associer Collaboration Debugger a
un objet de collaboration dans Collaboration Debugger lui-méme :

* Cliquez avec le bouton droit de la souris n'importe ot dans l'éditeur “du
modele de collaboration”, puis sélectionnez Attach Debugger dans le menu
contextuel.
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* Cliquez avec le bouton droit de la souris sur 'objet de collaboration dans la vue
“Breakpoints” ou “Events”, puis sélectionnez Attach Debugger dans le menu
contextuel.

» Sélectionnez 'objet de collaboration dans la vue “Breakpoints” ou “Events”, puis
sélectionnez Collaboration Debugger > Attach Debugger dans la barre de
menus.

* Sélectionnez l'objet de collaboration dans la vue “Breakpoints”, puis cliquez sur
Attach Debugger dans la barre d’outils de la vue “Breakpoints”.

* Sélectionnez 1'objet de collaboration dans la vue “Breakpoints”, cliquez sur le
menu déroulant dans le coin supérieur droit de la barre de titre, puis
sélectionnez Attach Debugger.

Dissociation de Collaboration Debugger

Vous pouvez dissocier Collaboration Debugger d'un objet de collaboration dans
System Manager ou dans Integrated Test Environment, comme indiqué dans les
sections suivantes :

+ |«Dissociation de Collaboration Debugger dans System Manager»|

+ |«Dissociation de Collaboration Debugger dans Integrated Test Environment»|

Dissociation de Collaboration Debugger dans System Manager
Procédez comme suit pour dissocier Collaboration Debugger d’un objet de
collaboration dans System Manager :

1. Dans la vue InterChange Server Component Management, développez
I'instance du serveur dans laquelle se trouve 1’objet de collaboration, puis
développez le dossier Collaboration Objects.

2. Sélectionnez les objets de collaboration dont vous souhaitez dissocier
Collaboration Debugger. Vous pouvez utiliser les techniques de sélection
standard de Windows pour sélectionner plusieurs projets utilisateur en méme
temps pour le déploiement, comme suit :

* Maintenez la touche Maj enfoncée pour sélectionner des éléments contigus.

* Maintenez la touche Ctrl enfoncée pour sélectionner des éléments non
contigus.

3. Cliquez avec le bouton droit de la souris sur l'un des objets de collaboration
sélectionnés, puis sélectionnez Detach Debugger dans le menu contextuel.

Dissociation de Collaboration Debugger dans Integrated Test
Environment

Pour dissocier Collaboration Debugger d"un objet de collaboration dans Integrated
Test Environment, cliquez avec le bouton droit de la souris sur l'icone centrale de
I'objet de collaboration dans la vue Test Unit, puis sélectionnez Detach Debugger
dans le menu contextuel.

Pour plus d’informations sur la vue Test Unit, voir [«Utilisation de la vue Test]
[Unit» a la page 281}

Dissociation de Collaboration Debugger dans Collaboration
Debugger

Effectuez I'une des opérations suivantes pour dissocier Collaboration Debugger
d’un objet de collaboration dans Collaboration Debugger lui-méme :

* Cliquez avec le bouton droit de la souris n'importe ou dans I'éditeur “du
modele de collaboration”, puis sélectionnez Detach Debugger dans le menu
contextuel.
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* Cliquez avec le bouton droit de la souris sur 'objet de collaboration dans la vue
“Breakpoints” ou “Events”, puis sélectionnez Detach Debugger dans le menu
contextuel.

» Sélectionnez 'objet de collaboration dans la vue “Breakpoints” ou “Events”, puis
sélectionnez Collaboration Debugger > Detach Debugger dans la barre de
menus.

* Sélectionnez l'objet de collaboration dans la vue “Breakpoints”, puis cliquez sur
Detach Debugger dans la barre d’outils de la vue “Breakpoints”.

* Sélectionnez 1'objet de collaboration dans la vue “Breakpoints”, cliquez sur le
menu déroulant dans le coin supérieur droit de la barre de titre, puis
sélectionnez Detach Debugger.

Suppression des objets de collaboration dissociés de
Collaboration Debugger

Effectuez I'une des opérations suivantes pour supprimer tous les objets de
collaboration que vous avez dissociés de Collaboration Debugger de sorte qu’ils ne
soient pas affichés dans les vues :

* Cliquez avec le bouton droit de la souris n'importe ot dans la vue “Events” ou
“Breakpoints”, puis sélectionnez Remove All Detached dans le menu contextuel.

* Cliquez sur Remove All Detached dans la barre d’outils de la vue
“Breakpoints”.

* Cliquez sur le menu déroulant dans le coin supérieur droit de la barre de titre
de la vue “Breakpoints”, puis sélectionnez Remove All Detached.

Utilisation de I’éditeur du modeéle de collaboration

L’éditeur “du modéle de collaboration” est un éditeur en lecture seule qui affiche
les diagrammes du modele de collaboration sur lequel est basé 1’objet de
collaboration en cours de débogage. Il permet d’afficher la conception du processus
métier et de réaliser nombre des taches associées au débogage d"une collaboration.

L’éditeur “du modele de collaboration” permet d’utiliser des diagrammes comme
indiqué dans la section [<Ouverture et fermeture des diagrammes»|ainsi que des
libellés et des ID de noeud comme indiqué dans la section [«Affichage et masquage|
[des ID et des libellés de noeud» a la page 324

Outre ces sections, qui décrivent les taches spécifiques a I'éditeur “du modele de
collaboration”, les sections suivantes décrivent les tdches que vous pouvez réaliser
a l'aide de plusieurs interfaces :

* |«Utilisation de I'éditeur du modele de collaboration»|

* |«Utilisation des points d’arrét» a la page 327

* |«Exécution d’opérations de débogage» a la page 330|

Ouverture et fermeture des diagrammes

Pour gérer les points d’arrét des noeuds appartenant aux noeuds Subdiagram et
Iterator dans un modele de collaboration, vous devez ouvrir le diagramme du
noeud.

Effectuez 'une des opérations suivantes pour ouvrir le diagramme d’un noeud
Subdiagram ou Iterator :

¢ Sélectionnez le noeud, puis appuyez sur Entrée.
* Cliquez deux fois sur le noeud.
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* Cliquez avec le bouton droit de la souris sur le noeud, puis sélectionnez Open
Diagram dans le menu contextuel.

Pour fermer le diagramme d’un noeud Subdiagram ou Iterator, cliquez sur X dans
le coin supérieur droit de 'onglet du diagramme.

Affichage et masquage des ID et des libellés de noeud

Les ID et libellés uniques affectés aux noeuds et aux liens dans le diagramme d’'un
modele de collaboration facilitent leur identification et 'interprétation du processus
métier défini par le modele. Leur affichage dans Collaboration Debugger peut par
conséquent faciliter I'identification et la résolution des incidents.

Pour afficher les identificateurs uniques dans un diagramme, cliquez avec le
bouton droit de la souris n'importe ot dans 1’éditeur, puis sélectionnez Show
uniquelDs dans le menu contextuel.

Pour masquer les identificateurs uniques dans un diagramme, cliquez avec le
bouton droit de la souris n'importe ot dans 1’éditeur, puis sélectionnez Hide
uniquelDs dans le menu contextuel.

Pour afficher les libellés dans un diagramme, cliquez avec le bouton droit de la
souris n'importe ol dans 'éditeur, puis sélectionnez Show labels dans le menu
contextuel.

Pour afficher les identificateurs uniques dans un diagramme, cliquez avec le
bouton droit de la souris n'importe ot dans 1’éditeur, puis sélectionnez Show
labels dans le menu contextuel.

Configuration des préférences de I’éditeur du modele de
collaboration

Procédez comme suit pour configurer les préférences de 1'éditeur du modele de
collaboration :

1. Sélectionnez Window > Preferences dans la barre de menus de l'atelier.
2. Développez Collaboration Debugger.
3. Sélectionnez Diagram Colors.

La [figure 100 a la page 325| présente les préférences de couleur du diagramme
de I'éditeur du modele de collaboration.
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Figure 100. Préférences de couleur du diagramme de I'éditeur du modéle de collaboration

4. Cliquez sur les icones représentant un pot de peinture associées aux différents
éléments d’interface pour définir la couleur de remplissage souhaitée pour ces
éléments.

Cliquez sur les icones représentant un crayon associées aux différents éléments
d’interface pour définir la couleur du trait souhaitée pour ces éléments.

Dans la boite de dialogue “Color”, sélectionnez la couleur que vous souhaitez
que la vue Test Unit utilise pour l'arriere-plan de ce type de composant, puis
cliquez sur OK.

5. Cliquez sur OK.

Utilisation des événements

Les événements correspondent aux flux qui déclenchent I’exécution d’un objet de
collaboration. Les collaborations exécutent la logique du processus métier pour
gérer les données d’événement, en les manipulant et en les coordonnant au sein
des ressources logicielles de 1'entreprise. Vous pouvez utiliser Collaboration
Debugger principalement pour interrompre le traitement d'un événement pour
vous permettre d’inspecter les données qu’il contient a des points importants dans
la logique applicative.
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Affichage d’un événement

Lorsqu’un nouveau flux est transmis pour traitement a un objet de collaboration en
cours de débogage, un numéro lui est attribué et il est placé sous 1'objet de
collaboration dans la vue “Events”.

La présente un événement recu par un objet de collaboration et affiché
dans la vue “Events”.

= Raouter PortToCaesasrOrClarify - WICS422DEY
YR E =Nt 4 - suspended

Figure 101. Evénement affiché dans la vue Events

Lorsque vous affichez un événement, Collaboration Debugger met en évidence le
noeud dans lequel le traitement est interrompu dans 1’éditeur “du modele de
collaboration” : des carrés noirs apparaissent dans chaque coin du noeud pour
indiquer qu’il est sélectionné et une icone en forme de drapeau associée au nom
d’instance de I’événement s’affiche dans le coin supérieur gauche du noeud. La
présente un noeud dans lequel le traitement de I'événement a été
interrompu dans 1’éditeur du modéle de collaboration.
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Wanables
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Figure 102. Evénement affiché dans I'éditeur du modele de collaboration

Si des points d’arrét actifs sont définis dans la collaboration, le flux interrompt le
traitement en attendant que vous exécutiez I'opération de débogage et une icone
en forme de drapeau est dessinée sur le noeud dans lequel le traitement est
interrompu pour représenter également 1’'événement.

Vous pouvez afficher un événement pour le localiser dans le diagramme de
collaboration et renseigner la vue “Variables” avec les données courantes dans le
flux.

La vue “Variables” est mise a jour dynamiquement au fur et a mesure que vous
exécutez les opérations de débogage. L’affichage d'un événement n’est par
conséquent nécessaire que dans les situations suivantes :

¢ lorsque l'objet de collaboration regoit en premier le flux pour traitement ;

* si vous avez navigué a un autre emplacement dans Collaboration Debugger
(pour afficher un point d’arrét par exemple) et que vous devez de nouveau
localiser 1'événement.

Effectuez 1'une des opérations suivantes pour afficher un événement :

* Cliquez avec le bouton droit de la souris sur I'événement dans la vue “Events”,
puis sélectionnez Display dans le menu contextuel.

e Sélectionnez I'événement dans la vue “Events”, puis sélectionnez Collaboration
Debugger > Display dans la barre de menus.
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Interruption d’un événement

Lorsque vous exécutez un événement, comme indiqué dans la section
[d’un événement» a la page 332 le flux d’exécution se poursuit normalement, sans
tenir compte des points d’arrét. Si vous choisissez de reprendre le débogage du
flux, vous pouvez interrompre 1'événement.

Apres que vous avez indiqué a Collaboration Debugger d’exécuter un événement,
il s’exécute généralement trop rapidement pour vous permettre de l'interrompre,
méme si les appels de service vous en donnent la possibilité. Lorsqu’un objet
métier est transmis a un appel de service, le processus métier est bloqué jusqu’a
réception d’une réponse. Cela vous laisse ainsi suffisamment de temps pour
interrompre le flux avant de répondre a la requéte et permettre la reprise du
débogage une fois la réponse transmise a la collaboration.

Effectuez 1'une des opérations suivantes pour interrompre un événement :

* Cliquez avec le bouton droit de la souris sur 'événement dans la vue “Events”,
puis sélectionnez Suspend dans le menu contextuel.

¢ Sélectionnez I'événement dans la vue “Events”, puis sélectionnez Collaboration
Debugger > Suspend dans la barre de menus.

Exécution d’un événement

Pour plus d’informations sur I'exécution d’un événement, voir |[«Exécution d’un|
Evénement» a la page 332

Utilisation des

points d’arrét

Les points d’arrét sont les instructions utilisées par Collaboration Debugger pour
interrompre 1’exécution d’un objet de collaboration. Vous pouvez définir des points
d’arrét au niveau du noeud du processus métier dans lequel vous souhaitez
analyser les données d"un flux pour étudier sa transformation et résoudre les
incidents.

Vous pouvez définir des points d’arrét sur les types de noeud suivants :
* Noeud Action

* Noeud Subdiagram

* Noeud Iterator

* Noeud End success

* Noeud End failure

* Noeud Iterator

* Noeud Break

Vous ne pouvez définir aucun point d’arrét sur un noeud Decision.

Pour plus d’informations sur les différents types de noeud contenus dans un
modele de collaboration, voir le document Collaboration Development Guide.

Les sections suivantes décrivent comment organiser les points d’arrét dans une
collaboration en cours de débogage :

» [«Définition des points d’arrét» a la page 328|
* |«Affichage des points d’arrét» a la page 328|
* |«Suppression des points d’arrét» a la page 328|

« |«Désactivation des points d’arrét» a la page 329|
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* |«Activation des points d’arrét» a la page 329

Apres avoir organisé les points d’arrét dans 1'objet de collaboration, suivez les
instructions indiquées dans la section |«Exécution d’opérations de débogage» a la|
pour gérer le traitement du flux.

Définition des points d’arrét
Effectuez 1'une des opérations suivantes pour définir un point d’arrét sur un noeud
pris en charge :

Cliquez avec le bouton droit de la souris sur le noeud, puis sélectionnez Set
breakpoint(s) dans le menu contextuel.

Sélectionnez le noeud, puis cliquez sur Set breakpoint(s) dans la barre d’outils
de Collaboration Debugger.

Sélectionnez le noeud, puis Collaboration Debugger > Set breakpoint(s) dans la
barre de menus.

Cliquez deux fois sur un noeud sur lequel aucun point d’arrét n’a été défini.

Affichage des points d’arrét

Effectuez 1'une des opérations suivantes pour sélectionner et mettre en évidence un
noeud sur lequel un point d’arrét a été défini :

Cliquez avec le bouton droit de la souris sur le point d’arrét dans la vue
“Breakpoints”, puis sélectionnez Display dans le menu contextuel.
Cliquez deux fois sur le point d’arrét dans la vue “Breakpoints”.
Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis appuyez sur
Entrée.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis cliquez sur Display
dans la barre d’outils de la vue “Breakpoints”.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, cliquez sur le menu
déroulant dans le coin supérieur droit de la barre de titre, puis sélectionnez
Display.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis cliquez sur Display
dans la barre d’outils de Collaboration Debugger.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis sélectionnez
Collaboration Debugger > Display breakpoint(s) dans la barre de menus.

Suppression des points d’arrét

Effectuez l'une des opérations suivantes pour supprimer un point d’arrét :

Cliquez avec le bouton droit de la souris sur le noeud sur lequel le point d’arrét
est défini dans 1'éditeur “du modele de collaboration”, puis sélectionnez
Remove breakpoint(s) dans le menu contextuel.

Cliquez avec le bouton droit de la souris sur le point d’arrét dans la vue
“Breakpoints”, puis sélectionnez Remove dans le menu contextuel.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis cliquez sur Remove
dans la barre d’outils de la vue “Breakpoints”.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, cliquez sur le menu
déroulant dans le coin supérieur droit de la barre de titre, puis sélectionnez
Remove.

Sélectionnez le noeud sur lequel le point d’arrét est défini dans l'éditeur “du

modele de collaboration”, puis sélectionnez Remove breakpoint(s) dans la barre
d’outils de Collaboration Debugger.
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Sélectionnez le noeud sur lequel le point d’arrét est défini dans 1’éditeur “du
modele de collaboration”, puis sélectionnez Collaboration Debugger > Remove
breakpoint(s) dans la barre de menus.

Cliquez deux fois sur un noeud sur lequel un point d’arrét a été défini.

Désactivation des points d’arrét

Effectuez l'une des opérations suivantes pour désactiver un point d’arrét de sorte
que l'exécution ne s’interrompe plus au noeud spécifié, tout en gardant la
possibilité de le réactiver si nécessaire :

Cliquez avec le bouton droit de la souris sur le noeud sur lequel le point d’arrét
est défini dans I'éditeur “du modele de collaboration”, puis sélectionnez Disable
breakpoint(s) dans le menu contextuel.

Cliquez avec le bouton droit de la souris sur le point d’arrét dans la vue
“Breakpoints”, puis sélectionnez Disable dans le menu contextuel.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis cliquez sur Disable
dans la barre d’outils de la vue “Breakpoints”.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, cliquez sur le menu
déroulant dans le coin supérieur droit de la barre de titre, puis sélectionnez
Disable.

Sélectionnez le noeud sur lequel le point d’arrét est défini dans 1'éditeur “du
modele de collaboration”, puis sélectionnez Disable breakpoint(s) dans la barre
d’outils de Collaboration Debugger.

Sélectionnez le noeud sur lequel le point d’arrét est défini dans 1'éditeur “du
modele de collaboration”, puis sélectionnez Collaboration Debugger > Disable
breakpoint(s) dans la barre de menus.

Activation des points d’arrét

Effectuez 1'une des opérations suivantes pour activer un point d’arrét qui a été
désactivé :

Cliquez avec le bouton droit de la souris sur le noeud sur lequel le point d’arrét
est défini dans I'éditeur “du modele de collaboration”, puis sélectionnez Enable
breakpoint(s) dans le menu contextuel.

Cliquez avec le bouton droit de la souris sur le point d’arrét dans la vue
“Breakpoints”, puis sélectionnez Enable dans le menu contextuel.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, puis cliquez sur Enable
dans la barre d’outils de la vue “Breakpoints”.

Sélectionnez le point d’arrét dans la vue “Breakpoints”, cliquez sur le menu
déroulant dans le coin supérieur droit de la barre de titre, puis sélectionnez
Enable.

Sélectionnez le noeud sur lequel le point d’arrét est défini dans l'éditeur “du
modele de collaboration”, puis sélectionnez Enable breakpoint(s) dans la barre
d’outils de Collaboration Debugger.

Sélectionnez le noeud sur lequel le point d’arrét est défini dans l'éditeur “du
modele de collaboration”, puis sélectionnez Collaboration Debugger > Enable
breakpoint(s) dans la barre de menus.

Filtrage des points d’arrét

Vous pouvez filtrer la vue “Breakpoints” pour afficher uniquement les points
d’arrét définis sur certains types de noeud. Procédez comme suit pour filtrer la vue
“Breakpoints” :
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1. Effectuez l'une des opérations suivantes pour afficher la boite de dialogue
“Breakpoints Filter” :
* Cliquez sur Filter dans la barre de titre de la vue “Breakpoints”.
* Cliquez sur la fleche vers le bas dans le coin supérieur droit de la barre de
titre de la vue “Breakpoints”, puis sélectionnez Filter dans le menu
déroulant.

Collaboration Debugger affiche la boite de dialogue “Breakpoints Filter”,
comme indiqué dans la [figure 104 a la page 333 :

4P Breakpoints Filter f x|

Show breakpoaints on:

=[] All Mode Types -
-[=] Action
: Breal
[ End Failure
[ £nd Success
- [#] Iterator

[ Start ~|

@ ¥or all colaboration objects.:

" For current collaboration objeck only,
€ For current diagram only.
™ for current diagram and its children.

ok I Cancel Reset

Figure 103. Filtrage des points d’arrét

2. Utilisez les techniques suivantes pour configurer les parametres de filtrage :

* Activez la case a cocher All Node Types pour afficher tous les types de
noeud pris en charge.

* Activez uniquement les cases a cocher des types de noeud spécifiques a
afficher.

* Cliquez sur Reset pour appliquer les parametres de filtrage par défaut.

3. Activez 'un des boutons radio suivants pour indiquer le champ d’application
du filtre :

* for all collaboration objects (a tous les objets de collaboration)

* for current collaboration object only (a 1'objet de collaboration courant
uniquement)

* for current diagram only (au diagramme courant uniquement)
* for current diagram and its children (au diagramme et a ses enfants)
4. Cliquez sur OK.

Exécution d’opérations de débogage

Apres avoir organisé les points d’arrét dans 1'objet de collaboration en cours de
débogage, vous devez exécuter des opérations de débogage pour gérer le flux de
I'événement par l'intermédiaire des points d’arrét. Les opérations suivantes sont
disponibles :

* |«Pas & pas principal» a la page 331

+ |«Pas a pas détaillé» a la page 331|

* |«Pas & pas sortant» a la page 331|
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* |«Exécution» a la page 332|

* |«Exécution jusqu’a un noeud spécifique» a la page 332

« |«Exécution d’un événement» a la page 332

Pas a pas principal
Lorsque vous exécutez une opération de type “step over”, InterChange Server

poursuit le flux interrompu de sorte que le noeud sur lequel le point d’arrét est
défini puisse s’exécuter, puis interrompt le flux au noeud suivant.

Effectuez I'une des opérations suivantes pour éviter un noeud dans lequel
I'exécution est interrompue :

* Cliquez avec le bouton droit de la souris n'importe out dans l’éditeur “du
modele de collaboration”, puis sélectionnez Step Over dans le menu contextuel.

* Mettez en évidence I'éditeur “du modele de collaboration”, puis cliquez sur Step
Over dans la barre d’outils.

* Mettez en évidence 1'éditeur “du modele de collaboration”, puis sélectionnez
Collaboration Debugger > Step Over dans la barre de menus.

* Mettez en évidence I'éditeur “du modele de collaboration” et utilisez le raccourci
clavier Fe.

Pas a pas détaillé

Lorsque vous exécutez une opération de type “step into” sur un noeud
Subdiagram ou Iterator, InterChange Server poursuit le flux interrompu.
L’exécution se poursuit jusqu’a ce que le flux atteigne le noeud de démarrage dans
le sous-diagramme ou l'itérateur puis s’interrompt.

Effectuez I'une des opérations suivantes pour entrer dans un sous-diagramme ou
un itérateur dans lequel 'exécution est interrompue :

* Cliquez avec le bouton droit de la souris n'importe out dans I’éditeur “du
modele de collaboration”, puis sélectionnez Step Into dans le menu contextuel.

* Mettez en évidence I'éditeur “du modele de collaboration”, puis cliquez sur Step
Into dans la barre d’outils.

* Mettez en évidence I'éditeur “du modele de collaboration”, puis sélectionnez
Collaboration Debugger > Step Into dans la barre de menus.

* Mettez en évidence I'éditeur “du modele de collaboration” et utilisez le raccourci
clavier F5.

Pas a pas sortant

Lorsque vous exécutez une opération de type “step out” sur un noeud a l'intérieur
d’un sous-diagramme ou d’un itérateur, InterChange Server poursuit le flux
interrompu. L’exécution se poursuit jusqu’a ce que le sous-diagramme ou
I'itérateur ait terminé ou jusqu’a ce que le flux atteigne un point d’arrét actif dans
le sous-diagramme ou l'itérateur.

Effectuez 'une des opérations suivantes pour sortir d'un sous-diagramme ou d’un
itérateur dans lequel I'exécution est interrompue :

* Cliquez avec le bouton droit de la souris n'importe ott dans 1’éditeur “du
modele de collaboration”, puis sélectionnez Step Out dans le menu contextuel.

* Mettez en évidence I'éditeur “du modele de collaboration”, puis cliquez sur Step
Out dans la barre d’outils.
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* Mettez en évidence l'éditeur “du modele de collaboration”, puis sélectionnez
Collaboration Debugger > Step Out dans la barre de menus.

¢ Mettez en évidence 1'éditeur “du modele de collaboration” et utilisez le raccourci
clavier F7.

Exécution

Lorsque vous exécutez une opération de type “run”, InterChange Server poursuit
le flux interrompu et autorise la poursuite du traitement jusqu’a la fin du
processus métier ou jusqu’au noeud sur lequel est défini un point d’arrét actif.

Effectuez 1'une des opérations suivantes pour exécuter un flux interrompu :

* Cliquez avec le bouton droit de la souris n'importe ot dans l'éditeur “du
modele de collaboration”, puis sélectionnez Run dans le menu contextuel.

* Mettez en évidence I'éditeur “du modele de collaboration”, puis cliquez sur Run
dans la barre d’outils.

* Mettez en évidence l'éditeur “du modele de collaboration”, puis sélectionnez
Collaboration Debugger > Run dans la barre de menus.

¢ Mettez en évidence 1'éditeur “du modele de collaboration” et utilisez le raccourci
clavier F8.

Exécution jusqu’a un noeud spécifique
Lorsque vous exécutez une opération de type “run to this node” sur un flux,
InterChange Server poursuit le flux interrompu et autorise la poursuite du
traitement jusqu’au noeud sur lequel vous avez effectué 1’opération ou jusqu’au
noeud sur lequel est défini un point d’arrét actif.

Effectuez 1'une des opérations suivantes pour exécuter un flux interrompu jusqu’a
un noeud spécifique :

* Cliquez avec le bouton droit de la souris sur le noeud sur lequel vous souhaitez
terminer 1’exécution, puis sélectionnez Run to this node dans le menu
contextuel.

* Sélectionnez le noeud sur lequel vous souhaitez terminer 1'exécution, puis
cliquez sur Run to dans la barre d’outils.

* Sélectionnez le noeud sur lequel vous souhaitez terminer 1’exécution, puis
sélectionnez Collaboration Debugger > Run to dans la barre de menus.

Exécution d’un événement

Lorsque vous exécutez une opération de type “run event”, InterChange Server
poursuit le flux interrompu et autorise la poursuite du traitement, en ignorant les
points d’arrét contenus dans le processus métier méme si ces derniers sont actifs.

Effectuez l'une des opérations suivantes pour exécuter un événement :

* Cliquez avec le bouton droit de la souris sur I'événement dans la vue “Events”,
puis sélectionnez Run dans le menu contextuel.

e Sélectionnez I'événement dans la vue “Events”, puis sélectionnez Collaboration
Debugger > Run Event(s) dans le menu contextuel.

* Sélectionnez I'événement dans la vue “Events”, puis cliquez sur Run Event(s)
dans la barre d’outils.
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Utilisation des variables

La vue “Variables” affiche la valeur de n’importe quelle variable signalée dans
I'onglet “Declarations” de la définition du modéle de collaboration. Cela inclut les
objets métier désignés automatiquement par Process Designer pour étre associés a
chaque port créé dans 1’'onglet “Ports and Triggering Events”, ainsi que toutes les
variables ajoutées a 'onglet “Declarations” par vous-méme.

Lorsque vous affichez un événement comme indiqué dans la section
|d’un événement» a la page 326 ou que vous gérez un flux comme décrit dans la
section [«Exécution d’opérations de débogage» a la page 330} la vue “Variables” met
a jour les informations relatives aux variables affichées. Vous pouvez développer
toute variable de type BusObj pour afficher ses attributs.

Il n’existe actuellement aucun moyen d’afficher la variable triggeringBusObj. Il
s’agit d'une variable déclarée par le systeme qui fait référence au flux a 'origine
du déclenchement de I'exécution de 'objet de collaboration et qui est généralement
trés importante. Si vous souhaitez conserver un enregistrement des valeurs de la
variable triggeringBusObj, vous pouvez déclarer une nouvelle variable BusObj
dans la section “Declarations” du modeéle de collaboration, puis l'initialiser avec la
valeur de la variable triggeringBusObj dans le premier noeud du scénario.

En outre, de nombreux modeles de collaboration transmis manipulent une variable
appelée processingBusObj et laissent la variable triggeringBusObj intacte. Bien que
la variable processingBusObj soit généralement déclarée au niveau du scénario
plutdt qu’au niveau du modele, elle n’est cependant pas affichée dans la vue
“Variables”. Pour mettre la variable processingBusObj a disposition dans la vue
“Variables”, déplacez la déclaration de la variable depuis la définition du scénario
vers la définition du modele.

Vous pouvez filtrer la vue “Variables” pour afficher uniquement certains types de
variable. Procédez comme suit pour filtrer la vue “Variables” :

1. Effectuez l'une des opérations suivantes pour afficher la boite de dialogue
“Variables Filter” :

* Cliquez sur Filter dans la barre de titre de la vue “Variables”.

* Cliquez sur la fleche vers le bas dans le coin supérieur droit de la barre de
titre de la vue “Variables”, puis sélectionnez Filter dans le menu déroulant.

Collaboration Debugger affiche la boite de dialogue “Variables Filter”, comme

indiqué dans la[figure 104 :

4p variables Filter x|

Show variables of type:

- [#] boolean

. [#] BusOkj

i byte

[ char

1 [¥] double

[ Float LI

K I Cancel | Reset |

Figure 104. Filtrage des variables

Chapitre 13. Utilisation de Collaboration Debugger 333



2.

3.

Utilisez les techniques suivantes pour configurer les parametres de filtrage :

* Activez la case a cocher All Types pour afficher tous les types de variable
pris en charge.

* Activez uniquement les cases a cocher des types de variable spécifiques a
afficher.

* Cliquez sur Reset pour appliquer les parametres de filtrage par défaut.
Cliquez sur OK.

Débogage d’une collaboration

Utilisez le flux de travail suivant comme instruction pour déboguer efficacement
un objet de collaboration :

1.

Créez le modeéle de collaboration, créez un objet de collaboration basé sur ce
modele, déployez-les tous les deux dans l'instance d’InterChange Server, puis
veillez a ce que l'objet de collaboration soit lancé.

Lancez la perspective Collaboration Debugger comme indiqué a la section
[«<Lancement de Collaboration Debugger» a la page 313|

Associez Collaboration Debugger a 1’objet de collaboration comme indiqué a la
section |«Association de Collaboration Debugger» a la page 321}

Définissez des points d’arrét aux emplacements souhaités, comme indiqué dans
la section [«Utilisation des points d’arrét» a la page 327

I1 peut s’avérer plus utile pour vous de définir des points d’arrét sur des
noeuds sur lesquels le flux est en cours de transformation, sur lesquels le flux
est en cours d’envoi depuis la collaboration et sur lesquels des éléments
problématiques de logique sont détectés.

Créez et envoyez un événement de telle sorte que 1'objet de collaboration soit
déclenché, au moyen de Test Connector ou d’Integrated Test Environment. Pour
plus d’informations sur Test Connector, voir [Chapitre 11, «Utilisation de Test]
[Connector», a la page 243

Pour plus d’informations sur Integrated Test Environment, voir |Chapitre 12,|
[«Utilisation d’'Integrated Test Environment», a la page 255|

Affichez 1’événement soumis, comme indiqué dans la section [«Affichage d"un|
[6vénement» a la page 326

Gérez le flux via les points d’arrét configurés a l'aide des techniques décrites
dans la section [«Exécution d’opérations de débogage» a la page 330}

Utilisez la vue “Variables” pour afficher les données de modification de
I’événement en cours de traitement par la collaboration, comme indiqué dans la
section [Utilisation des variables» a la page 333}

Répétez les étapes Elé @ pour modifier les points d’arrét et traiter les flux avec
des données différentes.
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Chapitre 14. Optimisation des performances

Ce chapitre explique comment mettre en oeuvre différentes techniques et
configurations pour améliorer les performances du systeme. Il contient les sections
suivantes :

+ [dmplémentation du traitement simultané des flux déclenchés par un]
événement»|

+ [dmplémentation du traitement simultané des requétes par les agents del
connecteur» a la page 337

» |[«Distribution des agents de connecteur» a la page 340

* |«Stockage en mémoire cache des relations statiques» a la page 340|

» [«Utilisation des pools de connexion de base de données» a la page 341

« |«Utilisation de l'unité d’exécution du vérificateur de mémoire» a la page 341|

Implémentation du traitement simultané des flux déclenchés par un
événement

Vous pouvez configurer des objets de collaboration et des controleurs de
connecteur pour traiter simultanément plusieurs flux déclenchés par un
événement. Cette opération peut améliorer de maniere significative les
performances des interfaces déclenchées par un événement.

Traitement simultané des flux déclenchés par un événement
dans des collaborations

Les collaborations peuvent étre configurées pour traiter simultanément plusieurs
flux déclenchés par un événement. La capacité de traitement du systeme et le
temps de réponse nécessaire pour traiter 'événement sont améliorés lorsque le
traitement simultané de 1’événement est correctement utilisé (voir I"astuce
ci-dessous). Par défaut, une collaboration ne traite qu'un seul flux déclenché par
un événement a la fois.

Lorsqu’une collaboration traite simultanément des flux déclenchés par un
événement, elle identifie les dépendances parmi ces flux et les traite dans 1'ordre
dans lequel ils ont été envoyés depuis le contrdleur du connecteur. Le traitement
simultané des flux déclenchés par un événement porte sur les flux dont les
données sont compatibles, tandis que les flux contenant des données incompatibles
sont traitées dans I'ordre dans lequel ils sont reqgus.

Pour configurer une collaboration pour traiter plusieurs flux déclenchés par un
événement, voir |«Maximum number of concurrent events» a la page 219

Astuce : Le traitement simultané des flux déclenchés par un événement dans les
collaborations nécessite des ressources systeme supplémentaires. Pour
optimiser les performances, vérifiez que les ressources systeme utilisées
pour traiter les événements simultanés ne sont pas inactives. Par exemple,
n’affectez pas a I'option Maximum number of concurrent events la
valeur 10 si le nombre d’événements présents dans la file d’attente des
collaborations n’atteint jamais 10.
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Si les ports entrants d’une collaboration sont connectés uniquement pour
recevoir les appels extérieurs via l'interface d’acces, et ne sont reliés a
aucun connecteur, vous pouvez améliorer les performances en affectant la
valeur zéro a l'option Maximum number of concurrent events. En
revanche, n’affectez pas la valeur zéro si la collaboration est utilisée pour
des échanges bidirectionnels avec les connecteurs.

Traitement simultané des flux déclenchés par un événement
dans des groupes d’objets de collaboration

Chaque collaboration dans un groupe d’objets de collaboration peut étre configurée
indépendamment afin de traiter un nombre de flux simultanés déclenchés par un
événement. Il est conseillé d’affecter une valeur identique a toutes les
collaborations d’un groupe pour le nombre de flux simultanés déclenchés par un
événement, de sorte qu'une collaboration dont le taux de collatéralité est faible ne
déséquilibre pas le traitement.

Traitement simultané des flux déclenchés par un événement
dans des controleurs de connecteur

Les contrdleurs de connecteur peuvent étre configurés pour traiter simultanément
plusieurs flux déclenchés par un événement.

Les performances de traitement des flux déclenchés par un événement s’améliorent
lorsqu’un connecteur est configuré pour traiter simultanément ces flux. Cela
s’explique par le fait que plusieurs objets métier peuvent étre simultanément
transformés en mappage.

Pour configurer le traitement simultané des flux déclenchés par un événement
pour les contrdleurs de connecteur, vous devez affecter a la propriété
ConcurrentEventTriggeredFlows le nombre maximal de flux que vous voulez
traiter en méme temps. Pour plus d’informations sur cette propriété, voir
l«ConcurrentEventTriggeredFlows» a la page 175| Pour plus d’informations sur
I'utilisation de Connector Configurator pour définir les propriétés du connecteur,
voir le [Chapitre 7, «Configuration des connecteurs», a la page 145|

Astuce : Si la propriété ConcurrentEventTriggeredFlows est configurée pour une
valeur supérieure a 1, le controleur de connecteur conserve le méme ordre
d’événements recus depuis 'application. Le traitement simultané des flux
déclenchés par un événement dans les connecteurs requiert des ressources
systéme supplémentaires. Pour optimiser les performances, vérifiez que
les ressources systeme utilisées pour traiter les événements simultanés ne
sont pas inactives. Par exemple, n’affectez pas a la propriété
ConcurrentEventTriggeredFlows la valeur 10 si le nombre d’événements
qui parviennent sur InterChange Server pour le connecteur n’atteint
jamais 10. Utilisez la fenétre des statistiques pour déterminer le nombre
d’événements présents dans la file d’attente du connecteur en contrdlant
la longueur de la file d’attente MQ du connecteur. Le contréle de cette
statistique peut vous aider a définir la valeur de la propriété
ConcurrentEventTriggeredFlows.

Si un connecteur est utilisé uniquement en tant que cible, vous pouvez
améliorer les performances en affectant la valeur zéro a la propriété
ConcurrentEventTriggeredFlows. En revanche, n’affectez pas la valeur
zéro a cette propriété si le connecteur est utilisé dans les échanges
bidirectionnels avec une collaboration.
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Implémentation du traitement simultané des requétes par les agents

de connecteur

Les agents de connecteur qui ont été congus en Java pour inclure plusieurs unités
d’exécution peuvent effectuer un traitement simultané de plusieurs unités
d’exécution sans configuration supplémentaire de 1’agent de connecteur. Par
ailleurs, certains connecteurs qui n’ont pas été congus pour le traitement multitache
peuvent étre configurés pour utiliser la fonction Connector Agent Parallelism
(CAP), qui permet a un connecteur de s’exécuter en tant que processus de
connecteur multiples pour traiter plusieurs requétes. La fonction CAP instancie
plusieurs processus en parallele a partir d'un seul processus maitre d’agent de
connecteur, ce qui permet de traiter des flux en simultané plutdt qu’en série.

L’utilisation de Connector Agent Parallelism dans le systéme d’intégration métier
IBM WebSphere InterChange Server peut étre configurée dans 'onglet “Resources”
de Connector Configurator. Etant donné que 1'utilisation du traitement simultané
pour les agents de connecteur peut améliorer les performances dans certains cas, le
comportement par défaut des agents de connecteur est d’utiliser le traitement en
série. Avant de modifier la configuration par défaut, il est conseillé de lire la
documentation d’IBM Business Integration Adapters relative au connecteur,
d’analyser I'application elle-méme afin de déterminer si son architecture ou ses
caractéristiques pourraient empécher 1'utilisation du traitement simultané, et de
définir comment vous pouvez exploiter au mieux les ressources disponibles de
votre environnement. Tout changement opéré dans cette configuration doit étre
testé avant de I'implémenter dans un environnement de production.

Raisons d’utiliser CAP

En regle générale, vous devez envisager d’utiliser Connector Agent Parallelism
dans les cas suivants :

* L’agent de connecteur a été rédigé en C++. Les agents de connecteur qui
utilisent le langage C++ CDK sont par nature monotache, mais ils peuvent étre
configurés pour utiliser Connector Agent Parallelism afin d’exécuter les
processus simultanément.

¢ L’agent de connecteur a été rédigé en Java, mais devait des verrous de
synchronisation en appelant les API d’applications. Par conséquent, il n’a pas pu
utiliser les fonctions de traitement multitache Java. Ce type de connecteur peut
étre configuré pour utiliser Connector Agent Parallelism afin d’exécuter des
processus simultanément.

Raisons de ne pas utiliser CAP

Méme si un connecteur entre dans les catégories précédentes, dans certains cas, il
est déconseillé d'utiliser la fonction Connector Agent Parallelism :

* Si le connecteur est basé sur Java et qu’il est congu pour le traitement
multi-tache, vous n’utiliserez probablement pas Connector Agent Parallelism car
le traitement simultané de plusieurs unités d’exécution (ce que le connecteur
peut faire sans Connector Agent Parallelism) mobilise moins de ressources.

* L’architecture ou les caractéristiques d’une application peuvent empécher le
traitement simultané, quelles que soient les fonctions du connecteur. Par
exemple, pour les connecteurs TPI, une seule instance du serveur Cyclone peut
étre instanciée.

* Un connecteur peut avoir besoin d’utiliser de maniéere exclusive les ressources
globales. Dans ce cas, vous devez examiner le comportement qui s’ensuit si
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plusieurs processus tentent d’accéder de maniere exclusive aux mémes
ressources globales. Il se peut que vous ne puissiez pas utiliser Connector Agent
Parallelism dans ce cas.

Configuration des agents de connecteur pour traiter
simultanément les requétes

Pour modifier les parametres permettant d’utiliser la fonction CAP, démarrez
Connector Configurator et sélectionnez I'onglet “Resources”. L’onglet “Resources”
est représenté dans la [figure 105|:

_o/x]
Standard Prop... | Connector-5.. | Supported Bu... | Associated Wa... | Resources | TracefLog Files | Messaging | Data Handler |
Resource | values Percentage
Parsllel Process Degree 1

Call Triggered Requests
Minimum Allocation 0 0 |
Maximum Alocation o [0 |

Evert Triggered Requests I
Minimum Allocstion 0 0 |
Maximum &lacation [i] lo |

Figure 105. Configuration des valeurs indiquées dans l'onglet “Resources”

Définissez les valeurs de 1'onglet Resources pour utiliser soit le traitement
simultané soit le traitement en série.

Si vous remplacez la valeur 1 par une valeur supérieure, ou que vous remplacez
une valeur supérieure par 1, vous devez réamorcer 'agent de connecteur pour que
le changement prenne effet. Si la valeur est déja supérieure a 1, vous pouvez la
remplacer par une autre valeur de maniere dynamique.

Pour le traitement en série

Par défaut, les définitions de connecteur sont configurées en affectant a la valeur 1

a la propriété Parallel Process Degree, qui indique d’utiliser le traitement en série.

Lorsque la propriété Parallel Process Degree a la valeur 1, toutes les autres valeurs
de la fenétre sont définies sur 0.

Pour le traitement simultané

Pour configurer un connecteur pour qu’il utilise le traitement simultané, procédez
comme suit :

1. Attribuez une valeur égale ou supérieure a 2 a la propriété Parallel Process
Degree. Le connecteur exécutera simultanément le nombre indiqué de processus
esclaves.

Remarque : La valeur correspond au nombre de processus esclaves. Chaque
agent de connecteur dispose d’un processus d’interrogation, d'un
processus maitre et d'un nombre configurable de processus
esclaves. Ainsi, pour une valeur de 2, par exemple, le connecteur
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utilise un total de quatre processus : le processus d’interrogation
du connecteur, le processus maitre du connecteur et 2 processus
esclaves.

2. Entrez le nombre minimum de processus esclaves que vous voulez générer
pour les flux déclenchés par un appel dans la colonne Values de la propriété
Minimum Allocation située en retrait de la propriété Call Triggered Requests.

3. Entrez le nombre maximal de processus esclaves que vous voulez générer pour
les flux déclenchés par un appel dans la colonne Values de la propriété Maximum
Allocation située en retrait de la propriété Call Triggered Requests.

4. Entrez le nombre minimum de processus esclaves que vous voulez générer
pour les flux déclenchés par un événement dans la colonne Values de la
propriété Minimum Allocation située en retrait de la propriété Event Triggered
Requests.

5. Entrez le nombre maximum de processus esclaves que vous voulez générer
pour les flux déclenchés par un événement dans la colonne Values de la
propriété Maximum Allocation située en retrait de la propriété Event Triggered
Requests.

Les flux déclenchés par un appel sont synchrones et sont initialisés par des clients
d’acces, qui attendent une réponse a leur requéte. Si le connecteur traite les flux
déclenchés par un appel et les flux déclenchés par un événement, vous pouvez
réserver d’autres processus esclaves aux flux déclenchés par un appel de maniére a
ce que les programmes d’initialisation regoivent une réponse aussi vite que
possible.

Vous pouvez accepter les valeurs par défaut ou entrer le nombre minimal et
maximal de processus que vous voulez consacrer a chaque type de requéte. Notez
que la somme des valeurs maximales des deux types de requéte ne peuvent pas
excéder la valeur de la propriété Parallel Process Degree. En outre, les valeurs
minimales ne peuvent pas étre supérieures aux valeurs maximales.

Pour utiliser au mieux la fonction Connector Agent Parallelism, associez la valeur
Parallel Process Degree aux valeurs Maximum Number of Concurrent Events dans
les objets de collaboration qui envoient des requétes a 1’agent de connecteur. Si un
seul objet de collaboration envoie des requétes a cet agent de connecteur, affectez a
la propriété Maximum Number of Concurrent Events de la collaboration une
valeur égale ou supérieure a la valeur de la propriété Parallel Process Degree de
I'agent de connecteur. Si plusieurs collaborations envoient des requétes a cet agent
de connecteur, affectez a la valeur de la propriété Parallel Process Degree une
valeur égale a la somme des valeurs de la propriété Maximum Number of
Concurrent Events des collaborations.

Si vous utilisez un connecteur dont les valeurs des parametres de taille de
segment/espace mémoire JVM (Java Virtual Machine) ne sont pas les valeurs par
défaut indiquées ci-dessous, vous devrez modifier le fichier de configuration du
connecteur. Les valeurs JVM que vous avez définies dans le fichier de
configuration du connecteur seront propagées a partir du processus maitre de
I'agent de connecteur vers les processus esclaves. Pour modifier ces valeurs,
utilisez un éditeur XML pour ouvrir le fichier InterchangeSystem.cfg, ou le fichier
de configuration de l'agent de connecteur local si vous utilisez un fichier local, et
modifiez les valeurs indiquées sous la partie JVM <connector_name>.

Les parametres JVM et leurs options Java VM correspondantes sont les suivantes :
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MIN_HEAP_SIZE  (-Xms)
MAX_HEAP_SIZE (-Xmx)
MAX_NATIVE_STACK_SIZE(-Xss)

Par défaut, on utilise les valeurs suivantes :

MIN_HEAP SIZE=1m
MAX_HEAP_SIZE=128m
MAX_NATIVE_STACK SIZE=128k

Vous pouvez étre amené a modifier les valeurs du connecteur. Par exemple, vous
pouvez affecter les valeurs suivantes dans la partie JVM du fichier de
configuration :

[JvM SAPConnector]

MIN_HEAP_SIZE=256m

MAX_HEAP_SIZE=512m
MAX_NATIVE_STACK_SIZE=1m

Distribution des agents de connecteur

Vous pouvez améliorer les performances du systeme d’intégration métier en
distribuant les agents de connecteur. La distribution des agents de connecteur
améliore les performances du systeme pour les raisons suivantes :

* Chaque processus d'InterChange Server et chaque processus d’agent de
connecteur s’exécute sur sa propre machine virtuelle (JVM). Un ordinateur peut
prendre en charge un nombre considérable d’instances JVM en cours d’exécution
avant que ses performances ne commencent a se dégrader. Le seuil dépend des
spécifications de 'ordinateur, mais la distribution d’un agent de connecteur
diminue la charge sur la machine qui héberge InterChange Server d'une JVM.

* Les performances d'un connecteur s’améliorent généralement plus il est proche
de l'application avec laquelle il communique, selon la topologie de réseau.
Idéalement, I’agent de connecteur doit étre installé sur 1'ordinateur qui héberge
le serveur d’applications, bien que cela ne soit pas toujours possible selon
I'environnement. Si I’ordinateur hote de I'application et I'ordinateur hote
d’InterChange Server sont sur des sous-réseaux différents, les performances de
l'agent de connecteur seront cependant meilleures s’il est installé sur un autre
ordinateur dans le méme sous-réseau que celui dans lequel I'ordinateur hote de
l'application réside.

Pour plus d’informations sur la distribution des agents de connecteur, voir le
document Installation Guide for WebSphere Business Integration Adapters.

Stockage en mémoire cache des relations statiques

Vous pouvez stocker en mémoire cache des relations statiques de maniere a ce que
les données du participant qu’elles contiennent soient chargées en mémoire et que
les requétes relatives aux données soient émises sur les données stockées en
mémoire, au lieu des données stockées dans la base de données. Ainsi, la relation
recherche les données beaucoup plus rapidement que si elle devait extraire les
informations de la base de données pour chaque flux.

Pour plus d’informations sur la configuration des relations statiques a stocker en
mémoire cache, voir le document Map Development Guide.
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Utilisation des pools de connexion de base de données

11 est fréquent de devoir extraire des informations d’une table de base de données
ou d’en ajouter au cours du traitement d’un flux. Une diminution des
performances se produit si 'interface doit établir une connexion a la base de
données pour chaque flux, en particulier parce qu'une ouverture d’une session doit
étre effectuée pour chaque connexion.

Les pools de connexion de base de données sont des composants d’intégration qui
créent et gerent un pool de connexions vers une ressource de base de données. Les
connexions sont créées au départ et sont mises a la disposition des autres
composants afin qu’ils émettent des requétes sur la ressource de la base de
données. Lorsqu'un composant a terminé d’utiliser une connexion, celle-ci est
libérée et retourne dans le pool afin qu’un autre composant puisse 'utiliser. De ce
fait, vous n’avez plus besoin d’ouvrir une session chaque fois qu'une connexion est
nécessaire.

Pour plus d’informations sur la création de pools de connexion de base de
données, voir [Chapitre 8, «Configuration des pools de connexion & une base de|
[données», a la page 191| Pour plus d’informations sur la maniére d’utiliser les
pools de connexion de base de données dans les mappes, voir le document Map
Development Guide. Pour plus d’informations sur la maniéere d’utiliser les pools de
connexion de base de données dans les modeles de collaboration, voir le document
Collaboration Development Guide.

Utilisation de I'unité d’exécution du vérificateur de mémoire

InterChange Server intégre une unité d’exécution de vérificateur de mémoire qui
permet de controler la maniére dont les événements sont traités par le systeme et
par la méme, la consommation de mémoire systeme. De cette maniere, le risque de
panne du systeme lié au manque de mémoire est limité.

L’unité d’exécution du vérificateur de mémoire mesure périodiquement l’espace
mémoire utilisé par InterChange et détermine si cette valeur est acceptable. Si
l"utilisation de la mémoire n’est pas comprise dans un intervalle acceptable, l'unité
d’exécution du vérificateur de mémoire gere les composants systeme afin de
réduire 1'utilisation de la mémoire.

Si l'utilisation de la mémoire dépasse un seuil inférieur indiqué, 1'unité d’exécution
du vérificateur de mémoire provoque la mise en veille des unités d’exécution du
programme d’écoute d’événement des contréleurs de connecteur dans le systeme
pendant une durée maximale configurable. Cette durée varie selon la proportion
d’utilisation de la mémoire au-dessus du seuil inférieur, mais n’excede pas la durée
indiquée par la propriété Connector pause time at threshold. En provoquant la
mise en veille des unités d’exécution du programme d’écoute d’événement de cette
maniere, 1'unité d’exécution du vérificateur de mémoire ralentit la vitesse a
laquelle les événements sont transmis a InterChange Server et limite le risque de
dépassement de l'utilisation de la mémoire du seuil supérieur.

Si l'utilisation de la mémoire dépasse le seuil supérieur indiqué par la propriété
Memory lower threshold percent, l'unité d’exécution du vérificateur de mémoire
interrompt les connecteurs dans le systeme. Lorsque les connecteurs sont
interrompus, ils continuent de traiter les objets métier mis en file d’attente, mais
n’interrogent pas les nouveaux événements. Les connecteurs réduisent ainsi le
nombre d’objets métier mis en file d’attente et donc la quantité de mémoire
utilisée, sans mobiliser d’autres ressources pour traiter les nouveaux objets. Les
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connecteurs restent en pause pendant un délai minimum indiqué par la propriété
Connector pause time at threshold. Lorsque le délai indiqué par la propriété
Connector pause time at threshold a expiré, 'unité d’exécution du vérificateur de
mémoire examine a nouveau l'utilisation de la mémoire. Si 'utilisation de la
mémoire n’excede pas le seuil supérieur, l'unité d’exécution du vérificateur de
mémoire redémarre les connecteurs. En revanche, si 'utilisation de la mémoire
excéde encore le seuil supérieur, 'unité d’exécution du vérificateur de mémoire
autorise les connecteurs a rester en veille.

L’unité d’exécution du vérificateur de mémoire interrompt ses opérations de
gestion des états temporaires et d’examen pendant la durée indiquée par la
propriété Memory checker sleep time.

Pour utiliser 'unité d’exécution du vérificateur de mémoire, vous devez suivre les
instructions des sections suivantes :

1. ‘«Configuration du parameétre CW_MEMORY_MAX»l
2. [«Configuration des propriétés de 'unité d’exécution du vérificateur dé

mémoire»|

3. [«Autres remarques» a la page 344

Configuration du parametre CW_MEMORY_MAX

Vous devez configurer le parametre Java CW_MEMORY_MAX dans le script de
démarrage d’InterChange Server pour définir le segment de mémoire maximal
qu’InterChange Server peut utiliser. L'unité d’exécution du vérificateur de mémoire
se comporte en fonction des valeurs des propriétés configurables qui indiquent les
pourcentages de taille de segment de mémoire maximale.

Vous devez affecter au paramétre CW_MEMORY_MAX la méme valeur que celle du
parametre -mx, qui spécifie la taille maximale de segment de mémoire utilisée par
InterChange Server. Par défaut, le parametre CW_MEMORY_MAX a la méme valeur que
celle du parametre -mx. Toutefois, si vous modifiez le parametre -mx, vous devez
modifier le parametre CW_MEMORY_MAX en conséquence.

L’exemple ci-dessous est tiré d'un script de démarrage start_server.bat non
modifié d'InterChange Server sur un systeme d’exploitation Windows :

REM This is the -mx param value for the Interchange Server's memory heap
set CW_MEM_HEAP=512

REM Start the InterChange Server

%CWJAVA% -Djava.ext.dirs=%JRE_EXT_DIRS%;"%MQ_LIB%";"%DB2_LIB%"
-Duser.home="%CROSSWORLDS%" -mx%CW_MEM_HEAP%m -DTEAgent=1200
-DCW_MEMORY_MAX=%CW_MEM_HEAP% %O0RB_PROPERTY% -classpath %JCLASSES%
ServerWrapper -s%SERVERNAME% %2 %3

La variable CW_MEM_HEAP a la valeur 512, et est utilisée pour définir le parametre
-mx. Ainsi, 512 mégaoctets de mémoire sont réservés au segment de mémoire Java.
Le paramétre CW_MEMORY_MAX a la méme valeur, indiquée par la variable
CW_MEM_HEAP. Notez que le parametre CW_MEMORY_MAX doit étre précédé de la lettre
-D.

Configuration des propriétés de I'unité d’exécution du
vérificateur de mémoire

Vous devez modifier le fichier de configuration d’InterChange Server pour définir
les propriétés de 1'unité d’exécution du vérificateur de mémoire. Ces propriétés
sont affichées dans 'onglet “Misc” de l'interface de configuration d’InterChange
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Server. Pour plus d’informations sur la configuration d’InterChange Server, voir

l«Configuration des autres propriétés a ’aide de System Manager» a la page 123|

Dans le panneau “Server Memory” de 'onglet “Misc”, procédez comme suit pour
configurer I'unité d’exécution du vérificateur de mémoire :

1.

Affectez au champ Memory checker sleep time l'intervalle de temps pendant
lequel l'unité d’exécution du vérificateur de mémoire doit se mettre en veille
entre chaque opération. Affectez au champ Memory checker sleep time la
valeur 0 (valeur par défaut) afin de désactiver I'unité d’exécution du
vérificateur de mémoire.

Affectez au champ Memory upper threshold percent le pourcentage de
mémoire totale disponible pour InterChange Server (indiqué par le parameétre
CW_MEMORY_MAX). Lorsque ce seuil est dépassé, l'unité d’exécution du vérificateur
de mémoire interrompt les connecteurs de sorte qu’ils n’interrogent pas les
nouveaux événements tant que l'utilisation de la mémoire ne redescend pas en
dessous du seuil supérieur. La valeur par défaut est 90, ce que signifie que le
seuil supérieur est fixé a 90 pour cent de la mémoire totale indiquée par le
parametre CW_MEMORY_MAX. Par exemple, si le parametre CW_MEMORY_MAX a la
valeur 512 mégaoctets, le seuil supérieur doit étre d’environ 460 mégaoctets.

Affectez au champ Memory lower threshold percent le pourcentage de
mémoire totale disponible pour InterChange Server (indiqué par le parameétre
CW_MEMORY_MAX). Lorsque ce seuil est dépassé, l'unité d’exécution du vérificateur
de mémoire doit réduire la vitesse a laquelle les connecteurs transmettent les
événements a InterChange Server. La valeur par défaut est 80, ce que signifie
que le seuil inférieur est fixé a 80 pour cent de la mémoire totale indiquée par
le parametre CW_MEMORY_MAX. Par exemple, si le parametre CW_MEMORY_MAX a la
valeur 512 mégaoctets, le seuil inférieur doit étre d’environ 410 mégaoctets.

Affectez au champ Connector pause time at threshold le délai nécessaire (en
minutes) qui indique la durée maximale pendant laquelle la vitesse de
transmission des événements des connecteurs a InterChange Server est réduite
lorsque le seuil inférieur d'utilisation de la mémoire est dépassé, et la durée
minimale pendant laquelle les connecteurs resteront en veille lorsque le seuil
supérieur est dépassé. La valeur par défaut est 5.

La [figure 106 a la page 344] représente 1'onglet “Misc” et les propriétés “Server
Memory” utilisées pour configurer 1'unité d’exécution du vérificateur de mémoire.
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Figure 106. Configuration des propriétés de I'unité d’exécution du vérificateur de mémoire

Autres remarques

Tenez compte des remarques suivantes lorsque vous utilisez 1'unité d’exécution du
vérificateur de mémoire :

* Vous ne devez pas utiliser l'unité d’exécution du vérificateur de mémoire si vous
exécutez une instance d’InterChange Server qui traite peu de transactions. Par
exemple, si vous avez affecté une valeur inférieure a 512 mégaoctets au
parametre -mx, l'unité d’exécution de la collecte des données obsolétes de la
machine virtuelle Java ne sera pas en mesure de libérer de suffisamment
d’espace.

 Utilisez les techniques suivantes pour déterminer la meilleure configuration a
appliquer pour les propriétés de 1'unité d’exécution du vérificateur de mémoire :

— Au préalable, affectez aux propriétés Memory lower threshold percent et
Memory upper threshold percent des valeurs proches, testez le
comportement du systéme, puis augmentez 1'écart qui existe entre les valeurs
et testez a nouveau le systeme. Répétez cette procédure pour déterminer
I'écart optimal.

— Affectez a la propriété Connector pause time at threshold une valeur
comprise entre une et cinq minutes.

— Si InterChange Server doit exécuter une charge de travail importante, affectez
a la propriété Memory checker sleep time une valeur faible afin qu’elle
effectue des opérations de contrdle et de mesure plus fréquentes.
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Remarques

Le présent document peut contenir des informations ou des références concernant
certains produits, logiciels ou services IBM non disponibles dans tous les pays.
Pour plus de détails, référez-vous aux documents d’annonce disponibles dans votre
pays, ou adressez-vous a votre partenaire commercial IBM. Toute référence a un
produit, logiciel ou service IBM n'implique pas que seul ce produit, logiciel ou
service puisse étre utilisé. Tout autre élément fonctionnellement équivalent peut
étre utilisé, s’il n’enfreint aucun droit d’IBM. Il est de la responsabilité de
l'utilisateur d’évaluer et de vérifier lui-méme les installations et applications
réalisées avec des produits, logiciels ou services non expressément référencés par
IBM.

IBM peut détenir des brevets ou des demandes de brevet couvrant les produits
mentionnés dans le présent document. La remise de ce document ne vous donne
aucun droit de licence sur ces brevets ou demandes de brevet. Si vous désirez
recevoir des informations concernant l'acquisition de licences, veuillez en faire la
demande par écrit a 'adresse suivante :

IBM EMEA Director of Licensing
IBM Europe Middle-East Africa
Tour Descartes

La Défense 5

2, avenue Gambetta

92066 - Paris-La Défense CEDEX
France

Pour le Canada, veuillez adresser votre courrier a :

IBM Director of Commercial Relations
IBM Canada Ltd.

3600 Steeles Avenue East

Markham, Ontario

L3R 977

Canada

Le paragraphe suivant ne s’applique ni au Royaume-Uni, ni dans aucun pays dans
lequel il serait contraire aux lois locales.

LE PRESENT DOCUMENT EST LIVRE EN L’ETAT. IBM DECLINE TOUTE
RESPONSABILITE, EXPLICITE OU IMPLICITE, RELATIVE AUX INFORMATIONS
QUI Y SONT CONTENUES, Y COMPRIS EN CE QUI CONCERNE LES
GARANTIES DE NON-CONTREFACON ET D’APTITUDE A L’EXECUTION D'UN
TRAVAIL DONNE. Certaines juridictions n’autorisent pas 1’exclusion des garanties
implicites, auquel cas 1’exclusion ci-dessus ne vous sera pas applicable.

Le présent document peut contenir des inexactitudes ou des coquilles. Il est mis a
jour périodiquement. Chaque nouvelle édition inclut les mises a jour. IBM peut
modifier sans préavis les produits et logiciels décrits dans ce document.

Les références a des sites Web non IBM sont fournies a titre d’information
uniquement et n’impliquent en aucun cas une adhésion aux données qu’ils
contiennent. Les éléments figurant sur ces sites Web ne font pas partie des
éléments du présent produit IBM et 1'utilisation de ces sites releve de votre seule
responsabilité.
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IBM pourra utiliser ou diffuser, de toute maniere qu’elle jugera appropriée et sans
aucune obligation de sa part, tout ou partie des informations qui lui seront
fournies.

Les licenciés souhaitant obtenir des informations permettant : (i) I'échange des
données entre des logiciels créés de fagon indépendante et d’autres logiciels (dont
celui-ci), et (ii) 'utilisation mutuelle des données ainsi échangées, doivent adresser
leur demande a :

IBM Burlingame Laboratory Director
IBM Burlingame Laboratory

577 Airport Blvd., Suite 800
Burlingame, CA 94010

US.A

Ces informations peuvent étre soumises a des conditions particuliéres, prévoyant
notamment le paiement d’une redevance.

Le logiciel sous licence décrit dans ce document et tous les éléments sous licence
disponibles s’y rapportant sont fournis par IBM conformément aux dispositions de
I'ICA, des Conditions internationales d’utilisation des logiciels IBM ou de tout
autre accord équivalent.

Les données de performance indiquées dans ce document ont été déterminées dans
un environnement contrélé. Par conséquent, les résultats peuvent varier de manieére
significative selon 1’environnement d’exploitation utilisé. Certaines mesures
évaluées sur des systemes en cours de développement ne sont pas garanties sur
tous les systemes disponibles. En outre, elles peuvent résulter d’extrapolations. Les
résultats peuvent donc varier. Il incombe aux utilisateurs de ce document de
vérifier si ces données sont applicables a leur environnement d’exploitation.

Les informations concernant des produits non IBM ont été obtenues aupres des
fournisseurs de ces produits, par l'intermédiaire d’annonces publiques ou via
d’autres sources disponibles. IBM n’a pas nécessairement testé ces produits et ne
peut confirmer 'exactitude de leurs performances ni leur compatibilité. Elle ne
peut recevoir aucune réclamation concernant des produits non IBM. Toute question
concernant les performances de produits non IBM doit étre adressée aux
fournisseurs de ces produits.

Le présent document peut contenir des exemples de données et de rapports utilisés
couramment dans 'environnement professionnel. Ces exemples peuvent
mentionner des noms fictifs de personnes, de sociétés, de marques ou de produits
a des fins illustratives ou explicatives uniquement. Toute ressemblance avec des
noms de personnes, de sociétés ou des données réelles serait purement fortuite.

Toute instruction relative aux intentions d’IBM pour ses opérations a venir est
susceptible d’étre modifiée ou annulée sans préavis, et doit étre considérée
uniquement comme un objectif.

Informations sur les interfaces de programmation

Les informations sur les interfaces de programmation ont pour objectif de vous
aider a créer des logiciels d’application a l'aide de ce programme.

Les interfaces de programmation génériques vous permettent de créer des logiciels
d’application qui obtiennent les services des outils de ce programme.
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Cependant, ces informations peuvent également contenir des informations sur le
diagnostic, la modification et le réglage. Ces informations vous permettent
d’exécuter le débogage de votre logiciel d’application.

Avertissement : N'utilisez pas ces informations sur le diagnostic, la modification et
le réglage comme interface de programmation car elles sont
susceptibles de changer.

Marques et marques de service

Les termes qui suivent sont des marques d’International Business Machines
Corporation aux Etats-Unis et/ou dans certains autres pays :

IBM

le logo IBM
AIX

CICS
CrossWorlds
DB2

DB2 Universal Database
Domino

IMS

Informix
iSeries

Lotus

Lotus Notes
MQIntegrator
MQSeries
MVS

0S/400
Passport Advantage
SupportPac
WebSphere
z/0S

Microsoft, Windows, Windows NT et le logo Windows sont des marques de
Microsoft Corporation aux Etats-Unis et/ou dans certains autres pays.

MMX, Pentium et ProShare sont des marques d’Intel Corporation aux Etats-Unis
et/ou dans certains autres pays.

Java et toutes les marques incluant Java sont des marques de Sun Microsystems,
Inc. aux Etats-Unis et/ou dans certains autres pays.

Linux est une marque de Linus Torvalds aux Etats-Unis et/ou dans certains autres
pays.

D’autres sociétés sont propriétaires des autres marques, noms de produits ou logos
qui pourraient apparaitre dans ce document. System Manager et les autres
perspectives incluent un logiciel développé par Eclipse Project

(http:/ /www.eclipse.org/)
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JAvA,

IBM WebSphere InterChange Server (5724-178), version 4.3.0 et IBM WebSphere
Business Integration Toolset (5724-177), version 4.3.0
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